## Contents

Before Beginning ................................................................. 25

Notes, Cautions, and Warnings ........................................... 27

About License ................................................................. 27
- As for RSA BSAFE .......................................................... 27
- ICC Profile Header ......................................................... 27
- JPEG Library ............................................................... 28
- Math Library ............................................................... 28
- libtiff ................................................................. 28
- Zlib ................................................................. 29

1 Dell™ Cloud Multifunction Printer | H815dw
Dell™ Smart Multifunction Printer | S2815dn
User’s Guide ................................................................. 31

Conventions ................................................................. 31

2 Finding Information ....................................................... 33

3 Product Features ......................................................... 35

4 About the Printer .......................................................... 39

Front and Rear Views ....................................................... 39
- Front View ............................................................. 39
- Rear View ............................................................. 40

Duplex Automatic Document Feeder (DADF) ......................... 41

Space Requirements ......................................................... 42

Operator Panel ............................................................. 42

Optional Accessory .......................................................... 43

Securing the Printer ......................................................... 43

Ordering Supplies .......................................................... 43
Setting Up the Printer (Printer Setup) ............... 45

5 Overview of the Printer Setup ......................... 47

6 Installing Optional Accessory .......................... 49
   Installing the Optional 550-Sheet Feeder .................. 49
   Updating Your Driver to Detect 550-Sheet Feeder ......... 53

7 Connecting and Setting Up Your Printer ............... 57
   Turning on the Printer .................................. 58
   Configuring Initial Settings on the Operator Panel ........ 58
   Connecting to a Computer or a Network .................. 65
      Connecting to a Computer Using the USB Cable (Direct Connection) ...... 65
      Connecting to a Network Using the Ethernet Cable .................. 66
      Connecting to a Wireless Network .......................... 66
   Connecting to the Telephone Line ......................... 66
   Setting Up the Printer Using Dell Printer Easy Install (Windows® Only) .... 68
      Basic Setup ........................................... 68
      To set up the Dell Cloud Multifunction Printer | H815dw as a wireless printer 68
      To set up the printer as a network (wired) printer ............. 68
      To set up the printer as a USB printer ........................ 68
      Setting Up the Printer in Another Connection Method .......... 70
   Configuring the Wireless Settings ...................... 71
      Determining the Wireless Network Settings .................. 71
      Configuring the Wireless Settings Using Dell Printer Easy Install .... 72
      Configuring the Wireless Settings Without Using Dell Printer Easy Install ... 74
      Reconfiguring the Wireless Settings ........................ 77

8 Setting the IP Address .................................. 79
   Assigning an IP Address ................................ 79
      When Using the Dell Printer Easy Install ............... 79
      When Using the Operator Panel .......................... 80
      When Using the Tool Box ................................ 81
   Verifying the IP Settings ............................... 81
      Verifying the Settings Using Operator Panel ................. 81
Verifying the Settings Using System Settings Report ...................................... 82
Verifying the Settings Using Ping Command .................................................. 82

9 Loading Paper ................................................................................................. 83

10 Installing Printer Drivers on Windows® Computers ........................................ 87
   Identifying Printer Driver Pre-install Status ................................................... 87
   Changing the firewall settings before installing your printer ......................... 87
   Starting Dell Printer Easy Install ................................................................. 87
   USB Cable Connection Setup ....................................................................... 88
   Network Connection Setup ......................................................................... 92
   Setting Up for Shared Printing ................................................................... 97
   Enabling Shared Printing from the Computer .............................................. 97
   Checking the Shared Printer ..................................................................... 99

11 Installing Printer Drivers on Macintosh Computers ....................................... 101
   Installing the Drivers and Software ........................................................... 101
   Adding a Printer on Mac OS X 10.5, Mac OS X 10.6, Mac OS X 10.7, OS X 10.8,
   OS X 10.9, or OS X 10.10 ........................................................................ 101
   Configuring Settings ................................................................................. 103

12 Installing Printer Drivers on Linux Computers (CUPS) .................................. 105
   Operation on Red Hat Enterprise Linux 6 Desktop ....................................... 105
      Setup Overview ..................................................................................... 105
      Installing the Printer Driver .................................................................. 105
      Setting Up the Queue ......................................................................... 105
      Setting the Default Queue .................................................................. 106
      Specifying the Printing Options .......................................................... 106
      Uninstalling the Printer Driver .............................................................. 106
   Operation on SUSE Linux Enterprise Desktop 11 ......................................... 107
      Setup Overview ..................................................................................... 107
      Installing the Printer Driver .................................................................. 107
      Setting Up the Queue ......................................................................... 108
      Setting the Default Queue .................................................................. 109
      Specifying the Printing Options .......................................................... 109
      Setting the Password for Authority as the Printer Administrator ........... 110
Uninstalling the Printer Driver ........................................ 110

Operation on Ubuntu 12.04 LTS ....................................... 110
  Setup Overview ..................................................... 110
  Installing the Printer Driver ...................................... 110
  Setting Up the Queue .............................................. 111
  Setting the Default Queue ........................................ 112
  Specifying the Printing Options .................................. 112
  Uninstalling the Printer Driver .................................... 112

Using Your Printer ................................................... 113

13 Operator Panel .................................................... 115
  About the Operator Panel ......................................... 115
    Dell™ Cloud Multifunction Printer | H815dw .................. 115
    Dell Smart Multifunction Printer | S2815dn .................. 115
  Basic Operations on the Touch Panel ............................ 117
    To Select the Item on the Screen ................................. 117
    To Scroll the Screen or the Listed Items ...................... 117
  About the Home Screen ............................................ 118
    Dock Menu ........................................................ 118
    Notification Bar ................................................. 118
    Lock Icon ........................................................ 119
    Envelope Mode Icon ............................................. 119
    Wi-Fi Direct Connection Status Icon ......................... 119
    Wireless LAN Connection Status Icon ......................... 119
    Time/Network Information ...................................... 119
    Account Name ................................................... 119
    Tiles ............................................................... 119
  Moving, Adding or Deleting the Tiles ........................... 120
    To Move the Tiles ............................................... 120
    To Add the Tiles ............................................... 120
    To Delete the Tiles ............................................. 120
  Using the Keyboard Displayed on the Touch Panel .............. 121
    To Change the Keyboard Layout ................................ 121
  Using the Number Pad .............................................. 122
    Number Pad Numbers ............................................. 122
    Changing Numbers ............................................... 122
    Inserting a Pause ................................................ 122
Printing a Panel Settings Report ......................................................... 122
Changing the Language ................................................................. 123
  When Using the Operator Panel .................................................... 123
  When Using the Tool Box ............................................................. 123
Setting the Power Saver Timer Option .............................................. 123
About the Concurrent Jobs Feature ................................................... 124

14 Dell™ Printer Configuration Web Tool ........................................... 125
Overview ......................................................................................... 125
Setting Up the Dell Printer Configuration Web Tool .......................... 126
  Setting Up From Web Browser ....................................................... 126
  Setting Up From Operator Panel .................................................... 126
Starting the Dell Printer Configuration Web Tool .............................. 127
Overview of the Menu Items .............................................................. 127
  Printer Status ........................................................................ 127
  Printer Jobs ........................................................................... 127
  Printer Settings ...................................................................... 127
  Print Server Settings ................................................................. 127
  Copy Printer Settings ................................................................. 128
  Print Volume .......................................................................... 128
  Address Book ........................................................................ 128
  Printer Information .................................................................. 128
  Tray Management .................................................................... 128
  E-Mail Server Settings Overview ................................................ 128
  Set Password .......................................................................... 128
  Online Help ........................................................................... 128
  Order Supplies at: ................................................................. 128
  Contact Dell Support at: ......................................................... 128
  Dell Document Hub at: ............................................................ 128
Page Display Format ......................................................................... 129
  Top Frame ............................................................................... 129
  Left Frame ............................................................................. 130
  Right Frame ........................................................................... 130
Changing the Settings of the Menu Items ......................................... 131
  Details of the Menu Items .......................................................... 131
  Printer Status ........................................................................ 134
  Printer Jobs ........................................................................... 135
  Printer Settings ...................................................................... 136
  Print Server Settings ................................................................. 152
15 Understanding the Printer Menus .............................. 181

Report / List ......................................................... 181
Report / List ......................................................... 181
System Settings ..................................................... 181
System Settings ..................................................... 181
Panel Settings ....................................................... 181
Panel Settings ....................................................... 181
PCL Fonts List ....................................................... 181
PCL Fonts List ....................................................... 181
PCL Macros List ..................................................... 181
PCL Macros List ..................................................... 181
PS Fonts List ......................................................... 181
PS Fonts List ......................................................... 181
PDF Fonts List ....................................................... 181
PDF Fonts List ....................................................... 181
Job History ........................................................... 181
Job History ........................................................... 181
Error History ......................................................... 181
Error History ......................................................... 181
Print Meter ........................................................... 182
Print Meter ........................................................... 182
Demo Page ............................................................ 182
Demo Page ............................................................ 182
Protocol Monitor ..................................................... 182
Protocol Monitor ..................................................... 182
Speed Dial ............................................................ 182
Speed Dial ............................................................ 182
Address Book ......................................................... 182
Address Book ......................................................... 182
Server Address ....................................................... 182
Server Address ....................................................... 182
Fax Activity ............................................................ 182
Fax Activity ............................................................ 182
Fax Pending ............................................................ 182
Fax Pending ............................................................ 182
Stored Documents .................................................... 182
 Stored Documents ...................................................... 182
Printing a Report/List Using the Operator Panel .................. 183
Printing a Report/List Using the Operator Panel .................. 183
Printing a Report/List Using the Tool Box ......................... 183
Printing a Report/List Using the Tool Box ......................... 183

Wi-Fi | WPS ............................................................ 183

Wi-Fi ................................................................. 183
Wi-Fi ................................................................. 183
Wi-Fi Direct ........................................................ 183
Wi-Fi Direct ........................................................ 183
WPS (Connect via PBC) ............................................. 183
WPS (Connect via PBC) ............................................. 183
WPS (Connect via PIN) .............................................. 183
WPS (Connect via PIN) .............................................. 183

Paired Device .......................................................... 184

Admin Settings ......................................................... 184

Phone Book ............................................................. 184
Phone Book ............................................................. 184
PCL ................................................................. 184
PCL ................................................................. 184
PS ................................................................. 191
PS ................................................................. 191
PDF ................................................................. 192
PDF ................................................................. 192
Network ............................................................... 194
Network ............................................................... 194
Fax Settings .......................................................... 201
Fax Settings .......................................................... 201
System Settings ....................................................... 209
System Settings ....................................................... 209
Maintenance ......................................................... 220
Maintenance ......................................................... 220
Secure Settings ....................................................... 224
Secure Settings ....................................................... 224
USB Settings .............................................................. 228
Default Settings .......................................................... 229
  Copy Defaults .......................................................... 229
  Fax Defaults ............................................................ 229
  Scan Defaults .......................................................... 229
  Direct Print Defaults (available on the Dell Cloud Multifunction Printer | H815dw only) USB Direct Print Defaults (available on the Dell Smart Multifunction Printer | S2815dn only) ........................................ 230
Tray Management ......................................................... 230
  Tray Settings ............................................................ 230
  Tray Priority ............................................................. 236
Language Settings .......................................................... 236
  Panel Language .......................................................... 236
  Keyboard Layout ......................................................... 237
Print ........................................................................ 237
  Private Mailbox .......................................................... 237
  Proof Print .............................................................. 238
  Secure Print ............................................................. 238
  Secure Fax Receive .......................................................... 239
  Tile Settings ............................................................. 239
Copy ....................................................................... 239
  Quantity ................................................................. 239
  Darken / Lighten .......................................................... 239
  Select Tray .............................................................. 240
  2 Sided Copying .......................................................... 241
  Sharpness ................................................................. 241
  Reduce/Enlarge ........................................................... 242
  Original Size .......................................................... 242
  Original Type .......................................................... 243
  Collation ................................................................. 243
  2-Up ................................................................. 243
  Margin ................................................................. 244
  Auto Exposure ........................................................... 244
  Save Settings ............................................................ 244
ID Copy ................................................................. 244
  Save Settings ............................................................ 244
Scan ....................................................................... 245
  Scan to Email ............................................................ 245
  Scan to Network Folder .................................................... 245
  Scan to USB ............................................................ 245
Scan to Computer ................................................. 245
Scan Settings ..................................................... 246
Save Settings ..................................................... 249

Fax ................................................................. 250
Fax Settings ..................................................... 250
Save Settings ..................................................... 251

Print PDF/TIFF .................................................. 252

Print JPEG ....................................................... 252
Print Settings .................................................... 252
Save Settings ..................................................... 254

Dell Document Hub ............................................. 254
Search for Files .................................................. 254
Browse for Files .................................................. 255
Scan ............................................................... 255
Smart OCR Scan .................................................. 256
E-mail Me .......................................................... 258
Business Card Reader ........................................... 259

SharePoint ......................................................... 259
Print ............................................................... 259
Scan ............................................................... 260
File Name Option ............................................... 260

Add Apps ........................................................ 260

Panel Lock ......................................................... 260
Enabling the Panel Lock ....................................... 260
Disabling the Panel Lock ...................................... 261

Resetting Defaults ............................................. 261
When Using the Operator Panel ............................... 262

16 Print Media Guidelines ..................................... 263

Paper .............................................................. 263
Recommended Paper .......................................... 263
Unacceptable Paper ............................................. 263
Selecting Paper ................................................... 264
Selecting Pre-Printed Media and Letterheads ............. 264
Selecting Pre-Punched Paper .................................. 264

Envelopes ........................................................ 265

Labels .............................................................. 266
Canceling a Job From a Computer Running Windows® Operating System ............................................................. 284

Duplex Printing .................................................................................................................................................. 285
  Duplex Printing With Duplex Unit ...................................................................................................................... 285
  Using Booklet Print ........................................................................................................................................ 285

Using the Stored Print Feature .......................................................................................................................... 286
  Overview .......................................................................................................................................................... 286
  Procedures for Printing Stored Print ................................................................................................................ 288

Printing from USB Memory (USB Direct Print) .................................................................................................. 289
  Supported File Formats .................................................................................................................................... 290
  Inserting and Removing a USB Memory ........................................................................................................... 290
  Printing a PDF/TIFF File in a USB Memory ...................................................................................................... 290
  Printing a JPEG File in a USB Memory ............................................................................................................ 291

Printing With Web Services on Devices (WSD) .................................................................................................. 291
  Adding Roles of Printer Services ..................................................................................................................... 291
  Printer Setup .................................................................................................................................................. 292
  Installing a Printer Driver Using the Add Printer Wizard .................................................................................. 292

Printing With Wi-Fi Direct .................................................................................................................................. 293
  Setting Up Wi-Fi Direct ..................................................................................................................................... 293
  Printing via Wi-Fi Direct ................................................................................................................................... 295
  Disconnecting Wi-Fi Direct Network .................................................................................................................. 296
  Resetting the Passphrase .................................................................................................................................. 296
  Resetting the PIN .............................................................................................................................................. 296

Mobile Printing and Scanning ............................................................................................................................ 297
  Android OS ...................................................................................................................................................... 297
  Apple iOS .......................................................................................................................................................... 297

Printing With AirPrint ........................................................................................................................................ 298
  Setting Up AirPrint on Your Printer .................................................................................................................. 298
  Printing via AirPrint .......................................................................................................................................... 298

Printing With Google Cloud Print ...................................................................................................................... 298
  Preparing to Use the Printer with Google Cloud Print ...................................................................................... 298
  Enabling Google Cloud Print on the Printer ..................................................................................................... 299
  Selecting the Version of the Google Cloud Print Service .................................................................................. 299
  Registering the Printer to the Google Cloud Print Service .............................................................................. 300
  Sharing the Printer Using the Google Cloud Print Service ............................................................................... 301
  Canceling Registration to Google Cloud Print ................................................................................................. 301
  Printing via Google Cloud Print ...................................................................................................................... 301

Mopria Print Service .......................................................................................................................................... 302
  Setting Up Mopria Print Service on Your Printer ............................................................................................ 302
## Table of Contents

1. **Printing via Mopria Print Service** .......................................................... 303
2. **Printing a Report Page** ................................................................. 303
3. **Printer Settings** ................................................................. 303
   - Using the Operator Panel to Change the Printer Settings ...................... 303
   - Using the Dell Printer Configuration Web Tool to Change the Printer Settings .......................................................... 303

19. **Copying** ................................................................. 305
   1. **Loading Paper for Copying** .................................................... 305
   2. **Selecting Paper Tray** .......................................................... 305
   3. **Preparing a Document** ....................................................... 305
   4. **Making Copies From the Document Glass** .................................. 306
   5. **Making Copies From the DADF** .............................................. 307
   6. **Setting Copy Options** ......................................................... 308
      - Quantity ............................................................................. 308
      - Darken / Lighten .................................................................. 308
      - Select Tray ........................................................................... 309
      - 2 Sided Copying .................................................................. 309
      - Sharpness ............................................................................ 310
      - Reduce / Enlarge .................................................................. 310
      - Original Size ........................................................................ 311
      - Original Type ........................................................................ 311
      - Collation .............................................................................. 312
      - 2-Up ...................................................................................... 313
      - Margin .................................................................................. 314
      - Auto Exposure ...................................................................... 314
   7. **Using the ID Copy** ............................................................... 314
   8. **Changing the Default Settings** .................................................. 315

20. **Scanning** ................................................................. 317
   1. **Scanning Overview** .......................................................... 317
   2. **Tips for Easy Network Scanning** ............................................ 317
   3. **Scanning - With scanner driver** ............................................. 317
   4. **Scanning - Without scanner driver** ......................................... 318
   5. **Scanning to a Computer With a USB Connection** ..................... 318
      - Changing the Location to Save the Scanned Data ......................... 319
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanning to a Computer Connected With Web Services on Devices (WSD)</td>
<td>319</td>
</tr>
<tr>
<td>Preparations for Scanning Using Web Services on Devices (WSD)</td>
<td>319</td>
</tr>
<tr>
<td>Scanning and Sending Images to the Computer Using Web Services on</td>
<td></td>
</tr>
<tr>
<td>Devices (WSD)</td>
<td></td>
</tr>
<tr>
<td>Scanning From a Computer Using Web Services on Devices (WSD)</td>
<td>320</td>
</tr>
<tr>
<td>Preparations for scanning from the computer</td>
<td>320</td>
</tr>
<tr>
<td>Scanning from the computer</td>
<td>321</td>
</tr>
<tr>
<td>Scanning Using the TWAIN Driver</td>
<td>322</td>
</tr>
<tr>
<td>Scanning Using the Windows Image Acquisition (WIA) Driver.</td>
<td>324</td>
</tr>
<tr>
<td>Scanning With Wi-Fi Direct</td>
<td>325</td>
</tr>
<tr>
<td>Scanning via Wi-Fi Direct</td>
<td>325</td>
</tr>
<tr>
<td>Scanning to a PC or Server via SMB/FTP</td>
<td>326</td>
</tr>
<tr>
<td>Overview</td>
<td>326</td>
</tr>
<tr>
<td>Procedures</td>
<td>327</td>
</tr>
<tr>
<td>Setting a Login Name and a Password (SMB Only).</td>
<td>327</td>
</tr>
<tr>
<td>Creating a Shared Folder (SMB Only)</td>
<td>329</td>
</tr>
<tr>
<td>Adding a Scanning Destination to the Printer’s Address Book.</td>
<td>331</td>
</tr>
<tr>
<td>Sending the Scanned File on the Network Folder.</td>
<td>336</td>
</tr>
<tr>
<td>Scanning to a USB Memory</td>
<td>337</td>
</tr>
<tr>
<td>Types of a USB Memory</td>
<td>337</td>
</tr>
<tr>
<td>Procedures</td>
<td>337</td>
</tr>
<tr>
<td>Specifying a Folder to Save the Scanned Image</td>
<td>337</td>
</tr>
<tr>
<td>Sending an E-Mail With the Scanned Image</td>
<td>338</td>
</tr>
<tr>
<td>Preparing the Printer to Send the E-Mail</td>
<td>338</td>
</tr>
<tr>
<td>Setting the DNS Server Address</td>
<td>338</td>
</tr>
<tr>
<td>Setting the Information Necessary to Access the Mail Server.</td>
<td>339</td>
</tr>
<tr>
<td>Setting the Administrator’s E-mail Address</td>
<td>340</td>
</tr>
<tr>
<td>Adding a New E-Mail Address to the Printer’s Address Book.</td>
<td>341</td>
</tr>
<tr>
<td>Sending an E-mail With the Scanned File</td>
<td>341</td>
</tr>
<tr>
<td>Managing the Scanner</td>
<td>342</td>
</tr>
<tr>
<td>Port Settings</td>
<td>342</td>
</tr>
<tr>
<td>Search Criteria Dialog Box (Windows® only)</td>
<td>343</td>
</tr>
<tr>
<td>Password Setting</td>
<td>343</td>
</tr>
<tr>
<td>21 Faxing</td>
<td>345</td>
</tr>
<tr>
<td>Specifying the Fax Initial Settings Using the Dell Printer Easy Install</td>
<td>345</td>
</tr>
<tr>
<td>Setting Your Country</td>
<td>346</td>
</tr>
<tr>
<td>Setting the Printer ID</td>
<td>346</td>
</tr>
</tbody>
</table>
Setting the Time and Date ................................................. 347
Changing the Clock Mode .............................................. 347
Setting Sounds .......................................................... 347
  Speaker Volume ...................................................... 347
  Ringer Volume ....................................................... 348
Specifying the Fax Settings Options ................................. 348
  Changing the Fax Settings Options .............................. 348
  Available Fax Settings Options ................................. 348
  Advanced Fax Settings ............................................ 352
Sending a Fax .......................................................... 354
  Loading an Original Document ................................. 354
  Adjusting the Document Resolution .......................... 355
  Adjusting the Document Contrast .............................. 356
  Sending a Fax From Memory ................................. 356
  Sending a Fax Manually ........................................... 357
  Confirming Transmissions ..................................... 357
  Automatic Redialing .............................................. 357
Sending a Delayed Fax .................................................. 358
Sending a Fax from the Driver (Direct Fax) ......................... 358
  Example ............................................................. 358
Receiving a Fax ........................................................ 363
  About Receiving Modes ........................................ 363
  Loading Paper for Receiving Faxes ......................... 363
  Receiving a Fax Automatically in the Fax Mode ............. 363
  Receiving a Fax Manually in the Telephone Mode .......... 363
  Receiving a Fax Automatically in the Telephone / Fax or Ans Machine/Fax 364
  Receiving a Fax Manually Using an External Telephone (Remote Receive) 364
  Receiving Faxes Using the DRPD .............................. 364
  Receiving Faxes in the Memory ................................. 365
  Polling Receive ................................................... 365
Automatic Dialing ....................................................... 365
  Speed Dialing ..................................................... 365
  Setting Speed Dial ............................................... 365
  Sending a Fax Using Speed Dial .............................. 366
  Group Dialing ...................................................... 366
  Setting Group Dial ............................................... 366
  Editing Group Dial ................................................ 367
  Sending a Fax Using Group Dial (Multi-address Transmission) 367
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing a Speed Dial List</td>
<td>367</td>
</tr>
<tr>
<td>Phone Book</td>
<td>368</td>
</tr>
<tr>
<td>Other Ways to Fax</td>
<td>368</td>
</tr>
<tr>
<td>Using the Secure Receiving Mode</td>
<td>368</td>
</tr>
<tr>
<td>Using an Answering Machine</td>
<td>369</td>
</tr>
<tr>
<td>Using a Computer Modem</td>
<td>370</td>
</tr>
<tr>
<td>Printing a Report</td>
<td>370</td>
</tr>
<tr>
<td>Changing Setting Options</td>
<td>370</td>
</tr>
<tr>
<td>22 Dell Document Hub</td>
<td>371</td>
</tr>
<tr>
<td>Registering the User and Signing In to the Dell Document Hub</td>
<td>371</td>
</tr>
<tr>
<td>Registering a New User to the Dell Document Hub</td>
<td>371</td>
</tr>
<tr>
<td>Signing In to the Dell Document Hub</td>
<td>372</td>
</tr>
<tr>
<td>When the Favorite List Screen is Displayed When You Tap the Tile on the Dell Document Hub Screen</td>
<td>372</td>
</tr>
<tr>
<td>Returning to the Home Screen</td>
<td>372</td>
</tr>
<tr>
<td>Logging Out From the Printer</td>
<td>372</td>
</tr>
<tr>
<td>Searching for and Printing Files</td>
<td>373</td>
</tr>
<tr>
<td>Browsing and Printing Files</td>
<td>374</td>
</tr>
<tr>
<td>Searching for the Files in the Selected Cloud Service</td>
<td>375</td>
</tr>
<tr>
<td>Scanning</td>
<td>375</td>
</tr>
<tr>
<td>Searching for the Location Across the Cloud Services</td>
<td>376</td>
</tr>
<tr>
<td>Searching for the Location in the Selected Cloud Service</td>
<td>376</td>
</tr>
<tr>
<td>Scanning the Document Using Optical Character Recognition (OCR)</td>
<td>377</td>
</tr>
<tr>
<td>Receiving the Scanned File as an E-Mail</td>
<td>378</td>
</tr>
<tr>
<td>Receiving the Scanned Image of the Business Card as an E-Mail</td>
<td>379</td>
</tr>
<tr>
<td>23 Printing and Scanning Directly From SharePoint®</td>
<td>381</td>
</tr>
<tr>
<td>Registering the SharePoint® Server</td>
<td>381</td>
</tr>
<tr>
<td>Editing the Server URL List</td>
<td>382</td>
</tr>
<tr>
<td>Signing In to the SharePoint® Server</td>
<td>382</td>
</tr>
<tr>
<td>Returning to the Home Screen</td>
<td>382</td>
</tr>
<tr>
<td>Browsing and Printing Files</td>
<td>383</td>
</tr>
<tr>
<td>Scanning</td>
<td>383</td>
</tr>
</tbody>
</table>
Know Your Printer ........................................ 385

24 Understanding Your Printer Software .................. 387

Overview .................................................. 387

Dell Printer Hub/Dell Printer Management Tool (for Microsoft® Windows®) ........................................... 388

Printer Status Window (for OS X and Linux) .................. 388

Status Monitor Widget (for OS X) ........................... 389
  Status Monitor Widget Feature ............................. 389
  Before Installing the Status Monitor Widget .......... 389
  Installing the Status Monitor Widget .................. 390
  Opening and Closing the Status Monitor Widget ....... 390
  Printer Status Window ................................. 390
  Order Window ......................................... 392
  Preferences .............................................. 393

Status Monitor Console (for Linux) .......................... 394
  Status Monitor Console Feature .......................... 394
  Before Installing the Status Monitor Console ......... 394
  Installing the Status Monitor Console ................. 394
  Starting the Status Monitor Console .................... 395
  Printer Selection Window .................................. 395
  Printer Status Window .................................. 396
  Dell Supplies Management System Window ........... 397
  Service Tag Window .................................... 398
  Settings Window ........................................ 398

Tool Box (for Microsoft® Windows®) ......................... 399
  To start the Tool Box .................................... 399

Address Book Editor (for Microsoft® Windows® and OS X) .......................... 399
  Types of Address Books .................................. 399
  Adding and Editing Entries to the Address Books Using the Address Book Editor ......................... 400

ScanButton Manager (for OS X) .............................. 402

User Setup Disk Creating Tool (for Microsoft® Windows®) .................................................. 402

App Manager (for Microsoft® Windows®) ..................... 403
  Preparing to use the App Manager ....................... 403
  Starting the App Manager ................................ 403
25 User Authentication ................................................. 405
   Creating and Editing the User Accounts .................. 405
      Creating a New User Account ............................ 405
      Editing the User Account ................................. 406
      Deleting the User Account ............................... 406
   Logging In to the User Account on the Dell Cloud Multifunction Printer | H815dw .......... 406
      Logging In Using the Touch Panel ....................... 406
      Logging In Using the NFC Authentication Card ....... 407
      Logging Out .............................................. 407
   Logging In to the User Account on the Dell Smart Multifunction Printer | S2815dn ........ 407
      Specifying the User Authentication Method ............ 407
      Preparations for Remote Authentication ................. 407
      Logging In for Remote Authentication .................. 407
      Logging In for Local Authentication .................... 408
      Logging Out .............................................. 408

26 Tile Customization ................................................ 409
   Adding a New Tile .............................................. 409
      Selecting From the Pre-defined Tiles ................... 409
      Creating a New Tile Including the Job Settings ....... 409

27 Using the Server Address Book and Server Phone Book .......... 411
   Preparing the Printer to Access the External LDAP Server ........ 411
      Starting the Dell Printer Configuration Web Tool ........ 411
      Setting Authentication Type .............................. 411
      Setting LDAP Server ..................................... 412
      Setting LDAP User Mapping .............................. 413
   Sending an E-mail With the Scanned File Using the E-mail Server Address Book ............ 414
   Sending a Fax Using the Fax Server Phone Book ............ 414

28 Using Digital Certificates ....................................... 415
   Managing Certificates ....................................... 415
      Preparing to Manage Certificates ....................... 415
      Creating and Downloading a Certificate Signing Request (CSR) ........ 416
Importing a Digital Certificate ........................................ 416
Setting a Digital Certificate ........................................ 417
Confirming the Settings of a Digital Certificate ............... 418
Deleting a Digital Certificate ...................................... 418
Exporting a Digital Certificate ................................... 419

Setting the Features .................................................. 419
Setting the SSL/TLS-use Server Certificate (HTTP/IPP) .... 420
Setting SMTP-SSL/TLS Communication .......................... 420
Setting LDAP-SSL/TLS Communication .......................... 420
Setting for Wireless LAN WPA-Enterprise (EAP-TLS) ........ 420
Setting for Wireless LAN WPA-Enterprise (PEAPv0-MS-CHAPv2, EAP-TTLS PAP, EAP-TTLS CHAP) .................. 422

29 Understanding Printer Messages ................................. 425
Status Codes ......................................................... 425
Error Messages ...................................................... 432

30 Specifications ..................................................... 435
Operating System Compatibility ................................. 435
Power Supply ......................................................... 435
Dimensions .......................................................... 435
Memory ............................................................... 435
Page Description Language (PDL)/Emulation, Operating System, and Interface ............................................ 436
MIB Compatibility .................................................. 436
Environment ........................................................ 436
Operation ............................................................ 436
Print Quality Guarantee ............................................ 436
Storage ............................................................... 436
Altitude .............................................................. 436
Cables ............................................................... 437
Print Specifications .................................................. 437
Copy Specifications .................................................. 438
Scanner Specifications .............................................. 438
Facsimile Specifications ............................................ 439
Wireless Connection Specifications ........................................ 439

Maintaining Your Printer ............................................... 441

31 Maintaining Your Printer ............................................ 443

Determining the Status of Supplies ................................ 443
Conserving Supplies ..................................................... 443
Ordering Supplies ......................................................... 443
Using Dell Printer Configuration Web Tool ......................... 443
Using Dell Printer Hub or Dell Printer Management Tool for Windows® 443
For OS X .......................................................................... 444
For Linux ........................................................................ 444
Storing Print Media ......................................................... 444
Storing Consumables ....................................................... 444
Replacing the Toner Cartridge ......................................... 445
Removing the Toner Cartridge ......................................... 445
Installing a Toner Cartridge ........................................... 446
Replacing the Drum Cartridge ......................................... 448
Removing the Drum Cartridge ......................................... 448
Installing a Drum Cartridge ........................................... 449
Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller ........................................ 452
Removing the Fusing Unit .............................................. 452
Installing a Fusing Unit .................................................. 453
Removing the Transfer Unit ............................................ 454
Installing a Transfer Unit ............................................... 454
Removing the Retard Roller in Tray1 ................................ 455
Installing a Retard Roller in Tray1 ................................ 456
Cleaning the Scanner ....................................................... 458
Cleaning the DADF Feed Roller ....................................... 459
Cleaning Inside the Printer .............................................. 459
Moving the Printer ......................................................... 462
Removing the Optional 550-Sheet Feeder ......................... 464
32 Clearing Jams ................................................. 469

Avoiding Jams .................................................. 469

Identifying the Location of Paper Jams ......................... 470

Clearing Paper Jams From the DADF ......................... 471
  If status code: 005-112, 005-121, or 005-900 appears: .......... 471
  If status code: 005-110 appears: .......................... 473

Clearing Paper Jams From the MPF ......................... 473

Clearing Paper Jams From Tray1 ................................. 477

Clearing Paper Jams From the Fusing Unit ...................... 480
  If status code: 050-130 appears: .......................... 480

Clearing Paper Jams From the Duplexer ....................... 483
  If status code: 050-131 appears: .......................... 483

Clearing Paper Jams From the Regi Roll ....................... 484
  If status code: 050-142 appears: .......................... 484
  If status code: 050-132 appears: .......................... 487

Clearing Paper Jams From the Optional 550-Sheet Feeder .... 491

Clearing Paper Jams From the Trays ............................ 494
  If status code 050-134 appears: .......................... 494
  If status code 050-133 appears: .......................... 496

Troubleshooting ............................................... 499

33 Troubleshooting Guide ........................................ 501

Basic Printer Problems ........................................ 501

Display Problems .............................................. 501

Printing Problems ............................................. 501

Print Quality Problems ........................................ 502
  The output is too light ..................................... 503
  Toner smears or print comes off ........................... 505
  Random spots/Blurred images ............................... 506
  The entire output is blank ................................ 506
  Streaks appear on the output ............................... 508
  Pitched dots ............................................... 509
  Vertical blanks ............................................ 510
Mottle .............................. 511
Ghosting .......................... 512
Light-induced fatigue .......... 513
Fog .................................. 513
Bead-Carry-Out (BCO) .......... 514
Jagged characters .............. 515
Banding .................. 516
Auger mark .................. 516
Wrinkled/Stained paper ....... 517
Damage on the leading edge of paper ...... 517

Jam/Alignment Problems ........ 518
The top and side margins are incorrect ........ 518
Images are skewed .............. 519
Tray1/Optional 550-Sheet Feeder Misfeed Jam ........ 519
MPF Misfeed Jam .............. 520
Regi Jam (Exit Sensor On JAM) .......... 521
Exit Jam (Exit Sensor Off JAM) .......... 521
Tray1/Optional 550-Sheet Feeder Multi-feed Jam ........ 521
MPF Multi-feed Jam ........ 522

Noise .................................. 522

Copy Problems .................. 523

Fax Problems .................. 523

Scanning Problems .............. 525

Digital Certificate Problems .... 527

Problems With Installed Optional Accessory .... 528

Wi-Fi Direct Problems .......... 528

Scanner Driver/Printer Utility Problems .......... 529

Other Problems .............. 529

Contacting Service .......... 529

Appendix ............................. 531

Appendix .................................. 533

Dell™ Technical Support Policy .......... 533
Online Services .......... 533
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warranty and Return Policy</td>
<td>533</td>
</tr>
<tr>
<td>Recycling Information</td>
<td>533</td>
</tr>
<tr>
<td>Contacting Dell</td>
<td>533</td>
</tr>
<tr>
<td>New Zealand PTC200 Warnings</td>
<td>534</td>
</tr>
<tr>
<td>USA/Canada Wi-Fi Warnings</td>
<td>535</td>
</tr>
</tbody>
</table>
Before Beginning

Notes, Cautions, and Warnings ................................................................. 27

1 Dell™ Cloud Multifunction Printer | H815dw
   Dell™ Smart Multifunction Printer | S2815dn
   User’s Guide ..................................................................................... 31

2 Finding Information ............................................................................... 33

3 Product Features .................................................................................. 35

4 About the Printer .................................................................................. 39
Notes, Cautions, and Warnings

**NOTE:** A NOTE indicates important information that helps you make better use of your printer.

**CAUTION:** A CAUTION indicates potential damage to hardware or loss of data if instructions are not followed.

**WARNING:** A WARNING indicates a potential for property damage, personal injury, or death.

Information in this document is subject to change without notice.

© 2015 Dell Inc. All rights reserved.

Reproduction of these materials in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell and the DELL logo are trademarks of Dell Inc.; Microsoft, Windows, Windows Server, Windows Vista, and Active Directory are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries; Apple, Bonjour, Macintosh, Mac OS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.; Adobe, PostScript and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries; Wi-Fi and Wi-Fi Direct are registered trademarks of the Wi-Fi Alliance; Wi-Fi Protected Setup, WPA, and WPA2 are registered trademarks of the Wi-Fi Alliance; Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat, Inc. in the U.S. and other countries; SUSE is a registered trademark of Novell, Inc., in the United States and other countries; MIFARE is a trademark of NXP Semiconductors; Thinxtream is a trademark of Thinxtream Technologies Pte. Ltd.; QR Code is a registered trademark of Denso Wave Incorporated; Dropbox is a trademark or registered trademark of Dropbox Inc.; Box and the Box logo are including without limitation, either trademarks, service marks or registered trademarks of Box, Inc.; RSA and BSAFE are either registered trademarks or trademarks of EMC Corporation in the United States and/or other countries; Mopria is a trademark of the Mopria Alliance.

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names or their products. Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.

About License

XML Paper Specification (XPS): This product may incorporate intellectual property owned by Microsoft Corporation. The terms and conditions upon which Microsoft is licensing such intellectual property may be found at http://go.microsoft.com/fwlink/?LinkId=52369; DES: This product includes software developed by Eric Young (eay@mincom.oz.au); AES: Copyright (c) 2003, Dr Brian Gladman, Worcester, UK. All rights reserved. This product uses published AES software provided by Dr Brian Gladman under BSD licensing terms; ICC Profile (Little cms): Copyright (c) 1998-2004 Marti Maria.

As for RSA BSAFE

This printer includes RSA® BSAFE® Cryptographic software from EMC Corporation.

ICC Profile Header

Copyright (c) 1994-1996 SunSoft, Inc.

Rights Reserved

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL SUNSOFT, INC. OR ITS PARENT COMPANY BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Except as contained in this notice, the name of SunSoft, Inc. shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without written authorization from SunSoft Inc.

**JPEG Library**

Independent JPEG Group's free JPEG software

This package contains C software to implement JPEG image encoding, decoding, and transcoding. JPEG is a standardized compression method for full-color and gray-scale images.

The distributed programs provide conversion between JPEG "JFIF" format and image files in PBMPLUS PPM/PGM, GIF, BMP, and Targa file formats. The core compression and decompression library can easily be reused in other programs, such as image viewers. The package is highly portable C code; we have tested it on many machines ranging from PCs to Crays.

We are releasing this software for both noncommercial and commercial use. Companies are welcome to use it as the basis for JPEG-related products. We do not ask a royalty, although we do ask for an acknowledgement in product literature (see the README file in the distribution for details). We hope to make this software industrial-quality --- although, as with anything that's free, we offer no warranty and accept no liability.

For more information, contact jpeg-info@jpegclub.org.

**Contents of this directory**

jpegsrc.vN.tar.gz contains source code, documentation, and test files for release N in Unix format.

jpegsrN.zip contains source code, documentation, and test files for release N in Windows format.

jpegaltui.vN.tar.gz contains source code for an alternate user interface for cjpeg/djpeg in Unix format.

jpegaltuiN.zip contains source code for an alternate user interface for cjpeg/djpeg in Windows format.

wallace.ps.gz is a PostScript file of Greg Wallace's introductory article about JPEG. This is an update of the article that appeared in the April 1991 Communications of the ACM.

jpeg.documents.gz tells where to obtain the JPEG standard and documents about JPEG-related file formats.

jif.txt.gz is a plain text transcription of the JFIF specification; it's missing a figure, so use the PostScript version if you can.

TIFFTechNote2.txt.gz is a draft of the proposed revisions to TIFF 6.0's JPEG support.

pm.errata.gz is the errata list for the first printing of the textbook "JPEG Still Image Data Compression Standard" by Pennebaker and Mitchell.

jdosaobj.zip contains pre-assembled object files for JMEMDOSA.ASM. If you want to compile the IJG code for MS-DOS, but don't have an assembler, these files may be helpful.

**Math Library**

Copyright (C) 1993 by Sun Microsystems, Inc. All rights reserved.

Developed at SunPro, a Sun Microsystems, Inc. business.

Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is preserved.

---

copysignf.c: * Copyright (C) 1993 by Sun Microsystems, Inc. All rights reserved.

math_private.h: * Copyright (C) 1993 by Sun Microsystems, Inc. All rights reserved.

powf.c: * Copyright (C) 1993 by Sun Microsystems, Inc. All rights reserved.

scalbnf.c: * Copyright (C) 1993 by Sun Microsystems, Inc. All rights reserved.

**libtiff**

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Zlib

zlib.h -- interface of the 'zlib' general purpose compression library version 1.2.8, April 28th, 2013

Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

UNITED STATES GOVERNMENT RESTRICTED RIGHTS

This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA.

October 2015 Rev. A00
Click the links to the left for information on the features, options, and operation of your Dell Cloud Multifunction Printer | H815dw and Dell Smart Multifunction Printer | S2815dn. For information on other documentation included with your printer, see "Finding Information."

**NOTE:** In this manual, Dell Cloud Multifunction Printer | H815dw and Dell Smart Multifunction Printer | S2815dn are referred to as the "printer."

**NOTE:** In this manual, the procedures for the computer are explained using Microsoft® Windows® 7 unless stated otherwise.

**Conventions**

The following describe the meaning of the symbols and fonts used in this manual:

**Bold texts**
- Names of hardware button on the operator panel.
- Screen names on the touch panel.
- Menus, commands, windows, or dialog boxes displayed on the computer screen.

**Texts in Courier New font**
- Menus and messages displayed on the touch panel.
- Characters entered from the computer.
- Directory paths.

< >
- Key on the keyboard of the computer.

→
- Indicates a path to a certain item within a procedure on a computer.

" "
- Cross references in this manual.
- Characters entered from the operator panel.
- Messages displayed on the computer screen.
## Finding Information

**NOTE:** The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Drivers for my printer</td>
<td>Software and Documentation disc</td>
</tr>
<tr>
<td>• My User's Guide</td>
<td>The Software and Documentation disc contains setup video, documentation, and drivers for your printer. You can use the Software and Documentation disc to install drivers or access your setup video and documentation.</td>
</tr>
<tr>
<td></td>
<td>Readme files may be included on your Software and Documentation disc to provide last-minute updates about technical changes to your printer or advanced technical reference material for experienced users or technicians.</td>
</tr>
<tr>
<td>• How to set up my printer</td>
<td>Setup Guide</td>
</tr>
<tr>
<td>• How to use my printer</td>
<td>Important Information</td>
</tr>
<tr>
<td>• Safety information</td>
<td><strong>WARNING:</strong> Read and follow all safety instructions in the Important Information prior to setting up and operating your printer.</td>
</tr>
<tr>
<td>• Warranty information</td>
<td></td>
</tr>
<tr>
<td>• Express Service Code and Service Tag</td>
<td>The Express Service Code and Service Tag are located inside the front cover of your printer.</td>
</tr>
<tr>
<td>• Latest drivers for my printer</td>
<td>Go to dell.com/support.</td>
</tr>
<tr>
<td>• Documentation for my printer</td>
<td></td>
</tr>
</tbody>
</table>

---

The Express Service Code and Service Tag are located inside the front cover of your printer.

Go to dell.com/support.

---
<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Answers to technical service and support questions</td>
<td><strong>dell.com/support</strong> provides several online tools, including:</td>
</tr>
<tr>
<td></td>
<td>• Solutions — Troubleshooting hints and tips, articles from technicians, and online courses</td>
</tr>
<tr>
<td></td>
<td>• Upgrades — Upgrade information for components, such as the printer drivers</td>
</tr>
<tr>
<td></td>
<td>• Customer Care — Contact information, order status, warranty, and repair information</td>
</tr>
<tr>
<td></td>
<td>• Downloads — Drivers</td>
</tr>
<tr>
<td></td>
<td>• Manuals — Printer documentation and product specifications</td>
</tr>
</tbody>
</table>

Go to **dell.com/support**. Select your region, and fill in the requested details to access help tools and information.
Product Features

This chapter describes the product features and indicates their links.

**Dell Document Hub App**

Easily access and share documents, images and digital content with the Dell Document Hub app. This innovative cloud collaboration solution connects your printer and devices to popular cloud services, providing a flexible and secure way to collaborate from virtually anywhere. Using your computer or mobile device, you can search file across multiple cloud services simultaneously to print documents or you can scan documents directly to the cloud using the app. Visit Windows Store, Google Play™ store, and App Store to download the apps. For more information about using the Dell Document Hub, see the FAQs in Dell.com/documenthub.

**Dell Printer Hub** *(Dell™ Cloud Multifunction Printer | H815dw only)*

Dell Printer Hub is a program that monitors and informs you of the printer status and allows you to customize the printer settings. The program also notifies you of the firmware/software updates. For convenient use, you can access the Dell Document Hub from the Dell Printer Hub. The Dell Printer Hub is included on your Software and Documentation disc and is installed with the manuals, drivers, and software for the printer. For more information, open the program and click on the top right of the main window to see the FAQs.

**Dell Printer Management Tool** *(Dell Smart Multifunction Printer | S2815dn only)*

Dell Printer Management Tool is a program that monitors and informs you of the printer status and allows you to customize the printer settings. The program also notifies you of the firmware/software updates. The Dell Printer Management Tool is included on your Software and Documentation disc and is installed with the manuals, drivers, and software for the printer. For more information, open the program and click on the top right of the main window to see the FAQs.

**Converting and storing with Dell Document Hub** *(Dell Cloud Multifunction Printer | H815dw Only)*

You can scan hard copy documents and store them directly in your preferred cloud storage service with the Dell Document Hub. You can also convert hard copy documents into editable digital content before sending them to the cloud storage.
Printing with Dell Document Hub
(Dell Cloud Multifunction Printer | H815dw Only)

With the Dell Document Hub, you can easily locate and print documents stored in cloud storage. You can also search for files across multiple cloud storage services simultaneously.

Printing from USB Memory (USB Direct Print)

The USB Direct Print feature enables you to print files directly from a USB memory without requiring you to start your computer and an application.

Printing With Web Services on Devices (WSD)

When the printer is connected to a computer via network using Web Services on Devices (WSD), you can print documents from the computer using the Web Services on Devices (WSD) Print function.

Using the ID Copy (ID Copy)

You can copy both sides of an ID card on one side of a single sheet of paper in its original size by tapping ID Copy on the touch panel.

Sending an E-Mail With the Scanned Image (Scan to Email)

When you want to send scanned data by e-mail, use the Scan to Email feature. You can directly send the data scanned as an e-mail attachment. You can choose destination e-mail addresses from the address book on the printer or server. Or, you can enter the address from the touch panel on the printer's operator panel.

Scanning to a Computer Connected With Web Services on Devices (WSD)

When the printer is connected to a computer via network using Web Services on Devices (WSD), you can scan and send the images to a computer using the Web Services on Devices (WSD) Scan function.
Scanning to a PC or Server via SMB/FTP (Scan to Network Folder)

You can transfer data scanned to a PC or a server via SMB or FTP without service software. Although prior registration of the destination FTP server or PC on the address book is required, it helps save your time.

Scanning to a USB Memory (Scan to USB)

With the Scan to USB feature, you don’t need a PC to connect a USB memory. You can specify the USB memory inserted into the printer’s port as a data saving location when you scan data.

Making Copies From the Document Glass (Scan From Document Glass)

You can scan the pages of a book or a brochure from the document glass. When you scan documents using the document glass, place them facing down.

Making Copies From the DADF (Scan From DADF)

You can scan pieces of unbound paper using the duplex automatic document feeder (DADF). When you scan documents using the DADF, load them facing up.

Remote Authentication Using the LDAP or Kerberos Server (Dell Smart Multifunction Printer | S2815dn Only)

The user authentication using the LDAP or Kerberos server is available to control the user’s login to the printer. Only users who can access the specified server are allowed to log in to the printer.

Managing the documents with PaperPort (Dell Smart Multifunction Printer | S2815dn Only)

You can organize, search, and share your scanned document using the bundled PaperPort software.
About the Printer

This chapter provides an overview of your printer.

**NOTE:** The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Front and Rear Views

Front View

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Duplex Automatic Document Feeder (DADF)</td>
<td>6</td>
<td>Drum Cartridge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Multipurpose Feeder (MPF)</td>
<td>7</td>
<td>Front Cover</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Tray1</td>
<td>8</td>
<td>Front USB Port</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Optional 550-Sheet Feeder (Tray2)</td>
<td>9</td>
<td>Operator Panel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Toner Cartridge</td>
<td>10</td>
<td>Output Tray Extension</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Extend the output tray extension to prevent the printed paper from falling off the printer.

**NOTE:** The operator panel can be flipped up until it clicks to make it easier to take out the printed paper or the drum cartridge.
Rear View

1. Power Switch
2. Ethernet Port
3. USB Port
4. Phone Connector
5. Wall Jack Connector
6. "Blue" Plug
7. Power Connector
8. Chute
9. Duplex Unit
10. Transfer Unit
11. Fusing Unit
12. Rear Cover
**Duplex Automatic Document Feeder (DADF)**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DADF Cover</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>Document Guides</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>Document Glass</td>
<td>6</td>
</tr>
</tbody>
</table>

**NOTE:** Pull out the document stopper to prevent the document from falling off the printer.
Space Requirements

Provide enough room to open the printer trays, covers, and optional accessories, and for proper ventilation.

Operator Panel

For more information on the operator panel, see "About the Operator Panel."
**Optional Accessory**

The optional 550-sheet feeder is available for the printer.

To install the optional 550-sheet feeder, refer to the installation instruction that comes with the optional 550-sheet feeder.

**Securing the Printer**

To protect your printer from theft, you can use the optional Kensington lock.

Attach the Kensington lock to the security slot on your printer.

For details, see the operating instructions supplied with the Kensington lock.

**Ordering Supplies**

You can order consumables from Dell online when using a networked printer. Enter the IP address of your printer in your web browser, launch the Dell Printer Configuration Web Tool, and click the web address under Order Supplies at: to order toner or supplies for your printer.

For details, see "Ordering Supplies."
Setting Up the Printer (Printer Setup)

5 Overview of the Printer Setup................................................... 47

6 Installing Optional Accessory................................................... 49

7 Connecting and Setting Up Your Printer ................................. 57

8 Setting the IP Address ............................................................... 79

9 Loading Paper.............................................................................. 83

10 Installing Printer Drivers on Windows® Computers ............... 87

11 Installing Printer Drivers on Macintosh Computers.......... 101

12 Installing Printer Drivers on Linux Computers (CUPS) .......... 105
Overview of the Printer Setup

The following are the procedures necessary to set up the printer.

Hardware preparations
- "Installing Optional Accessory"
- "Turning on the Printer"

Initial settings
- "Configuring Initial Settings on the Operator Panel"

Connections
- "Connecting to a Computer or a Network"
- "Connecting to the Telephone Line"

Printer setup
- "Setting Up the Printer Using Dell Printer Easy Install (Windows® Only)"
- "Installing Printer Drivers on Windows® Computers"
- "Installing Printer Drivers on Macintosh Computers"
- "Installing Printer Drivers on Linux Computers (CUPS)"
Installing Optional Accessory

This chapter describes how to install the optional 550-sheet feeder (tray2).

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Installing the Optional 550-Sheet Feeder

WARNING: If you install the optional 550-sheet feeder after setting up the printer, be sure to turn off the printer, unplug the power cable, and disconnect all cables from the rear of the printer before starting this task.

NOTE: The Software and Documentation disc also contains video instructions. In the main menu window of Dell Printer Easy Install, click Installation Video.

1. Ensure that the printer is turned off, and then disconnect all cables from the rear of the printer.
2. Remove the tape and the bag holding the screws.
   
   NOTE: Save the screws as you will need them later.
3. Place the optional 550-sheet feeder in the same location that the printer is located.
4. Gently pull open the MPF cover.

5. Grasp both sides of the MPF, and then pull the MPF from the printer.
6 Pull tray 1 out of the printer about 200 mm.

7 Hold tray 1 with both hands, and remove it from the printer.
Lift the printer and align the five guide pins of the optional 550-sheet feeder with the holes at the bottom of the printer. Gently lower the printer onto the optional 550-sheet feeder.

⚠️ **WARNING:** Two people are required to lift the printer.

⚠️ **WARNING:** Be careful not to pinch your fingers when lowering the printer onto the optional 550-sheet feeder.

Secure the optional 550-sheet feeder to the printer by tightening the two screws provided with the feeder, using a coin or similar object.
10 Insert tray1 into the printer, and push until it stops.

11 Insert the MPF into the printer, push until it stops, and close the MPF cover.

12 Re-connect all cables into the rear of the printer, and turn on the printer.

**NOTE:** The printer will automatically detect the attached tray but will not detect the paper type.

13 Print the system settings report to confirm that the optional 550-sheet feeder is installed correctly. For details about how to print a system settings report, see "Report / List."

14 Confirm Tray2 (550 Sheet Feeder) is listed in the system settings report under Printer Options. If the feeder is not listed, turn off the printer, unplug the power cable, and re-install the optional 550-sheet feeder.

15 After loading paper in the optional 550-sheet feeder, specify the paper type from the printer touch panel.
   a Press the (Information) button.
   b Tap the Tools tab, and then tap Tray Management.
   c Tap Tray Settings.
   d Tap Tray2.
   e Tap Type.
   f Tap ▼ until the desired paper type appears, and then tap the desired paper type.
   g Tap OK.

16 If you installed the optional 550-sheet feeder after installing the printer driver, update your driver by following the instructions for each operating system. If the printer is on a network, update the driver for each client.
## Updating Your Driver to Detect 550-Sheet Feeder

### When Using PCL Driver

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Instructions</th>
</tr>
</thead>
</table>
| Windows® 10/ Windows® 10 x64 | 1 Right-click the Start button, and then click Control Panel → Hardware and Sound → Devices and Printers.  
2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties.  
3 Click the Configuration tab, and then select Bi-Directional Setup.  
4 Select Get Information from Printer and then click OK.  
5 Click Apply, and then click OK.  
6 Close the Devices and Printers dialog box. |
2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties.  
3 Click the Configuration tab, and then select Bi-Directional Setup.  
4 Select Get Information from Printer and then click OK.  
5 Click Apply, and then click OK.  
6 Close the Devices and Printers dialog box. |
| Windows® 7/ Windows® 7 x64/ Windows Server® 2008 R2 x64 | 1 Click Start → Devices and Printers.  
2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties.  
3 Click the Configuration tab, and then select Bi-Directional Setup.  
4 Select Get Information from Printer and then click OK.  
5 Click Apply, and then click OK.  
6 Close the Devices and Printers dialog box. |
| Windows Vista®/ Windows Vista® x64 | 1 Click Start → Control Panel → Hardware and Sound → Printers.  
2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties.  
3 Click the Configuration tab, and then select Bi-Directional Setup.  
4 Select Get Information from Printer and then click OK.  
5 Click Apply, and then click OK.  
6 Close the Printers dialog box. |
| Windows Server® 2008/ Windows Server® 2008 x64 | 1 Click Start → Control Panel → Printers.  
2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties.  
3 Click the Configuration tab, and then select Bi-Directional Setup.  
4 Select Get Information from Printer and then click OK.  
5 Click Apply, and then click OK.  
6 Close the Printers dialog box. |
| Windows Server® 2003/ Windows Server® 2003 x64 | 1 Click Start → Printers and Faxes.  
2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties.  
3 Click the Configuration tab, and then select Bi-Directional Setup.  
4 Select Get Information from Printer and then click OK.  
5 Click Apply, and then click OK.  
6 Close the Printers and Faxes dialog box. |
If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1. Click the Configuration tab, and then select Installable Options.
2. Select Paper Tray Configuration in the Items list box.
4. Click OK.
5. Close the Devices and Printers (Printers, or Printers and Faxes) dialog box.

When Using PS Driver

<table>
<thead>
<tr>
<th>Windows® 10/</th>
<th>1 Right-click the Start button, and then click Control Panel → Hardware and Sound → Devices and Printers.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® 10 x64</td>
<td>2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties.</td>
</tr>
<tr>
<td>Windows® 8/</td>
<td>3 Click the Configuration tab, and then select Bi-Directional Setup.</td>
</tr>
<tr>
<td>Windows® 8 x64/</td>
<td>4 Select Get Information from Printer and then click OK.</td>
</tr>
<tr>
<td>Windows® 8.1/</td>
<td>5 Click Apply, and then click OK.</td>
</tr>
<tr>
<td>Windows® 8.1 x64/</td>
<td>6 Close the Devices and Printers dialog box.</td>
</tr>
<tr>
<td>Windows Server® 2012/</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2012 R2</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows® 7/</th>
<th>1 On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware for Windows Server® 2012/Windws Server® 2012 R2) → Devices and Printers.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® 7 x64/</td>
<td>2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties.</td>
</tr>
<tr>
<td>Windows Server® 2008 R2 x64</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008 R2</td>
<td>3 Click the Configuration tab, and then select Bi-Directional Setup.</td>
</tr>
<tr>
<td>Windows Server® 2008</td>
<td>4 Select Get Information from Printer and then click OK.</td>
</tr>
<tr>
<td>Windows Server® 2008 x64</td>
<td>5 Click Apply, and then click OK.</td>
</tr>
<tr>
<td>Windows Vista®</td>
<td>6 Close the Devices and Printers dialog box.</td>
</tr>
<tr>
<td>Windows Vista® x64</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows Server® 2008/</th>
<th>1 Click Start → Devices and Printers.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server® 2008</td>
<td>2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties.</td>
</tr>
<tr>
<td>Windows Server® 2008 x64</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008</td>
<td>3 Click the Configuration tab, and then select Bi-Directional Setup.</td>
</tr>
<tr>
<td>Windows Server® 2008 x64</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows Server® 2008/</th>
<th>1 Click Start → Control Panel → Printers.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server® 2008</td>
<td>2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties.</td>
</tr>
<tr>
<td>Windows Server® 2008 x64</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008</td>
<td>3 Click the Configuration tab, and then select Bi-Directional Setup.</td>
</tr>
<tr>
<td>Windows Server® 2008 x64</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows Server® 2008/</th>
<th>1 Click Start → Control Panel → Printers.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server® 2008</td>
<td>2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties.</td>
</tr>
<tr>
<td>Windows Server® 2008 x64</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008</td>
<td>3 Click the Configuration tab, and then select Bi-Directional Setup.</td>
</tr>
<tr>
<td>Windows Server® 2008 x64</td>
<td></td>
</tr>
</tbody>
</table>
Installing Optional Accessory

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1. Click the Configuration tab, and then select Installable Options.
2. Select Paper Tray Configuration in the Items list box.
4. Click OK.
5. Close the Devices and Printers (Printers, or Printers and Faxes) dialog box.

When Using XML Paper Specification (XPS) Driver

**NOTE:** The XML Paper Specification (XPS) driver does not support Windows Server® 2003 and Windows Server® 2003 x64.

Windows® 10/
Windows® 10 x64

1. Right-click the Start button, and then click Control Panel → Hardware and Sound → Devices and Printers.
2. Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties.
3. Click the Device Setting tab, and then select Available in Tray2 drop-down menu.
4. Click Apply, and then click OK.
5. Close the Devices and Printers dialog box.

Windows® 8/
Windows® 8 x64/
Windows® 8.1/
Windows® 8.1 x64/
Windows Server® 2012/
Windows Server® 2012 R2

1. On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware for Windows Server® 2012/Windows Server® 2012 R2) → Devices and Printers.
2. Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties.
3. Click the Device Setting tab, and then select Available in Tray2 drop-down menu.
4. Click Apply, and then click OK.
5. Close the Devices and Printers dialog box.
<table>
<thead>
<tr>
<th>Operating System</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® 7/ Windows® 7 x64/ Windows Server® 2008 R2 x64</td>
<td>1 Click Start → Devices and Printers. 2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Printer properties. 3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu. 4 Click Apply, and then click OK. 5 Close the Devices and Printers dialog box.</td>
</tr>
<tr>
<td>Windows Vista®/ Windows Vista® x64</td>
<td>1 Click Start → Control Panel → Hardware and Sound → Printers. 2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties. 3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu. 4 Click Apply, and then click OK. 5 Close the Printers dialog box.</td>
</tr>
<tr>
<td>Windows Server® 2008/ Windows Server® 2008 x64</td>
<td>1 Click Start → Control Panel → Printers. 2 Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Properties. 3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu. 4 Click Apply, and then click OK. 5 Close the Printers dialog box.</td>
</tr>
</tbody>
</table>
Connecting and Setting Up Your Printer

To connect your printer to a computer or device, the following specification must be met for each of the connection type:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless</td>
<td>IEEE 802.11b/802.11g/802.11n (Dell™ Cloud Multifunction Printer</td>
</tr>
<tr>
<td>Ethernet</td>
<td>10 Base-T/100 Base-TX/1000 Base-T</td>
</tr>
<tr>
<td>USB</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>Phone connector</td>
<td>RJ11</td>
</tr>
<tr>
<td>Wall jack connector</td>
<td>RJ11</td>
</tr>
</tbody>
</table>

*NOTE:* The images used in this manual are those of the Dell Cloud Multifunction Printer | H815dw unless otherwise mentioned.

![Diagram of printer connections](image_url)

1. Ethernet port
2. USB port
3. Phone connector
4. Wall jack connector
Turning on the Printer

⚠ WARNING: Do not use extension cords or power strips.

⚠ WARNING: The printer should not be connected to an Uninterruptible Power Supply (UPS) system.

โน NOTE: The Software and Documentation disc also contains video instructions. In the main menu window of Dell Printer Easy Install, click Installation Video.

1 Connect the power cable to the power connector on the rear of the printer, and then to a power source.

2 Turn on the printer.

Configuring Initial Settings on the Operator Panel

You need to set the printer language, country, clock date, time, and fax settings when you turn on the printer for the first time.

When you turn the printer on, the wizard screen to perform the initial setup appears on the touch panel. Follow the steps below to set the initial settings.

ノ NOTE: If you do not start configuring the initial settings, the printer automatically restarts in 3 minutes, and the Home screen appears on the touch panel. After that, you can set the following initial setup by enabling Power on Wizard on the touch panel or Dell Printer Configuration Web Tool if needed.

For more information on operator panel, see "Operator Panel."

For more information on Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration Web Tool."

1 The Select Your Language screen appears.

   a Tap  until desired language appears, and then tap the desired language.

<table>
<thead>
<tr>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
</tr>
<tr>
<td>Français</td>
</tr>
<tr>
<td>Italiano</td>
</tr>
<tr>
<td>Deutsch</td>
</tr>
<tr>
<td>Español</td>
</tr>
</tbody>
</table>
b Tap Next.

2 The **Date & Time** screen appears.

a Tap **Time Zone**.

b Tap ▼ until the desired geographic region appears, and then tap the desired geographic region.

c Tap ▼ until the desired time zone appears, and then tap the desired time zone.

<table>
<thead>
<tr>
<th>Geographic Region</th>
<th>Time Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Africa</td>
<td>(UTC) Accra, Bamako, Dakar, Nouakchott</td>
</tr>
<tr>
<td></td>
<td>(UTC) Casablanca</td>
</tr>
<tr>
<td></td>
<td>(UTC +01:00) Algiers, Douala, Libreville, Luanda</td>
</tr>
<tr>
<td></td>
<td>(UTC +01:00) Tunis</td>
</tr>
<tr>
<td></td>
<td>(UTC +01:00) Windhoek</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Cairo</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Harare, Johannesburg, Kinshasa, Tripoli</td>
</tr>
<tr>
<td></td>
<td>(UTC +03:00) Addis Ababa, Khartoum, Mogadishu, Nairobi</td>
</tr>
<tr>
<td>Geographic Region</td>
<td>Time Zone</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Americas</td>
<td>(UTC -10:00) Adak</td>
</tr>
<tr>
<td></td>
<td>(UTC -09:00) Alaska</td>
</tr>
<tr>
<td></td>
<td>(UTC -08:00) Pacific Time (US &amp; Canada)</td>
</tr>
<tr>
<td></td>
<td>(UTC -08:00) Tijuana</td>
</tr>
<tr>
<td></td>
<td>(UTC -07:00) Arizona, Dawson Creek, Sonora</td>
</tr>
<tr>
<td></td>
<td>(UTC -07:00) Chihuahua, Mazatlan</td>
</tr>
<tr>
<td></td>
<td>(UTC -07:00) Mountain Time (US &amp; Canada)</td>
</tr>
<tr>
<td></td>
<td>(UTC -06:00) Cancun, Mexico City, Monterrey</td>
</tr>
<tr>
<td></td>
<td>(UTC -06:00) Central America</td>
</tr>
<tr>
<td></td>
<td>(UTC -06:00) Central Time (US &amp; Canada)</td>
</tr>
<tr>
<td></td>
<td>(UTC -06:00) Saskatchewan</td>
</tr>
<tr>
<td></td>
<td>(UTC -05:00) Atikokan, Resolute</td>
</tr>
<tr>
<td></td>
<td>(UTC -05:00) Bogota, Lima, Panama, Quito</td>
</tr>
<tr>
<td></td>
<td>(UTC -05:00) Cayman Islands, Jamaica, Port-au-Prince</td>
</tr>
<tr>
<td></td>
<td>(UTC -05:00) Eastern Time (US &amp; Canada)</td>
</tr>
<tr>
<td></td>
<td>(UTC -05:00) Grand Turk</td>
</tr>
<tr>
<td></td>
<td>(UTC -05:00) Havana</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:30) Caracas</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Asuncion</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Atlantic Time (Canada)</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Blanc-Sablon</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Caribbean Islands</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Cuiaba</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Georgetown, La Paz, Manaus</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Thule</td>
</tr>
<tr>
<td></td>
<td>(UTC -03:30) St. John's</td>
</tr>
<tr>
<td></td>
<td>(UTC -03:00) Brasilia, Cayenne, Paramaribo</td>
</tr>
<tr>
<td></td>
<td>(UTC -03:00) Buenos Aires</td>
</tr>
<tr>
<td></td>
<td>(UTC -03:00) Greenland</td>
</tr>
<tr>
<td></td>
<td>(UTC -03:00) Miquelon</td>
</tr>
<tr>
<td></td>
<td>(UTC -03:00) Montevideo</td>
</tr>
<tr>
<td></td>
<td>(UTC -02:00) Noronha</td>
</tr>
<tr>
<td>Antarctica</td>
<td>(UTC -04:00) Palmer Archipelago, Santiago</td>
</tr>
<tr>
<td></td>
<td>(UTC -05:00) Rothera</td>
</tr>
<tr>
<td></td>
<td>(UTC +03:00) Syowa</td>
</tr>
<tr>
<td></td>
<td>(UTC +06:00) Mawson, Vostok</td>
</tr>
<tr>
<td></td>
<td>(UTC +07:00) Davis</td>
</tr>
<tr>
<td></td>
<td>(UTC +08:00) Casey</td>
</tr>
<tr>
<td></td>
<td>(UTC +10:00) Dumont d'Urville</td>
</tr>
<tr>
<td></td>
<td>(UTC +12:00) McMurdo</td>
</tr>
<tr>
<td>Geographic Region</td>
<td>Time Zone</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Asia</td>
<td>(UTC +02:00) Amman</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Beirut</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Damascus</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Jerusalem</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Nicosia</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Palestine</td>
</tr>
<tr>
<td></td>
<td>(UTC +03:00) Aden, Baghdad, Qatar, Riyadh</td>
</tr>
<tr>
<td></td>
<td>(UTC +03:30) Tehran</td>
</tr>
<tr>
<td></td>
<td>(UTC +04:00) Baku</td>
</tr>
<tr>
<td></td>
<td>(UTC +04:00) Dubai, Muscat, Tbilisi</td>
</tr>
<tr>
<td></td>
<td>(UTC +04:00) Yerevan</td>
</tr>
<tr>
<td></td>
<td>(UTC +04:30) Kabul</td>
</tr>
<tr>
<td></td>
<td>(UTC +05:00) Aqtau, Aqtobe, Ashgabat, Samarkand</td>
</tr>
<tr>
<td></td>
<td>(UTC +05:00) Ekaterinburg</td>
</tr>
<tr>
<td></td>
<td>(UTC +05:00) Karachi</td>
</tr>
<tr>
<td></td>
<td>(UTC +05:30) Colombo, Kolkata</td>
</tr>
<tr>
<td></td>
<td>(UTC +05:45) Kathmandu</td>
</tr>
<tr>
<td></td>
<td>(UTC +06:00) Almaty, Bishkek, Dhaka, Thimphu</td>
</tr>
<tr>
<td></td>
<td>(UTC +06:00) Novosibirsk, Omsk</td>
</tr>
<tr>
<td></td>
<td>(UTC +06:30) Yangon (Rangoon)</td>
</tr>
<tr>
<td></td>
<td>(UTC +07:00) Bangkok, Ho Chi Minh, Hovd, Jakarta</td>
</tr>
<tr>
<td></td>
<td>(UTC +07:00) Krasnoyarsk</td>
</tr>
<tr>
<td></td>
<td>(UTC +08:00) Chongqing, Hong Kong, Shanghai</td>
</tr>
<tr>
<td></td>
<td>(UTC +08:00) Irkutsk</td>
</tr>
<tr>
<td></td>
<td>(UTC +08:00) Kuala Lumpur, Makassar, Manila, Singapore</td>
</tr>
<tr>
<td></td>
<td>(UTC +08:00) Taipei</td>
</tr>
<tr>
<td></td>
<td>(UTC +08:00) Ulaan Baatar</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:00) Dili, Jayapura</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:00) Pyongyang</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:00) Seoul</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:00) Tokyo</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:00) Yakutsk</td>
</tr>
<tr>
<td></td>
<td>(UTC +10:00) Sakhalin, Vladivostok</td>
</tr>
<tr>
<td></td>
<td>(UTC +11:00) Magadan</td>
</tr>
<tr>
<td></td>
<td>(UTC +12:00) Anadyr, Kamchatka</td>
</tr>
<tr>
<td>Atlantic Ocean</td>
<td>(UTC -04:00) Bermuda</td>
</tr>
<tr>
<td></td>
<td>(UTC -04:00) Stanley</td>
</tr>
<tr>
<td></td>
<td>(UTC -02:00) South Georgia Island</td>
</tr>
<tr>
<td></td>
<td>(UTC -01:00) Azores, Scoresby sund</td>
</tr>
<tr>
<td></td>
<td>(UTC -01:00) Cape Verde</td>
</tr>
<tr>
<td></td>
<td>(UTC) Reykjavik</td>
</tr>
<tr>
<td>Geographic Region</td>
<td>Time Zone</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Australia</td>
<td>(UTC +08:00) Perth</td>
</tr>
<tr>
<td></td>
<td>(UTC +08:45) Eucla</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:30) Adelaide</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:30) Darwin</td>
</tr>
<tr>
<td></td>
<td>(UTC +10:00) Brisbane, Lindeman</td>
</tr>
<tr>
<td></td>
<td>(UTC +10:00) Hobart, Melbourne, Sydney</td>
</tr>
<tr>
<td></td>
<td>(UTC +10:30) Lord Howe Island</td>
</tr>
<tr>
<td>Europe</td>
<td>(UTC) Dublin, Edinburgh, Lisbon, London</td>
</tr>
<tr>
<td></td>
<td>(UTC +01:00) Amsterdam, Berlin, Rome, Stockholm, Vienna</td>
</tr>
<tr>
<td></td>
<td>(UTC +01:00) Belgrade, Bratislava, Budapest, Prague</td>
</tr>
<tr>
<td></td>
<td>(UTC +01:00) Brussels, Copenhagen, Madrid, Paris</td>
</tr>
<tr>
<td></td>
<td>(UTC +01:00) Sarajevo, Skopje, Warsaw, Zagreb</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Athens, Bucharest, Istanbul</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Helsinki, Kiev, Riga, Sofia</td>
</tr>
<tr>
<td></td>
<td>(UTC +02:00) Kaliningrad, Minsk</td>
</tr>
<tr>
<td></td>
<td>(UTC +03:00) Moscow</td>
</tr>
<tr>
<td></td>
<td>(UTC +04:00) Samara</td>
</tr>
<tr>
<td>Indian Ocean</td>
<td>(UTC +05:00) Antananarivo, Comoro Islands, Mayotte</td>
</tr>
<tr>
<td></td>
<td>(UTC +04:00) Malhe, Reunion</td>
</tr>
<tr>
<td></td>
<td>(UTC +04:00) Mauritius</td>
</tr>
<tr>
<td></td>
<td>(UTC +05:00) Kerguelen, Maldives</td>
</tr>
<tr>
<td></td>
<td>(UTC +06:00) Chagos</td>
</tr>
<tr>
<td></td>
<td>(UTC +06:30) Cocos Islands</td>
</tr>
<tr>
<td></td>
<td>(UTC +07:00) Christmas Island</td>
</tr>
<tr>
<td>Pacific Ocean</td>
<td>(UTC -11:00) Midway Island, Niue, Samoa</td>
</tr>
<tr>
<td></td>
<td>(UTC -10:00) Cook Islands, Hawaii, Tahiti</td>
</tr>
<tr>
<td></td>
<td>(UTC -09:30) Marquesas Islands</td>
</tr>
<tr>
<td></td>
<td>(UTC -09:00) Gambier Islands</td>
</tr>
<tr>
<td></td>
<td>(UTC -08:00) Pitcairn Islands</td>
</tr>
<tr>
<td></td>
<td>(UTC -06:00) Easter Island</td>
</tr>
<tr>
<td></td>
<td>(UTC -06:00) Galapagos Islands</td>
</tr>
<tr>
<td></td>
<td>(UTC +09:00) Palau</td>
</tr>
<tr>
<td></td>
<td>(UTC +10:00) Guam, Port Moresby, Saipan</td>
</tr>
<tr>
<td></td>
<td>(UTC +11:00) Efate, Guadalcanal, Kosrae</td>
</tr>
<tr>
<td></td>
<td>(UTC +11:30) Norfolk Island</td>
</tr>
<tr>
<td></td>
<td>(UTC +12:00) Auckland</td>
</tr>
<tr>
<td></td>
<td>(UTC +12:00) Fiji, Marshall Islands</td>
</tr>
<tr>
<td></td>
<td>(UTC +12:45) Chatham</td>
</tr>
<tr>
<td></td>
<td>(UTC +13:00) Tongatapu</td>
</tr>
<tr>
<td></td>
<td>(UTC +14:00) Kiritimati</td>
</tr>
</tbody>
</table>
d  Tap OK.
e  Tap Date.
f  Select a date format from the menu displayed by selecting Format.

<table>
<thead>
<tr>
<th>Format</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>YYYY/MM/DD</td>
<td></td>
</tr>
<tr>
<td>DD/MM/YYYY</td>
<td></td>
</tr>
<tr>
<td>MM/DD/YYYY</td>
<td></td>
</tr>
</tbody>
</table>

g  After tapping the box under Year, tap - or +, or use the number pad to enter the desired value. Repeat this step to enter the desired value for Month and Day.

h  Tap OK.
i  Tap Time.
j  Select the time format from 12 Hour or 24 Hour. If you select 12 Hour, select AM or PM.
k  After tapping the box under Hour, use the number pad to enter the desired value. Repeat this step to enter the desired value for Minute.
l  Tap OK.
m  Tap Next.

3 The Fax (Do you want to setup Fax Now?) screen appears.

To set Fax settings, select Yes, Setup FAX and follow the procedure below. To end the settings, select No, I'll Do It Later and proceed to Step 4.

a  Enter the fax number of the printer using the number pad.
b  Tap Country.
c  Tap ▼ until the desired country appears, and then tap the desired country.

   The default paper size is automatically set when you select a country.

<table>
<thead>
<tr>
<th>Country</th>
<th>Paper Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>A4</td>
</tr>
<tr>
<td>Austria</td>
<td>A4</td>
</tr>
<tr>
<td>Belgium</td>
<td>A4</td>
</tr>
<tr>
<td>Canada</td>
<td>Letter</td>
</tr>
<tr>
<td>Colombia</td>
<td>Letter</td>
</tr>
<tr>
<td>Denmark</td>
<td>A4</td>
</tr>
<tr>
<td>France</td>
<td>A4</td>
</tr>
<tr>
<td>Germany</td>
<td>A4</td>
</tr>
<tr>
<td>Greece*</td>
<td>A4</td>
</tr>
<tr>
<td>Iceland*</td>
<td>A4</td>
</tr>
<tr>
<td>Ireland</td>
<td>A4</td>
</tr>
<tr>
<td>Italy</td>
<td>A4</td>
</tr>
<tr>
<td>Japan*</td>
<td>A4</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>A4</td>
</tr>
<tr>
<td>Malaysia</td>
<td>A4</td>
</tr>
<tr>
<td>Mexico</td>
<td>Letter</td>
</tr>
<tr>
<td>Netherlands</td>
<td>A4</td>
</tr>
</tbody>
</table>
4 Tap Next.

5 The Setup Complete (Congratulations, setup is complete.) screen appears.

6 Tap OK.

The printer automatically restarts after tapping OK.
Connecting to a Computer or a Network

**NOTE:** The Software and Documentation disc also contains video instructions. In the main menu window of Dell Printer Easy Install, click Installation Video.

**NOTE:** Before making connections, be sure to turn off the printer.

**Connecting to a Computer Using the USB Cable (Direct Connection)**

A local printer is a printer which is directly connected to your computer using the USB cable. If your printer is connected to a network instead of your computer, skip this section and go to "Connecting to a Network Using the Ethernet Cable."

1. Connect the smaller USB connector into the USB port at the rear of the printer.

   ![USB connector](image)

   **NOTE:** Ensure that you match the USB symbol on the cable to the USB symbol on the printer.

2. Connect the other end of the cable into a USB port of the computer.

   **CAUTION:** Do not connect the printer USB cable to a USB port located on the keyboard.
Connecting to a Network Using the Ethernet Cable

1. Connect the Ethernet cable.

To connect the printer to the network, connect one end of an Ethernet cable into the Ethernet port on the rear of the printer, and the other end to a LAN drop or hub.

Connecting to a Wireless Network

NOTE: The wireless network connection feature is available on the Dell Cloud Multifunction Printer | H815dw only.

You can connect the Dell Cloud Multifunction Printer | H815dw to a wireless network, using the built-in wireless network function.

For a wireless connection setup, see "Configuring the Wireless Settings."

NOTE: To use the Dell Cloud Multifunction Printer | H815dw through wireless connection, be sure to disconnect the Ethernet cable and the USB cable.

Connecting to the Telephone Line

CAUTION: Do not connect your printer directly to a Digital Subscriber Line (DSL). This may damage the printer. To use a DSL, you will need to use an appropriate DSL filter. Contact your service provider for the DSL filter.

NOTE: The Software and Documentation disc also contains video instructions. In the main menu window of Dell Printer Easy Install, click Installation Video.
1 Connect one end of a telephone line cord into the wall jack connector and the other end into an active wall jack.

2 If the "Blue" plug is attached to the phone connector, remove it.

3 To connect a telephone and/or answering machine to your printer, connect the telephone or answering machine line cord into the phone connector ( ).

If the phone communication is serial in your country (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, France and Switzerland), and that you are supplied with a "Yellow" terminator, insert the "Yellow" terminator into the phone connector ( ).
Connecting and Setting Up Your Printer

Setting Up the Printer Using Dell Printer Easy Install (Windows® Only)

NOTE: To set up the printer connected with Macintosh computers or Linux computers, see "Installing Printer Drivers on Macintosh Computers" or "Installing Printer Drivers on Linux Computers (CUPS)" respectively.

Basic Setup

To set up the printer, you can use the Dell Printer Easy Install program on the computer running a Microsoft® Windows® operating system.

The program first searches for the printer and grasps how the printer is connected to the computer. Based on that information, the program will automatically try to configure the printer, and install the drivers and software to your computer.

Before starting this basic setup, make sure that the printer is turned off, and ensure the cable connections as follows:

To set up the Dell Cloud Multifunction Printer | H815dw as a wireless printer

1 Disconnect the Ethernet cable and the USB cable from the printer.
2 Ensure the computer you use for printer setup is connected to a known wireless network (2.4 GHz).

After setup completion, the printer will connect to the same wireless network that your setup computer is connected to.

To set up the printer as a network (wired) printer

1 Connect the Ethernet cable to the printer.

To set up the printer as a USB printer

1 Connect the USB cable to the printer.

NOTE: Where the wireless network connection is available, you cannot set up the Dell Cloud Multifunction Printer | H815dw as a USB printer in the basic setup. In this case, set up the printer following the procedures described in "Setting Up the Printer in Another Connection Method."

NOTE: For Windows Vista®, you cannot set up the Dell Cloud Multifunction Printer | H815dw automatically as a wireless printer in the basic setup. In this case, set up the printer manually following the procedures described in "Setting Up the Printer in Another Connection Method."
1. Turn on the printer.

2. Insert the *Software and Documentation* disc provided with the printer into your computer. The *Dell Printer Easy Install* program launches automatically.

3. Wait until the screen changes or click *Next*.

4. Click *Finish* to exit the wizard when the *Ready to Print!* screen appears.

5. Eject the *Software and Documentation* disc.

---

**NOTE:** If the *Dell Printer Easy Install* program does not launch automatically, follow the procedure below.

For Windows Server® 2008 and Windows Server® 2008 R2

Click **start** → **Run**, enter `D:\setup.exe` (where D is the drive letter of the optical drive) in the Run dialog box, and then click **OK**.

For Windows Vista® and Windows® 7

Click **Start** → **All Programs** → **Accessories** → **Run**, enter `D:\setup.exe` (where D is the drive letter of the optical drive) in the Run dialog box, and then click **OK**.


Point to the top or bottom right corner of the screen, and then click **Search** → **Type Run** in the search box, click **Apps** (for Windows® 8 and Windows Server® 2012 only), and then click **Run** → **Type D: \setup.exe** (where D is the drive letter of the optical drive), and then click **OK**.

For Windows® 10

Right-click the Start button, and then click **Run** → **Type D:\setup.exe** (where D is the drive letter of the optical drive), and then click **OK**.

If the Main Menu of Dell Printer Easy Install Appears Without Starting or Completing the Basic Setup

Proceed to step 4 in "Setting Up the Printer in Another Connection Method," and set up the printer manually following the on-screen instructions.
Setting Up the Printer in Another Connection Method

You can set up the printer, specifying the connection method other than the one used in the basic setup.

Before starting the setup procedure below, make sure that the printer is turned off, and ensure the cable connection as described in “Basic Setup.”

1. Turn on the printer.
2. Insert the *Software and Documentation* disc provided with the printer into your computer.
   The Dell Printer Easy Install program launches automatically.
3. Click Main Menu.
   
   ![Dell Printer Easy Install](image)

   The Main Menu screen appears.
4. Click Setup.
   
   ![Dell Printer Easy Install](image)

   Follow the instructions displayed on the screen.
5. Click Finish to exit the wizard when the Ready to Print! screen appears.
6. Eject the *Software and Documentation* disc.
Configuring the Wireless Settings

**NOTE:** The wireless network connection feature is available on the Dell Cloud Multifunction Printer | H815dw only.

This section describes how to configure the wireless connection on Dell Cloud Multifunction Printer | H815dw. The specifications of the wireless connection are described below.

### Determining the Wireless Network Settings

You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, contact your network administrator.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connectivity Technology</td>
<td>Wireless</td>
</tr>
<tr>
<td>Compliant Standards</td>
<td>IEEE 802.11b, 802.11g, and 802.11n</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>2.4 GHz</td>
</tr>
</tbody>
</table>
| Data Transfer Rate       | IEEE 802.11n: 65 Mbps  
                          | IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps  
                          | IEEE 802.11b: 11, 5.5, 2, and 1 Mbps                                                                 |
| Security                 | 64 (40-bit key)/128 (104-bit key) WEP,  
                          | WPA-PSK (TKIP, AES), WPA2-PSK (AES), WPA-Enterprise (TKIP, AES)*1,  
                          | WPA2-Enterprise (AES)*1                                                                                   |
| Wi-Fi Protected Setup (WPS)*2 | Push-Button Configuration (PBC),  
                          | Personal Identification Number (PIN)                                                                     |

*1 EAP method supports PEAPv0, EAP-TLS, EAP-TTLS PAP, and EAP-TTLS CHAP.

*2 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK AES, WPA2-PSK AES, WPA-PSK TKIP, Open (No Security)

### Wireless Settings

<table>
<thead>
<tr>
<th>Wireless Settings</th>
<th>SSID</th>
<th>Specifies the name that identifies the wireless network with up to 32 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Network Mode</td>
<td>Specifies the network mode from Ad-hoc or Infrastructure.</td>
</tr>
</tbody>
</table>

### Security Settings

<table>
<thead>
<tr>
<th>Security Settings</th>
<th>Security</th>
<th>Selects the encryption type from No Security, Mixed mode PSK*, WPA-PSK-TKIP, WPA2-PSK-AES, and WEP.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Transmit Key</td>
<td>Specifies the transmit key from the list.</td>
</tr>
<tr>
<td></td>
<td>WEP Key</td>
<td>Specifies the WEP key used through the wireless network only when WEP is selected as the encryption type.</td>
</tr>
<tr>
<td></td>
<td>Passphrase</td>
<td>Specifies the passphrase of alphanumeric characters from 8 to 63 bytes long and the hexadecimal characters of 64 bytes long only when Mixed mode PSK*, or WPA2-PSK-AES is selected as the encryption type.</td>
</tr>
</tbody>
</table>

* Mixed mode PSK automatically selects an available encryption type from WPA-PSK-TKIP, WPA-PSK-AES, or WPA2-PSK-AES.
You can select a method to configure the Wireless Connection from the following:

- Wizard Setup through Dell Printer Easy Install
- WPS-PBC*1*3
- WPS-PIN*2*3
- Auto SSID Setup
- Manual SSID Setup
- Dell Printer Configuration Web Tool

NOTE: If Panel Lock Control is set to Enable, you need to enter the four-digit password to enter the Admin Settings menu.

NOTE: For details about using WPA-Enterprise-AES or WPA2-Enterprise-AES, see "Using Digital Certificates."

**Configuring the Wireless Settings Using Dell Printer Easy Install**

1. Insert the Software and Documentation disc provided with the printer into your computer. The Dell Printer Easy Install program launches automatically.
2. Click Main Menu.
3 Click Change.

4 Select Configure the Wi-Fi settings, and then click Next.

5 Follow the on-screen instructions, and configure the wireless settings of the printer.

For WPS-PBC, WPS-PIN, Auto SSID Setup, Manual SSID Setup, and Dell Printer Configuration Web Tool, see the following instructions.
Configuring the Wireless Settings Without Using Dell Printer Easy Install

**WPS-PBC**

![NOTE: WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for wireless configuration by pressing the button provided on the access point via wireless routers, and then performing WPS-PBC setting on the operator panel. This setting is available only when the access point supports WPS.

![NOTE: Before starting WPS-PBC, confirm the position of the WPS button (button name may vary) on the wireless LAN access point. For information about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN access point.

1. Press the **(Information)** button.
2. Tap the **Tools** tab, and then tap **Admin Settings**.
3. Tap **Network**.
4. Tap **Wi-Fi**.
5. Tap **WPS Setup**.
6. Tap **Push Button Configuration**.
7. Tap **Start Configuration**.
   - Ensure that the message **Push WPS Button on router** is displayed, and start the WPS-PBC on the wireless LAN access point (Registrar) within 2 minutes.
8. When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed.

**WPS-PIN**

![NOTE: WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required for wireless configuration by entering PIN assignments to a printer and computer. This setting, performed through an access point, is available only when the access points of your wireless router support WPS.

1. Press the **(Information)** button.
2. Tap the **Tools** tab, and then tap **Admin Settings**.
3. Tap **Network**.
4. Tap **Wi-Fi**.
5. Tap **WPS Setup**.
6. Tap **PIN Code**.
7. Write down the displayed 8-digit PIN code or tap **Print PIN Code**. The PIN code is printed.
8. Tap **Start Configuration**.
9. Ensure that the message **Operate Wireless Router** is displayed, and enter the PIN code displayed on step 7 into the wireless LAN access point (Registrar).

![NOTE: For WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN access point.

10. When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed.
Connecting and Setting Up Your Printer

Auto SSID Setup

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Network.
4. Tap Wi-Fi.
5. Tap Wi-Fi Setup Wizard.
   The printer automatically searches the access points on wireless network.
6. Tap ▼ until the desired access point appears, and then select the access point.
   If the desired access point does not appear, go to "Manual SSID Setup."
   ☛ NOTE: Some hidden SSID may not be displayed. If the SSID is not detected turn on SSID broadcast from the router.
7. Tap Next.
8. Enter the WEP key or passphrase.
   When the encryption type of the selected access point is WEP in step 6:
   a. Tap the WEP Key text box, and then enter the WEP key.
   b. Tap OK.
   When the encryption type of the selected access point is WPA, WPA2 or Mixed in step 6:
   a. Tap the Passphrase text box, and then enter the passphrase.
   b. Tap OK.
10. Turn off the printer, and turn it on again to apply the settings.
    Wireless LAN connection setting is complete.

Manual SSID Setup

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Network.
4. Tap Wi-Fi.
5. Tap Wi-Fi Setup Wizard.
6. Tap the Manual SSID Setup check box, and then tap Next.
7. Enter the SSID, and then tap Next.
8. Select the network mode from Infrastructure and Ad-hoc depending on your environment, and then tap Next.
   If you select Infrastructure, proceed to step 9.
   If you select Ad-hoc, proceed to step 10.
9 Select the encryption type from No Security, Mixed mode PSK, WPA2-PSK-AES, or WEP.
   If you do not set security for your wireless network:
   a Tap ▼ until No Security appears, and then tap No Security.
   b Tap OK.
   To use Mixed mode PSK or WPA2-PSK-AES encryption:
   a Tap ▼ until Mixed mode PSK, or WPA2-PSK-AES appears, and then tap the desired encryption type.
   b Tap the Passphrase text box, and then enter the passphrase.
   c Tap OK.
   To use WEP encryption:
   a Tap ▼ until WEP appears, and then tap WEP.
   b Tap the WEP Key text box, and then enter the WEP key.
   c Tap Transmit Key, and then select the desired transmit key from Auto or WEP Key 1 to WEP Key 4.
   d Tap OK.
   Proceed to step 11.

10 Select the encryption type from No Security or WEP.
    If you do not set security for your wireless network:
    a Tap ▼ until No Security appears, and then tap No Security.
    b Tap OK.
    To use WEP encryption:
    a Tap ▼ until WEP appears, and then tap WEP.
    b Tap the WEP Key text box, and then enter the WEP key.
    c Tap Transmit Key, and then select the desired transmit key from Auto or WEP Key 1 to WEP Key 4.
    d Tap OK.

11 The Restart System screen appears.

12 Turn off the printer, and turn it on again to apply the settings.
   Wireless LAN connection setting is complete.

Dell Printer Configuration Web Tool

NOTE: For details about using WPA-Enterprise-AES or WPA2-Enterprise-AES, see "Using Digital Certificates."

1 Ensure that the printer is turned off.

2 Connect the printer to the network with an Ethernet cable.
   For details about how to connect the Ethernet cable, see "Connecting to a Computer or a Network."

3 Turn on the printer.

4 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser.

5 Click Print Server Settings.

6 Click Print Server Settings tab.

7 Click Wi-Fi.

8 Enter the SSID in the SSID text box.

9 Select Ad-Hoc or Infrastructure in the Network Type drop-down list box.
10 Select the encryption type from **No Security**, **WEP**, **WPA-PSK-AES/WEP2-PSK AES**, and **Mixed Mode PSK** in the **Encryption** drop-down list box, and then set each item for the encryption type selected.

**NOTE:** For details on each item, see "Dell™ Printer Configuration Web Tool."

11 Click **Apply New Settings** to apply the settings.

12 Turn off the printer, disconnect the Ethernet cable and turn it on again.

Wireless LAN connection setting is complete.

---

Reconfiguring the Wireless Settings

To change the wireless settings from your computer, perform the following.

**NOTE:** To change the wireless settings through wireless connection, ensure that the wireless connection setting is completed in "Configuring the Wireless Settings."

Reconfiguring the Wireless Settings Using Dell Printer Configuration Web Tool

**NOTE:** The following settings are available when the network mode is set to infrastructure in "Configuring the Wireless Settings."

1 Check the IP address of the printer.
   a Press the (Information) button.
   b Tap **About This MFP**.
   c Tap the **Network** tab.
   d Tap ▼ button until **IP(v4) Address** appears, and then check the IP address displayed in the **IP(v4) Address**.

2 Launch the **Dell Printer Configuration Web Tool** by entering the IP address of the printer in your web browser.

   ![Dell Printer Configuration Web Tool](image)

3 Click **Print Server Settings**.
4 Click **Print Server Settings** tab.
5 Click **Wi-Fi**.
6 Change the wireless settings of the printer.
7 Reboot the printer.
8 Change the wireless settings on your computer or access point accordingly.

**NOTE:** To change the wireless settings on your computer, refer to the manuals provided with the wireless adapter or if your computer provides a wireless adapter tool, change the wireless settings using that tool.

### Reconfiguring the Wireless Settings Using Dell Printer Easy Install

1. Insert the *Software and Documentation* disc provided with the printer into your computer. The Dell Printer Easy Install program launches automatically.
2. Click Main Menu.
3. Click Change.
   The Configure Printer window appears.
4. Select Configure the Wi-Fi settings, and then click Next.

### Reconfiguring the Wireless Settings Using Configuration Tool

1. Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.  
   For Windows® 10: Click the Start button → Dell Printer Hub or Dell Printer Management Tool.
2. For Dell Printer Hub, select the printer from My Printers on the home screen.
   For Dell Printer Management Tool, select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the home screen.
3. Click the shortcut to the Configuration Tool on the left of the screen.
4. Select Configure the wireless network settings, and click Next.
5. Follow the on-screen instructions, and change the wireless settings of the printer.
Setting the IP Address

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Assigning an IP Address

An IP address is a unique number that consists of four sections that are delimited by a period and can include up to three digits in each section, for example, 111.222.33.44.

You can select the IP mode from Dual Stack, IPv4, and IPv6. If your network supports both IPv4 and IPv6, select Dual Stack.

Select the IP mode of your environment, and then set IP address, subnet mask (for IPv4 only), and gateway address.

⚠️ CAUTION: Assigning an IP address that is already in use can cause network performance issues.

NOTE: Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

NOTE: When you assign an IP address manually in IPv6 mode, use the Dell Printer Configuration Web Tool. To display the Dell Printer Configuration Web Tool, use the link-local address. To confirm the link-local address, print a system settings report and check the Link-Local Address under Network (Wired) or Network (Wireless).

For details about how to print a system settings report, see “Report / List.”

NOTE: If Panel Lock Control is set to Enable, you need to enter the four-digit password to enter the Admin Settings menu.

When Using the Dell Printer Easy Install

1. Insert the Software and Documentation disc provided with the printer into your computer. The Dell Printer Easy Install program launches automatically.

2. Click Main Menu.
3 Click Change.

The Configure Printer window appears.

4 Select Configure the IP address settings, and then click Next.

5 Follow the instructions displayed on the screen.

**When Using the Operator Panel**

For more information on using the operator panel, see "Operator Panel."

1 Press the (Information) button.
2 Tap the Tools tab, and then tap Admin Settings.
3 Tap Network.
4 Do either of the following:
   - When connecting to network with the Ethernet cable:
     Tap Ethernet.
   - When connecting to network through wireless connection (Dell Cloud Multifunction Printer / H815dw only):
     Tap Wi-Fi.
5 Tap IP Mode.
6 Tap IPv4 Mode, and then tap OK.
Setting the IP Address

1. Tap until TCP/IP appears, and then tap TCP/IP.
2. Tap Get IP Address.
3. Tap Panel, and then tap OK.
4. Tap IP Address.
   The cursor is located at the first octet of the IP address.
5. Use the number pad to enter the first octet of the IP address, and then tap .
   The cursor moves to the next digit.
   **NOTE:** You can only enter one octet at a time and must tap  after entering each octet.
6. Enter the rest of the octets, and then tap OK.
7. Tap Subnet Mask.
8. Repeat steps 11 and 12 to set Subnet Mask.
9. Tap Gateway Address.
10. Repeat steps 11 and 12 to set Gateway Address.
11. Turn off the printer, and then turn it on again.

When Using the Tool Box

1. Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.
   For Windows® 10: Click the Start button → Dell Printer Hub or Dell Printer Management Tool.
2. For Dell Printer Hub, select the printer from My Printers on the home screen.
   For Dell Printer Management Tool, select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the home screen.
3. Click the shortcut to the Tool Box on the left of the screen.
   The Tool Box opens.
4. Click the Printer Maintenance tab.
5. Select TCP/IP Settings from the list at the left side of the page.
   The TCP/IP Settings page appears.
6. Select the mode from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway Address.
7. Click Apply New Settings to take effect.

You can also assign the IP address to the printer when installing the printer drivers with the installer. When you use the Wireless or Ethernet Connection feature, and the Get IP Address is set to AutoIP or DHCP on the printer, you can set the IP address from 0.0.0.0 to the desired IP address on the printer selection window.

Verifying the IP Settings

You can confirm the settings by using the operator panel, printing the system settings report, or using the ping command.

Verifying the Settings Using Operator Panel

1. Press the (Information) button.
2. Tap About This MFP.
3 Tap the Network tab.
4 Verify the IP address displayed in IP (v4) Address.

**Verifying the Settings Using System Settings Report**

1 Print the system settings report.
   For details about how to print a system settings report, see "Report / List."

2 Verify the correct IP address, subnet mask, and gateway address are listed in the system settings report under Network (Wired) or Network (Wireless).
   If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your printer, see "Assigning an IP Address."

**Verifying the Settings Using Ping Command**

Send a ping request to the printer and verify that it responds. For example, at a command prompt on a network computer, type "ping" followed by the new IP address (for example, 192.0.2.0):

```
ping 192.0.2.0
```

If the printer is active on the network, you will receive a reply.
Loading Paper

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

NOTE: To avoid paper jams, do not remove the tray while printing is in progress.

NOTE: The Software and Documentation disc also contains video instructions. In the main menu window of Dell Printer Easy Install, click Installation Video.

1. Pull the tray out of the printer about 200 mm.

2. Hold the tray with both hands, and remove it from the printer.
3 Adjust the paper guides.

![Adjusting paper guides](image)

**NOTE:** Extend the front side of the tray when you load Legal-size paper.

4 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on a level surface.

![Flexing and fanning paper](image)

5 Load the print media into the tray with the recommended print side facing up.

**NOTE:** Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6 Align the width guides against the edges of the paper.

![Aligning width guides](image)

**NOTE:** When loading user-specified print media, adjust the width guides and slide the extendable part of the tray by pinching the length guide and sliding it until it rests lightly against the edge of the paper.
7 After confirming that the guides are securely adjusted, insert the tray into the printer.

![Printer with tray inserted]

**NOTE:** If the front side of the tray is extended, the tray protrudes when it is inserted into the printer.

8 On the touch panel, tap **Size**.

![Tray1 Configuration screen]

**NOTE:** Set the same paper size and type as the actual paper being loaded. An error may occur if the paper size or type setting is different from the loaded paper.

9 Select ▼ until the desired paper size appears, and then select the desired paper size.

10 Tap **Type**.

11 Select ▼ until the desired paper type appears, and then select the desired paper type.

12 Select **OK**.
Installing Printer Drivers on Windows® Computers

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Identifying Printer Driver Pre-install Status
Before installing the printer driver on your computer, check the IP address of your printer by performing one of the procedures in "Verifying the IP Settings."

Changing the firewall settings before installing your printer
If you are running one of the following operating systems, you must change the firewall settings before installing the Dell™ printer software:
- Microsoft® Windows Vista®
- Windows® 7
- Windows® 8
- Windows® 8.1
- Windows Server® 2008
- Windows Server® 2008 R2
- Windows Server® 2012
- Windows Server® 2012 R2
- Windows® 10

The following procedure uses Windows® 7 as an example.
1. Insert the Software and Documentation disc into your computer.
2. Click Start → Control Panel.
4. Click Allow a program through Windows Firewall.
5. Click Change settings → Allow another program.
6. Check Browse.
7. Type D:\setup.exe (where D is the drive letter of the optical drive) in the File name text box, and then click Open.
8. Click Add, and then click OK.

Starting Dell Printer Easy Install
1. Insert the Software and Documentation disc provided with the printer into your computer. The Dell Printer Easy Install program launches automatically.

NOTE: If the Dell Printer Easy Install program does not launch automatically, follow the procedure below.
- For Windows Server® 2008 and Windows Server® 2008 R2
  Click start → Run, enter D:\setup.exe (where D is the drive letter of the optical drive) in the Run dialog box, and then click OK.
- For Windows Vista® and Windows® 7
  Click Start → All Programs → Accessories → Run, enter D:\setup.exe (where D is the drive letter of the optical drive) in the Run dialog box, and then click OK.
Point to the top or bottom right corner of the screen, and then click Search → Type Run in the search box, click Apps (for Windows® 8 and Windows Server® 2012 only), and then click Run → Type D:\setup.exe (where D is the drive letter of the optical drive), and then click OK.
For Windows® 10
Right-click the Start button, and then click Run → Type D:\setup.exe (where D is the drive letter of the optical drive), and then click OK.

2 Click Main Menu.

The main menu window appears.

**USB Cable Connection Setup**

⚠️ **NOTE:** If you are connecting the printer to a network, see "Network Connection Setup."

For installing PCL, PS and Fax printer driver

1 Start the Dell Printer Easy Install program, following the procedures shown in "Starting Dell Printer Easy Install."
2 In the main menu window of Dell Printer Easy Install, click Connect.
3 Select USB Cable Connection, and then click Next.

4 Follow the on-screen instructions to connect the computer and the printer with a USB cable, and then turn the printer on.

   The Plug and Play installation starts and the installation software proceeds to the next page automatically.

5 Select either Typical Installation (recommended) or Custom Installation from the installation wizard, and then click Next. If you select Custom Installation, you can select the specific software you want to install.

6 Click Finish to exit the wizard when the Ready to Print! screen appears.

   If you want to verify installation, click Print Test Page before clicking Finish.

For installing XML Paper Specification (XPS) printer driver

   NOTE: XML Paper Specification (XPS) driver is supported on Windows Vista® or later.

   NOTE: If you are using Windows Vista® or Windows Server® 2008, you need to install Service Pack 2 or later, and then the Windows® Platform Update (KB971644). The update (KB971644) is available for download from Windows Update.

Windows Vista® or Windows Vista® 64-bit Edition

1 Extract the following zip file to your desired location.

   D:\Drivers\XPS\Win_7Vista\XPS-V3_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Click Start→Control Panel→Hardware and Sound→Printers.

3 Click Add a printer.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the inf file in the folder extracted in step 1.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next. To use this printer as the default printer, select the check box displayed under the Printer name, and then click Next.

   Installation starts.

   If the User Account Control dialog box appears, click Continue.
NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired action.

11 As the driver installation is completed, click Print a test page to verify installation.

12 Click Finish.

Windows Server® 2008 or Windows Server® 2008 64-bit Edition

NOTE: You must log in as an administrator.

1 Extract the following zip file to your desired location.

   D:\Drivers\XPS\Win_7Vista\XPS-V3_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Click Start→Control Panel→Hardware and Sound→Printers.

3 Click Add a printer.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the inf file in the folder extracted in step 1.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

   To use this printer as the default printer, select the Set as the default printer check box, and then click Next.

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it.

12 Click Next.

   Installation starts.

13 As the driver installation is completed, click Print a test page to verify installation.

14 Click Finish.


1 Extract the following zip file to your desired location.

   D:\Drivers\XPS\Win_7Vista\XPS-V3_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Click Start→Devices and Printers.

3 Click Add a printer.

   When you use Windows Server® 2008 R2, click Add a local or network printer as an administrator.

   If the User Account Control dialog box appears, click Yes.

   NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired action.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the inf file in the folder extracted in step 1.

8 Click OK.
9. Select your printer name and click Next.
10. To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation starts.
11. If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it.
12. Click Next.
13. As the driver installation is completed, click Print a test page to verify installation. To use this printer as the default printer, select the Set as the default printer check box.
14. Click Finish.


1. Extract the following zip file to your desired location.
   \D:\\Drivers\\XPS\\Win_8\\XPS-V4_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2. On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel.

3. Click Hardware and Sound (Hardware for Windows Server® 2012/Windows Server® 2012 R2) → Devices and Printers → Add a printer.

4. Click The printer that I want isn't listed.

5. Select Add a local printer or network printer with manual settings, and then click Next.

6. Select the port connected to your printer, and then click Next.

7. Click Have Disk to display the Install From Disk dialog box.

8. Click Browse, and then select the inf file in the folder extracted in step 1.

9. Click OK.

10. Select your printer name and click Next.

11. To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation starts.

12. If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it. Click Next.

13. As the driver installation is completed, click Print a test page to verify installation. To use this printer as the default printer, select the Set as the default printer check box.

14. Click Finish.

Windows® 10

1. Extract the following zip file to your desired location.
   \D:\\Drivers\\XPS\\Win_8\\XPS-V4_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2. Right-click the Start button, and then click Control Panel.

3. Click Hardware and Sound → Devices and Printers → Add a printer.

4. Click The printer that I want isn't listed.

5. Select Add a local printer or network printer with manual settings, and then click Next.

6. Select the port connected to this product, and then click Next.

7. Click Have Disk to display the Install From Disk dialog box.

8. Click Browse, and then select the inf file in the folder extracted in step 1.
9 Click OK.
10 Select your printer name and click Next.
11 To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation starts.
12 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it. Click Next.
13 As the driver installation is completed, click Print a test page to verify installation. To use this printer as the default printer, select the Set as the default printer check box.
14 Click Finish.

**Network Connection Setup**

[NOTE: To use this printer in a Linux environment, you need to install a Linux driver. For more information on how to install and use these, see "Installing Printer Drivers on Linux Computers (CUPS)."

**For installing PCL, PS and Fax printer driver**

1 Start the Dell Printer Easy Install program, following the procedures shown in "Starting Dell Printer Easy Install."
2 In the main menu window of Dell Printer Easy Install, click Connect.
3 Select Wireless or Ethernet Connection, and then click Next.
4 Select the printer you want to install from the printer list, and then click **Next**. If the target printer is not displayed on the list, click the 🔄 (Refresh) button to refresh the list or click **add printer manually** to add a printer to the list manually. You may specify the IP address and port name at this point. If you have installed this printer on the server computer, select the **I am setting up this printer on a server** check box.

**NOTE:** When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid IP address.

**NOTE:** If **Windows Security Alert** is displayed in this step, select **Unblock** or **Allow access**, and then continue the procedure.

5 Specify the printer settings, and then click **Next**.
   a Enter the printer name.
   b If you want to set the printer as the default printer, select the **Set this printer as default** check box.
   c If you want to install the PostScript 3 Compatible printer driver, select the **PS Driver** check box.
      If you want to install the Fax Driver, select the **Fax Driver** check box.
   d If you want other users on the network to access the printer, select **Share this printer with other computers on the network**, and then enter a share name that users can identify.

6 Select the software and documentation you want to install, and then click **Install**. If you want to change the installation destination, click **Change Destination Folder** and specify a new location.

7 Click **Finish** to exit the wizard when the Ready to Print! screen appears.
   If you want to verify installation, click **Print Test Page** before clicking **Finish**.

**For installing XML Paper Specification (XPS) printer driver**

**NOTE:** XML Paper Specification (XPS) driver is supported on Windows Vista® or later.

**Windows Vista® or Windows Vista® 64-bit Edition**

1 Extract the following zip file to your desired location.
   D:\Drivers\XPS\Win_7Vista\XPS-V3_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Click **Start**→**Control Panel**→**Hardware and Sound**→**Printers**.

3 Click **Add a printer**.

4 Click **Add a network, wireless or Bluetooth printer**.

5 Select printer and click **Next**, or click **The printer that I want isn't listed**.

6 Select **Add a printer using a TCP/IP address or host name**, and then click **Next**.

7 Select **TCP/IP Device** from **Device type**, and enter the IP address for **Hostname or IP address**, and then click **Next**.
   If the **User Account Control** dialog box appears, click **Continue**.

**NOTE:** If you are an administrator on the computer, click **Continue**; otherwise, contact your administrator to continue the desired action.

8 Click **Have Disk** to display the **Install From Disk** dialog box.

9 Click **Browse**, and then select the inf file in the folder extracted in step 1.

10 Click **OK**.

11 Select your printer name and click **Next**.
12 To change the printer name, enter the printer name in the **Printer name** box, and then click **Next**.

To use this printer as the default printer, select the **Set as the default printer** check box, and then click **Next**.

Installation starts.

13 As the driver installation is completed, click **Print a test page** to verify installation.

14 Click **Finish**.

**Windows Server® 2008 or Windows Server® 2008 64-bit Edition**

NOTE: You must log in as an administrator.

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS-V3_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers**.

3 Click **Add a printer**.

4 Click **Add a network, wireless or Bluetooth printer**.

5 Select printer and click **Next**, or click **The printer that I want isn't listed**.

When you select your printer, go to step 8.

When you click **The printer that I want isn't listed**, go to step 6.

6 Select **Add a printer using a TCP/IP address or host name**, and then click **Next**.

7 Select **TCP/IP Device** from **Device type**, and enter the IP address for **Hostname or IP address**, and then click **Next**.

If the **User Account Control** dialog box appears, click **Continue**.

NOTE: If you are an administrator on the computer, click **Continue**; otherwise, contact your administrator to continue the desired action.

8 Click **Have Disk** to display the **Install From Disk** dialog box.

9 Click **Browse**, and then select the inf file in the folder extracted in step 1.

10 Click **OK**.

11 Select your printer name and click **Next**.

12 To change the printer name, enter the printer name in the **Printer name** box, and then click **Next**.

To use this printer as the default printer, select the **Set as the default printer** check box, and then click **Next**.

13 If you do not share your printer, select **Do not share this printer**. If you share your printer, select **Share this printer** so that others on your network can find and use it.

14 Click **Next**.

Installation starts.

15 As the driver installation is completed, click **Print a test page** to verify installation.

16 Click **Finish**.

**Windows Server® 2008 R2**

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS-V3_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Click **Start** → **Devices and Printers**.
3 Click Add a printer.
4 Click Add a network, wireless or Bluetooth printer.
5 Select printer and click Next, or click The printer that I want isn't listed.

NOTE: When you click The printer that I want isn't listed, Find a printer by name or TCP/IP address screen appears. Find your printer on the screen.

If the User Account Control dialog box appears, click Continue.

NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired action.

6 Click Have Disk to display the Install From Disk dialog box.
7 Click Browse, and then select the inf file in the folder extracted in step 1.
8 Click OK.
9 Select your printer name and click Next.
10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box, and then click Next.
11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it.
12 Click Next.

Installation starts.
13 As the driver installation is completed, click Print a test page to verify installation.
14 Click Finish.

Windows® 7 or Windows® 7 64-bit Edition

1 Extract the following zip file to your desired location.
   D:\Drivers\XPS\Win_7Vista\XPS-V3_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Click Start→ Devices and Printers.
3 Click Add a printer.
4 Click Add a network, wireless or Bluetooth printer.
5 Select printer and click Next, or click The printer that I want isn't listed.

When you select your printer, go to step 8.

When you click The printer that I want isn't listed, go to step 6.
6 Select Add a printer using a TCP/IP address or host name, and then click Next.
7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click Next.

If the User Account Control dialog box appears, click Yes.

NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired action.

8 Click Have Disk to display the Install From Disk dialog box.
9 Click Browse, and then select the inf file in the folder extracted in step 1.
10 Click OK.
11 Select your printer name and click Next.
Installing Printer Drivers on Windows® Computers

To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation starts.

If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it.

Click Next.

As the driver installation is completed, click Print a test page to verify installation. To use this printer as the default printer, select the Set as the default printer check box.

Click Finish.


1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_8\XPS-V4_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel.

3 Click Hardware and Sound → Devices and Printers → Add a printer.

4 Click The printer that I want isn't listed.

5 Select Add a printer using a TCP/IP or host name, and then click Next.

6 Select TCP/IP Device from Device Type, enter the IP address in the Hostname or IP address box, and then click Next.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the inf file in the folder extracted in step 1.

9 Click OK.

10 Select your printer name and click Next.

11 To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation starts.

12 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it. Click Next.

13 As the driver installation is completed, click Print a test page to verify installation. To use this printer as the default printer, select the Set as the default printer check box.

14 Click Finish.

Windows® 10

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_8\XPS-V4_H815dw_S2815dn.zip (where D is the drive letter of the optical drive)

2 Right-click the Start button, and then click Control Panel.

3 Click Hardware and Sound → Devices and Printers → Add a printer.

4 Click The printer that I want isn't listed.

5 Select Add a local printer or network printer with manual settings, and then click Next.

6 Select the port connected to this product, and then click Next.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the inf file in the folder extracted in step 1.
9 Click OK.
10 Select your printer name and click Next.
11 To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation starts.
12 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer so that others on your network can find and use it. Click Next.
13 As the driver installation is completed, click Print a test page to verify installation. To use this printer as the default printer, select the Set as the default printer check box.
14 Click Finish.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering replacement consumables. You can click the Dell supplies link for ordering supplies.

NOTE: The Dell Printer Configuration Web Tool is not available when the printer is directly connected to a computer or a print server.

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. The printer configuration appears on the screen.

You can set up the Dell Printer Configuration Web Tool to send you an e-mail when the printer needs supplies or intervention.

To set up e-mail alerts:
1 Launch the Dell Printer Configuration Web Tool.
2 Click E-Mail Server Settings Overview link.
3 Under E-Mail Server Settings, enter the Primary SMTP Gateway, Reply Address, and your or key operator's e-mail address in the e-mail list box.
4 Click Apply New Settings.

NOTE: Connection pending until printer sends an alert is displayed on the SMTP server until an error occurs.

Setting Up for Shared Printing

You can share your USB connected printer with other computers (clients) on the same network.

To share your USB connected printer, enable shared printing when installing the printer driver. You can also enable shared printing by following the procedures below.

Enabling Shared Printing from the Computer

Windows Server® 2003 or Windows Server® 2003 x64 Edition
1 Click Start→ Printers and Faxes.
2 Right-click the printer icon and select Properties.
3 On the Sharing tab, select the Share this printer check box, and then type a name in the Share name text box.
4 Click Additional Drivers and select the operating systems of all network clients that print to the printer, and then click OK.
5 Click OK.
If you are missing files, you are prompted to insert the server operating system CD.
Windows Vista® or Windows Vista® 64-bit Edition

1. Click Start→ Control Panel→ Hardware and Sound→ Printers.
2. Right-click the printer icon and select Sharing.
3. Click Change sharing options.
   The message Windows needs your permission to continue appears.
4. Click Continue.
5. Select the Share this printer check box, and then type a name in the Share name text box.
6. Click Additional Drivers and select the operating systems of all network clients that print to the printer, and then click OK.
7. Click OK.

Windows Server® 2008 or Windows Server® 2008 64-bit Edition

1. Click Start→ Control Panel→ Printers.
2. Right-click the printer icon and select Sharing.
3. Click Change Sharing Options if exists.
4. Select the Share this printer check box, and then type a name in the Share name text box.
5. Click Additional Drivers and select the operating systems of all network clients that print to the printer, and then click OK.
6. Click OK.


1. Click Start→ Devices and Printers.
2. Right-click the printer icon and select Printer properties.
3. On the Sharing tab, click Change Sharing Options if exists.
   Select the Share this printer check box, and then type a name in the Share name text box.
4. Click Additional Drivers and select the operating systems of all network clients that print to the printer, and then click OK.
5. Click Apply, and then click OK.


1. On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel→ Hardware and Sound (Hardware for Windows Server® 2012/Windows Server® 2012 R2)→ Devices and Printers.
   For Windows® 10:
   Right-click the Start button, and then click Control Panel→ Hardware and Sound→ Devices and Printers.
2. Right-click the printer icon and select Printer properties.
3. On the Sharing tab, click Change Sharing Options if exists.
4. Select the Share this printer check box, and then type a name in the Share name text box.
5. Click Additional Drivers and select the operating systems of all network clients using this printer, and then click OK.
6. Click Apply, and then click OK.
Checking the Shared Printer

To confirm that the printer is properly shared:

- Ensure that the printer object in the Printers, Printers and Faxes, or Devices and Printers folder is shared. The shared icon is shown under the printer icon.
- From a network client, browse Network or My Network Places. Find the host name of the server and the shared name you assigned to the printer.

After you have checked that the printer is shared, use methods such as Windows® Point and Print to use the shared printer from a network client.

**NOTE:** If the OS bit editions (32/64 bit edition) differ between a print server and a client computer, you need to manually add the printer driver for the client computer edition on the server. Otherwise, the printer driver cannot be installed on the client computer using methods such as Point and Print. For example, if the print server runs on Windows Vista® 32-bit edition, while the client computer runs on Windows® 7 64-bit edition, follow the procedures below to additionally install the printer driver for 64-bit client on the 32-bit server.

a Click Additional Drivers on the screen for sharing printers.
   For details about how to display this screen, see "Enabling Shared Printing from the Computer."

b Select the x64 check box, and then click OK.

c Insert the Software and Documentation disc into your computer.

d Click Browse to specify the folder that contains the 64-bit OS driver, and then click OK.
   Installation starts.
Installing Printer Drivers on Macintosh Computers

Installing the Drivers and Software

1. Run the Software and Documentation disc on the Macintosh computer.
2. For Dell™ Cloud Multifunction Printer | H815dw, double-click the Dell MFP H815dw Installer icon, and then click Continue.
   For Dell Smart Multifunction Printer | S2815dn, double-click the Dell MFP S2815dn Installer icon, and then click Continue.
3. When the popup dialog box prompts you for confirming the program included in the installation package, click Continue.
4. Click Continue on the Important Information screen.
5. Select a language for the Software License Agreement screen.
6. After reading the Software License Agreement, click Continue.
7. If you agree to the terms of the Software License Agreement, click Agree to continue the installation process.
8. Confirm the installation location.
9. Click Install to perform the standard installation.
   If you want to select a custom installation, click Customize to select items that you want to install.
   • Dell MFP H815dw Printer Driver or Dell MFP S2815dn Printer Driver
   • Dell MFP H815dw Fax Driver or Dell MFP S2815dn Fax Driver
   • Dell MFP H815dw Scan Driver or Dell MFP S2815dn Scan Driver
   • Dell Printer Status Monitor
10. Type the administrator’s name and password, and then click Install Software.
11. Click Continue Installation to continue the installation.
12. When the message The installation was successful. appears, click Log Out to complete installation.

Adding a Printer on Mac OS X 10.5, Mac OS X 10.6, Mac OS X 10.7, OS X 10.8, OS X 10.9, or OS X 10.10

When Using a USB connection

1. Turn on the printer.
2. Connect the USB cable between the printer and the Macintosh computer.
   The printer is automatically added to your Macintosh computer.

When Using IP Printing

1. Turn on the printer.
2. Ensure that Macintosh computer and the printer are connected via network.
   If you use wired connection, connect the LAN cable between the printer and the network.
   If you use wireless connection on the Dell Cloud Multifunction Printer | H815dw, ensure that wireless connection is configured properly on your Macintosh computer and the printer.
Installing Printer Drivers on Macintosh Computers

3 For Mac OS X 10.5 and Mac OS X 10.6: Open the System Preferences, and click Print & Fax.
For Mac OS X 10.7 and OS X 10.8: Open the System Preferences, and click Print & Scan.
For OS X 10.9 and OS X 10.10: Open the System Preferences, and click Printers & Scanners.

4 Click the Plus (+) sign, select Add Printer or Scanner (Add Other Printer or Scanner for Mac OS X 10.7), and select IP.
For Mac OS X 10.5 and Mac OS X 10.6, just click the Plus (+) sign and select IP.

5 Select Line Printer Daemon - LPD for Protocol.

6 Type the IP address for the printer in the Address area.

7 For Mac OS X 10.5, Mac OS X 10.6, and Mac OS X 10.7: Select Dell MFP H815dw v3012 PS vX.X or Dell MFP S2815dn v3012 PS vX.X for Print Using.
For OS X 10.8, OS X 10.9, and OS X 10.10: Select Dell MFP H815dw v3012 PS vX.X or Dell MFP S2815dn v3012 PS vX.X for Use.

   NOTE: When printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.

8 Click Add.

9 Specify the options that have been installed on the printer, and then click Continue.

10 For Mac OS X 10.5 and Mac OS X 10.6: Confirm that the printer is displayed in the Print & Fax dialog box.
For Mac OS X 10.7 and OS X 10.8: Confirm that the printer is displayed in the Print & Scan dialog box.
For OS X 10.9 and OS X 10.10: Confirm that the printer is displayed in the Printers & Scanners dialog box.

When Using Bonjour

1 Turn on the printer.

2 Ensure that Macintosh computer and the printer are connected via network.
   If you use wired connection, connect the LAN cable between the printer and the network.
   If you use wireless connection on the Dell Cloud Multifunction Printer | H815dw, ensure that wireless connection is configured properly on your Macintosh computer and the printer.

3 For Mac OS X 10.5 and Mac OS X 10.6: Open the System Preferences, and click Print & Fax.
For Mac OS X 10.7 and OS X 10.8: Open the System Preferences, and click Print & Scan.
For OS X 10.9 and OS X 10.10: Open the System Preferences, and click Printers & Scanners.

4 Click the Plus (+) sign, select Add Printer or Scanner (Add Other Printer or Scanner for Mac OS X 10.7), and select Default.
For Mac OS X 10.5 and Mac OS X 10.6, just click the Plus (+) sign and select Default.

5 Select the printer connected via Bonjour from the Name (Printer Name for Mac OS X 10.5, Mac OS X 10.6, and Mac OS X 10.7) list.

6 For Mac OS X 10.5, Mac OS X 10.6, and Mac OS X 10.7: Name and Print Using are automatically entered.
For OS X 10.8, OS X 10.9, and OS X 10.10: Name and Use are automatically entered.

   NOTE: If AirPrint Printer is automatically selected for Print Using (or Use), select Dell MFP H815dw v3012 PS vX.X or Dell MFP S2815dn v3012 PS vX.X manually.

7 Click Add.

8 Specify the options that have been installed on the printer, and then click Continue.
9 For Mac OS X 10.5 and Mac OS X 10.6: Confirm that the printer is displayed in the Print & Fax dialog box.
   For Mac OS X 10.7 and OS X 10.8: Confirm that the printer is displayed in the Print & Scan dialog box.
   For OS X 10.9 and OS X 10.10: Confirm that the printer is displayed in the Printers & Scanners dialog box.

Configuring Settings
Configure the options available for the printer.

1  For Mac OS X 10.5 and Mac OS X 10.6: Open the System Preferences, and click Print & Fax.
   For Mac OS X 10.7 and OS X 10.8: Open the System Preferences, and click Print & Scan.
   For OS X 10.9 and OS X 10.10: Open the System Preferences, and click Printers & Scanners.

2  Select the printer in the Printers list, and click Options & Supplies.

3  For Mac OS X 10.5, Mac OS X 10.6, Mac OS X 10.7, and OS X 10.8: Select Driver, select the options that can be configured for the printer, and then click OK.
   For OS X 10.9 and OS X 10.10: Select Options, select the options that can be configured for the printer, and then click OK.
Installing Printer Drivers on Linux Computers (CUPS)

This section provides information for installing or setting up the printer driver with CUPS (Common UNIX Printing System) on Red Hat Enterprise Linux 6 (32/64bit), SUSE Linux Enterprise Desktop 11 (32/64bit), or Ubuntu 12.04 LTS (32/64bit).

Operation on Red Hat Enterprise Linux 6 Desktop

Setup Overview

1. Install the printer driver.
2. Set up the print queue.
3. Specify the default queue.
4. Specify the printing options.

Installing the Printer Driver

1. Select Applications → System Tools → Terminal.
2. Type the following command in the terminal window.

For the 32-bit architecture

```
su
(Type the administrator password)
rpm -ivh (Type the file path)/Dell-MFP-H815dw-S2815dn-*.*-.i686.rpm
```

For the 64-bit architecture

```
su
(Type the administrator password)
rpm -ivh (Type the file path)/Dell-MFP-H815dw-S2815dn-*.*-.x86_64.rpm
```

The printer driver is installed.

Setting Up the Queue

To execute printing, you must set up the print queue on your workstation.

2. Click Administration.
3. Click Add Printer.
4. Type root as the user name, type the administrator password, and click OK.
   For network connections:
   a. Select LPD/LPR Host or Printer from the Other Network Printers menu, and click Continue.
b Type the IP address of the printer in Connection, and click Continue.
   Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

For USB connections:
   a Select Dell MFP H815dw or Dell MFP S2815dn from the Local Printers menu, and click Continue.

5 Type the name of the printer in the Name box in the Add Printer window, and click Continue.
   You can optionally specify the location and description of the printer for further information.
   If you want to share the printer, select the Share This Printer check box.

6 Select Dell from the Make menu, and click Continue.

7 Select Dell MFP H815dw vXXXX PS or Dell MFP S2815dn vXXXX PS from the Model menu, and click Add Printer.
   The setup is complete.

Printing From the Applications
   When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the application, and specify the queue in the print dialog box.
   However, sometimes you can print only from the default queue depending on the application (for example Mozilla). In these cases, before you start printing, set queue you want to print to as the default queue. For information on specifying the default queue, see "Setting the Default Queue."

Setting the Default Queue
   1 Select Applications → System Tools → Terminal.
   2 Type the following command in the terminal window.

`su
   (Type the administrator password)
   lpadmin -d (Type the queue name)

Specifying the Printing Options
   You can specify the printing options such as 2-sided printing.
   1 Open the URL "http://localhost:631" using a web browser.
   2 Click Administration.
   3 Click Manage Printers.
   4 Click the queue name for which you want to specify the printing options.
   5 Select Set Default Options from the Administration menu.
   6 Click the desired setting item, specify the required settings, and click Set Default Options.
   The message Printer xxx default options have been set successfully. appears.
   The setting is complete.

Uninstalling the Printer Driver
   1 Select Applications → System Tools → Terminal.
   2 Type the following command in the terminal window to delete the print queue.
3 Repeat the command above for all queues for the same model.
4 Type the following command in the terminal window.

```
su
(Type the administrator password)
/usr/sbin/lpadmin -x (Type the print queue name)
```

The printer driver is uninstalled.

**Operation on SUSE Linux Enterprise Desktop 11**

**Setup Overview**
1 Install the printer driver.
2 Set up the print queue.
3 Specify the default queue.
4 Specify the printing options.

**Installing the Printer Driver**
1 Select **Computer** → **More Applications**... and select **GNOME Terminal** on the Application Browser.
2 Type the following command in the terminal window.

**For the 32-bit architecture**

```
su
(Type the administrator password)
rpm -ivh (Type the file path)/ Dell-MFP-H815dw-S2815dn-i686.rpm
```

The printer driver is installed.

**For the 64-bit architecture**

```
su
(Type the administrator password)
rpm -ivh (Type the file path)/ Dell-MFP-H815dw-S2815dn-*.x86_64.rpm
```

The printer driver is installed.
Setting Up the Queue

To execute printing, you must set up the print queue on your workstation.

1. Select Computer → More Applications..., and select YaST on the Application Browser.
2. Type the administrator password, and click Continue.

YaST Control Center is activated.

3. Select Hardware on YaST Control Center, and select Printer.

The Printer Configurations dialog box opens.

For network connections:

a. Click Add.

The Add New Printer Configuration dialog box opens.

b. Click Connection Wizard.

The Connection Wizard dialog box opens.

c. Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver Box via.

d. Type the IP address of the printer in IP Address or Host Name:.

e. Select Dell in the Select the printer manufacturer: drop-down menu.

f. Click OK.

The Add New Printer Configuration dialog box appears.

g. For Dell™ Cloud Multifunction Printer | H815dw, select Dell MFP H815dw vXXXX PS [Dell/Dell_MFP_H815dw.ppd.gz] from the Assign Driver list.

For Dell Smart Multifunction Printer | S2815dn, select Dell MFP S2815dn vXXXX PS [Dell/Dell_MFP_S2815dn.ppd.gz] from the Assign Driver list.

**NOTE:** You can specify the printer name in Set Name:.

h. Confirm the settings, and click OK.

For USB connections:

a. Click Add.

The printer name is displayed in the Determine Connection list.

b. Click Add.

The Add New Printer Configuration dialog box opens.

The printer name is displayed in the Determine Connection list.

c. For Dell Cloud Multifunction Printer | H815dw, select Dell MFP H815dw vXXXX PS [Dell/Dell_MFP_H815dw.ppd.gz] from the Assign Driver list.

For Dell Smart Multifunction Printer | S2815dn, select Dell MFP S2815dn vXXXX PS [Dell/Dell_MFP_S2815dn.ppd.gz] from the Assign Driver list.

**NOTE:** You can specify the printer name in Set Name:.

d. Confirm the settings, and click OK.

Printing From the Applications

When you have finished setting up the queue you can print jobs from the applications. Start the print job from the application, and specify the queue in the print dialog box.

However, sometimes you can print only from the default queue depending on the application (for example Mozilla). In these cases, before you start printing, set queue you want to print to as the default queue. For information on specifying the default queue, see "Setting the Default Queue."
Setting the Default Queue

You can set the default queue when you add the printer.

1. Select Computer → More Applications..., and select YaST on the Application Browser.
2. Type the administrator password, and click Continue.
   YaST Control Center is activated.
3. Select Hardware on YaST Control Center, and select Printer.
   The Printer Configurations dialog box opens.
4. Click Edit.
   A dialog box to modify the specified queue opens.
5. Confirm that the printer you want to set is selected in the Connection list.
6. Select the Default Printer check box.
7. Confirm the settings, and click OK.

Specifying the Printing Options

You can specify the printing options such as 2-sided printing.

1. Open a web browser.
3. Click Manage Printers.
4. Click Set Printer Options of the printer for which you want to specify the printing options.
5. Specify the required settings, and click Set Printer Options.
6. Type root as the user name, type the administrator password, and click OK.

**NOTE:** Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to “Setting the Password for Authority as the Printer Administrator.”

The message Printer xxx has been configured successfully appears.

The setting is complete. Execute printing from the application.
Setting the Password for Authority as the Printer Administrator
You must set the password for authority as the printer administrator to do operations as the printer administrator.

1. Select Computer → More Applications... and select GNOME Terminal on the Application Browser.
2. Type the following command in the terminal window.

```
su
(Type the administrator password)
lppasswd -g sys -a root
(Type the password for authority as the printer administrator after the Enter password prompt.)
(Retype the password for authority as the printer administrator after the Enter password again prompt.)
```

Uninstalling the Printer Driver

1. Select Computer → More Applications... and select GNOME Terminal on the Application Browser.
2. Type the following command in the terminal window to delete the print queue.

```
su
(Type the administrator password)
/usr/sbin/lpadmin -x (Type the printer queue name)
```

3. Repeat the command above for all queues for the same model.
4. Type the following command in the terminal window.

```
su
(Type the administrator password)
rpm -e Dell-MFP-H815dw-S2815dn
```

The printer driver is uninstalled.

Operation on Ubuntu 12.04 LTS

Setup Overview

1. Install the printer driver.
2. Set up the print queue.
3. Specify the default queue.
4. Specify the printing options.

Installing the Printer Driver

1. Click Dash Home, and enter terminal in the Search text box.
2. Click Terminal in the Applications category of the search results.
3 Type the following command in the terminal window.

**For the 32-bit architecture**

```
sudo dpkg -i (Type the file path)/dell-mfp-S2815dn-H815dw-*.**_i386.deb
(Type the administrator password)
```

**For the 64-bit architecture**

```
sudo dpkg -i (Type the file path)/dell-mfp-S2815dn-H815dw-*.**_amd64.deb
(Type the administrator password)
```

The printer driver is installed.

**Setting Up the Queue**

To execute printing, you must set up the print queue on your workstation.

1 Open the URL "http://localhost:631" using a web browser.
2 Click Administration.
3 Click Add Printer.
4 Type the user name and the administrator password, and click OK.
5 Select either of the following according to the type of your printer connection.
   
   **For network connections:**
   
   a Select LPD/LPR Host or Printer from the Other Network Printers menu, and click Continue.
   b Type the IP address of the printer in Connection, and click Continue.
      Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)
   
   **For USB connections:**
   
   a Select Dell MFP H815dw or Dell MFP S2815dn from the Local Printers menu, and click Continue.
   b Type the name of the printer in the Name box in the Add Printer window, and click Continue.
      You can optionally specify the location and description of the printer for further information.
      If you want to share the printer, select the Share This Printer check box.
   
6 Select Dell from the Make menu, and click Continue.
7 Select Dell MFP H815dw vXXXX PS or Dell MFP S2815dn vXXXX PS from the Model menu, and click Add Printer.
   The setup is complete.

**Printing From the Applications**

When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the application, and specify the queue in the print dialog box.
However, sometimes you can print only from the default queue depending on the application (for example Mozilla). In these cases, before you start printing, set queue you want to print to as the default queue. For information on specifying the default queue, see "Setting the Default Queue."

**Setting the Default Queue**

1. Click Dash Home, and enter terminal in the Search text box.
2. Click Terminal in the Applications category of the search results.
3. Type the following command in the terminal window.
   
   ```
   sudo lpadmin -d (Type the queue name)
   (Type the administrator password)
   ```

**Specifying the Printing Options**

You can specify the printing options such as 2-sided printing.

2. Click Administration.
3. Click Manage Printers.
4. Click the queue name for which you want to specify the printing options.
5. Select Set Default Options from the Administration menu.
6. Click the desired setting item, specify the required settings, and click Set Default Options.
   
   The message **Printer xxx default options have been set successfully.** appears.
   
   The setting is complete.

**Uninstalling the Printer Driver**

1. Click Dash Home, and enter terminal in the Search text box.
2. Click Terminal in the Applications category of the search results.
3. Type the following command in the terminal window to delete the print queue.
   
   ```
   sudo /usr/sbin/lpadmin -x (Type the print queue name)
   (Type the administrator password)
   ```

4. Repeat the command above for all queues for the same model.
5. Type the following command in the terminal window.
   
   ```
   sudo dpkg --r Dell-MFP-H815dw-S2815dn
   (Type the administrator password)
   ```
   
   The printer driver is uninstalled.
Using Your Printer

13 Operator Panel ................................................................. 115
14 Dell™ Printer Configuration Web Tool................................. 125
15 Understanding the Printer Menus...................................... 181
16 Print Media Guidelines.................................................... 263
17 Loading Print Media ......................................................... 269
Operator Panel

About the Operator Panel

The operator panel has a touch panel, a ready/error LED, control buttons, and a number pad, which allows you to control the printer.

**NOTE:** The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

**Dell™ Cloud Multifunction Printer | H815dw**

![Operator Panel Diagram]

**Dell Smart Multifunction Printer | S2815dn**

![Operator Panel Diagram]

1. **(Home) button**
   - Moves to the Home screen.

2. **(Login/Logout) button**
   - Allows the user to log out.
3 Touch Panel
   - Specifies the settings by directly tapping the screen.
   - Displays various settings, instructions, and error messages.

4 Ready / Error LED
   - Shows a green light when the printer is ready and a blinking green light when data is being received.
   - Shows an amber light when an error occurs and a blinking amber light when an unrecoverable print error occurs.

5 Number Pad
   - Enters numbers and characters.

6 ✪ (Redial / Pause) button
   - Calls up the last called number.
   - Inserts a pause into a telephone number.

7 ✬ (Copy) button
   - Starts copying the document. Effective only from the Home screen while you are logged in to the printer.

8 ✠ (Power Saver) button
   - Enters or exits the Power Saver mode. When the printer is not used for a while, it enters the Power Saver mode to reduce power consumption. When the Power Saver mode is active, the ✠ (Power Saver) button blinks.

9 ✰ (NFC) reader
   - Starts communication between the printer and an NFC card or a mobile device with the NFC function when the card or the device is tapped to the reader.

10 ✨1 ✨2 (Speed Dial 1 / Speed Dial 2) button
    - Starts faxing the document to the number registered as "001" and "002" respectively of the FAX Speed Dial. Effective only when the Home screen is displayed.

11 ← (Delete) button
    - Deletes numbers and characters.

12 ✨ (Job Status) button
    - Moves to the Job Status screen. From this screen, you can check or cancel active jobs.

13 ✪ (Information) Wi-Fi/WPS button
    - Moves to the Information screen. You can access various information and settings menu including Wi-Fi and Wi-Fi Direct features, check the name of the connected device via Wi-Fi Direct, check consumable levels and network status, and print various types of reports and lists.

14 ✪ (Information) button
    - Moves to the Information screen. You can access various information and settings menu, check consumable levels and network status, and print various types of reports and lists.

NOTE: Moving to a different menu or returning to a previous screen cancels the current entry or setting. Be sure to select OK to save the current entry or setting.
Basic Operations on the Touch Panel

You can operate the touch panel as with a smartphone or a tablet.

To Select the Item on the Screen

Tap the item.

To Scroll the Screen or the Listed Items

Swipe the screen by dragging your finger on the screen.

To scroll faster, flick the screen.

NOTE: If you cannot swipe or flick on some screens, operate by tapping the tiles or buttons.
**About the Home Screen**

This section describes the fields and buttons on the **Home** screen which is displayed by pressing the **(Home)** button while the user is logged in to the printer. As the factory default setting, the **Home** screen is displayed when the printer is turned on.

- **NOTE:** To display the **Home** screen, the user must be registered beforehand and log in to the printer. For more information, see "User Authentication."

* Available on the Dell Cloud Multifunction Printer | H815dw only

**Dock Menu**

The tiles are grouped according to the functions under the Dock Menu. Tap the button to display the tiles grouped under the button:

- **(Recent) Button:** Displays the tiles of the functions you recently used. Up to 8 tiles can be stored.
- **(Copy) Button:** Displays the tiles of the copy functions.
- **(Print ) Button:** Displays the tiles of the print functions.
- **(Scan) Button:** Displays the tiles of the scan functions.
- **(Fax) Button:** Displays the tile of the fax function.
- **(Tools) Button:** Displays the **Information** screen.

**Notification Bar**

Displays the status of the printer when the handle **is dragged down.** To close, drag up the handle.

You can adjust the screen brightness, see the toner information, or monitor the jobs currently progressing. **Warnings** are displayed in this area, too.

To adjust the screen brightness, drag the slider in **Screen Brightness.**

To see the **Toner Information**, tap **Supplies.**

The information of the toner is displayed.
Lock Icon
Displays when some functions are limited to access by the Functions Control settings. While the Lock icon is displayed on the upper-right of the tile, you are required to enter the password to enable the function. After the function is enabled, the Lock icon is displayed on the left to the account name, and you can access the password-locked functions without re-entering the password.

Envelope Mode Icon
Appears when the printer is set to the envelope mode.

Wi-Fi Direct Connection Status Icon
Displays the Wi-Fi Direct connection status. This icon is displayed only when Wi-Fi Direct is enabled.
(Dell Cloud Multifunction Printer | H815dw only)

Wireless LAN Connection Status Icon
Displays the intensity of wireless signal when the printer is connected to a wireless network.
(Dell Cloud Multifunction Printer | H815dw only)

Time/Network Information
Displays the current time or the network information (IPv4 address or host name).

Account Name
Displays the name of the user currently logging in to the printer.

Tiles
Displays the tiles of the functions you can select from.
When the tile color is pale and disabled, you cannot select the function.
When the Lock icon is displayed on the tile, the function is controlled by the Functions Control setting and you will need to enter the password to enable the function.
For more information about Functions Control, see "Functions Control."
Moving, Adding or Deleting the Tiles

To Move the Tiles
Tap and hold the tile you want to move, and drag it to the desired place.
The short orange bar appears between the tiles to show the nearest drop point when you are dragging the tile.
You can move the tile between pages as well.

NOTE: You cannot move the tiles in the Recent group screen of the Dock Menu.

To Add the Tiles
Find the Add App tile in the last page of the Home screen or each group screen, and tap it.
The Apps List screen appears.
Tap the tile you want to add to the Home screen.

To Delete the Tiles
1 Tap and hold the tile you want to delete.
   ❌ appears.
2 Drag the tile to ❌.

The confirmation screen is displayed.
3 Tap OK to delete the tile.

NOTE: To delete all tiles in the Recent group screen of the Dock Menu, tap ❌ in the Recent group screen, and then tap OK.
Using the Keyboard Displayed on the Touch Panel

During operations, a keyboard for entering text sometimes appears. The following describes how to enter text.

You can enter the following characters: numbers, alphabets, and symbols.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entering alphabets</td>
<td>To enter uppercase letters, tap ( ) . To return to the lowercase letters, tap ( ) again. To lock to the uppercase letters, double-tap ( ) .</td>
</tr>
<tr>
<td>Entering numbers and symbols</td>
<td>Tap 7123 .</td>
</tr>
<tr>
<td>Entering a space</td>
<td>Tap (  ).</td>
</tr>
<tr>
<td>Deleting characters</td>
<td>Tap ( ) to delete one character at a time.</td>
</tr>
</tbody>
</table>

**To Change the Keyboard Layout**

1. Press the \( \) (Information) button.
2. Tap the Tools tab, and then tap Language Settings.
3. Tap Keyboard Layout.
4. Tap the desired keyboard layout.
5. Tap OK.
Using the Number Pad

As you perform various tasks, you may need to enter numbers. For example, when you enter fax number directly.

Number Pad Numbers

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>9</td>
</tr>
<tr>
<td>0</td>
<td>*</td>
<td>#</td>
</tr>
</tbody>
</table>

Changing Numbers

If you make a mistake while entering a number, press the \(<\to\) (Delete) button to delete the last digit. Then enter the correct number.

Inserting a Pause

For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must be entered in order for the access code to function. For example, enter the access code 9 and then press the \(\leftarrow\) (Redial/Pause) button before entering the telephone number. "." appears on the display when a pause is entered.

Printing a Panel Settings Report

The panel settings report shows current settings for the printer menus. For details about how to print a panel settings report, see "Report / List."
Changing the Language

You can change the language used on the touch panel.

When Using the Operator Panel

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Language Settings.
3. Tap Panel Language.
4. Tap ▼ until the desired language appears, and then tap the desired language.
5. Tap OK.

When Using the Tool Box

1. Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.
   For Windows® 10: Click the Start button → Dell Printer Hub or Dell Printer Management Tool.
2. For Dell Printer Hub, select the printer from My Printers on the home screen.
   For Dell Printer Management Tool, select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the home screen.
3. Click the shortcut to the Tool Box on the left of the screen.
   The Tool Box opens.
4. Click the Printer Maintenance tab.
5. Select Panel Language from the list at the left side of the page.
   The Panel Language page appears.
6. Select the desired language from Panel Language, and then click Apply New Settings.

Setting the Power Saver Timer Option

You can set the power saver timer for the printer. The printer enters the power saver mode when the printer is not used for a certain period of time.

**NOTE:** If Panel Lock Control is set to Enable, you need to enter the four-digit password to enter the Admin Settings menu.

To set the power saver timer:

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap System Settings.
4. Tap General.
5. Tap Power Saver Timer.
6. Tap Sleep or Deep Sleep.
7. Tap – or +, or use the number pad to enter the desired value.
   You can specify from 1 to 60 minutes for Sleep or 1 to 60 minutes for Deep Sleep.
8. Tap OK.
About the Concurrent Jobs Feature

This feature enables you to start a concurrent job while a fax job is running. This is done by temporarily displaying the Home screen and switching to a different function that can be run concurrently such as copy or scan.

1. While the printer is sending or receiving a fax, press the (Home) button.
2. Tap → Copy, or tap → Scan.
3. After setting the copy or scan settings, tap OK.

For details about Copy or Scan, see "Copying" or "Scanning."
Dell™ Printer Configuration Web Tool

Overview

**NOTE:** This web tool is available only when the printer is connected to a network using an Ethernet cable or the built-in wireless network function.

**NOTE:** The images used in this manual are those of the Dell Cloud Multifunction Printer | H815dw unless otherwise mentioned.

One of the features of the Dell Printer Configuration Web Tool is E-Mail Alert Setup, which sends e-mail to you or the key operator when the printer needs supplies or intervention.

To fill out printer inventory reports requiring the asset tag number of all the printers in your area, use the **Printer Information** feature in the Dell Printer Configuration Web Tool. Enter the IP address of each printer on the network to display the asset tag number.

The Dell Printer Configuration Web Tool feature also allows you to change the printer settings and keep track of printing trends. If you are a network administrator, you can copy the printer settings to one or all printers on the network using your web browser.
Setting Up the Dell Printer Configuration Web Tool

Ensure that you activate JavaScript in your browser before using the Dell Printer Configuration Web Tool.

Follow the procedures below to configure both the environment settings of your web browser and the operator panel before using the Dell Printer Configuration Web Tool.

NOTE: The Dell Printer Configuration Web Tool pages may be displayed unreadable if the pages were configured by the language different from the language of your web browser.

Setting Up From Web Browser

For Internet Explorer®

Setting Up the Display Language

1 Select Internet Options from Tools on the menu bar.
2 Select Languages in the General tab.
3 Specify the display language in order of preference in the Language list.
   For example:
   • Italian (Italy) [it-IT]
   • Spanish (Traditional Sort) [es-ES tradnl]
   • German (Germany) [de-DE]
   • French (France) [fr-FR]
   • English (United States) [en-US]
   • Danish [da-DK]
   • Dutch (Netherlands) [nl-NL]
   • Norwegian (Bokmal) [no]
   • Swedish [sv-SE]

Setting the IP Address of the Printer to Non-Proxy

1 Select Internet Options from the Tools menu.
2 Click LAN Settings under Local Area Network (LAN) Settings in the Connections tab.
3 Do either of the following:
   • Clear the Use a proxy server for your LAN check box under Proxy server.
   • Click Advanced, and then specify the IP address of the printer in the Do not use proxy server for addresses beginning with field under Exceptions.

Setting Up From Operator Panel

You can launch the Dell Printer Configuration Web Tool only when the operator panel setting is set to Enable. Confirm the operator panel setting if you cannot launch the Dell Printer Configuration Web Tool. For more information, see "Understanding the Printer Menus."
Starting the Dell Printer Configuration Web Tool

To launch the Dell Printer Configuration Web Tool, enter the IP address of your printer in your web browser.

If you do not know the IP address of your printer, print the system settings report or display the TCP/IP settings page, which lists the IP address. For details about how to find your printer's IP address, see "Verifying the IP Settings."

Overview of the Menu Items

The Dell Printer Configuration Web Tool consists of the following menus:

- Printer Status
- Printer Jobs
- Printer Settings
- Print Server Settings
- Copy Printer Settings
- Print Volume
- Address Book
- Printer Information
- Tray Management
- E-Mail Server Settings Overview
- Set Password
- Online Help
- Order Supplies at:
- Contact Dell Support at:
- Dell Document Hub at:*1

*1 This item is available only on the Dell Cloud Multifunction Printer | H815dw.

Printer Status

Use the Printer Status menu to get immediate feedback on the printer supply status. When the toner cartridge is running low, click the order supplies link on the first screen to order a new toner cartridge.

Printer Jobs

Use the Printer Jobs menu to contain information on the Job List page and Completed Jobs page. These pages show the details of the status regarding each protocol or job.

Printer Settings

Use the Printer Settings menu to change the printer settings and to view the settings in the operator panel remotely.

Print Server Settings

Use the Print Server Settings menu to change the type of printer interface and the necessary conditions for communications.
Copy Printer Settings
Use the Copy Printer Settings menu to copy the printer settings to another printer or printers on the network by typing the IP address of each printer.

NOTE: You must log in as an administrator to use this feature.

Print Volume
Use the Print Volume menu to check the history of printing, such as paper usage or the types of jobs being printed.

Address Book
Use the Address Book menu to view or edit the e-mail address, server address, and fax number entries in the Address Book, or to register new entries.

NOTE: You must log in as an administrator to use this feature.

Printer Information
Use the Printer Information menu to get information on service calls, inventory reports, or the status of current memory and engine code levels.

Tray Management
Use the Tray Management menu to get information about the paper type and size for each tray.

E-Mail Server Settings Overview
Use the E-Mail Server Settings Overview menu to configure E-Mail Server settings for Scan to Email, e-mail alert and forwarding fax to email features. Job history reports, job statistics reports, and print volume reports can also be received by e-mail. To receive alerts or reports, specify your e-mail address or the e-mail address of the key operator in the E-Mail Server menu.

Set Password
Use the Set Password menu to lock the Dell Printer Configuration Web Tool with a password so that other users do not inadvertently change the printer settings that you have selected.

NOTE: You must log in as an administrator to use this feature.

Online Help
Click Online Help to visit the Dell Support website.

Order Supplies at:
www.dell.com/supplies

Contact Dell Support at:
support.dell.com

Dell Document Hub at:
www.dell.com/dochub
Page Display Format

The layout of the page is divided into three sections listed below:

- **Top Frame**
- **Left Frame**
- **Right Frame**

**Top Frame**

The top frame is located at the top of all pages. When the Dell Printer Configuration Web Tool is activated, the current status and specifications of the printer are displayed in the top frame on every page. The following items are displayed in the top frame.

1. **Product Name**
   Displays the product name of the printer.

2. **IPv4**
   Displays the IP address of the printer.

3. **Location**
   Displays location of the printer. The location can be changed in the Basic Information section on the Print Server Settings page.

4. **Contact Person**
   Displays the name of the printer administrator. The name can be changed in the Basic Information section on the Print Server Settings page.

5. **Event Panel**
   Displays the indicator for the condition of the printer.

6. **Machine image**
   Shows the bitmap image of the printer. The Printer Status menu appears in the right frame when you click the image.
**Left Frame**

The left frame is located on the left side of all the pages. The menu titles displayed in the left frame are linked to corresponding menus and pages. You can go to the corresponding page by clicking their characters.

The following menus are displayed in the left frame.

1. **Printer Status**
   - Links to the Printer Status menu.
2. **Printer Jobs**
   - Links to the Printer Jobs menu.
3. **Printer Settings**
   - Links to the Printer Settings menu.
4. **Print Server Settings**
   - Links to the Print Server Settings menu.
5. **Copy Printer Settings**
   - Links to the Copy Printer Settings menu.
6. **Print Volume**
   - Links to the Print Volume menu.
7. **Address Book**
   - Links to the E-Mail Address menu.
8. **Printer Information**
   - Links to the Printer Information menu.
9. **Tray Management**
   - Links to the Tray Management menu.
10. **E-Mail Server Settings Overview**
    - Links to the E-Mail Server Settings menu.
11. **Set Password**
    - Links to the Security menu.
12. **Online Help**
    - Links to the Dell Support website.
13. **Order Supplies at:**
    - Links to the Dell web page.
14. **Contact Dell Support at:**
    - Links to the Dell Support website.
15. **Dell Document Hub at:**
    - Links to the Dell Document Hub website.

*1 This item is available only on the Dell Cloud Multifunction Printer | H815dw.

---

**Right Frame**

The right frame is located on the right side of all the pages. The contents of the right frame correspond to the menu that you select in the left frame. For details on the items displayed in the right frame, see "Details of the Menu Items."
### Buttons in the Right Frame

![Image of Dell Printer Configuration Web Tool]

1. **Refresh Button**
   - Receives the current printer configuration and updates the latest information in the right frame.

2. **Apply New Settings Button**
   - Submits new settings made on the Dell Printer Configuration Web Tool to the printer. The new settings replace the old settings of the printer.

3. **Restore Settings Button**
   - Restores the old settings that existed before any changes were made. New settings will not be submitted to the printer.

### Changing the Settings of the Menu Items

Some menus allow you to change the printer settings through the Dell Printer Configuration Web Tool. When you access these menus, the authentication window appears on the screen. Type a user name and password for the printer administrator by following the prompts displayed in the dialog box.

The default user name is **admin**, and the default password is left blank (NULL). You can change only the password in the **Set Password** page in the **Security** menu. The user name cannot be changed. See "Set Password" for more information.

### Details of the Menu Items

<table>
<thead>
<tr>
<th>Menu Item 1</th>
<th>Menu Item 2</th>
<th>Menu Item 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Printer Status&quot;</td>
<td>&quot;Printer Status&quot;</td>
<td>&quot;Printer Status&quot;</td>
</tr>
<tr>
<td>&quot;Printer Events&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Printer Information&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Printer Jobs&quot;</td>
<td>&quot;Printer Jobs&quot;</td>
<td>&quot;Job List&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Completed Jobs&quot;</td>
</tr>
<tr>
<td>&quot;Printer Settings&quot;</td>
<td>&quot;Printer Settings Report&quot;</td>
<td>&quot;Menu Settings&quot;</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Reports&quot;</td>
</tr>
<tr>
<td>&quot;Printer Settings&quot;</td>
<td>&quot;System Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Network Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;USB Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;PCL Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;PS Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;PDF Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Secure Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Copy Defaults&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Copy Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Fax Defaults&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Fax Settings&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Scan Defaults&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Direct Print Defaults/USB Direct Print Defaults&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;MIFARE Customized Card&quot;</td>
<td>&quot;1&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Printer Maintenance&quot;</th>
<th>&quot;Paper Density&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Adjust Transfer Unit&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Adjust Fusing Unit&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Adjust Density&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Chart&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Clean Developer&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Clean Transfer Unit&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Reset Defaults&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Initialize PrintMeter&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Storage&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Non-Dell Toner&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Adjust Altitude&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Decrease Electrostatic Memory&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Decrease Ghosting&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Clock Settings&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Web Link Customization&quot;</td>
</tr>
<tr>
<td>&quot;Print Server Settings&quot;</td>
<td>&quot;Print Server Reports&quot;</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>&quot;Print Server Settings&quot;</td>
<td>&quot;Basic Information&quot;</td>
</tr>
<tr>
<td>&quot;Print Server Settings&quot;</td>
<td>&quot;Port Settings&quot;</td>
</tr>
<tr>
<td>&quot;TCP/IP&quot;</td>
<td>&quot;SMB&quot;</td>
</tr>
<tr>
<td>&quot;E-Mail Server&quot;</td>
<td>&quot;Bonjour (mDNS)&quot;</td>
</tr>
<tr>
<td>&quot;SNMP&quot;</td>
<td>&quot;Scan to Network Folder&quot;</td>
</tr>
<tr>
<td>&quot;Scan to Network Folder&quot;</td>
<td>&quot;E-Mail Server Setup Page&quot;</td>
</tr>
<tr>
<td>&quot;SNTP&quot;</td>
<td>&quot;Proxy Server&quot;</td>
</tr>
<tr>
<td>&quot;Scan to Network Folder&quot;</td>
<td>&quot;Wi-Fi&quot;</td>
</tr>
<tr>
<td>&quot;SNTP&quot;</td>
<td>&quot;Wi-Fi Direct&quot;</td>
</tr>
<tr>
<td>&quot;AirPrint&quot;</td>
<td>&quot;Reset Print Server&quot;</td>
</tr>
<tr>
<td>&quot;Mopria&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Google Cloud Print&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Dell Document Hub&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Proxy Server&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Wi-Fi Direct&quot;</td>
<td></td>
</tr>
</tbody>
</table>

| "Security"              | "Set Password"         | "Copy Printer Settings"   |
| "Authentication System" |                        | "Copy Printer Settings"   |
| "Kerberos Server"       |                        | "Copy Printer Settings"   |
| "LDAP Server"           |                        | "Copy Printer Settings"   |
| "LDAP Authentication"   |                        | "Copy Printer Settings"   |
| "LDAP User Mapping"     |                        | "Copy Printer Settings"   |
| "SSL/TLS"               | "IPsec"                | "Copy Printer Settings"   |
| "IPsec"                 | "802.1x"               | "Copy Printer Settings"   |
| "802.1x"                | "IP Filter (IPv4)"     | "Copy Printer Settings"   |
| "IP Filter (IPv4)"      | "SMTP Domain Filtering" | "Copy Printer Settings"   |

| "Copy Printer Settings" | "Copy Printer Settings" | "Copy Printer Settings" |
| "Copy Printer Settings" | "Copy Printer Settings" | "Copy Printer Settings" |
| "Copy Printer Settings" | "Copy Printer Settings" | "Copy Printer Settings" |
| "Copy Printer Settings" | "Copy Printer Settings" | "Copy Printer Settings" |

| "Print Volume"          | "Print Volume"         | "Print Volume"           |
| "Print Volume"          | "Print Volume"         | "Print Volume"           |
| "Print Volume"          | "Print Volume"         | "Print Volume"           |
| "Print Volume"          | "Print Volume"         | "Print Volume"           |

| "Address Book"          | "E-Mail Address"       | "E-Mail Address"         |
| "Address Book"          | "E-Mail Address"       | "E-Mail Address"         |
| "E-Mail Address"        | "E-Mail Address"       | "E-Mail Address"         |
| "E-Mail Address"        | "E-Mail Address"       | "E-Mail Address"         |

| "Server Address"        | "Server Address"       | "Server Address"         |
| "Phone Book"            | "FAX Speed Dial"       | "FAX Speed Dial"         |
| "Phone Book"            | "FAX Speed Dial"       | "FAX Speed Dial"         |
| "Phone Book"            | "FAX Speed Dial"       | "FAX Speed Dial"         |
| "Phone Book"            | "FAX Speed Dial"       | "FAX Speed Dial"         |

| "Tray Management"       | "Tray Management"      | "Tray Management"        |
| "Tray Management"       | "Tray Management"      | "Tray Management"        |
| "Tray Management"       | "Tray Management"      | "Tray Management"        |
| "Tray Management"       | "Tray Management"      | "Tray Management"        |
Printer Status

Use the Printer Status menu to check the status of consumables, hardware, and specifications of the printer.

The following pages are displayed in the Printer Status menu.

Printer Status

Purpose:
To check the status of the consumables, trays, and covers.

Values:

<table>
<thead>
<tr>
<th>Component</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toner Cartridge</td>
<td>OK</td>
<td>Indicates that there is enough amount of toner for use.</td>
</tr>
<tr>
<td></td>
<td>Replace Soon</td>
<td>Indicates that the toner needs to be replaced soon.</td>
</tr>
<tr>
<td></td>
<td>Replace Now</td>
<td>Indicates that the toner needs to be replaced now.</td>
</tr>
<tr>
<td>Consumables Status</td>
<td>OK</td>
<td>Indicates that the status of the drum cartridge is OK for use.</td>
</tr>
<tr>
<td></td>
<td>Replace Soon</td>
<td>Indicates that the drum cartridge needs to be replaced soon.</td>
</tr>
<tr>
<td></td>
<td>Replace Now</td>
<td>Indicates that the drum cartridge needs to be replaced now.</td>
</tr>
<tr>
<td>Paper Trays Status</td>
<td>OK</td>
<td>Indicates that there is some paper in the tray but the quantity is unknown.</td>
</tr>
<tr>
<td></td>
<td>Add Paper</td>
<td>Indicates that there is no paper in the tray.</td>
</tr>
<tr>
<td></td>
<td>Capacity</td>
<td>Displays the maximum capacity of the paper tray.</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>Displays the size of paper in the tray.</td>
</tr>
<tr>
<td>Output Tray Status</td>
<td>OK</td>
<td>Indicates that the tray is available.</td>
</tr>
<tr>
<td></td>
<td>Capacity</td>
<td>Displays the maximum capacity of the paper tray.</td>
</tr>
<tr>
<td>Cover Status</td>
<td>Closed</td>
<td>Indicates that the cover is closed.</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Indicates that the cover is open.</td>
</tr>
<tr>
<td>Printer Type</td>
<td></td>
<td>Displays the type of the printer. Laser is displayed normally.</td>
</tr>
<tr>
<td>Printing Speed</td>
<td></td>
<td>Displays the printing speed.</td>
</tr>
</tbody>
</table>
**Printer Events**

**Purpose:**
To check the details of all alerts or indications of faults displayed in the Printer Events page when any faults such as Out of Paper or Cover is Open occur.

**Values:**

<table>
<thead>
<tr>
<th>Location</th>
<th>Displays the location where a fault occurred.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Displays the details of the fault.</td>
</tr>
</tbody>
</table>

**Printer Information**

**Purpose:**
To verify the printer details such as the hardware configuration and software version. This page can also be displayed by clicking Printer Information in the left frame.

**Values:**

<table>
<thead>
<tr>
<th>Dell Service Tag Number</th>
<th>Displays Dell service tag number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Express Service Code</td>
<td>Displays Dell express service code.</td>
</tr>
<tr>
<td>Asset Tag Number</td>
<td>Displays the asset tag number of the printer.</td>
</tr>
<tr>
<td>Printer Serial Number</td>
<td>Displays the serial number of the printer.</td>
</tr>
<tr>
<td>Memory Capacity</td>
<td>Displays the memory capacity.</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>Displays the processing speed.</td>
</tr>
<tr>
<td>Printer Revision Levels</td>
<td>Displays the revision date (revision level).</td>
</tr>
<tr>
<td>Firmware Version</td>
<td></td>
</tr>
</tbody>
</table>

**Printer Jobs**

The Printer Jobs menu contains information on the Job List and Completed Jobs pages. These pages show the details of the status regarding each protocol or job.

**Job List**

**Purpose:**
To confirm the jobs that are being processed. Click the Refresh button to update the screen.

**Values:**

<table>
<thead>
<tr>
<th>ID</th>
<th>Displays the job ID.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Displays the file name of the job being processed.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the name of the job owner.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Job Status</td>
<td>Displays the status of the job being processed.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Displays the type of the job.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date when the job was submitted.</td>
</tr>
</tbody>
</table>
**Completed Jobs**

**Purpose:**
To check the completed jobs. Up to the last 20 jobs are displayed. Click the **Refresh** button to update the screen.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the job ID.</td>
</tr>
<tr>
<td>Job Name</td>
<td>Displays the file name of the completed job.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the name of the job owner.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Output Result</td>
<td>Displays the status of the completed job.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Displays the type of the job.</td>
</tr>
<tr>
<td>Impression Number</td>
<td>Displays the total number of pages for the job.</td>
</tr>
<tr>
<td>No. of Sheets</td>
<td>Displays the total number of sheets for the job.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date when the job was submitted.</td>
</tr>
</tbody>
</table>

**Printer Settings**

Use the **Printer Settings** menu to display the **Printer Settings Report**, **Printer Settings**, and **Printer Maintenance** tabs and to configure the printer settings.

The following tabbed pages are displayed at the top of the right frame.

**Printer Settings Report**

The **Printer Settings Report** tab includes the **Menu Settings** and **Reports** pages.

**Menu Settings**

Use the **Menu Settings** page to display the current settings of the printer menus.

**Reports**

**Purpose:**
To print various types of reports and lists.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Settings</td>
<td>Click <strong>Start</strong> to print the System Settings report.</td>
</tr>
<tr>
<td>Panel Settings</td>
<td>Click <strong>Start</strong> to print the Panel Settings report.</td>
</tr>
<tr>
<td>PCL Fonts List</td>
<td>Click <strong>Start</strong> to print the PCL (Hewlett-Packard Printer Control Language) Fonts List.</td>
</tr>
<tr>
<td>PCL Macros List</td>
<td>Click <strong>Start</strong> to print the PCL Macro List.</td>
</tr>
<tr>
<td>PS Fonts List</td>
<td>Click <strong>Start</strong> to print the PS Fonts List.</td>
</tr>
<tr>
<td>PDF Fonts List</td>
<td>Click <strong>Start</strong> to print the PDF Fonts List.</td>
</tr>
<tr>
<td>Job History</td>
<td>Click <strong>Start</strong> to print the Job History report.</td>
</tr>
<tr>
<td>Error History</td>
<td>Click <strong>Start</strong> to print the Error History report.</td>
</tr>
<tr>
<td>Print Meter</td>
<td>Click <strong>Start</strong> to print the Print Meter report.</td>
</tr>
<tr>
<td>Demo Page</td>
<td>Click <strong>Start</strong> to print the Demo Page.</td>
</tr>
<tr>
<td>Protocol Monitor</td>
<td>Click <strong>Start</strong> to print the Protocol Monitor report.</td>
</tr>
<tr>
<td>Printer Settings</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>System Settings</strong></td>
<td>Purpose: To configure the basic printer settings. Values:</td>
</tr>
<tr>
<td>Power Saver Time - Sleep</td>
<td>Sets the time taken by the printer to enter Sleep mode after it finishes a job.</td>
</tr>
<tr>
<td>Power Saver Time - Deep Sleep</td>
<td>Sets the time taken by the printer to enter Deep Sleep mode after it has entered Sleep mode.</td>
</tr>
<tr>
<td>mm / inch</td>
<td>Sets the measurement unit to be used on the touch panel as either mm or inches.</td>
</tr>
<tr>
<td>Screen Brightness</td>
<td>Sets the brightness level of the touch panel screen.</td>
</tr>
<tr>
<td>Control Panel Tone</td>
<td>Sets the volume of the tone that is emitted when the operator panel input is correct, or disables the tone.</td>
</tr>
<tr>
<td>Invalid Key Tone</td>
<td>Sets the volume of the tone that is emitted when the operator panel input is incorrect, or disables the tone.</td>
</tr>
<tr>
<td>Machine Ready Tone</td>
<td>Sets the volume of the tone that is emitted when the printer becomes ready, or disables the tone.</td>
</tr>
<tr>
<td>Copy Completed Tone</td>
<td>Sets the volume of the tone that is emitted when a copy job is complete, or disables the tone.</td>
</tr>
<tr>
<td>Job Completed Tone</td>
<td>Sets the volume of the tone that is emitted when a job other than a copy job is complete, or disables the tone.</td>
</tr>
<tr>
<td>Fault Tone</td>
<td>Sets the volume of the tone that is emitted when a job ends abnormally, or disables the tone.</td>
</tr>
<tr>
<td>Alert Tone</td>
<td>Sets the volume of the tone that is emitted when a problem occurs, or disables the tone.</td>
</tr>
<tr>
<td>Out of Paper Tone</td>
<td>Sets the volume of the tone that is emitted when the printer runs out of paper, or disables the tone.</td>
</tr>
<tr>
<td>Low Toner Alert Tone</td>
<td>Sets the volume of the tone that is emitted when the toner is low, or disables the tone.</td>
</tr>
<tr>
<td>Auto Clear Alert Tone</td>
<td>Sets the volume of the tone that is emitted 5 seconds before the printer performs auto clear, or disables the tone.</td>
</tr>
<tr>
<td><strong>NFC Authentication Tone</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Sets the volume of the tone that is emitted when an NFC card is placed on the NFC reader for authentication, or disables the tone.</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>All Tones</strong></td>
<td>Sets the volume of all the alert tones, or disables all the tones.</td>
</tr>
<tr>
<td><strong>Low Toner Alert Message</strong></td>
<td>Alerts you if the toner is low.</td>
</tr>
<tr>
<td><strong>OffHook Wake Up</strong></td>
<td>Sets whether to wake up from Sleep or Deep Sleep mode when you pick up the handset of the external telephone.</td>
</tr>
<tr>
<td><strong>Auto Log Print</strong></td>
<td>Sets if a job history needs to be printed after every 20 jobs.</td>
</tr>
<tr>
<td><strong>RAM Disk</strong></td>
<td>Sets whether to allocate RAM for the file system for the Secure Print, Proof Print, Private Mail Box Print, and Public Mail Box Print features.</td>
</tr>
<tr>
<td><strong>Panel Language</strong></td>
<td>Used to set the language on the touch panel.</td>
</tr>
<tr>
<td><strong>Max E-mail Size</strong></td>
<td>Sets the maximum size of e-mail that can be sent. The available range is from 50 to 16384 (KB) (Default: 2048).</td>
</tr>
<tr>
<td><strong>Auto Reset</strong></td>
<td>Sets the amount of time before the printer automatically resets its settings to the defaults when no additional settings are made.</td>
</tr>
<tr>
<td><strong>Fault Time-out</strong></td>
<td>Sets the amount of time the printer waits before canceling a job that stops abnormally.</td>
</tr>
<tr>
<td><strong>Default Paper Size</strong></td>
<td>Sets the default print paper size.</td>
</tr>
<tr>
<td><strong>Print ID</strong></td>
<td>Sets where to print the user ID on the output paper.</td>
</tr>
<tr>
<td><strong>Print Text</strong></td>
<td>Sets whether the printer outputs PDL data (which is not supported by the printer) as text when the printer receives it.</td>
</tr>
<tr>
<td><strong>Banner Sheet Insert Position</strong></td>
<td>Sets where to insert a banner sheet in the output.</td>
</tr>
<tr>
<td><strong>Banner Sheet Specify Tray</strong></td>
<td>Sets from which tray a banner sheet is fed.</td>
</tr>
<tr>
<td><strong>Substitute Tray</strong></td>
<td>Sets whether to use another size paper when the paper that is loaded in the specified tray does not match the paper size settings for the current job.</td>
</tr>
<tr>
<td><strong>Letterhead 2 Sided</strong></td>
<td>Sets whether to print on both sides of letterhead.</td>
</tr>
<tr>
<td><strong>A4&lt;&gt;Letter Switch</strong></td>
<td>Sets whether to print A4 size jobs on Letter size paper if A4 is not available in the paper trays and vice versa (Letter size job on A4 size paper).</td>
</tr>
<tr>
<td><strong>A5&lt;&gt;Statement Switch</strong></td>
<td>Sets whether to print A5 size jobs on Statement size paper if A5 is not available in the paper trays and vice versa (Statement size job on A5 size paper).</td>
</tr>
<tr>
<td><strong>Report 2 Sided Print</strong></td>
<td>Sets whether to print reports on both sides a sheet of paper.</td>
</tr>
<tr>
<td><strong>Use Another Tray</strong></td>
<td>Sets whether to show a message to select another tray when the specified paper is not available in the paper tray.</td>
</tr>
<tr>
<td><strong>Envelope Mode Mismatch</strong></td>
<td>Sets whether to display the alert window when the print job is started without setting to the envelope mode.</td>
</tr>
<tr>
<td><strong>Resume Printing After Jam Recovery</strong></td>
<td>Sets whether to reprint or delete the jammed job after jam recovery.</td>
</tr>
<tr>
<td><strong>Tap To Print</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Sets whether to add the printer to a mobile device such as a tablet or a smartphone by tapping the device to (NFC) of the printer.</td>
</tr>
</tbody>
</table>

<sup>1</sup> This item is available only on the Dell Cloud Multifunction Printer | H815dw.

**Network Settings**

**Purpose:**
To Specify the PostScript 3 Compatible communication protocol for this printer.

**Values:**

<table>
<thead>
<tr>
<th><strong>PS Data Format</strong></th>
<th>Sets PostScript 3 Compatible communication protocol.</th>
</tr>
</thead>
</table>
### USB Settings

**Purpose:**
To change USB settings on your printer.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Port</td>
<td>Enables the USB interface on your printer.</td>
</tr>
<tr>
<td>PS Data Format</td>
<td>Sets PostScript 3 Compatible communication protocol.</td>
</tr>
<tr>
<td>Job Time-out</td>
<td>Sets the amount of time the printer waits for data to arrive from the computer.</td>
</tr>
</tbody>
</table>

### PCL Settings

**Purpose:**
To change the PCL settings.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Tray</td>
<td>Sets the paper input tray.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Sets the paper size.</td>
</tr>
<tr>
<td>Custom Paper Size - Y</td>
<td>Sets the length of custom size paper. The available range is from 127 mm (5.0 inch) to 355 mm (14.0 inch).</td>
</tr>
<tr>
<td>Custom Paper Size - X</td>
<td>Sets the width of custom size paper. The available range is from 77 mm (3.0 inch) to 215 mm (8.5 inch).</td>
</tr>
<tr>
<td>Orientation</td>
<td>Sets how text and graphics are oriented on the page.</td>
</tr>
<tr>
<td>2 Sided Print</td>
<td>Sets duplexing as the default for all print jobs.</td>
</tr>
<tr>
<td>Font</td>
<td>Sets the font from the list of registered fonts.</td>
</tr>
<tr>
<td>Symbol Set</td>
<td>Sets a symbol set for the specified font.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Sets the font size for scalable typographic fonts.</td>
</tr>
<tr>
<td>Font Pitch</td>
<td>Sets the font pitch for scalable mono spaced fonts.</td>
</tr>
<tr>
<td>Form Line</td>
<td>Sets the number of lines in a page.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Sets the number of copies to print.</td>
</tr>
<tr>
<td>Image Enhance</td>
<td>Sets whether to enable the Image Enhancement feature.</td>
</tr>
<tr>
<td>Hex Dump</td>
<td>Sets whether to help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in hexadecimal and character representation. Control codes are not executed.</td>
</tr>
<tr>
<td>Draft Mode</td>
<td>Sets whether to print in the draft mode.</td>
</tr>
<tr>
<td>Line Termination</td>
<td>Sets how to handle line terminations.</td>
</tr>
<tr>
<td>Ignore Form Feed</td>
<td>Sets whether to ignore blank pages that only contain Form Feed control codes.</td>
</tr>
<tr>
<td>A4 Wide</td>
<td>Sets whether to expand the printable area width.</td>
</tr>
<tr>
<td>Barcode Mode</td>
<td>Sets whether to enable the barcode mode, which is suitable for barcode printing.</td>
</tr>
</tbody>
</table>
### PS Settings

**Purpose:**
To change printer settings that only affect jobs using the PostScript 3 Compatible emulation printer language.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS Error Report</td>
<td>Sets whether the contents of the errors concerning PostScript 3 Compatible page description language are printed.</td>
</tr>
<tr>
<td>PS Job Time-out</td>
<td>Sets the execution time for one PostScript 3 Compatible job.</td>
</tr>
<tr>
<td>Paper Select Mode</td>
<td>Sets the way to select the tray for the PostScript 3 Compatible mode.</td>
</tr>
</tbody>
</table>

### PDF Settings

**Purpose:**
To change the PDF settings.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>Sets the number of copies.</td>
</tr>
<tr>
<td>2 Sided Print</td>
<td>Sets whether to print on both sides of a sheet of paper.</td>
</tr>
<tr>
<td>Print Mode</td>
<td>Sets a print mode.</td>
</tr>
<tr>
<td>PDF Password</td>
<td>Sets a password.</td>
</tr>
<tr>
<td>Re-enter PDF Password</td>
<td>Confirms the set password.</td>
</tr>
<tr>
<td>Collation</td>
<td>Sets whether to sort the output.</td>
</tr>
<tr>
<td>Output Size</td>
<td>Sets the output paper size.</td>
</tr>
<tr>
<td>Layout</td>
<td>Sets the output layout.</td>
</tr>
<tr>
<td>Detect Job Separator</td>
<td>Sets whether to detect the end of the job in printing PDF files successively from the USB memory.</td>
</tr>
</tbody>
</table>
Secure Settings

Panel Lock

Purpose:
To set a limited access to Admin Settings with a password, and to set or change the password.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Lock Control*1</td>
<td>Enables/Disables password protection for the Admin Settings.</td>
</tr>
<tr>
<td>New Password</td>
<td>Sets a password that is required to access the Admin Settings.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Confirms the set password.</td>
</tr>
</tbody>
</table>

*1 Some setting items in the Secure Settings are displayed only when this setting item is enabled.

NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Functions Control

Purpose:
To specify whether to lock the Copy, Scan, Fax, and Print functions with a password, and to set or change the password.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Sets whether to lock the Copy function with a password.</td>
</tr>
<tr>
<td>Scan to E-mail</td>
<td>Sets whether to lock the Scan to Email function with a password.</td>
</tr>
<tr>
<td>Fax</td>
<td>Sets whether to lock the Fax function with a password.</td>
</tr>
<tr>
<td>Fax Driver</td>
<td>Sets whether to enable or disable the Fax Driver function.</td>
</tr>
<tr>
<td>Scan to Network Folder</td>
<td>Sets whether to lock the Scan to Network Folder function with a password.</td>
</tr>
<tr>
<td>Scan to Computer</td>
<td>Sets whether to lock the Scan to Computer function with a password.</td>
</tr>
<tr>
<td>PC Scan</td>
<td>Sets whether to lock the PC Scan function with a password.</td>
</tr>
<tr>
<td>Scan to USB</td>
<td>Sets whether to lock the Scan to USB function with a password.</td>
</tr>
<tr>
<td>USB Direct Print</td>
<td>Sets whether to lock the USB Direct Print function with a password.</td>
</tr>
<tr>
<td>ID Copy</td>
<td>Sets whether to enable or disable the ID Copy function.</td>
</tr>
<tr>
<td>USB Services - Show When Inserted</td>
<td>Sets whether to show a USB Drive Detected screen when a USB memory is inserted into the printer.</td>
</tr>
<tr>
<td>New Password</td>
<td>Sets a password that is required to access the Copy, Scan, Fax, and Print functions.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Confirms the set password.</td>
</tr>
</tbody>
</table>

NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Secure Receive

Purpose:
Allows you to password protect all the incoming faxes. When the Secure Receive feature is enabled, the printer stores incoming faxes and prints them when the correct password is entered on the operator panel.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Receive Set</td>
<td>Enables/Disables password protection for all incoming faxes.</td>
</tr>
<tr>
<td>New Password</td>
<td>Sets a password to print incoming faxes.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Confirms the set password.</td>
</tr>
</tbody>
</table>
NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Desktop Login

NOTE: This Desktop Login feature is available on the Dell Smart Multifunction Printer | S2815dn only.

Purpose:
Select the user authentication method from either local authentication or remote authentication. To use the remote authentication method, the LDAP server or the Kerberos server is required to authenticate the user.

Values:

<table>
<thead>
<tr>
<th>Desktop Authentication</th>
<th>Sets the authentication method.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Authentication*</td>
<td>Use the local authentication method.</td>
</tr>
<tr>
<td>Remote Authentication</td>
<td>Use the authentication by external server.</td>
</tr>
</tbody>
</table>

Authentication System Click to display the Authentication System page and to specify the authentication system settings.

User Login History Sets whether to enable the user login history feature.

Edit E-mail From Fields

Purpose:
To set whether to enable editing of the transmission source when you use the Scan to Email function.

Reconfirm Recipients

Purpose:
To set whether to reconfirm before sending fax or scan jobs.

Software Download

Purpose:
To set whether to enable download of firmware updates.

Display of Network Information

Purpose:
To set whether to show network information in the message field of the Home screen.

Login Error

Purpose:
To specify how many times an administrator can attempt to log in to Panel Lock, Functions Control, and Secure Receive.

NFC Authentication

NOTE: NFC Authentication feature is available on the Dell Cloud Multifunction Printer | H815dw only.

Purpose:
To set whether to enable the authentication using the NFC authentication card.

FIPS 140-2 Validation Mode

NOTE: The FIPS 140-2 Validation Mode feature is available on the Dell Smart Multifunction Printer | S2815dn only.

Purpose:
To set whether to use the FIPS 140-2 Level-1 approved encryption algorithms for RSA modules.
NOTE: Communication using the following protocols will not be encrypted using FIPS 140-2 Level-1 approved encryption algorithms even when FIPS 140-2 Validation Mode is enabled. Users are advised to turn them off manually when FIPS 140-2 Validation Mode is enabled:

- SNMP v3
- SMB
- PDF Direct Print

NOTE: This feature may not be available for certain models.

Set Available Time - Copy/Scan/Fax/Print

Purpose:
To specify the time to enable the secure setting for the Copy, Scan, Fax, and Print functions.

Values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Available Time</td>
<td>Allows you to set the available time period for the Copy, Scan, Fax, and Print functions.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Sets the start time of the available time period for the Copy, Scan, Fax, and Print functions.</td>
</tr>
<tr>
<td>End Time</td>
<td>Sets the end time of the available time period for the Copy, Scan, Fax, and Print functions.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>Sets the day of the week to repeat the setting.</td>
</tr>
</tbody>
</table>

Secure Job Expiration

NOTE: Secure Job Expiration feature is available only when RAM Disk is enabled.

Purpose:
To specify the date and time to delete the files stored as Secure Print in the RAM disk.

Values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration Mode</td>
<td>Allows you to set the date to delete the files stored as Secure Print in the RAM disk.</td>
</tr>
<tr>
<td>Expiration Time</td>
<td>Sets the time to delete the files stored as Secure Print in the RAM disk.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>Sets the period to repeat the setting.</td>
</tr>
<tr>
<td>Weekly Settings</td>
<td>Sets the day of the week to repeat the setting.</td>
</tr>
<tr>
<td>Monthly Settings</td>
<td>Sets the day of the month to repeat the setting.</td>
</tr>
</tbody>
</table>

Copy Defaults

Purpose:
To create your own default Copy settings.

Values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tray</td>
<td>Sets the default input tray.</td>
</tr>
<tr>
<td>Collation</td>
<td>Sets whether to sort a copy job.</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td>Sets the default reduction/enlargement ratio.</td>
</tr>
<tr>
<td>Custom Reduce/Enlarge</td>
<td>Sets the custom reduction/enlargement ratio.</td>
</tr>
<tr>
<td>Original Size</td>
<td>Sets the paper size of the original.</td>
</tr>
<tr>
<td>Original Type</td>
<td>Sets the type of the original.</td>
</tr>
<tr>
<td>Darken/Lighten</td>
<td>Sets the default copy density.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Sets the default sharpness level.</td>
</tr>
<tr>
<td>Auto Exposure</td>
<td>Sets whether to suppress the background of the original to enhance text on the copy.</td>
</tr>
</tbody>
</table>
Copy Settings
Purpose:
To configure the Copy settings.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.
Values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Exposure Level</td>
<td>Sets the background suppression level.</td>
</tr>
<tr>
<td>2 Sided Copying</td>
<td>Sets whether to print on both sides of a sheet of paper.</td>
</tr>
<tr>
<td>Binding of Original</td>
<td>Sets the binding position for the 2-sided copying.</td>
</tr>
<tr>
<td>2-Up</td>
<td><em>(Off)</em> Does not perform multiple-up printing.</td>
</tr>
<tr>
<td></td>
<td>Auto Automatically reduces the original pages to fit onto one sheet of paper.</td>
</tr>
<tr>
<td></td>
<td>Manual Prints the original pages onto one sheet of paper in the size specified for Reduce/Enlarge.</td>
</tr>
<tr>
<td>Margin Top/Bottom</td>
<td>Sets the value of the top and bottom margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).</td>
</tr>
<tr>
<td>Margin Left/Right</td>
<td>Sets the value of the left and right margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).</td>
</tr>
<tr>
<td>Margin Middle</td>
<td>Sets the value of the middle margin within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).</td>
</tr>
<tr>
<td>Resolution</td>
<td>Standard* Suitable for documents with normal sized characters.</td>
</tr>
<tr>
<td></td>
<td>Fine Suitable for documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td></td>
<td>Super Fine Suitable for documents containing extremely fine detail. The super fine mode is enabled only if the remote machine also supports the Super Fine resolution.</td>
</tr>
<tr>
<td></td>
<td>Photo Suitable for documents containing photographic images.</td>
</tr>
<tr>
<td>2 Sided Scanning</td>
<td>Sets whether to scan both sides of a document.</td>
</tr>
<tr>
<td>Binding of Original</td>
<td>Sets the binding position for the 2-sided scanning.</td>
</tr>
<tr>
<td>Darken/Lighten</td>
<td>Sets the default density to fax your documents lighter or darker.</td>
</tr>
<tr>
<td>Delayed Send</td>
<td>Sets the fax transmission start time when sending a fax at a specified time.</td>
</tr>
</tbody>
</table>

Fax Defaults
Purpose:
To create your own default Fax settings.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.
Values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Standard* Suitable for documents with normal sized characters.</td>
</tr>
<tr>
<td></td>
<td>Fine Suitable for documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td></td>
<td>Super Fine Suitable for documents containing extremely fine detail. The super fine mode is enabled only if the remote machine also supports the Super Fine resolution.</td>
</tr>
<tr>
<td></td>
<td>Photo Suitable for documents containing photographic images.</td>
</tr>
</tbody>
</table>

Fax Settings
Purpose:
To configure the Fax settings.

NOTE: You cannot set up the items on the Fax Settings page unless you set up the country code under Country.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.
Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Number</td>
<td>Allows you to enter the fax number of the printer, which will be printed on the header of faxes.</td>
</tr>
<tr>
<td>Country</td>
<td>Sets the country where the printer is used.</td>
</tr>
<tr>
<td>Fax Header Name</td>
<td>Allows you to enter a name that will be printed on the header of faxes.</td>
</tr>
<tr>
<td>Line Type</td>
<td>Sets the default line type; PSTN or PBX.</td>
</tr>
<tr>
<td>Line Monitor</td>
<td>Sets the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a connection is made.</td>
</tr>
<tr>
<td>DRPD Pattern</td>
<td>Sets the Distinctive Ring Pattern Detection (DRPD) setting from Pattern1 to Pattern7. DRPD is a service provided by some telephone companies.</td>
</tr>
<tr>
<td>Receive Mode</td>
<td>Telephone: Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external telephone and then pressing a remote receive code, or by tapping Receive on On Hook and then tapping Receive. For details about Manual Receive, see &quot;Receiving a Fax Manually in the Telephone Mode.&quot; Fax: Automatically receives faxes. Telephone/Fax: When the printer receives an incoming fax, the external telephone rings for the time specified in Auto Receive Tel/Fax, and then the printer automatically receives a fax. If an incoming call is not a fax, the printer beeps from the internal speaker indicating that the call is a telephone call. Ans Machine/Fax: The printer can share a telephone line with an answering machine. In this mode, the printer will monitor the fax signal and pick up the line if there are fax tones. If the telephone communication in your country is serial, this mode is not supported. DRPD: Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.</td>
</tr>
<tr>
<td>Ring Tone Volume</td>
<td>Sets the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker when Receive Mode is set to Telephone/Fax.</td>
</tr>
<tr>
<td>Auto Receive Fax</td>
<td>Sets the interval at which the printer goes into the fax receive mode after answering an incoming call.</td>
</tr>
<tr>
<td>Auto Receive Tel/Fax</td>
<td>Sets the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming call.</td>
</tr>
<tr>
<td>Auto Receive Answer/Fax</td>
<td>Sets the interval at which the printer goes into the fax receive mode after the external answering machine receives an incoming call.</td>
</tr>
<tr>
<td>Junk Fax Setup</td>
<td>Sets whether to reject unwanted faxes by accepting only the faxes from the numbers registered in the Phone Book.</td>
</tr>
<tr>
<td>2 Sided Printing</td>
<td>Sets whether to print on both sides of a sheet of paper.</td>
</tr>
<tr>
<td>Remote Receive</td>
<td>Sets whether to receive a fax by pressing a remote receive code on the external telephone.</td>
</tr>
<tr>
<td>Remote Receive Tone</td>
<td>Sets a 2-digit remote receive code when Remote Receive is On.</td>
</tr>
<tr>
<td>Discard Size</td>
<td>Sets whether to delete text or images at the bottom of a fax page when the entire page does not fit onto the output paper. Selecting Auto Reduction automatically reduces the fax page to fit it onto the output paper, and does not discard any images or text at the bottom of the page.</td>
</tr>
<tr>
<td>Received Fax Forward</td>
<td>Sets whether to forward incoming faxes to a specified destination.</td>
</tr>
<tr>
<td>Forwarding Number</td>
<td>Allows you to enter the fax number of the destination to which incoming faxes will be forwarded.</td>
</tr>
<tr>
<td>Forwarding E-mail Address</td>
<td>Allows you to enter the e-mail address to which incoming faxes are to be forwarded.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forwarding E-mail Address 2</td>
<td>Allows you to enter the e-mail address to which incoming faxes are to be forwarded.</td>
</tr>
<tr>
<td>Forwarding E-mail Address 3</td>
<td>Allows you to enter the e-mail address to which incoming faxes are to be forwarded.</td>
</tr>
<tr>
<td>Forwarding E-mail Address 4</td>
<td>Allows you to enter the e-mail address to which incoming faxes are to be forwarded.</td>
</tr>
<tr>
<td>Forwarding E-mail Address 5</td>
<td>Allows you to enter the e-mail address to which incoming faxes are to be forwarded.</td>
</tr>
<tr>
<td>Server Type</td>
<td>Sets the server type.</td>
</tr>
<tr>
<td>Server Address</td>
<td>Sets the server address registered under the server ID.</td>
</tr>
<tr>
<td>Server Port Number</td>
<td>Sets the server port number.</td>
</tr>
<tr>
<td>Login Name</td>
<td>Sets the login name.</td>
</tr>
<tr>
<td>Login Password</td>
<td>Sets the login password.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Enter the password again to confirm it.</td>
</tr>
<tr>
<td>Share Name</td>
<td>Sets the shared name.</td>
</tr>
<tr>
<td>Server Path</td>
<td>Sets the server path.</td>
</tr>
<tr>
<td>Redial Attempts</td>
<td>Sets the number of redial attempts (0–13) to make if the destination fax number is busy. If you enter 0, the printer will not redial.</td>
</tr>
<tr>
<td>Interval of Redial</td>
<td>Sets the interval (1–15 minutes) between redial attempts.</td>
</tr>
<tr>
<td>Resend Delay</td>
<td>Sets the interval (3–255 seconds) between re-send attempts.</td>
</tr>
<tr>
<td>Tone/Pulse</td>
<td>Sets whether to use tone or pulse dialing.</td>
</tr>
<tr>
<td>Prefix Dial</td>
<td>Sets whether to set a prefix dial number.</td>
</tr>
<tr>
<td>Prefix Dial Number</td>
<td>Sets a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful for accessing the Private Automatic Branch Exchange (PABX).</td>
</tr>
<tr>
<td>Fax Cover Page</td>
<td>Sets whether to attach a cover page to faxes.</td>
</tr>
<tr>
<td>Fax Header*1</td>
<td>Sets whether to print the information of the sender on the header of faxes.</td>
</tr>
<tr>
<td>ECM</td>
<td>Sets whether to enable the Error Correction Mode (ECM). To use the ECM, the remote machines must also support the ECM.</td>
</tr>
<tr>
<td>Modem Speed</td>
<td>Allows you to adjust the fax modem speed when a fax transmission or reception error occurs.</td>
</tr>
<tr>
<td>Display Manual Fax Recipients</td>
<td>Sets whether to show the fax number of the recipient on the Sending Fax screen when manually sending a fax.</td>
</tr>
<tr>
<td>Fax Activity</td>
<td>Sets whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.</td>
</tr>
<tr>
<td>Fax Transmit</td>
<td>Sets whether to print a transmission report after every fax transmission or only when an error occurs.</td>
</tr>
<tr>
<td>Fax Broadcast</td>
<td>Sets whether to print a transmission report after every fax transmission to multiple destinations or only when an error occurs.</td>
</tr>
<tr>
<td>Fax Protocol</td>
<td>Sets whether to print the protocol monitor report after every fax transmission or only when an error occurs.</td>
</tr>
</tbody>
</table>

*1 This item is not available when **Country** is set to **United States**.
**Scan Defaults**

**Purpose:**
To create your own default Scan settings.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Format</td>
<td>Sets the file format in which scanned documents are to be saved.</td>
</tr>
<tr>
<td>Output Color</td>
<td>Sets whether to scan in color or in black and white.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Sets the default scan resolution.</td>
</tr>
<tr>
<td>Original Size</td>
<td>Sets the paper size of the original.</td>
</tr>
<tr>
<td>2 Sided Scanning</td>
<td>Sets whether to scan both sides of a document.</td>
</tr>
<tr>
<td>Binding of Original</td>
<td>Sets the binding position for the 2-sided scanning.</td>
</tr>
<tr>
<td>Darken/Lighten</td>
<td>Sets the default scan density.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Sets the default sharpness level.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Sets the default contrast level.</td>
</tr>
<tr>
<td>Auto Exposure</td>
<td>Sets whether to suppress the background of the original to enhance text on the scanned data.</td>
</tr>
<tr>
<td>Auto Exposure Level</td>
<td>Sets the default background suppression level.</td>
</tr>
<tr>
<td>Margin Top/Bottom</td>
<td>Sets the value of the top and bottom margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).</td>
</tr>
<tr>
<td>Margin Left/Right</td>
<td>Sets the value of the left and right margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).</td>
</tr>
<tr>
<td>Margin Middle</td>
<td>Sets the value of the middle margin within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).</td>
</tr>
<tr>
<td>TIFF File Format</td>
<td>Sets the TIFF file format to TIFF V6 or TTN2.</td>
</tr>
<tr>
<td>Image Compression</td>
<td>Sets the image compression level.</td>
</tr>
<tr>
<td>File Naming Mode</td>
<td>Sets the detailed settings of File Naming Mode to Auto, Add Prefix or Add Suffix.</td>
</tr>
<tr>
<td>Prefix/Suffix String</td>
<td>Sets the texts that are added when Add Prefix or Add Suffix are selected.</td>
</tr>
<tr>
<td>Create Folder</td>
<td>Sets whether to create a folder when saving scanned documents.</td>
</tr>
</tbody>
</table>

**Direct Print Defaults/USB Direct Print Defaults**

- **NOTE:** Direct Print Defaults feature is available on the Dell Cloud Multifunction Printer | H815dw; USB Direct Print Defaults feature is available on the Dell Smart Multifunction Printer | S2815dn.

**Purpose:**
To create your own Direct Print Defaults/USB Direct Print Defaults setting.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tray</td>
<td>Sets the default input tray.</td>
</tr>
<tr>
<td>2 Sided Printing</td>
<td>Sets whether to print on both sides of a sheet of paper.</td>
</tr>
<tr>
<td>Layout</td>
<td>Sets the default paper layout when Layout is selected.</td>
</tr>
<tr>
<td>Image Types</td>
<td>Sets the print image quality when printing documents.</td>
</tr>
<tr>
<td>Collation</td>
<td>Sets whether to sort the output.</td>
</tr>
<tr>
<td>PDF Password</td>
<td>Sets a password.</td>
</tr>
<tr>
<td>Re-enter PDF Password</td>
<td>Confirms the set password.</td>
</tr>
</tbody>
</table>
**MIFARE Customized Card**

*NOTE:* MIFARE Customized Card feature is available on the Dell Cloud Multifunction Printer | H815dw only.

**Purpose:**
To register SSFC formatted NFC ID cards.

**Values:**

<table>
<thead>
<tr>
<th>User ID Block 1</th>
<th>Allows you to register the MIFARE Customized Card.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID Block 2</td>
<td>Allows you to register the MIFARE Customized Card.</td>
</tr>
<tr>
<td>User ID Block 3</td>
<td>Allows you to register the MIFARE Customized Card.</td>
</tr>
</tbody>
</table>

**Printer Maintenance**

The Printer Maintenance tab includes the Paper Density, Adjust Transfer Unit, Adjust Fusing Unit, Adjust Density, Chart, Clean Developer, Clean Transfer Unit, Reset Defaults, Initialize PrintMeter, Storage, Non-Dell Toner, Adjust Altitude, Decrease Electrostatic Memory, Decrease Ghosting, Clock Settings, and Web Link Customization pages.

**Paper Density**

**Purpose:**
To specify the paper density.

**Values:**

| Plain | Sets the density of plain paper to Light (<81g/m²) or Normal. |

**Adjust Transfer Unit**

**Purpose:**
To specify the optimum voltage settings for printing for the transfer unit. To lower the voltage, set negative values. To increase, set positive values.

The default settings may not give the best output quality on all paper types. If you see mottles on the printed paper, try to increase the voltage. If you see white spots on the printed paper, try to decrease the voltage.

⚠️ **CAUTION:** The print quality changes depending on the setting values you select for this item.

**Values:**

<table>
<thead>
<tr>
<th>Plain(60-80g/m²)</th>
<th>Sets the reference voltage setting for the transfer unit for plain paper within the range of -5 to 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Thick(81-105g/m²)</td>
<td>Sets the reference voltage setting for the transfer unit for thick plain paper within the range of -5 to 10.</td>
</tr>
<tr>
<td>Covers(106-163 g/m²)</td>
<td>Sets the reference voltage setting for the transfer unit for cover paper within the range of -5 to 10.</td>
</tr>
<tr>
<td>Covers Thick (164-216 g/m²)</td>
<td>Sets the reference voltage setting for the transfer unit for thick cover paper within the range of -5 to 10.</td>
</tr>
<tr>
<td>Rough Surface</td>
<td>Sets the reference voltage setting for the transfer unit for rough surface paper within the range of -5 to 10.</td>
</tr>
<tr>
<td>Label</td>
<td>Sets the reference voltage setting for the transfer unit for labels within the range of -5 to 10.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Sets the reference voltage setting for the transfer unit for envelopes within the range of -5 to 10.</td>
</tr>
<tr>
<td>Japanese Postcard</td>
<td>Sets the reference voltage setting for the transfer unit for Japanese postcards within the range of -5 to 10.</td>
</tr>
</tbody>
</table>
### Adjust Fusing Unit

**Purpose:**
To specify the optimum temperature settings for printing for the fusing unit. To lower the temperature, set negative values. To increase, set positive values.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

**NOTE:** The print quality changes depending on the setting values you select for this item.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain (60-80g/m²)</td>
<td>Sets the temperature settings for the fusing unit for plain paper within the range of -3 to 3.</td>
</tr>
<tr>
<td>Plain Thick (81-105g/m²)</td>
<td>Sets the temperature settings for the fusing unit for thick plain paper within the range of -3 to 3.</td>
</tr>
<tr>
<td>Covers (106-163 g/m²)</td>
<td>Sets the temperature settings for the fusing unit for cover paper within the range of -3 to 3.</td>
</tr>
<tr>
<td>Covers Thick (164-216 g/m²)</td>
<td>Sets the temperature settings for the fusing unit for thick cover paper within the range of -3 to 3.</td>
</tr>
<tr>
<td>Rough Surface</td>
<td>Sets the temperature settings for the fusing unit for rough surface paper within the range of -3 to 3.</td>
</tr>
<tr>
<td>Label</td>
<td>Sets the temperature settings for the fusing unit for labels within the range of -3 to 3.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Sets the temperature settings for the fusing unit for envelopes within the range of -3 to 3.</td>
</tr>
<tr>
<td>Japanese Postcard</td>
<td>Sets the temperature settings for the fusing unit for Japanese postcards within the range of -3 to 3.</td>
</tr>
</tbody>
</table>

### Adjust Density

**Purpose:**
To adjust the density level.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Darker 3</td>
<td>Adjusts the density level darker than the normal setting.</td>
</tr>
<tr>
<td>Darker 2</td>
<td></td>
</tr>
<tr>
<td>Darker 1</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td>Works well with standard typed or printed documents.</td>
</tr>
<tr>
<td>Lighter 1</td>
<td>Adjusts the density level lighter than the normal setting.</td>
</tr>
<tr>
<td>Lighter 2</td>
<td></td>
</tr>
<tr>
<td>Lighter 3</td>
<td></td>
</tr>
</tbody>
</table>

### Chart

**Purpose:**
To print various charts that can be used for diagnosis of the printer.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch Chart</td>
<td>Print Prints a full halftone page. Also prints a page to check the pitch. A total of two pages are printed.</td>
</tr>
<tr>
<td>Full Page Solid</td>
<td>Print 1-Sided Prints a chart on one side of the paper.</td>
</tr>
<tr>
<td></td>
<td>2-Sided Prints a chart of the full page solid on both sides of the paper.</td>
</tr>
<tr>
<td>Alignment Chart</td>
<td>Print Prints a chart to check for proper alignment of the print image on the paper.</td>
</tr>
</tbody>
</table>
**Clean Developer**

**Purpose:**
To stir the developer in the drum cartridge.

**Values:**

<table>
<thead>
<tr>
<th>Function</th>
<th>Start</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Developer</td>
<td>Start</td>
<td>Stirs the developer in the drum cartridge.</td>
</tr>
</tbody>
</table>

**Clean Transfer Unit**

**Purpose:**
To clean the transfer unit.

**Values:**

<table>
<thead>
<tr>
<th>Function</th>
<th>Start</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Transfer Unit</td>
<td>Start</td>
<td>Cleans the transfer unit.</td>
</tr>
</tbody>
</table>

**Reset Defaults**

**Purpose:**
To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu parameters are reset to their default values.

**Values:**

<table>
<thead>
<tr>
<th>Function</th>
<th>Reset Defaults User Fax Section and restart printer.</th>
<th>Click Start to reset the fax number entries in the Address Book.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reset Defaults User Scan Section and restart printer.</td>
<td>Click Start to reset the e-mail and server address entries in the Address Book.</td>
</tr>
<tr>
<td></td>
<td>Reset Defaults User Account Section and restart printer.</td>
<td>Click Start to reset the user account entries.</td>
</tr>
<tr>
<td></td>
<td>Reset Defaults User App Section and restart printer.</td>
<td>Click Start to reset the user application entries.</td>
</tr>
<tr>
<td></td>
<td>Reset Defaults System Section and restart printer.</td>
<td>Click Start to reset the system parameters.</td>
</tr>
</tbody>
</table>

**Power On Wizard**

<table>
<thead>
<tr>
<th>Function</th>
<th>Power On Wizard</th>
<th>Click Start to perform the initial setup for the printer.</th>
</tr>
</thead>
</table>

*1 This item is available on the Dell Cloud Multifunction Printer | H815dw only.

**Initialize PrintMeter**

**Purpose:**
To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to 0.

**Storage**

**NOTE:** Storage feature is available only when RAM Disk is enabled.

**Purpose:**
To clear all files stored in the RAM disk.
Values:

<table>
<thead>
<tr>
<th>Clear Storage*1</th>
<th>All Clear</th>
<th>Click Start to clear all files stored as Secure Print, Proof Print, Private Mail Box Print, and Public Mail Box Print in the RAM disk.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Document</td>
<td>Click Start to clear all files stored as Secure Print, Proof Print, Private Mail Box Print, and Public Mail Box Print in the RAM disk.</td>
<td></td>
</tr>
<tr>
<td>Stored Document</td>
<td>Click Start to clear all files stored in the RAM disk.</td>
<td></td>
</tr>
</tbody>
</table>

*1 This item is available only when RAM Disk is enabled.

**Non-Dell Toner**

Purpose:
To use toner cartridge of another manufacturer.

⚠️ **WARNING:** Using a non-Dell toner cartridge may severely damage your printer. The warranty does not cover damages caused by using non-Dell toner cartridges.

**Adjust Altitude**

Purpose:
To specify the altitude of the location where the printer is installed.

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are performed by specifying the altitude of the location where the printer is being used.

**Decrease Electrostatic Memory**

Purpose:
To widen the print gap not to leave toner streak on the next page.

💡 **NOTE:** When Decrease Electrostatic Memory is set to On, the print speed will be slowed.

**Decrease Ghosting**

Purpose:
To reduce negative ghost.

**Clock Settings**

Purpose:
To specify the clock settings.

Values:

<table>
<thead>
<tr>
<th>Date Format</th>
<th>Sets the date format; YYYY/MM/DD, MM/DD/YYYY, or DD/MM/YYYY.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Format</td>
<td>Sets the time format; 24 Hour Clock or 12 Hour Clock.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Sets the time zone.</td>
</tr>
<tr>
<td>Set Date</td>
<td>Sets the current date.</td>
</tr>
<tr>
<td>Set Time</td>
<td>Sets the current time.</td>
</tr>
</tbody>
</table>
**Web Link Customization**

**Purpose:**
To specify a link used for ordering consumables, which can be accessed from Order Supplies at: in the left frame.

**Values:**

<table>
<thead>
<tr>
<th>Select Reorder URL</th>
<th>Sets a URL to be linked to Order Supplies at:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Regular</strong></td>
<td>Displays the regular URL (<a href="http://accessories.us.dell.com/sna">http://accessories.us.dell.com/sna</a>) that can be linked to Order Supplies at:</td>
</tr>
<tr>
<td><strong>Premier</strong></td>
<td>Displays the premier URL (<a href="http://premier.dell.com">http://premier.dell.com</a>) that can be linked to Order Supplies at:</td>
</tr>
</tbody>
</table>

**Print Server Settings**

Use the Print Server Settings menu to set the type of printer interface and the necessary conditions for communication.

The following tabbed pages are displayed in the top of the right frame.

**Print Server Reports**

The Print Server Reports tab includes the Print Server Setup Page and the E-Mail Server Setup Page.

**Print Server Setup Page**

Displays the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) and printing ports.

**E-Mail Server Setup Page**

Displays the current settings of the e-mail server.

**Print Server Settings**

The Print Server Settings tab includes the Basic Information, Port Settings, TCP/IP, SMB, E-Mail Server, Bonjour (mDNS), SNMP, Scan to Network Folder, SNTP, AirPrint, Mopria, Google Cloud Print, Dell Document Hub*1, Proxy Server, Wi-Fi*1, Wi-Fi Direct*1, and Reset Print Server pages.

*1 This item is available only on the Dell Cloud Multifunction Printer | H815dw.

**Basic Information**

**Purpose:**
To configure basic information of the printer.

**Values:**

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Printer Name</th>
<th>Sets the name of the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Location</td>
<td>Sets the location of the printer.</td>
</tr>
<tr>
<td></td>
<td>Contact Person</td>
<td>Sets the contact name, number, and other information of the printer administrator and service center.</td>
</tr>
<tr>
<td></td>
<td>Administrator E-Mail Address</td>
<td>Sets the contact address of the printer administrator and service center.</td>
</tr>
<tr>
<td></td>
<td>Asset Tag Number</td>
<td>Enters the asset tag number for the printer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dell Printer Configuration Web Tool Settings</th>
<th>Auto Refresh</th>
<th>Automatically refreshes the contents of the status display pages.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Refresh Interval</td>
<td>Sets the time interval for refreshing the contents of the status display pages automatically from 15 to 600 seconds.</td>
<td></td>
</tr>
</tbody>
</table>
NOTE: The Auto Refresh feature is effective for the contents of the top frame, Printer Status page, Job List page, and Completed Jobs page.

**Port Settings**

**Purpose:**
To enable or disable printing ports and management protocol features.

**Values:**

<table>
<thead>
<tr>
<th>Ethernet&lt;sup&gt;1&lt;/sup&gt;</th>
<th>Ethernet Settings</th>
<th>Auto</th>
<th>Detects the Ethernet transmission rate and the duplex settings automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10Base-T Half-Duplex</td>
<td></td>
<td>Selects 10Base-T Half-Duplex as the default value.</td>
</tr>
<tr>
<td></td>
<td>10Base-T Full-Duplex</td>
<td></td>
<td>Selects 10Base-T Full-Duplex as the default value.</td>
</tr>
<tr>
<td></td>
<td>100Base-TX Half-Duplex</td>
<td></td>
<td>Selects 100Base-TX Half-Duplex as the default value.</td>
</tr>
<tr>
<td></td>
<td>100Base-TX Full-Duplex</td>
<td></td>
<td>Selects 100Base-TX Full-Duplex as the default value.</td>
</tr>
<tr>
<td></td>
<td>1000Base-T Full-Duplex</td>
<td></td>
<td>Selects 1000Base-T Full-Duplex as the default value.</td>
</tr>
</tbody>
</table>

**Current Ethernet Settings** Displays the current settings of the Ethernet.

**MAC Address** Displays the MAC address of the printer.

**Energy Efficient Ethernet** Sets whether to enable the Energy Efficient Ethernet feature.

<table>
<thead>
<tr>
<th>Port Status</th>
<th>LPD</th>
<th>Sets whether to enable LPD.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Port9100</td>
<td>Sets whether to enable Port9100.</td>
</tr>
<tr>
<td></td>
<td>IPP</td>
<td>Sets whether to enable IPP.</td>
</tr>
<tr>
<td></td>
<td>WSD Print</td>
<td>Sets whether to enable Web Services on Devices (WSD) Print.</td>
</tr>
<tr>
<td></td>
<td>WSD Scan</td>
<td>Sets whether to enable Web Services on Devices (WSD) Scan.</td>
</tr>
<tr>
<td></td>
<td>Network TWAIN</td>
<td>Sets whether to enable Network TWAIN.</td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>Sets whether to enable FTP.</td>
</tr>
<tr>
<td></td>
<td>SMB</td>
<td>Sets whether to enable SMB.</td>
</tr>
<tr>
<td></td>
<td>Bonjour (mDNS)</td>
<td>Sets whether to enable Bonjour (mDNS).</td>
</tr>
<tr>
<td></td>
<td>E-Mail Alert</td>
<td>Sets whether to enable E-Mail Alert.</td>
</tr>
<tr>
<td></td>
<td>Telnet</td>
<td>Sets whether to enable Telnet.</td>
</tr>
<tr>
<td></td>
<td>SNMP</td>
<td>Sets whether to enable SNMP.</td>
</tr>
<tr>
<td></td>
<td>Update Address Book</td>
<td>Sets whether to enable Update Address Book.</td>
</tr>
<tr>
<td></td>
<td>SNTP</td>
<td>Sets whether to enable SNTP.</td>
</tr>
<tr>
<td></td>
<td>Google Cloud Print</td>
<td>Sets whether to enable Google Cloud Print.</td>
</tr>
<tr>
<td></td>
<td>Print from Widget Apps</td>
<td>Sets whether to enable printing from the widget apps.</td>
</tr>
<tr>
<td></td>
<td>Scan to Widget Apps</td>
<td>Sets whether to enable scanning to the widget apps.</td>
</tr>
</tbody>
</table>

<sup>1</sup> This item is available only when the printer is connected using an Ethernet cable.

NOTE: The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the settings, click the **Apply New Settings** button to apply the new settings.
**TCP/IP**

**Purpose:**
To configure the IP address, subnet mask, and gateway address of the printer.

**Values:**

<table>
<thead>
<tr>
<th>TCP/IP Settings</th>
<th>IP Mode</th>
<th>Sets the IP mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Host Name</td>
<td>Sets the host name.</td>
</tr>
</tbody>
</table>

**IPv4**

<table>
<thead>
<tr>
<th>IP Address Mode</th>
<th>Sets the method for acquiring the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual IP Address</td>
<td>When an IP address is being set manually, the IP is allocated to the printer using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255.</td>
</tr>
<tr>
<td>Manual Subnet Mask</td>
<td>When an IP address is being set manually, the subnet mask is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 255.255.255.255 cannot be specified as the subnet mask.</td>
</tr>
<tr>
<td>Manual Gateway Address</td>
<td>When an IP address is being set manually, the gateway address is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 127 and any value in the range of 224 to 254 cannot be specified for the first octet of a gateway address.</td>
</tr>
</tbody>
</table>

**IPv6**

<table>
<thead>
<tr>
<th>Enable Stateless Address</th>
<th>Select the check box to enable the stateless address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Manual Address</td>
<td>Select the check box to set the IP address manually.</td>
</tr>
<tr>
<td>Get IP Address from DHCP</td>
<td>Allows you to enable or disable the automatic setting of the IP address via DHCP.</td>
</tr>
<tr>
<td>Manual Address</td>
<td>Sets the IP address. To specify an IPv6 address, enter the address followed by a slash (/) and then &quot;64&quot;. For details, consult your system administrator.</td>
</tr>
</tbody>
</table>

**DNS**

<table>
<thead>
<tr>
<th>DNS Domain Name</th>
<th>Sets the DNS domain name.</th>
</tr>
</thead>
</table>

**IPv4**

<table>
<thead>
<tr>
<th>Get DNS Server Address from DHCP</th>
<th>Allows you to enable or disable the automatic setting of the DNS server address via DHCP.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual DNS Server Address</td>
<td>Manually sets the DNS server address in xxx.xxx.xxx.xxx format when Get DNS Server Address from DHCP is not selected.</td>
</tr>
</tbody>
</table>

**IPv6**

<table>
<thead>
<tr>
<th>Get DNS Server Address from DHCPv6-lite</th>
<th>Select the check box to get the DNS server address automatically from the DHCPv6-lite server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual DNS Server Address</td>
<td>Sets the DNS server address.</td>
</tr>
</tbody>
</table>

**DNS Dynamic Update (IPv4)**

Select the check box to enable dynamic updates to DNS.

**DNS Dynamic Update (IPv6)**

Select the check box to enable dynamic updates to DNS.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Generate Search List</td>
<td>Select the check box to automatically generate the search list. Adamantit.</td>
</tr>
<tr>
<td>Search Domain Name</td>
<td>Sets the search domain name. Up to 255 alphanumeric characters, periods, and hyphens can be used. If you need to specify more than one domain name, separate them using a comma or semicolon.</td>
</tr>
<tr>
<td>Time-out</td>
<td>Sets the time-out period between 1 and 60 seconds.</td>
</tr>
<tr>
<td>Priority to IPv6 DNS Name Resolution</td>
<td>Select the check box to enable the DNS Name Resolution feature.</td>
</tr>
<tr>
<td>WINS WINS Mode</td>
<td>Allows you to enable or disable the automatic setting of the primary and secondary WINS server addresses via DHCP.</td>
</tr>
<tr>
<td>WINS Primary Server</td>
<td>Manually sets the primary WINS server address in xxx.xxx.xxx.xxx format when WINS Mode is not selected.</td>
</tr>
<tr>
<td>WINS Secondary Server</td>
<td>Manually sets the secondary (backup) WINS server address in xxx.xxx.xxx.xxx format when WINS Mode is not selected.</td>
</tr>
<tr>
<td>LPD Connection Time-Out</td>
<td>Sets the connection time-out period from 1 to 3,600 seconds.</td>
</tr>
<tr>
<td>IP Filter (IPv4)</td>
<td>Click IP Filter (IPv4) to set the IP Filter settings on the IP Filter (IPv4) page.</td>
</tr>
<tr>
<td>Port9100 Port Number</td>
<td>Sets the port number from 9000 to 9999.</td>
</tr>
<tr>
<td>Connection Time-Out</td>
<td>Sets the connection time-out period between 1 and 3,600 seconds.</td>
</tr>
<tr>
<td>IP Filter (IPv4)</td>
<td>Click IP Filter (IPv4) to set the IP filter settings on the IP Filter (IPv4) page.</td>
</tr>
<tr>
<td>IPP Printer URI</td>
<td>Displays the printer URI.</td>
</tr>
<tr>
<td>IPP Connection Time-Out</td>
<td>Sets the connection time-out period from 1 to 1,000 seconds.</td>
</tr>
<tr>
<td>IPP Port Number</td>
<td>Displays the port number for receiving requests from the client.</td>
</tr>
<tr>
<td>IPP Maximum Sessions</td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td>WSD Port Number</td>
<td>Sets the port number to 80 or from 8000 to 9999.</td>
</tr>
<tr>
<td>WSD Receive Time-Out</td>
<td>Sets the receive time-out period from 1 to 65,535 seconds.</td>
</tr>
<tr>
<td>WSD Notification Time-Out</td>
<td>Sets the notification time-out period from 1 to 60 seconds.</td>
</tr>
<tr>
<td>WSD Maximum Number of TTL</td>
<td>Sets the maximum number of TTL from 1 to 10.</td>
</tr>
<tr>
<td>WSD Maximum Number of Notification</td>
<td>Sets the maximum number of notifications from 10 to 20.</td>
</tr>
<tr>
<td>Network TWAIN Connection Time-Out</td>
<td>Sets the connection time-out period between 1 and 65,535 seconds.</td>
</tr>
<tr>
<td>FTP Password</td>
<td>Sets the password for FTP.</td>
</tr>
<tr>
<td>FTP Re-enter Password</td>
<td>Enter the password again to confirm it.</td>
</tr>
<tr>
<td>FTP Connection Time-Out</td>
<td>Sets the connection time-out period from 1 to 1,000 seconds.</td>
</tr>
</tbody>
</table>
HTTP

| Port Number | Sets the port number to 80 or from 8000 to 9999. |
| Simultaneous Connections | Displays the maximum number of simultaneous connections. |
| CSRF Protection | Select the check box to enable the CSRF Protection. |
| Connection Time-Out | Sets the connection time-out period from 1 to 255 seconds. |

Telnet

| Password | Sets the password for Telnet. |
| Re-enter Password | Confirms the set password. |
| Connection Time-Out | Sets the connection time-out period from 1 to 1,000 seconds. |

Update Address Book

| Connection Time-Out | Sets the connection time-out period from 1 to 65,535 seconds. |

**SMB**

**Purpose:**
To specify the setting of the Server Message Block (SMB) protocol.

**Values:**

| Host Name | Sets the host name of the server computer. |
| Workgroup | Sets the workgroup. |
| Maximum Sessions | Sets the maximum number of sessions. |
| Unicode Support | Sets whether to notify the host name and workgroup name in Unicode characters during SMB transmission. |
| Auto Master Mode | Sets whether to enable the Auto Master Mode. |
| Encrypt Password | Sets whether to encrypt the password. |
| Job Time-Out | Sets the job time-out period between 60 and 3,600 seconds. |
| Connection Time-Out | Sets the connection time-out period between 60 and 3,600 seconds. |

**E-Mail Server**

**Purpose:**
To configure detailed settings of E-Mail Server, E-Mail Alert and E-Mail Report. This page can also be displayed by clicking E-Mail Server Settings Overview in the left frame.

**Values:**

| Primary SMTP Gateway | Sets the primary SMTP gateway. |
| SMTP Port Number | Sets the SMTP port number. This must be between 1 and 65535. |
| E-Mail Send Authentication | Sets the authentication method for outgoing e-mail. |
| SMTP Login User | Sets the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, underscores, and at symbols (@) can be used. If specifying more than one address, separate them using commas. |
| SMTP Login Password | Sets the SMTP account password using up to 31 alphanumeric characters. |
| Re-enter SMTP Login Password | Confirms the set SMTP account password. |
### POP3 Server Address*1
Sets the POP3 server address in IP address format of "aaa.bbbccc.ddd" or as a DNS host name using up to 63 characters.

### POP3 Port Number*1
Sets the POP3 server port number. This must be between 1 and 65535.

### POP User Name*1
Sets the POP3 account user name. Up to 63 alphanumeric characters, periods, hyphens, underscores, and at symbols (@) can be used. If specifying more than one address, separate them using commas.

### POP User Password*1
Sets the POP3 account password using up to 31 alphanumeric characters.

### Re-enter POP User Password*1
Confirms the set password.

### Reply Address
Designates the reply e-mail address sent with each E-mail Alert.

### SMTP Server Connection
Displays the status of the SMTP server connection.

<table>
<thead>
<tr>
<th>E-Mail Alert Settings</th>
<th>E-Mail List 1</th>
<th>Sets acceptable e-mail addresses for the E-Mail Alert feature using up to 255 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Alerts for List 1</td>
<td>Supplies Alerts</td>
<td>Select the check box to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td></td>
<td>Paper Handling Alerts</td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
</tr>
<tr>
<td></td>
<td>Service Call</td>
<td>Select the check box to receive an E-Mail Alert for Service Calls.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail List 2</th>
<th>Sets acceptable e-mail addresses for the E-Mail Alert feature using up to 255 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Alerts for List 2</td>
<td>Supplies Alerts</td>
</tr>
<tr>
<td></td>
<td>Paper Handling Alerts</td>
</tr>
<tr>
<td></td>
<td>Service Call</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail Report Settings</th>
<th>History Report</th>
<th>Sets whether to receive the job history report by e-mail after every 20 print, copy, scan, and fax jobs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistics Report</td>
<td>Sets whether to receive the statistic report by e-mail on the use of print, copy, scan, and fax.</td>
<td></td>
</tr>
<tr>
<td>Volume Report</td>
<td>Sets whether to receive the print volume report by e-mail.</td>
<td></td>
</tr>
<tr>
<td>Transmission Time</td>
<td>Sets what time the reports are sent.</td>
<td></td>
</tr>
<tr>
<td>Recurrence</td>
<td>Sets at what recurrence the reports are sent.</td>
<td></td>
</tr>
<tr>
<td>Weekly Settings (for Weekly only)</td>
<td>Sets the day of the week the reports are sent.</td>
<td></td>
</tr>
<tr>
<td>Monthly Settings (for Monthly only)</td>
<td>Sets the day of the month the reports are sent.</td>
<td></td>
</tr>
<tr>
<td>Destination E-Mail Address 1</td>
<td>Allows you to enter the e-mail address to which the reports are sent to.</td>
<td></td>
</tr>
<tr>
<td>Destination E-Mail Address 2</td>
<td>Allows you to enter the e-mail address to which the reports are sent to.</td>
<td></td>
</tr>
</tbody>
</table>

---

*1 This item is available only when POP before SMTP (Plain) or POP before SMTP (APOP) for E-Mail Send Authentication is selected.
**Bonjour (mDNS)**

**Purpose:**
To configure the detailed settings of Bonjour.

**Values:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>Sets the host name up to 63 alphanumeric characters and &quot;.&quot; (dash).</td>
</tr>
<tr>
<td>Printer Name</td>
<td>Sets the printer name up to 63 alphanumeric characters and symbol sets.</td>
</tr>
<tr>
<td>Wide-Area Bonjour</td>
<td>Select the check box to enable the Wide-Area Bonjour protocol.</td>
</tr>
</tbody>
</table>

**SNMP**

**Purpose:**
To configure the detailed settings of SNMP.

**Values:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNMP v1/v2c Protocol</td>
<td>Select the check box to enable the SNMP v1/v2c protocol.</td>
</tr>
<tr>
<td>Edit SNMP v1/v2c Properties</td>
<td>Click to display the SNMP v1/v2c page and to edit the setting of SNMP v1/v2c protocol from the page.</td>
</tr>
<tr>
<td>Enable SNMP v3 Protocol</td>
<td>Select the check box to enable the SNMP v3 protocol.</td>
</tr>
<tr>
<td>Edit SNMP v3 Properties</td>
<td>Click to display the SNMP v3 page and to edit the setting of SNMP v3 protocol from the page. You can click this item only when SSL/TLS communication is enabled.</td>
</tr>
</tbody>
</table>

**SNMP v1/v2c**

**Purpose:**
To edit the detailed settings of SNMP v1/v2c protocol.

To enter this page, click **Edit SNMP v1/v2c Properties** in the SNMP page.

**Values:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community Name (Read only)</td>
<td>Sets the community name to access (read only) data using up to 31 alphanumeric characters. The default Read Community is public.</td>
</tr>
<tr>
<td>Re-enter Community Name (Read only)</td>
<td>Enters the community name to access (read only) data again to confirm it.</td>
</tr>
<tr>
<td>Community Name (Read/Write)</td>
<td>Sets the community name to access (read and write) data using up to 31 alphanumeric characters. The default Read/Write Community is private.</td>
</tr>
<tr>
<td>Re-enter Community Name (Read/Write)</td>
<td>Enters the community name to access (read and write) data again to confirm it.</td>
</tr>
<tr>
<td>Community Name (Trap)</td>
<td>Sets the community name used for trap up to 31 alphanumeric characters. The default Trap Community is &quot; &quot; (NULL).</td>
</tr>
<tr>
<td>Re-enter Community Name (Trap)</td>
<td>Enters the community name used for trap again to confirm it.</td>
</tr>
</tbody>
</table>
**SNMP v3**

**Purpose:**
To edit the detailed settings of SNMP v3 protocol.

To enter this page, click **Edit SNMP v3 Properties** in the **SNMP** page.

**Values:**

<table>
<thead>
<tr>
<th><strong>Administrator Account</strong></th>
<th><strong>Account Enabled</strong></th>
<th>Select the check box to enable the administrator account.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Name</strong></td>
<td><strong>Enters the user name of the administrator account.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Authentication Password</strong></td>
<td><strong>Sets the authentication password of the administrator account using 8 to 32 alphanumeric characters.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Re-enter Authentication Password</strong></td>
<td><strong>Confirms the set password.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Privacy Password</strong></td>
<td><strong>Sets the privacy password of the administrator account using 8 to 32 alphanumeric characters.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Re-enter Privacy Password</strong></td>
<td><strong>Confirms the set password.</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Print Drivers / Remote Client Account</strong></th>
<th><strong>Account Enabled</strong></th>
<th>Select the check box to enable the print drivers and remote client account.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reset to default Password</strong></td>
<td><strong>Click to reset the password for the print drivers and remote client account to default.</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Scan to Network Folder**

**Purpose:**
To specify the client when scanning data.

**Values:**

<table>
<thead>
<tr>
<th><strong>FTP Client</strong></th>
<th><strong>Connection Time-Out</strong></th>
<th>Sets the connection time-out period from 1 to 60 seconds.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FTP Passive</strong></td>
<td><strong>Sets whether to enable the FTP Passive mode.</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>SMB Client</strong></th>
<th><strong>Connection Time-Out</strong></th>
<th>Sets the connection time-out period from 1 to 60 seconds.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SMB Protocol</strong></td>
<td><strong>Sets the SMB protocol.</strong></td>
<td></td>
</tr>
</tbody>
</table>

---

**Note:**
- The default value can be changed by using Dell Printer Configuration Web Tool.
- This item is available only when **Wi-Fi Direct** is set to **Enable**.
**SNTP**

Purpose:
To configure the SNTP server settings in order to perform time synchronization through SNTP.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SNTP</strong></td>
<td></td>
</tr>
<tr>
<td>IP Address / Host Name</td>
<td>Sets the IP address or the host name of the SNTP server.</td>
</tr>
<tr>
<td>Connection Time-Out</td>
<td>Sets the connection time-out period from 1 to 120 seconds.</td>
</tr>
<tr>
<td>Time Synchronization Interval</td>
<td>Sets the interval for performing time synchronization using SNTP.</td>
</tr>
<tr>
<td>Last Connection Time</td>
<td>Displays the last date and time when your printer was connected to the SNTP server.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>Displays the status of the connections between the SNTP server and your printer.</td>
</tr>
</tbody>
</table>

**AirPrint**

Purpose:
To configure the detailed setting of AirPrint.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AirPrint</strong></td>
<td></td>
</tr>
<tr>
<td>Enable AirPrint</td>
<td>Select the check box to enable the printer for AirPrint.</td>
</tr>
<tr>
<td>Bonjour Name</td>
<td>Enter the name that is to be displayed as an AirPrint printer.</td>
</tr>
<tr>
<td>Location</td>
<td>Enter the location of the printer.</td>
</tr>
<tr>
<td>Geo-Location</td>
<td>Enter the physical location of the printer.</td>
</tr>
<tr>
<td>IPP Authentication Basic Authentication</td>
<td>Select the check box to enable the basic authentication scheme.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the user password.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Re-enter the user password for confirmation.</td>
</tr>
<tr>
<td>SSL/TLS</td>
<td>Click Settings to display the SSL/TLS page.</td>
</tr>
<tr>
<td>Supply Levels Toner Cartridge</td>
<td>Displays the toner level.</td>
</tr>
</tbody>
</table>

**Mopria**

Purpose:
To enable the printer for Mopria Print Service.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mopria</strong></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>Click to enable the printer for Mopria.</td>
</tr>
</tbody>
</table>

**NOTE:** When both Bonjour(mDNS) and IPP are enabled, the Enable button is disabled.
### Google Cloud Print

**Purpose:**
To register the printer to Google Cloud Print.

**Values:**

<table>
<thead>
<tr>
<th><strong>Google Cloud Print</strong>&lt;sup&gt;1&lt;/sup&gt;</th>
<th><strong>(Registration state)</strong></th>
<th>Displays the Google Cloud Print registration state.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Register This Device to Google Cloud Print</strong></td>
<td>Click to register the printer to Google Cloud Print.</td>
<td></td>
</tr>
<tr>
<td><strong>Cancel Registration</strong></td>
<td>Click to cancel to register the printer to Google Cloud Print.</td>
<td></td>
</tr>
</tbody>
</table>

<sup>1</sup> Google Cloud Print can only be used when the machine is using IPv4.

### Dell Document Hub

**NOTE:** Dell Document Hub feature is available on the Dell Cloud Multifunction Printer H815dw only.

**Purpose:**
To configure the connections to the Dell Document Hub server.

**Values:**

<table>
<thead>
<tr>
<th><strong>Dell Document Hub</strong></th>
<th><strong>Connection Time-Out</strong></th>
<th>Sets the time duration until the connection becomes time-out.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Polling Interval</strong></td>
<td>Sets the interval time for polling.</td>
</tr>
</tbody>
</table>

### Proxy Server

**Purpose:**
To configure the Proxy Server settings.

**Values:**

<table>
<thead>
<tr>
<th><strong>Proxy Server</strong></th>
<th><strong>Use Proxy Server</strong></th>
<th>Sets whether to enable the use of a proxy server.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Address to Bypass Proxy Server</strong></td>
<td>Sets the address to bypass proxy server.</td>
</tr>
<tr>
<td></td>
<td><strong>Server Name</strong></td>
<td>Sets the name of the proxy server.</td>
</tr>
<tr>
<td></td>
<td><strong>Port Number</strong></td>
<td>Sets the port number from 1 to 65535.</td>
</tr>
<tr>
<td></td>
<td><strong>Authentication</strong></td>
<td>Sets whether to enable authentication.</td>
</tr>
<tr>
<td></td>
<td><strong>Login Name</strong></td>
<td>Sets the login name for the proxy server.</td>
</tr>
<tr>
<td></td>
<td><strong>Password</strong></td>
<td>Sets the login password for the proxy server.</td>
</tr>
<tr>
<td></td>
<td><strong>Re-enter Password</strong></td>
<td>Confirms the set password.</td>
</tr>
</tbody>
</table>
**Wi-Fi**

- **NOTE:** Wi-Fi feature is available only on the Dell Cloud Multifunction Printer | H815dw, when the printer is connected using the wireless network.

**Purpose:**
To configure the detailed setting for the wireless network.
To use the printer through wireless connection, be sure to disconnect the Ethernet cable.

- **NOTE:** Once wireless LAN is activated, wired LAN protocol will be disabled.

**Values:**

<table>
<thead>
<tr>
<th>Wi-Fi Settings</th>
<th>Wi-Fi</th>
<th>Sets whether to enable the wireless network connections.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSID</td>
<td>Sets the name that identifies the wireless network. Up to 32 alphanumeric characters can be entered.</td>
<td></td>
</tr>
<tr>
<td>Network Type</td>
<td>Sets the network type from either Ad-Hoc or Infrastructure.</td>
<td></td>
</tr>
<tr>
<td>MAC Address</td>
<td>Displays the MAC address of the printer.</td>
<td></td>
</tr>
<tr>
<td>Link Channel</td>
<td>Displays the channel number of the wireless connection for the printer.</td>
<td></td>
</tr>
<tr>
<td>Link Quality</td>
<td>Displays the quality of the wireless network connection for the printer.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Security Settings</th>
<th>Encryption</th>
<th>Select the encryption type from the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Security</td>
<td>Sets No Security to configure the wireless settings without specifying an encryption type from WEP, WPA-PSK, and WPA-Enterprise.</td>
<td></td>
</tr>
<tr>
<td>WEP</td>
<td>Sets the WEP to use through the wireless network.</td>
<td></td>
</tr>
<tr>
<td>WPA-PSK AES/WPA2-PSK AES&lt;sup&gt;1, 2&lt;/sup&gt;</td>
<td>Sets the WPA-PSK AES/WPA2-PSK AES to use through the wireless network.</td>
<td></td>
</tr>
<tr>
<td>WPA-Enterprise AES/WPA2-Enterprise AES&lt;sup&gt;2, 3&lt;/sup&gt;</td>
<td>Sets the WPA-Enterprise AES/WPA2-Enterprise AES to use through the wireless network.</td>
<td></td>
</tr>
<tr>
<td>Mixed Mode PSK&lt;sup&gt;1, 2&lt;/sup&gt;</td>
<td>Sets the Mixed Mode PSK to use through the wireless network. Mixed Mode PSK automatically selects the encryption type from either WPA-PSK TKIP, WPA-PSK AES, or WPA2-PSK AES.</td>
<td></td>
</tr>
<tr>
<td>Mixed Mode Enterprise&lt;sup&gt;2, 3&lt;/sup&gt;</td>
<td>Sets the Mixed Mode Enterprise to use through the wireless network. Mixed Mode Enterprise automatically selects the encryption type from either WPA-Enterprise TKIP, WPA-Enterprise AES, or WPA2-Enterprise AES.</td>
<td></td>
</tr>
</tbody>
</table>

**WEP**

<table>
<thead>
<tr>
<th>Encryption</th>
<th>Select the WEP key code from either Hex or Ascii.</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEP Key 1</td>
<td>Sets the WEP key set used through the wireless network only when WEP 128bit or WEP 64bit is selected for Encryption.</td>
</tr>
<tr>
<td>Re-enter WEP Key 1</td>
<td>Enters the WEP key 1 again to confirm it.</td>
</tr>
<tr>
<td>WEP Key 2</td>
<td>Sets the WEP key set used through the wireless network only when WEP 128bit or WEP 64bit is selected for Encryption.</td>
</tr>
<tr>
<td>Re-enter WEP Key 2</td>
<td>Enters the WEP key 2 again to confirm it.</td>
</tr>
</tbody>
</table>
Wi-Fi Direct

**NOTE:** Wi-Fi Direct feature is available on the Dell Cloud Multifunction Printer | H815dw only.

**Purpose:**
To configure the detailed setting of the Wi-Fi Direct connection.

**Values:**

<table>
<thead>
<tr>
<th>Wi-Fi Direct</th>
<th>Sets whether to enable the Wi-Fi Direct connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Role</td>
<td>Sets the group role of the printer.</td>
</tr>
<tr>
<td>Device Name</td>
<td>Specifies the printer name that identifies the Wi-Fi Direct network with up to 32 alphanumeric characters. Confirm it when selecting the printer name on your Wi-Fi mobile device.</td>
</tr>
<tr>
<td>WPS Setup</td>
<td>Configures the Wi-Fi Direct network using WPS.</td>
</tr>
<tr>
<td>Group Owner</td>
<td></td>
</tr>
<tr>
<td>SSID (Character string following “DIRECT-****”)</td>
<td>Specifies a name to identify the Wi-Fi Direct network. Up to 32 alphanumeric characters can be entered. &quot;DIRECT-****&quot; cannot be changed.</td>
</tr>
<tr>
<td>Passphrase</td>
<td>Displays the passphrase. Confirm it when entering the passphrase into your Wi-Fi mobile device.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Displays the IP address of the Wi-Fi Direct.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Displays the subnet mask.</td>
</tr>
<tr>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>Paired Device</td>
<td>Displays the mobile name currently connected.</td>
</tr>
<tr>
<td>Current Role</td>
<td>Displays the current group role of the printer.</td>
</tr>
<tr>
<td>Current SSID</td>
<td>Displays the current SSID. Confirm it selecting the Wi-Fi Direct network name on your Wi-Fi mobile device.</td>
</tr>
</tbody>
</table>
**Reset Print Server**

**Purpose:**
To initialize NVRAM (non-volatile RAM) for the network feature and reboot the printer. You can also initialize NVRAM of the printer from Reset Defaults in the Printer Settings menu.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize NIC NVRAM Memory and restart printer.</td>
<td>Click Start to initialize NVRAM, revert network settings to the factory default settings, and reboot the network capability.</td>
</tr>
<tr>
<td>Restart Printer</td>
<td>Click Start to reboot the printer.</td>
</tr>
</tbody>
</table>

**Security**

The Security tab includes Set Password, Authentication System, Kerberos Server, LDAP Server, LDAP Authentication, LDAP User Mapping, SSL/TLS, IPsec, 802.1x, IP Filter (IPv4), and SMTP Domain Filtering.

**Set Password**

**Purpose:**
To set or change the password that is required to access the setup parameters of the printer from the Dell Printer Configuration Web Tool. This page can also be displayed by clicking Set Password in the left frame.

- **NOTE:** To restore the password to the default (NULL), initialize the non-volatile memory (NVM).
- **NOTE:** You can set the password for access to Admin Settings from Panel Lock in Printer Settings.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator Password</td>
<td>Sets the password using up to 128 alphanumeric characters.</td>
</tr>
<tr>
<td>Re-enter Administrator Password</td>
<td>Confirms the set password.</td>
</tr>
<tr>
<td>Access denial by the authentication failure of the Administrator</td>
<td>Sets how many times the failure in administrator authentication is allowed in total. Sets the number from 5 to 255. If you set 0, this mode is disabled.</td>
</tr>
</tbody>
</table>

**Authentication System**

**Purpose:**
To specify the server authentication type, the server response time-out, or the search time-out.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Type</td>
<td>Select the authentication system from the list.</td>
</tr>
<tr>
<td>Server Response Time-Out</td>
<td>Sets the amount of time the printer should wait for response from the server. Sets the time period from 1 to 75 seconds.</td>
</tr>
<tr>
<td>Search Time-Out</td>
<td>Sets the amount of time the printer should wait for searching for the server. Sets the time period from 5 to 120 seconds.</td>
</tr>
</tbody>
</table>
### Kerberos Server

**Purpose:**
To specify the settings for the Kerberos server.

**Values:**

<table>
<thead>
<tr>
<th>Kerberos Server 1-5</th>
<th>IP Address / Host Name &amp; Port</th>
<th>Sets the IP address or host name, and the port address. The port address must be between 1 and 65535.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain Name</td>
<td>Enter the domain name.</td>
<td></td>
</tr>
</tbody>
</table>

### LDAP Server

**Purpose:**
To specify the settings of the LDAP server.

**Values:**

<table>
<thead>
<tr>
<th>Server Information</th>
<th>IP Address / Host Name &amp; Port</th>
<th>Sets IP address or the host name, and the port address. The port address must be 389, 636, 3268, 3269, or between 5000 and 65535.</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP Server</td>
<td>Displays the current software information of the LDAP server.</td>
<td></td>
</tr>
</tbody>
</table>

**Optional Information**

<table>
<thead>
<tr>
<th>Search Directory Root</th>
<th>Enters the search directory root.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Credentials to Access LDAP Server</td>
<td>Select credential used to access the LDAP server.</td>
</tr>
<tr>
<td>None</td>
<td>The login credential will be set as anonymous. When using this setting, make sure that the LDAP server accepts anonymous login.</td>
</tr>
<tr>
<td>Preset</td>
<td>The preset login credential will be applied to each user.</td>
</tr>
<tr>
<td>Prompt User</td>
<td>The users are prompted to enter their login credentials.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Login Name</th>
<th>Enters the login name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>Enters the login password using 1 to 127 alphanumeric characters. If the password is left blank (NULL), you cannot log in to a server.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Enters the login password again to confirm it.</td>
</tr>
<tr>
<td>Search Time-Out</td>
<td>Select <strong>Wait LDAP Server Limit</strong> to follow the time specified by the LDAP server. Select <strong>Wait</strong> to specify the time between 5 and 120 seconds.</td>
</tr>
<tr>
<td>Search Name Order</td>
<td>Sets the search order.</td>
</tr>
<tr>
<td>Server Address Book</td>
<td>Select the check box to enable the server address book.</td>
</tr>
<tr>
<td>Server Phone Book</td>
<td>Select the check box to enable the server phone book.</td>
</tr>
</tbody>
</table>

**NOTE:** Server Address Book must be set to **On** before you can use the server address book for the Scan to Email feature.

**NOTE:** Server Phone Book must be set to **On** before you can use the server phone book for the Fax function.
**LDAP Authentication**

**Purpose:**
To specify the LDAP server authentication method.

**Values:**

<table>
<thead>
<tr>
<th>LDAP Authentication</th>
<th>Authentication Method</th>
<th>Shows the authentication method.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use Added Text String</td>
<td>Select whether to use the added text string from the list.</td>
</tr>
<tr>
<td></td>
<td>Text String Added to User Name</td>
<td>Enter the added text string.</td>
</tr>
</tbody>
</table>

**LDAP User Mapping**

**Purpose:**
To specify the settings of the LDAP user mapping.

**Values:**

<table>
<thead>
<tr>
<th>Common Name</th>
<th>Sets the attribute type of the common name set for the LDAP server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surname</td>
<td>Sets the attribute type of the surname set for the LDAP server.</td>
</tr>
<tr>
<td>Given Name</td>
<td>Sets the attribute type of the given name set for the LDAP server.</td>
</tr>
<tr>
<td>E-mail Address</td>
<td>Sets the attribute type of the e-mail address set for the LDAP server.</td>
</tr>
<tr>
<td>Fax Phone</td>
<td>Sets the attribute type of the fax phone number set for the LDAP server.</td>
</tr>
</tbody>
</table>

**SSL/TLS**

**Purpose:**
To specify the settings for the SSL/TLS encryption communication to the printer, and set/delete the certificate used for IPsec, LDAPS, or Wireless LAN.

**Values:**

<table>
<thead>
<tr>
<th>SSL/TLS</th>
<th>HTTP-SSL/TLS Communication*1</th>
<th>Select the check box to enable the HTTP-SSL/TLS Communication.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HTTP-SSL/TLS Communication Port Number</td>
<td>Sets the port number, which is not identical with that of HTTP. This must be 443 or between 8000 and 9999.</td>
</tr>
<tr>
<td></td>
<td>LDAP-SSL/TLS Communication*1</td>
<td>Select the check box to enable the LDAP, and access is established using SSL/TLS communication.</td>
</tr>
<tr>
<td></td>
<td>SMTP-SSL/TLS Communication</td>
<td>Sets the type of SSL/TLS used to communicate with the SMTP server.</td>
</tr>
<tr>
<td></td>
<td>MD5</td>
<td>Select the check box to enable the MD5.</td>
</tr>
<tr>
<td></td>
<td>Machine Digital Certificate</td>
<td>Generate Self-Signed Certificate*2</td>
</tr>
<tr>
<td></td>
<td>Certificate Signing Request (CSR)*2</td>
<td>Click to display the Certificate Signing Request (CSR) page and to create a certificate signing request from the page.</td>
</tr>
<tr>
<td></td>
<td>Upload Signed Certificate*2</td>
<td>Click to display the Upload Signed Certificate page and to upload the certificate file to the device from the page.</td>
</tr>
</tbody>
</table>
**Certificate Management**

- **Delete All Certificates**: Click to delete all the certificates.

**Generate Self-Signed Certificate**

- **Public Key Method**: Select the public key method of the self-signed certificate.
- **Size of Public Key**: Select the size of public key.
- **Issuer**: Enter the issuer of self-signed certificate.
- **Validity**: Enter the valid days from 1 to 9999 days.
- **Generate Signed Certificate**: Click to generate the self-signed certificate.

**Certificate Signing Request (CSR)**

- **Digital Signature Algorithm**: Select the digital signature algorithm.
- **Public Key Size**: Select the public key size.
- **2 Letter Country Code (Required)**: Enter the 2-letter country code.
- **State / Province Name**: Enter the state or province name up to 16 bytes.
- **Locality Name**: Enter the locality name up to 32 bytes.
- **Organization Name (Required)**: Enter the organization name up to 32 bytes.
- **Organization Unit (Required)**: Enter the organization unit up to 32 bytes.
- **Common Name**: Enter the common name.
- **E-mail Address**: Enter the e-mail address.

**Upload Signed Certificate**

- **Password**: Enter the password to upload the certificate file.
- **Re-enter Password**: Enter the password again for confirmation.
- **File Name**: Click **Browse** to browse the file name to upload to the device.
- **Import**: Click **Import** to upload the certificate file to the device.

**Certificate Management**

- **Category**: Select the device to certificate.
- **Certificate Purpose**: Select the purpose to certificate.
- **Certificate Order**: Select the order to certificate.
- **Display the List**: Click to display the **Certificate List** page.

**Certificate List**

- **Category**: Displays the device to certificate selected at the **Certificate Management** page.
- **Certificate Purpose**: Displays the connection to certificate selected at the **Certificate Management** page.
- **Issued To**: Displays the list of certificate order.
- **Validity**: Displays whether certificate is valid or not.
- **Certificate Details**: Click to display the **Certificate Details** page. The SSL/TLS page is displayed when no item in the **Issued To** column is selected.
**Certificate Details**

- **Category**: Displays the device to certificate selected at the Certificate Management page or SSL/TLS page.
- **Issued To**: Displays the device to certificate.
- **Issuer**: Displays the issuer to certificate.
- **Serial Number**: Displays the serial number of the device.
- **Public Key Method**: Displays the public key method.
- **Size of Public Key**: Displays the size of public key.
- **Valid From**: Displays the time the certificate is valid.
- **Valid Until**: Displays the time the certificate is invalid.
- **Status**: Displays whether certificate is valid or not.
- **Certificate Purpose**: Displays the purpose of certificate.
- **Certificate Selection Status**: Displays the type of device certificate you selected.
- **E-mail Address**: Displayed only when an e-mail address is specified in the certificate.
- **Use this certificate**: Click to apply this certificate to the device.
- **Delete**: Click to delete this certificate.
- **Export This Certificate**: Click to export the certificate to the other device.
- **Delete All Certificates**: Click to delete all the certificates.

*1 This item is available only when the self-signed certificate has been generated.

*2 This item is effective only when connected via SSL/TLS (https). Only the administrator is allowed to display the pages.

**IPsec**

**Purpose**: To specify the Security Architecture settings for Internet Protocol (IPsec) for encrypted communication to the printer.

**Values**:

**IPsec Settings**

- **Protocol**: Select the check box to enable the protocol.
- **IKE**: "Pre-Shared Key" is displayed for IKE.
- **Pre-Shared Key**: Sets a shared key. Up to 255 alphanumeric characters, periods, and hyphens can be used.
- **Re-enter Pre-Shared Key**: Enters the shared key again to confirm it.
- **IKE SA Lifetime**: Sets the lifetime for IKE SA from 5 to 28,800 minutes.
- **IPsec SA Lifetime**: Sets the lifetime for IPsec SA from 5 to 2,880 minutes.
- **DH Group**: Sets the DH group.
- **PFS**: Select the check box to enable the PFS setting.
- **Remote peers IPv4 address**: Sets the IP address to connect to.
- **Remote peers IPv6 address**: Sets the IP address to connect to.
- **Non IPsec communication policy**: Allows communication with a device which does not support IPsec.

**NOTE**: If IPsec is enabled with incorrect settings, you must disable it using the IPsec menu on the operator panel.
### 802.1x

**Purpose:**
To specify the settings for IEEE 802.1x authentication for encrypted communication to the printer.

**Values:**

<table>
<thead>
<tr>
<th>Configure 802.1x</th>
<th>Enable 802.1x</th>
<th>Select the check box to enable IEEE 802.1x authentication.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Method</td>
<td>EAP-MD5</td>
<td>Selects the authentication method to use for IEEE 802.1x authentication.</td>
</tr>
<tr>
<td></td>
<td>EAP-MS-CHAPv2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PEAP/MS-CHAPv2</td>
<td></td>
</tr>
<tr>
<td>Login Name: (Device Name)</td>
<td>Sets the login name (device name) for IEEE 802.1x authentication using up to 128 alphanumeric characters.</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Sets the login password for IEEE 802.1x authentication using up to 128 alphanumeric characters.</td>
<td></td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Confirms the set login password.</td>
<td></td>
</tr>
</tbody>
</table>

### IP Filter (IPv4)

**Purpose:**
To specify the IP address and subnet mask to be permitted or denied access to the printer.

**Values:**

<table>
<thead>
<tr>
<th>Access List</th>
<th>Address</th>
<th>Sets the IP addresses that are permitted or denied access to the printer. Enter a numeric value between 0 and 255 in each field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Mask</td>
<td>Sets the subnet mask that are permitted or denied access to the printer. Enter a numeric value between 0 and 255 in each field.</td>
<td></td>
</tr>
<tr>
<td>Active Mode</td>
<td>Reject</td>
<td>Rejects printing from specified network address.</td>
</tr>
<tr>
<td></td>
<td>Accept</td>
<td>Permits printing from specified network address.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the IP Filter feature for the specified IP address.</td>
</tr>
</tbody>
</table>

To configure the IP Filter feature, enter an IP address to be filtered in the Address field and the subnet mask in the Address Mask field. Enter a numeric value between 0 and 255 in each field. "*" is appended to the current value.

**IP Filter Setup Procedure**

You can set up to a maximum of five items and the first item set takes priority. When setting multiple filters, enter the shortest address first followed by a slightly longer address, a longer address and so on.

**Enabling Printing From a Specified User**

The following describes the procedure to enable printing only from the "192.0.2.1" IP address.

1. Click the first column of the Access List row 1.
2. Enter "192.0.2.1" in the Address field and "255.255.255.255" in the Address Mask field.
3. Select Accept.
4. Click Apply New Settings.
Disabling Printing From a Specified User

The following describes the procedure to disable printing only from the "192.0.2.1" IP address.

1. Click the first column of the Access List row 1.
2. Enter "192.0.2.1" in the Address field and "255.255.255.255" in the Address Mask field.
3. Select Reject.
4. Click the first column of the Access List row 2.
5. Enter "0.0.0.0" in the Address field and "0.0.0.0" in the Address Mask field.
6. Select Accept.
7. Click Apply New Settings.

Enabling and Disabling Printing from Network Addresses

You can enable printing from the "192.0" network address and disable printing from the "192.0.2" network address.

The example below describes how to enable printing from the "192.0.2.1" IP address.

1. Click the first column of the Access List row 1.
2. Enter "192.0.2.1" in the Address field and "255.255.255.255" in the Address Mask field.
3. Select Accept.
4. Click the first column of the Access List row 2.
5. Enter "192.0.2.0" in the Address field and "255.255.255.0" in the Address Mask field.
6. Select Reject.
7. Click the first column of the Access List row 3.
8. Enter "192.0.0.0" in the Address field and "255.255.0.0" in the Address Mask field.
9. Select Accept.
10. Click Apply New Settings.
**SMTP Domain Filtering**

**Purpose:**
To specify whether to restrict sending e-mails to specific domains only.

- **NOTE:** This feature does not restrict sending e-mails through the E-Mail Alert feature.

**Values:**

<table>
<thead>
<tr>
<th>SMTP Domain Filtering</th>
<th>Domain Filtering</th>
<th>Select the check box to enable Domain Filtering.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Domain List</td>
<td></td>
<td>Allows you to register up to five domains allowed for sending e-mails.</td>
</tr>
</tbody>
</table>

**Copy Printer Settings**

This menu includes the **Copy Printer Settings** and **Copy Printer Settings Report** pages.

**Copy Printer Settings**

**Purpose:**
To copy the printer settings to one or more printers on the network having the same model number.

**Copying the printer settings to the destination printer**

1. In the **IP Address** and **Password** field, type the IP address and password of the destination printer.
2. Click Copy the settings to the Host in the above list.
   - **NOTE:** The copying of printer settings will time-out within 60 seconds if no input is received.
3. Restart the destination printer and go to Dell Printer Configuration Web Tool.
4. Verify if the printer settings are copied as desired.
   - **NOTE:** This feature allows you to copy printer settings to up to 10 destination printers simultaneously. If the destination printer has different configuration fields, only the common fields will be copied.
   - **NOTE:** You cannot copy the Address Book when the destination printer has a job and is operated on the Fax/Scan/Address Book menu of the operator panel.

**Copy Printer Settings Report**

**Purpose:**
To verify if the printer settings were successfully copied to the destination printers.

- **NOTE:** The report is not accessible once the printer is restarted.

**Print Volume**

The **Print Volume** menu includes the **Print Volume** and **Dell AccessControl** pages.

**Print Volume**

**Purpose:**
To verify the number of printed pages. This page can also be displayed by clicking **Print Volume** in the left frame.

**Values:**

<table>
<thead>
<tr>
<th>Printer Page Count</th>
<th>Displays the total number of pages printed since the printer was shipped from the factory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Used</td>
<td>Displays the number of pages printed for each paper size.</td>
</tr>
</tbody>
</table>
Dell AccessControl

Purpose:
To specify which users have access to printing and to limit print volume per user.

Values:

<table>
<thead>
<tr>
<th>AccessControl Mode</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Enables to print the data with no authentication information.</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Restricts printing based on the print user information registered in the internal server.</td>
<td></td>
</tr>
</tbody>
</table>

Non Registered User
Sets whether to permit the printing of data with no authentication information. To permit the printing for non-account user, select the check box.

AccessControl Error Report
Sets whether to automatically print error-related information if printing using AccessControl results in an error.

User Registration
Click Edit User Registration to display the Edit Print User Registration page.
- To register a user, click Create to open the Print User Settings page.
- To delete a user, click Delete to open the Delete User page.
  Clicking Back returns the screen to the status prior to deleting the user.
- To confirm or change the registered user, click Confirm / Change to open the Print User Settings page.

Print User Settings
User Registration No.
Displays the user registration number. The Delete User button is displayed when the user is already registered.
User Name
Sets the user name.
Password
Sets the user password using 4 to 12 alphanumeric characters.
Re-enter password
Enter the password again to confirm it.
Upper Limit for Monochrome Print
Sets the maximum number of pages allowed for monochrome printing.
Cumulative Monochrome Page Count
Displays the cumulative number of pages printed for monochrome printing.

Address Book
The Address Book menu includes the E-Mail Address, Server Address, and Phone Book pages.

<table>
<thead>
<tr>
<th>E-Mail Address</th>
<th>E-Mail Address</th>
<th>Allows you to view, edit, or create e-mail address entries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Mail Group</td>
<td>E-Mail Group</td>
<td>Allows you to view, edit, or create e-mail group entries.</td>
</tr>
<tr>
<td>Default Setup</td>
<td>Default Setup</td>
<td>Allows you to view, edit, or set the default e-mail subject and message.</td>
</tr>
<tr>
<td>Server Address</td>
<td>Server Address</td>
<td>Allows you to view, edit, or create server address entries.</td>
</tr>
<tr>
<td>Phone Book</td>
<td>FAX Speed Dial</td>
<td>Allows you to view, edit, or create speed dial entries.</td>
</tr>
<tr>
<td></td>
<td>FAX Group</td>
<td>Allows you to view, edit, or create fax group entries.</td>
</tr>
</tbody>
</table>

*1 This item is displayed only when AccessControl Mode is On.
### E-Mail Address

The E-mail Address page includes the following subpages.

<table>
<thead>
<tr>
<th>Subpage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Mail Address</td>
<td>Allows you to view, edit, or create e-mail address entries.</td>
</tr>
<tr>
<td>E-Mail Group</td>
<td>Allows you to view, edit, or create e-mail group entries.</td>
</tr>
<tr>
<td>Default Setup</td>
<td>Allows you to view, edit, or set the default e-mail subject and message.</td>
</tr>
</tbody>
</table>

#### E-Mail Address

**Purpose:**
To view the e-mail address entries registered on the E-Mail Address page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address List to</td>
<td>Selecting each button displays a list of entries for the group of user IDs indicated on the button.</td>
</tr>
<tr>
<td>ID</td>
<td>Displays the user ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the user name. (Not in Use) is displayed when there is no registration.</td>
</tr>
<tr>
<td>Address</td>
<td>Displays the e-mail address of the user.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the entry for the selected user ID.</td>
</tr>
<tr>
<td>Confirm / Change</td>
<td>Displays a dialog box where you can edit the entry of the selected user ID.</td>
</tr>
<tr>
<td>Create</td>
<td>Displays a dialog box where you can create a new entry under the selected user ID.</td>
</tr>
</tbody>
</table>

#### E-Mail Address (Confirm/Change, Create)

**Purpose:**
To view or edit the e-mail address entries on the E-Mail Address page, or create a new entry. The following items are in the dialog box that appears when you click Confirm / Change or Create on the E-Mail Address top page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the selected user ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Allows you to view or edit the name of the user registered under the user ID, or enter a name for the new entry.</td>
</tr>
<tr>
<td>Address</td>
<td>Allows you to view or edit the e-mail address of the user, or enter an e-mail address for the new entry.</td>
</tr>
<tr>
<td>Delete</td>
<td>Allows you to view or edit the e-mail address of the user, or enter an e-mail address for the new entry.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Restore Settings</td>
<td>Click this button to restore the previous settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
</tr>
</tbody>
</table>

*1 This item is available only when you click Confirm / Change.

#### E-Mail Address (Delete)

**Purpose:**
To delete the e-mail address entries registered on the E-Mail Address page. The following items are in the dialog box that appears when you click Delete on the E-Mail Address top page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the selected user ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name of the user registered under the selected user ID.</td>
</tr>
</tbody>
</table>
**E-Mail Group**

**Purpose:**
To view the e-mail address entries registered on the E-Mail Group page.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupID</td>
<td>Displays the group ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the assigned group name. (Not in Use) is displayed when there is no registration.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the entry for the selected group ID.</td>
</tr>
<tr>
<td>Confirm / Change</td>
<td>Displays a dialog box where you can edit the entry for the selected group ID.</td>
</tr>
<tr>
<td>Create</td>
<td>Displays a dialog box where you can create a new entry under the selected group ID.</td>
</tr>
</tbody>
</table>

**E-Mail Group (Confirm/Change, Create)**

**Purpose:**
To view or edit the e-mail address group entries on the E-Mail Group page, or create a new entry. The following items are in the dialog box that appears when you click Confirm / Change or Create on the E-Mail Group top page.

**Values:**

<table>
<thead>
<tr>
<th>E-Mail Group</th>
<th>ID</th>
<th>Displays the selected group ID.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Name</td>
<td>Allows you to view or edit the name assigned for the group ID, or enter a new group name.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Click this button to delete the current entry.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail Address</th>
<th>Address List to:</th>
<th>Selecting each button displays a list of entries for the group of IDs indicated on the button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the user ID.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select the check box on the left to create the group.</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Displays the user name. (Not in Use) is displayed when there is no registration.</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>Allows you to view or edit the e-mail address of an entry registered under the selected user ID, or enter an e-mail address for the new entry.</td>
<td></td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
<td></td>
</tr>
<tr>
<td>Restore Settings</td>
<td>Click this button to restore the previous settings.</td>
<td></td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
<td></td>
</tr>
</tbody>
</table>

*1 This item is available only when you click Confirm / Change.
**E-Mail Group (Delete)**

**Purpose:**
To delete the e-mail group entries registered on the E-Mail Group page. The following items are in the dialog box that appears when you click **Delete** on the E-Mail Group top page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the selected group ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name assigned for the group ID.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
</tr>
</tbody>
</table>

**Default Setup**

**Purpose:**
To set the default e-mail subject and message.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Subject</td>
<td>Allows you to enter the default e-mail subject.</td>
</tr>
<tr>
<td>Body Text</td>
<td>Allows you to enter the default e-mail message.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Restore Settings</td>
<td>Click this button to restore the previous settings.</td>
</tr>
</tbody>
</table>

**Server Address**

**Server Address**

**Purpose:**
To view the server address entries registered on the Server Address page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address List to</td>
<td>Selecting each button displays a list of entries for the group of IDs indicated on the button.</td>
</tr>
<tr>
<td>ID</td>
<td>Displays the server ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the file directory name. (Not in Use) is displayed when there is no registration.</td>
</tr>
<tr>
<td>Server Address</td>
<td>Displays the address of the file directory.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the entry for the selected server ID.</td>
</tr>
<tr>
<td>Confirm / Change</td>
<td>Displays a dialog box where you can edit the entry for the selected server ID.</td>
</tr>
<tr>
<td>Create</td>
<td>Displays a dialog box where you can create a new entry under the selected server ID.</td>
</tr>
</tbody>
</table>

**Server Address (Confirm/Change, Create)**

**Purpose:**
To view or edit the server address entries on the Server Address page, or create a new entry. The following items are in the dialog box that appears when you click **Confirm / Change** or **Create** on the Server Address top page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the selected server ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Allows you to view or change the server name assigned to the server ID, or enter a new server name.</td>
</tr>
</tbody>
</table>
Server Type

Allows you to view the server type if you click Confirm/Change. Allows you to edit the server type if you click Create.

<table>
<thead>
<tr>
<th>FTP*1</th>
<th>Select this to store scanned documents on a server via the FTP protocol.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMB*1</td>
<td>Select this to store scanned documents on a computer via the Server Message Block (SMB) protocol.</td>
</tr>
</tbody>
</table>

Server Address

Allows you to view or edit the server address registered under the server ID, or enter a new server address.

Share Name*2

Allows you to view or edit the assigned shared name, or enter a new shared name, when Server Type is set to SMB.

Server Path

Allows you to view or edit the assigned server path, or enter a new path.

Server Port Number

Allows you to view or edit the assigned server port number, or enter a new port number. If you leave the text box blank, the default port number (FTP: 21, SMB: 139) will be used.

Login Name

Allows you to view or edit the login name that is required to access the selected protocol, or enter a new login name.

Login Password

Allows you to view or edit the password that is required to access the selected protocol, or enter a new password.

Re-enter Password

Confirms the set password.

Delete*3

Click this button to delete the current entry.

Apply New Settings

Click this button to apply the new settings.

Restore Settings

Click this button to restore the previous settings.

Back

Click this button to return to the top page.

*1 You can edit this item only when you click Create.

*2 This item is available only when Server Type is set to SMB.

*3 This item is available only when you click Confirm/Change.

Server Address (Delete)

Purpose:

To delete the server address entries registered on the Server Address page. The following items are in the dialog box that appears when you click Delete on the Server Address top page.

Values:

<table>
<thead>
<tr>
<th>ID</th>
<th>Displays the selected server ID.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name assigned for the server ID.</td>
</tr>
<tr>
<td>Server Address</td>
<td>Displays the server address registered under the server ID.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
</tr>
</tbody>
</table>

Phone Book

The Phone Book page includes the following subpages.

<table>
<thead>
<tr>
<th>FAX Speed Dial</th>
<th>Allows you to view, edit, or create speed dial entries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAX Group</td>
<td>Allows you to view, edit, or create fax group entries.</td>
</tr>
</tbody>
</table>
**FAX Speed Dial**

**Purpose:**
To view the fax number entries registered on the FAX Speed Dial page.

**Values:**

<table>
<thead>
<tr>
<th>Speed Dial List to:</th>
<th>Selecting each button displays a list of entries for the group of speed dial codes indicated on the button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed Dial</td>
<td>Displays the speed dial ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the assigned name for a speed dial ID. <em>(Not in Use)</em> is displayed when there is no registration.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Displays the speed dial code.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the entry for the selected speed dial code.</td>
</tr>
<tr>
<td>Confirm / Change</td>
<td>Displays a dialog box where you can edit the entry for the selected speed dial code.</td>
</tr>
<tr>
<td>Create</td>
<td>Displays a dialog box where you can create a new entry under the selected speed dial code.</td>
</tr>
</tbody>
</table>

**FAX Speed Dial (Confirm/Change, Create)**

**Purpose:**
To view or edit the speed dial entries on the FAX Speed Dial page, or create a new entry. The following items are in the dialog box that appears when you click Confirm / Change or Create on the FAX Speed Dial top page.

**Values:**

<table>
<thead>
<tr>
<th>Speed Dial</th>
<th>Displays the selected speed dial code.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Allows you to view or edit the name of an entry registered under the speed dial code, or enter a name for the new entry.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Allows you to view or edit the fax number of an entry registered under the speed dial code, or enter a fax number for the new entry.</td>
</tr>
<tr>
<td>Delete*1</td>
<td>Click this button to delete the entry for the speed dial code. This button is available only on the dialog box for editing an existing entry.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Restore Settings</td>
<td>Click this button to restore the previous settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
</tr>
</tbody>
</table>

*1 This item is available only when you click Confirm / Change.

**FAX Speed Dial (Delete)**

**Purpose:**
To delete the speed dial entries registered on the FAX Speed Dial page. The following items are in the dialog box that appears when you click Delete on the FAX Speed Dial top page.

**Values:**

<table>
<thead>
<tr>
<th>Speed Dial</th>
<th>Displays the selected speed dial code.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name registered under the speed dial code.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Displays the fax number registered under the speed dial code.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
</tr>
</tbody>
</table>
**FAX Group**

**Purpose:**
To view the fax group entries registered on the **FAX Group** page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays a fax group ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the assigned group name. <em>(Not in Use)</em> is displayed when there is no registration.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the entry for the selected group ID.</td>
</tr>
<tr>
<td>Confirm / Change</td>
<td>Displays a dialog box where you can edit the entry for the selected group ID.</td>
</tr>
<tr>
<td>Create</td>
<td>Displays a dialog box where you can create a new entry under the selected group ID.</td>
</tr>
</tbody>
</table>

**FAX Group (Confirm/Change, Create)**

**Purpose:**
To view or edit the fax number group entries on the **FAX Group** page, or create a new entry. The following items are in the dialog box that appears when you click **Confirm / Change** or **Create** on the **FAX Group** top page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the selected group ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Allows you to view or edit the name assigned for the group ID, or enter a new group name.</td>
</tr>
<tr>
<td>Delete *1</td>
<td>Click this button to delete the current entry.</td>
</tr>
<tr>
<td>Speed Dial List to:</td>
<td>Selecting each button displays a list of entries for the group of speed dial codes indicated on the button.</td>
</tr>
<tr>
<td>Speed Dial</td>
<td>Displays the speed dial code. Select the check box on the left to add the speed dial code in the group.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name registered for the speed dial code. <em>(Not in Use)</em> is displayed when there is no registration.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Allows you to view or edit the fax number of an entry registered under the selected speed dial code, or enter a fax number for the new entry.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Restore Settings</td>
<td>Click this button to restore the previous settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
</tr>
</tbody>
</table>

*1 This item is available only when you click **Confirm / Change**.

**FAX Group (Delete)**

**Purpose:**
To delete the fax number group entries registered on the **FAX Group** page. The following items are in the dialog box that appears when you click **Delete** on the **FAX Group** top page.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Displays the selected group ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name assigned for the group ID.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Click this button to apply the new settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Click this button to return to the top page.</td>
</tr>
</tbody>
</table>
# Tray Management

Use the **Tray Management** menu to set the paper size and type of paper loaded in tray1 and the optional 550-sheet feeder.

## Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MPF Mode</strong></td>
<td>Sets the MPF Mode.</td>
</tr>
<tr>
<td><strong>MPF Paper Size</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Sets the size of paper loaded in the MPF.</td>
</tr>
<tr>
<td><strong>MPF Paper Type</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Sets the type of paper loaded in the MPF.</td>
</tr>
<tr>
<td><strong>MPF Custom Paper Size - Y</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Sets the length of custom size paper loaded in the MPF.</td>
</tr>
<tr>
<td><strong>MPF Custom Paper Size - X</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Sets the width of custom size paper loaded in the MPF.</td>
</tr>
<tr>
<td><strong>MPF Display Tray Prompt</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Sets whether to display a popup message that prompts the user to set the paper size and type when the paper is loaded in the MPF.</td>
</tr>
<tr>
<td><strong>Tray 1 Paper Size</strong></td>
<td>Sets the size of paper loaded in tray1.</td>
</tr>
<tr>
<td><strong>Tray 1 Paper Type</strong></td>
<td>Sets the type of paper loaded in tray1.</td>
</tr>
<tr>
<td><strong>Tray 1 Custom Paper Size - Y</strong></td>
<td>Sets the length of custom size paper loaded in tray1.</td>
</tr>
<tr>
<td><strong>Tray 1 Custom Paper Size - X</strong></td>
<td>Sets the width of custom size paper loaded in tray1.</td>
</tr>
<tr>
<td><strong>Tray 1 Display Tray Prompt</strong></td>
<td>Sets whether to display a popup message that prompts the user to set the paper size and type when the paper is loaded in tray1.</td>
</tr>
<tr>
<td><strong>Tray 2 Paper Size</strong>&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Sets the size of paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td><strong>Tray 2 Paper Type</strong>&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Sets the type of paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td><strong>Tray 2 Custom Paper Size - Y</strong>&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Sets the length of custom size paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td><strong>Tray 2 Custom Paper Size - X</strong>&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Sets the width of custom size paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td><strong>Tray 2 Display Tray Prompt</strong>&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Sets whether to display a popup message that prompts the user to set the paper size and type when the paper is loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td><strong>1st Priority</strong></td>
<td>Sets the paper source to be used as the first priority.</td>
</tr>
<tr>
<td><strong>2nd Priority</strong></td>
<td>Sets the paper source to be used as the second priority.</td>
</tr>
<tr>
<td><strong>3rd Priority</strong>&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Sets the paper source to be used as the third priority.</td>
</tr>
</tbody>
</table>

<sup>1</sup> This item is available only when **Use Panel Settings** is selected in **MPF Mode**.

<sup>2</sup> This item is available only when the optional 550-sheet feeder is installed.
Understanding the Printer Menus

When your printer is connected to a network and available to a number of users, the access to the Admin Settings can be limited. This prevents other users from using the operator panel to inadvertently change a user default that has been set by the administrator.

However, you can use your printer driver to override user defaults and select settings for individual print jobs.

Report / List

Use the Report/List menu to print various types of reports and lists.

System Settings
Purpose:
To print a list of the current user default values, the installed options, the amount of installed print memory, and the status of printer supplies.

Panel Settings
Purpose:
To print a detailed list of all the settings of the printer menus.

PCL Fonts List
Purpose:
To print a sample of the available PCL fonts.

PCL Macros List
Purpose:
To print the information on the downloaded PCL macro.

PS Fonts List
Purpose:
To print a sample of the available PS fonts.

PDF Fonts List
Purpose:
To print a sample of the available PDF fonts.

Job History
Purpose:
To print a detailed list of the print, copy, fax, or scan jobs that have been processed. This list contains the last 20 jobs.

Error History
Purpose:
To print a detailed list of paper jams and fatal errors.
Print Meter
Purpose:
To print the reports for the total number of pages printed.

Demo Page
Purpose:
To print a Demo page.

Protocol Monitor
Purpose:
To print a detailed list of monitored protocols.

Speed Dial
Purpose:
To print the list of all members stored as speed dial numbers.

Address Book
Purpose:
To print the list of all addresses stored as Address Book information.

Server Address
Purpose:
To print the list of all members stored as Server Address information.

Fax Activity
Purpose:
To print the report of faxes you recently received or sent.

Fax Pending
Purpose:
To print the list of status of pending faxes.

Stored Documents
NOTE: Stored Documents feature is available only when RAM Disk under System Settings is enabled.
Purpose:
To print a list of all files stored for Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof Print in the RAM disk.
Printing a Report/List Using the Operator Panel

1. Press the (Information) button.
2. Tap Report/List.
3. Tap ▼ until the desired report or list appears, and then select that report or list.
4. Tap Print.
   The selected report or list is printed.

Printing a Report/List Using the Tool Box

1. Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.
   For Windows® 10: Click the Start button → Dell Printer Hub or Dell Printer Management Tool.
2. For Dell Printer Hub, select the printer from My Printers on the home screen.
   For Dell Printer Management Tool, select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the home screen.
3. Click the shortcut to the Tool Box on the left of the screen.
   The Tool Box opens.
4. Ensure that the Printer Setting Reports tab is open.
5. Select Reports from the list at the left side of the page.
   The Reports page appears.
6. Click the button for the desired report or list.
   The report or list is printed.

Wi-Fi | WPS

NOTE: The Wi-Fi | WPS menu is available on the Dell™ Cloud Multifunction Printer | H815dw only.
Use the Wi-Fi | WPS menu to confirm or specify wireless network settings or connections.

Wi-Fi
Use the Wi-Fi menu to confirm or specify wireless network settings.
For details, see “Wi-Fi.”

Wi-Fi Direct
Use the Wi-Fi Direct menu to confirm or specify Wi-Fi Direct network settings.
For details, see “Wi-Fi Direct.”

WPS (Connect via PBC)
Use WPS (Connect via PBC) menu to start configurations of the Wi-Fi Direct network with WPS-PBC.
For details, see “WPS Setup.”

WPS (Connect via PIN)
Use WPS (Connect via PIN) menu to start configurations of the Wi-Fi Direct network with WPS-PIN.
For details, see “WPS Setup.”
**Paired Device**

- **NOTE:** The Paired Device menu is available on the Dell Cloud Multifunction Printer | H815dw only.

Use the Paired Device menu to confirm the device name in the Paired Device list, if there is any device connected to the printer via Wi-Fi Direct.

You can disconnect the paired device from this list. For details, see "Disconnecting Wi-Fi Direct Network."

**Admin Settings**

Use the Admin Settings menu to configure a variety of printer features.

**Phone Book**

Use the Phone Book menu to configure the speed dial and group dial settings.

**Individuals**

**Purpose:**
To store up to 200 frequently dialed numbers in speed dial locations.

**Groups**

**Purpose:**
To create a group of fax destinations and register it under a two-digit dial code. Up to six group dial codes can be registered.

**PCL**

Use the PCL menu to change printer settings that only affect jobs using the PCL emulation printer language.

- **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Paper Tray**

**Purpose:**
To specify the default paper tray.

**Values:**

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong></td>
</tr>
<tr>
<td><strong>MPF</strong></td>
</tr>
<tr>
<td><strong>Tray1</strong></td>
</tr>
<tr>
<td><strong>Tray2</strong></td>
</tr>
</tbody>
</table>

* This item is available only when the optional 550-sheet feeder is installed.

**Paper Size**

**Purpose:**
To specify the default paper size.
Values:

**mm series**

<table>
<thead>
<tr>
<th>Value</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>(210x297mm)*1</td>
</tr>
<tr>
<td>A5</td>
<td>(148x210mm)</td>
</tr>
<tr>
<td>A6</td>
<td>(105x148mm)</td>
</tr>
<tr>
<td>B5</td>
<td>(182x257mm)</td>
</tr>
<tr>
<td>B6</td>
<td>(128x182mm)</td>
</tr>
<tr>
<td>Letter</td>
<td>(8.5x11&quot;)</td>
</tr>
<tr>
<td>Folio</td>
<td>(8.5x13&quot;)</td>
</tr>
<tr>
<td>Legal</td>
<td>(8.5x14&quot;)</td>
</tr>
<tr>
<td>Statement</td>
<td>(5.5x8.5&quot;)</td>
</tr>
<tr>
<td>Executive</td>
<td>(7.3x10.5&quot;)</td>
</tr>
<tr>
<td>Envelope #10</td>
<td>(4.1x9.5&quot;)</td>
</tr>
<tr>
<td>Monarch Env.</td>
<td>(3.9x7.5&quot;)</td>
</tr>
<tr>
<td>DL Env.</td>
<td>(110x220mm)</td>
</tr>
<tr>
<td>C5 Env.</td>
<td>(162x229mm)</td>
</tr>
<tr>
<td>Postcard</td>
<td>(100x148mm)</td>
</tr>
</tbody>
</table>

**Custom Paper Size**

*1 Denotes country-specific factory default value.

**inch series**

<table>
<thead>
<tr>
<th>Value</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>(8.5x11&quot;)*1</td>
</tr>
<tr>
<td>Folio</td>
<td>(8.5x13&quot;)</td>
</tr>
</tbody>
</table>
### Orientation

**Purpose:**
To specify how text and graphics are oriented on the page.

**Values:**

<table>
<thead>
<tr>
<th>Orientation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portrait</td>
<td>Prints text and graphics parallel to the short edge of the paper.</td>
</tr>
<tr>
<td>Landscape</td>
<td>Prints text and graphics parallel to the long edge of the paper.</td>
</tr>
</tbody>
</table>

### 2 Sided Print

**Purpose:**
To specify whether to print on both sides of a sheet of paper.
**Values:**

<table>
<thead>
<tr>
<th>1 Sided*</th>
<th>2 Sided</th>
<th>Flip on Long Edge*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Prints on both sides of a sheet of paper to be bound by long edge.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Print on both sides of a sheet of paper to be bound by short edge.</td>
</tr>
</tbody>
</table>

**Font**

**Purpose:**

To specify the default font from the fonts registered in the printer.

**Values:**

<table>
<thead>
<tr>
<th>Font</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG Times</td>
<td>Albertus Md</td>
</tr>
<tr>
<td>CG Times It</td>
<td>Albertus XBD</td>
</tr>
<tr>
<td>CG Times Bd</td>
<td>Clarendon Cd</td>
</tr>
<tr>
<td>CG Times BdIt</td>
<td>Coronet</td>
</tr>
<tr>
<td>Univers Md</td>
<td>Marigold</td>
</tr>
<tr>
<td>Univers MdIt</td>
<td>Arial</td>
</tr>
<tr>
<td>Univers Bd</td>
<td>Arial It</td>
</tr>
<tr>
<td>Univers BdIt</td>
<td>Arial Bd</td>
</tr>
<tr>
<td>Univers BdCd</td>
<td>Arial BdIt</td>
</tr>
<tr>
<td>Univers MdCd</td>
<td>Times New</td>
</tr>
<tr>
<td>Univers MdCdIt</td>
<td>Times New It</td>
</tr>
<tr>
<td>Univers BdCdIt</td>
<td>Times New Bd</td>
</tr>
<tr>
<td>AntiqueOlv</td>
<td>Times New BdIt</td>
</tr>
<tr>
<td>AntiqueOlv It</td>
<td>Times New Bd</td>
</tr>
<tr>
<td>CG Omega</td>
<td>Line Printer</td>
</tr>
<tr>
<td>CG Omega It</td>
<td>Times Roman</td>
</tr>
<tr>
<td>CG Omega Bd</td>
<td>Times It</td>
</tr>
<tr>
<td>CG Omega BdIt</td>
<td>Times Bd</td>
</tr>
<tr>
<td>GaramondAntiqua</td>
<td>Times BdIt</td>
</tr>
<tr>
<td>Garamond Ksv</td>
<td>Helvetica</td>
</tr>
<tr>
<td>Garamond Hlb</td>
<td>Helvetica Ob</td>
</tr>
<tr>
<td>GaramondKsvHlb</td>
<td>Helvetica Bd</td>
</tr>
<tr>
<td>Courier</td>
<td>Helvetica BdOb</td>
</tr>
<tr>
<td>Courier It</td>
<td>CourierPS</td>
</tr>
<tr>
<td>Courier Bd</td>
<td>CourierPS Ob</td>
</tr>
<tr>
<td>Courier BdIt</td>
<td>CourierPS Bd</td>
</tr>
<tr>
<td>LetterGothic</td>
<td>CourierPS BdOb</td>
</tr>
<tr>
<td>LetterGothic It</td>
<td>SymbolPS</td>
</tr>
<tr>
<td>LetterGothic Bd</td>
<td></td>
</tr>
</tbody>
</table>

---

1 Sided: Does not print on both sides of a sheet of paper.
2 Sided: Prints on both sides of a sheet of paper to be bound by long edge.
Flip on Short Edge: Prints on both sides of a sheet of paper to be bound by short edge.
Symbol Set

Purpose:
To specify a symbol set for a specified font.

Values:

<table>
<thead>
<tr>
<th>Symbol Set</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESKTOP</td>
<td>MATH-8</td>
<td>WIN 3.0</td>
</tr>
<tr>
<td>DNBTSMS</td>
<td>MS PUB</td>
<td>WINBALT</td>
</tr>
<tr>
<td>ISO-11</td>
<td>PC-1004</td>
<td>WIN L1</td>
</tr>
<tr>
<td>ISO-15</td>
<td>PC-775</td>
<td>WIN L2</td>
</tr>
<tr>
<td>ISO-17</td>
<td>PC-8</td>
<td>WIN L5</td>
</tr>
<tr>
<td>ISO-21</td>
<td>PC-850</td>
<td>PC CYR</td>
</tr>
<tr>
<td>ISO-4</td>
<td>PC-852</td>
<td>PC-866U</td>
</tr>
<tr>
<td>ISO-60</td>
<td>PC-8 DN</td>
<td>ISO CYR</td>
</tr>
<tr>
<td>ISO-69</td>
<td>PC-8 TK</td>
<td>WIN CYR</td>
</tr>
<tr>
<td>ISO L1</td>
<td>PI FONT</td>
<td>GREEK-8</td>
</tr>
<tr>
<td>ISO L2</td>
<td>PS MATH</td>
<td>WIN-GRK</td>
</tr>
<tr>
<td>ISO L5</td>
<td>PS TEXT</td>
<td>PC-851</td>
</tr>
<tr>
<td>ISO L6</td>
<td>ROMAN-8</td>
<td>PC8-GRK</td>
</tr>
<tr>
<td>LEGAL</td>
<td>SYMBOL</td>
<td>ISO-GRK</td>
</tr>
</tbody>
</table>

Font Size

Purpose:
To specify the font size for scalable typographic fonts.

Values:

<table>
<thead>
<tr>
<th>Font Size</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.00*</td>
<td>Sets the values in increments of 0.25.</td>
<td></td>
</tr>
</tbody>
</table>

Available Range: 4.00 – 50.00

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch (0.35 mm).

NOTE: The Font Size menu is only displayed for typographic fonts.

Font Pitch

Purpose:
To specify the font pitch for scalable mono spaced fonts.

Values:

<table>
<thead>
<tr>
<th>Font Pitch</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.00*</td>
<td>Sets the value in increments of 0.01.</td>
<td></td>
</tr>
</tbody>
</table>

Available Range: 6.00–24.00

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For non-scalable mono spaced fonts, the pitch is displayed, but cannot be changed.

NOTE: The Font Pitch menu is only displayed for fixed or mono spaced fonts.
Form Line
Purpose:
To set the number of lines in a page.
Values:

<table>
<thead>
<tr>
<th>mm series</th>
<th>inch series</th>
</tr>
</thead>
<tbody>
<tr>
<td>64(^1)</td>
<td>(^{1}) Denotes country-specific factory default values.</td>
</tr>
<tr>
<td>Available Range: 5–128</td>
<td></td>
</tr>
</tbody>
</table>

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and Orientation menu items. Select the correct Orientation before changing Form Line.

See also:
"Orientation"

Quantity
Purpose:
To set the default print quantity. (Set the number of copies required for a specific job from the printer driver. Values selected from the printer driver always override values selected from the operator panel.)
Values:

<table>
<thead>
<tr>
<th>Sets the value in increments of 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(^{1}) Denotes country-specific factory default values.</td>
</tr>
</tbody>
</table>

Image Enhance
Purpose:
To specify whether to enable the Image Enhance feature, which makes the boundary line between black and white smoother to decrease jagged edges and enhance the visual appearance.
Values:

| Disables the Image Enhance feature. |
| Enables the Image Enhance feature. |

\(^{1}\) Denotes country-specific factory default values.
**Hex Dump**

*Purpose:* To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in hexadecimal and character representation. Control codes are not executed.

*Values:*

<table>
<thead>
<tr>
<th>Disable</th>
<th>Enables the Hex Dump feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td></td>
</tr>
</tbody>
</table>

**Draft Mode**

*Purpose:* To save toner by printing in the draft mode. The print quality is reduced when printing in the draft mode.

*Values:*

<table>
<thead>
<tr>
<th>Disable</th>
<th>Does not print in the draft mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Prints in the draft mode.</td>
</tr>
</tbody>
</table>

**Line Termination**

*Purpose:* To add the line termination commands.

*Values:*

<table>
<thead>
<tr>
<th>Off</th>
<th>The line termination command is not added.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CR=CR, LF=LF, FF=FF</td>
</tr>
<tr>
<td>Add-LF</td>
<td>The LF command is added.</td>
</tr>
<tr>
<td></td>
<td>CR=CR-LF, LF=LF, FF=FF</td>
</tr>
<tr>
<td>Add-CR</td>
<td>The CR command is added.</td>
</tr>
<tr>
<td></td>
<td>CR=CR, LF=CR-LF, FF=CR-FF</td>
</tr>
<tr>
<td>CR-XX</td>
<td>The CR and LF commands are added.</td>
</tr>
<tr>
<td></td>
<td>CR=CR-LF, LF=CR-LF, FF=CR-FF</td>
</tr>
</tbody>
</table>

**Ignore Form Feed**

*Purpose:* To specify whether to ignore blank pages that only contain Form Feed control codes.

*Values:*

<table>
<thead>
<tr>
<th>Off</th>
<th>Enables the Ignore Form Feed feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>
**A4 Wide**

**Purpose:**
To expand the printable area width.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables A4 Wide.</td>
</tr>
<tr>
<td>On</td>
<td>Enables A4 Wide.</td>
</tr>
</tbody>
</table>

**Barcode Mode**

**Purpose:**
To specify whether to enable the barcode mode, which is suitable for barcode printing.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Disables the barcode mode.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enables the barcode mode.</td>
</tr>
</tbody>
</table>

**NOTE:** Be sure to set to **Disable** after using the barcode mode.

**PS**

Use the **PS** menu to change printer settings that only affect jobs using the PostScript 3 Compatible emulation printer language.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**PS Error Report**

**Purpose:**
To specify whether the contents of the errors concerning PostScript 3 Compatible page description language are printed.

The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Discards the print job without printing an error message.</td>
</tr>
<tr>
<td>On*</td>
<td>Prints an error message before it discards the job.</td>
</tr>
</tbody>
</table>

**NOTE:** Instructions from the **PS** driver override the settings specified on the operator panel.

**PS Job Time-out**

**Purpose:**
To specify the execution time for one PostScript 3 Compatible job. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Job time-out does not occur.</td>
</tr>
<tr>
<td>On</td>
<td>1 minute* An error concerning the PostScript 3 Compatible page description language occurs if processing is not completed after the specified time.</td>
</tr>
</tbody>
</table>

Available Range: 1-900 minutes
**Paper Select Mode**

**Purpose:**
To specify the way to select the tray for PostScript 3 Compatible mode. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>The tray is selected as the same setting as in the PCL mode.</td>
</tr>
<tr>
<td>Select From Tray</td>
<td>The tray is selected in a method compatible with regular PostScript 3 Compatible printers.</td>
</tr>
</tbody>
</table>

**PDF**

Use the PDF menu to change printer settings that only affect the PDF jobs.

⚠️ **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Quantity**

**Purpose:**
To specify the number of copies to print.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td>Sets the value in increments of 1.</td>
</tr>
</tbody>
</table>

Available Range: 1–999

**2 Sided Print**

**Purpose:**
To specify whether to print on both sides of a sheet of paper.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Sided*</td>
<td>Does not print on both sides of a sheet of paper.</td>
</tr>
<tr>
<td>2 Sided</td>
<td>Flip on Long Edge* Prints on both sides of a sheet of paper to be bound by long edge.</td>
</tr>
<tr>
<td></td>
<td>Flip on Short Edge Prints on both sides of a sheet of paper to be bound by short edge.</td>
</tr>
</tbody>
</table>

**Print Mode**

**Purpose:**
To specify the print mode.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal*</td>
<td>For documents with normal sized characters.</td>
</tr>
<tr>
<td>High Quality</td>
<td>For documents with small characters or thin lines, or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td>High Speed</td>
<td>Prints with the higher speed than the Normal mode, but the quality is less.</td>
</tr>
</tbody>
</table>
**PDF Password**

**Purpose:**
To specify the password to print a PDF file secured with a document open password (password to open the PDF file).

**Values:**

<table>
<thead>
<tr>
<th>Enter PDF Password</th>
<th>Enter the document open password to print the secure PDF</th>
</tr>
</thead>
</table>

**Collation**

**Purpose:**
To specify whether to sort the job.

**Values:**

<table>
<thead>
<tr>
<th>Collated</th>
<th>Sorts the job.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uncollated*</td>
<td>Does not sort the job.</td>
</tr>
</tbody>
</table>

**Output Size**

**Purpose:**
To specify the output paper size for PDF.

**Values:**

<table>
<thead>
<tr>
<th>A4*1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter*1</td>
<td></td>
</tr>
<tr>
<td>Auto</td>
<td></td>
</tr>
</tbody>
</table>

*1 The default paper size is displayed.

**Layout**

**Purpose:**
To specify the output layout.

**Values:**

<table>
<thead>
<tr>
<th>Auto %*</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>100% (No Zoom)</td>
<td></td>
</tr>
<tr>
<td>Booklet</td>
<td></td>
</tr>
<tr>
<td>2 Pages Up</td>
<td></td>
</tr>
<tr>
<td>4 Pages Up</td>
<td></td>
</tr>
</tbody>
</table>

**Detect Job Separator**

**Purpose:**
To specify whether to detect the end of the job in printing PDF files successively.

**Values:**

<table>
<thead>
<tr>
<th>Off</th>
<th>Disables the Detect Job Separator feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Enables the Detect Job Separator feature.</td>
</tr>
</tbody>
</table>
Network
Use the Network menu to change the printer settings affecting jobs sent to the printer through the wired or wireless network.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

### Wi-Fi

**NOTE:** The Wi-Fi feature is available on the Dell Cloud Multifunction Printer | H815dw only.

**Purpose:**
To confirm or specify wireless network settings.

**Wi-Fi**

**Purpose:**
To specify whether to enable the Wi-Fi feature.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables the Wi-Fi feature.</td>
</tr>
<tr>
<td>On</td>
<td>Enables the Wi-Fi feature.</td>
</tr>
</tbody>
</table>

**Wi-Fi Status**

**Purpose:**
To confirm the wireless communication status.

**Values:**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>Acceptable</td>
<td></td>
</tr>
<tr>
<td>Low</td>
<td></td>
</tr>
<tr>
<td>No Reception</td>
<td></td>
</tr>
</tbody>
</table>

**SSID**
Displays the name that identifies the wireless network.

**Encryption Type**
Displays the encryption type.

**Wi-Fi Setup Wizard**

**NOTE:** Wi-Fi Setup Wizard is available only when the printer is connected using the wireless network.

**Purpose:**
To configure the wireless network interface.

**Values:**

<table>
<thead>
<tr>
<th>Select access point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEP Key</td>
<td>When you select an access point using WEP as the encryption type, enter the WEP key.</td>
</tr>
<tr>
<td>Passphrase</td>
<td>When you select an access point using WPA, WPA2, or Mixed as the encryption type, enter the passphrase.</td>
</tr>
</tbody>
</table>

**Manual SSID Setup**

**Enter SSID**
Specifies a name to identify the wireless network. Up to 32 alphanumeric characters can be entered.
**WPS Setup**

**Purpose:**
To configure the wireless network using WPS.

**Values:**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Button Configuration</td>
<td>Configure the wireless settings with WPS-PBC.</td>
</tr>
<tr>
<td>PIN Code</td>
<td>Configure the wireless settings using the PIN code assigned automatically by the printer.</td>
</tr>
<tr>
<td>Print PIN Code</td>
<td>Prints the PIN code. Confirm it when entering PIN assigned to the printer into your computer.</td>
</tr>
</tbody>
</table>

**Infrastructure**
Select when you configure the wireless settings through the access point such as a wireless router.

**No Security**
Specifies No Security to configure the wireless settings without specifying an encryption type.

**Mixed mode PSK**
Select to configure the wireless settings with the encryption type of Mixed mode PSK. Mixed mode PSK automatically selects the encryption type from either WPA-PSK- TKIP, WPA-PSK-AES, or WPA2-PSK-AES.

**Passphrase**
Specifies the passphrase of alphanumeric characters from 8 to 63.

**WPA2-PSK-AES**
Select to configure the wireless settings with the encryption type of WPA2-PSK-AES.

**Passphrase**
Specifies the passphrase of alphanumeric characters from 8 to 63.
(hex: 0-9, a-f, A-F, 16 to 64 characters)

**WEP**
Specifies the WEP key to use through the wireless network. For 64bit keys, 10 hexadecimal characters can be entered. For 128bit keys, 26 hexadecimal characters can be entered.

**Transmit Key**
Specifies the transmit key from Auto*, WEP Key 1, WEP Key 2, WEP Key 3, and WEP Key 4.

**Ad-hoc**
Select to configure the wireless settings without the access point such as a wireless router.

**No Security**
Select to configure the wireless settings without specifying the encryption type from WEP.

**WEP**
Specifies the WEP key to use through the wireless network. For 64bit keys, up to 10 hexadecimal characters can be entered. For 128bit keys, up to 26 hexadecimal characters can be entered.

**Transmit Key**
Specifies the transmit key from WEP Key 1, WEP Key 2, WEP Key 3, and WEP Key 4.
**IP Mode**

**Purpose:**

To configure the IP mode.

**Values:**

<table>
<thead>
<tr>
<th>Dual Stack*</th>
<th>Uses both IPv4 and IPv6 to set the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 Mode</td>
<td>Uses IPv4 to set the IP address.</td>
</tr>
<tr>
<td>IPv6 Mode</td>
<td>Uses IPv6 to set the IP address.</td>
</tr>
</tbody>
</table>

**TCP/IP**

**Purpose:**

To configure TCP/IP settings.

**Values:**

<table>
<thead>
<tr>
<th>Get IP Address</th>
<th>AutoIP*</th>
<th>Sets the IP address automatically. The printer will first try to get the IP address from the DHCP server. If the printer cannot get the IP address, then the printer uses the link local address. A random value in the range of 169.254.0.0 to 169.254.255.255 that is not currently in use on the network is set as the IP address. The subnet mask is set as 255.255.0.0.</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTOIP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BOOTP</td>
<td>Sets the IP address using BOOTP.</td>
<td></td>
</tr>
<tr>
<td>RARP</td>
<td>Sets the IP address using RARP.</td>
<td></td>
</tr>
<tr>
<td>DHCP</td>
<td>Sets the IP address using DHCP.</td>
<td></td>
</tr>
<tr>
<td>Panel</td>
<td>Use this option when you want to set the IP address manually on the operator panel.</td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>When an IP address is being set manually, the IP is allocated to the printer using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255.</td>
<td></td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>When an IP address is being set manually, the subnet mask is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 255.255.255.255 cannot be specified as the subnet mask.</td>
<td></td>
</tr>
<tr>
<td>Gateway Address</td>
<td>When an IP address is being set manually, the gateway address is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 127 and any value in the range of 224 to 254 cannot be specified for the first octet of a gateway address.</td>
<td></td>
</tr>
</tbody>
</table>

**IPsec**

NOTE: IPsec feature is available only when **IPsec** is enabled on the Dell Printer Configuration Web Tool.

**Purpose:**

Disables IPsec.
**Reset Wi-Fi**

**Purpose:**
To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network settings are reset to their default values.

**Wi-Fi Direct**

**NOTE:** The Wi-Fi Direct feature is available on the Dell Cloud Multifunction Printer | H815dw only.

**Purpose:**
To configure the Wi-Fi Direct network settings.

**Values:**

<table>
<thead>
<tr>
<th>Wi-Fi Direct</th>
<th>Disable*</th>
<th>Disables the Wi-Fi Direct network.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enable</td>
<td>Enables the Wi-Fi Direct network.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group Role</th>
<th>Auto</th>
<th>Automatically resolves the group role for Wi-Fi Direct.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Group Owner*</td>
<td>Sets the printer as the Group Owner when using Wi-Fi Direct. Setting the printer to become the group owner makes it possible for devices to discover this printer. The SSID of the printer will be then displayed in the list of wireless networks on your Wi-Fi mobile device.</td>
</tr>
</tbody>
</table>

| Device Name | Specifies the printer name that identifies the Wi-Fi Direct network with up to 32 alphanumeric characters. Confirm it when selecting the printer name on your Wi-Fi certified device. |

<table>
<thead>
<tr>
<th>Paired Device</th>
<th>Displays the status of the Wi-Fi Direct connections between the printer and up to 3 Wi-Fi mobile devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disconnect All</td>
<td>Disconnects all the Wi-Fi Direct connections.</td>
</tr>
<tr>
<td>Disconnect now</td>
<td>Disconnects all the Wi-Fi Direct connections right now.</td>
</tr>
<tr>
<td>Disconnect and Reset Passphrase</td>
<td>Disconnects the Wi-Fi Direct connections and resets the passphrase.</td>
</tr>
</tbody>
</table>

| SSID | Displays the name that identifies the Wi-Fi Direct network. You can also specify the name with up to 32 alphanumeric characters ("DIRECTXY" cannot be changed). Confirm it when selecting the Wi-Fi Direct network name on the Wi-Fi mobile devices. |

<table>
<thead>
<tr>
<th>Passphrase</th>
<th>Displays the passphrase. Confirm it when entering the passphrase into the Wi-Fi mobile devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Passphrase</td>
<td>Prints the passphrase. Confirm it when entering the passphrase into the Wi-Fi mobile devices.</td>
</tr>
<tr>
<td>Reset Passphrase</td>
<td>Resets the passphrase.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WPS Setup</th>
<th>Configures the Wi-Fi Direct network using WPS.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Button Configuration*</td>
<td>Configures the Wi-Fi Direct network with WPS-PBC.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PIN Code</th>
<th>Configures the Wi-Fi Direct network using PIN code assigned automatically by the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print PIN Code</td>
<td>Prints the PIN code. Confirm it when entering PIN assigned to the printer into your Wi-Fi mobile device.</td>
</tr>
<tr>
<td>Reset Code</td>
<td>Resets the PIN code.</td>
</tr>
</tbody>
</table>
Ethernet

NOTE: When the Ethernet cable is connected, Ethernet is displayed.

Purpose:
To confirm or specify wired network settings.

**IP Mode**

Purpose:
To configure the IP mode.

Values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dual Stack</td>
<td>Uses both IPv4 and IPv6 to set the IP address.</td>
</tr>
<tr>
<td>IPv4 Mode</td>
<td>Uses IPv4 to set the IP address.</td>
</tr>
<tr>
<td>IPv6 Mode</td>
<td>Uses IPv6 to set the IP address.</td>
</tr>
</tbody>
</table>

**TCP/IP**

Purpose:
To configure TCP/IP settings.

Values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get IP Address</td>
<td>AutoIP uses the IP address from the DHCP server. If the printer cannot get the IP address, then the printer uses the link local address. A random value in the range of 169.254.0.0 to 169.254.255.255 that is not currently in use on the network is set as the IP address. The subnet mask is set as 255.255.0.0.</td>
</tr>
<tr>
<td></td>
<td>BOOTP sets the IP address using BOOTP.</td>
</tr>
<tr>
<td></td>
<td>RARP sets the IP address using RARP.</td>
</tr>
<tr>
<td></td>
<td>DHCP sets the IP address using DHCP.</td>
</tr>
<tr>
<td></td>
<td>Panel use this option when you want to set the IP address manually on the operator panel.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>When an IP address is being set manually, the IP is allocated to the printer using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>When an IP address is being set manually, the subnet mask is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 255.255.255.255 cannot be specified as the subnet mask.</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>When an IP address is being set manually, the gateway address is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 127 and any value in the range of 224 to 254 cannot be specified for the first octet of a gateway address.</td>
</tr>
</tbody>
</table>

**IPsec**

NOTE: IPsec feature is available only when IPsec is enabled on the Dell Printer Configuration Web Tool.

Purpose:
Disables IPsec.
**Connection Speed**

NOTE: Connection Speed feature is available only when the printer is connected using the wired network.

**Purpose:**
To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Speed</td>
<td>Auto*</td>
<td>Detects the Ethernet settings automatically.</td>
</tr>
<tr>
<td>10BASE-T Half</td>
<td>Disable</td>
<td>Uses 10BASE-T Half-duplex.</td>
</tr>
<tr>
<td>10BASE-T Full</td>
<td>Enable*</td>
<td>Uses 10BASE-T Full-duplex.</td>
</tr>
<tr>
<td>100BASE-TX Half</td>
<td>Disable</td>
<td>Uses 100BASE-TX Half-duplex.</td>
</tr>
<tr>
<td>100BASE-TX Full</td>
<td>Enable*</td>
<td>Uses 100BASE-TX Full-duplex.</td>
</tr>
<tr>
<td>1000BASE-T Full</td>
<td>Disable</td>
<td>Uses 1000BASE-T Full-duplex.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td></td>
</tr>
</tbody>
</table>

**Protocols**

**Purpose:**
To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPD</td>
<td>Disable</td>
<td>Disables the Line Printer Daemon (LPD) port.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables the Line Printer Daemon (LPD) port.</td>
</tr>
<tr>
<td>Port9100</td>
<td>Disable</td>
<td>Disables the Port9100 port.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables the Port9100 port.</td>
</tr>
<tr>
<td>FTP</td>
<td>Disable</td>
<td>Disables FTP port.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables FTP port.</td>
</tr>
<tr>
<td>IPP</td>
<td>Disable</td>
<td>Disables IPP port.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables IPP port.</td>
</tr>
<tr>
<td>SMB TCP/IP</td>
<td>Disable</td>
<td>Disables SMB TCP/IP port.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables SMB TCP/IP port.</td>
</tr>
<tr>
<td>WSD Print</td>
<td>Disable</td>
<td>Disables Web Services on Devices (WSD) print.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables Web Services on Devices (WSD) print.</td>
</tr>
<tr>
<td>WSD Scan</td>
<td>Disable</td>
<td>Disables Web Services on Devices (WSD) scan.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables Web Services on Devices (WSD) scan.</td>
</tr>
<tr>
<td>Network TWAIN</td>
<td>Disable</td>
<td>Disables Network TWAIN.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables Network TWAIN.</td>
</tr>
<tr>
<td>SNMP UDP</td>
<td>Disable</td>
<td>Disables the Simple Network Management Protocol (SNMP) UDP port.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables the Simple Network Management Protocol (SNMP) UDP port.</td>
</tr>
<tr>
<td>E-mail Alert</td>
<td>Disable</td>
<td>Disables the E-mail Alert feature.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables the E-mail Alert feature.</td>
</tr>
<tr>
<td>Dell Printer Configuration Web Tool</td>
<td>Disable</td>
<td>Disables an access to Dell Printer Configuration Web Tool embedded in the printer.</td>
</tr>
<tr>
<td></td>
<td>Enable*</td>
<td>Enables an access to Dell Printer Configuration Web Tool embedded in the printer.</td>
</tr>
</tbody>
</table>
### Advanced Settings

**Purpose:**
To specify advanced network settings.

### IP Filter

*NOTE:* IP Filter feature is available only for LPD or Port9100.

**Purpose:**
To block data received from certain IP addresses through the wired or wireless network. You can set up to five IP addresses. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>n (n is 1-5)</th>
<th>IP Address</th>
<th>Sets the IP address for Filter n.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subnet Mask</td>
<td>Sets the address mask for Filter n.</td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td>Off*</td>
<td>Disables the IP Filter feature for Filter n.</td>
</tr>
<tr>
<td></td>
<td>Accept</td>
<td>Accepts an access from the specified IP address.</td>
</tr>
<tr>
<td></td>
<td>Reject</td>
<td>Rejects an access from the specified IP address.</td>
</tr>
</tbody>
</table>

### IEEE 802.1x

*NOTE:* IEEE 802.1x feature is available only when the printer is connected using Ethernet cable and it is available only when the IEEE 802.1x authentication is enabled.

**Purpose:**
To disable IEEE 802.1x authentication. The change becomes effective after the printer is turned off and then on again.
**PS Data Format**

**Purpose:**
To specify PostScript 3 Compatible communication protocol, you can configure the PS Data Format settings. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Used when auto-detecting the PostScript 3 Compatible communication protocol.</td>
</tr>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required for data.</td>
</tr>
</tbody>
</table>

**Reset LAN**

**Purpose:**
To initialize wired network data stored in non-volatile memory (NVM). After executing this function and rebooting the printer, all wired network settings are reset to their default values.

**Delete All Certificates**

**Purpose:**
To delete all certificates of the printer. After executing this function and rebooting the printer, all certificates are deleted.

**Fax Settings**

Use the Fax Settings menu to configure the basic fax settings.

- **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Fax Line Settings**

**Purpose:**
To configure basic settings for the fax line.

**Fax Number**

**Purpose:**
To set the fax number of the printer, which will be printed on the header of a fax message.

- **NOTE:** Ensure to specify Fax Number before using Junk Fax Setup.
**Country**

**Purpose:**
To select the country where the printer is used.

**Values:**

<table>
<thead>
<tr>
<th>Country</th>
<th>Italy</th>
<th>Singapore</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>Japan*</td>
<td>South Africa</td>
</tr>
<tr>
<td>Belgium</td>
<td>Luxembourg</td>
<td>Spain</td>
</tr>
<tr>
<td>Canada</td>
<td>Malaysia</td>
<td>Sweden</td>
</tr>
<tr>
<td>Colombia</td>
<td>Mexico</td>
<td>Switzerland</td>
</tr>
<tr>
<td>Denmark</td>
<td>Netherlands</td>
<td>Thailand</td>
</tr>
<tr>
<td>France</td>
<td>New Zealand</td>
<td>Turkey*</td>
</tr>
<tr>
<td>Germany</td>
<td>Norway</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>Greece*</td>
<td>Poland*</td>
<td>United States</td>
</tr>
<tr>
<td>Iceland*</td>
<td>Portugal*</td>
<td>Unknown</td>
</tr>
<tr>
<td>Ireland</td>
<td>Saudi Arabia*</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available on the Dell Smart Multifunction Printer | S2815dn only.

**Fax Header Name**

**Purpose:**
To set the sender name to be printed on the header on faxes.

**Line Type**

**Purpose:**
To select the default line type.

**Values:**

<table>
<thead>
<tr>
<th>Line Type</th>
<th>Uses PSTN.</th>
<th>Uses PBX.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSTN*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PBX</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Line Monitor**

**Purpose:**
To set the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a connection is made.

**Values:**

<table>
<thead>
<tr>
<th>Volume</th>
<th>Uses</th>
<th>Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medium*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**DRPD Pattern**

**Purpose:**
To provide a separate number for faxing with a distinctive ring pattern.

**Values:**

<table>
<thead>
<tr>
<th>Pattern 1–7</th>
<th>DRPD is a service provided by some telephone companies. DRPD Patterns are specified by your telephone company. The patterns provided with your printer are shown below:</th>
</tr>
</thead>
</table>

- **Pattern 1**
- **Pattern 2**
- **Pattern 3**
- **Pattern 4**
- **Pattern 5**
- **Pattern 6**
- **Pattern 7**

Ask your telephone company which pattern you need to select to use this service. For example, Pattern 7 is the New Zealand FaxAbility distinctive ringing pattern: rings for 400 ms, stops for 800 ms, rings for 400 ms and stops for 1400 ms. This pattern is repeated over and over again. This printer only responds to Distinctive Alert cadence(s) DA4 in New Zealand.

**Incoming Defaults**

**Purpose:**
To configure settings for incoming fax.
**Receive Mode**

**Purpose:**
To select the default fax receiving mode.

**Values:**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Telephone</strong></td>
<td>Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external telephone and then pressing Manual Receive in On Hook and then tapping Receive. For details about Manual Receive, see &quot;Receiving a Fax Manually in the Telephone Mode.&quot;</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td>Automatically receives faxes.</td>
</tr>
<tr>
<td><strong>Telephone / Fax</strong></td>
<td>When the printer receives an incoming fax, the external telephone rings for the time specified in Auto Receive Tel/Fax, and then the printer automatically receives a fax. If an incoming call is not a fax, the printer beeps from the internal speaker indicating that the call is a telephone call.</td>
</tr>
<tr>
<td><strong>Ans Machine/Fax</strong></td>
<td>The printer can share a telephone line with an answering machine. In this mode, the printer will monitor the fax signal and pick up the line if there are fax tones. If the phone communication in your country is serial, this mode is not supported.</td>
</tr>
<tr>
<td><strong>DRPD</strong></td>
<td>Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.</td>
</tr>
</tbody>
</table>

**Ring Tone Volume**

**Purpose:**
To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker when Receive Mode is set to Telephone/Fax.

**Values:**

<table>
<thead>
<tr>
<th>Volume</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Turns off the volume of the ring tone.</td>
</tr>
<tr>
<td>Low</td>
<td>Sets the volume of the ring tone to Low.</td>
</tr>
<tr>
<td>Medium</td>
<td>Sets the volume of the ring tone to Medium.</td>
</tr>
<tr>
<td>High*</td>
<td>Sets the volume of the ring tone to High.</td>
</tr>
</tbody>
</table>

**Auto Receive Setup**

**Purpose:**
To configure settings for automatic fax reception.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto Receive Fax</strong></td>
<td>0 seconds* Sets the interval at which the printer goes into the fax receive mode after receiving an incoming call. The value is set in increments of 1 second.</td>
</tr>
<tr>
<td><strong>Auto Receive Tel/Fax</strong></td>
<td>6 seconds* Sets the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming call. The value is set in increments of 1 second.</td>
</tr>
</tbody>
</table>

*Available Range: 0-255 seconds
### Junk Fax Setup

**Purpose:**
To reject unwanted faxes by accepting faxes only from the fax numbers registered in the Phone Book.

**Values:**
- **Off**
  - Does not reject faxes sent from unwanted numbers.
- **On**
  - Rejects faxes sent from unwanted numbers.

### Secure Receive

**NOTE:** Secure Receive feature is available only when Panel Lock Control is set to Enable.

**Purpose:**
Allows you to password protect all the incoming faxes, and to set or change the password.

When the Secure Receive feature is enabled, the printer stores incoming faxes and prints them when the correct password is entered on the operator panel.

**Values:**
- **Secure Receive Set**
  - **Disable**
    - Does not require a password to print stored incoming faxes.
  - **Enable**
    - Requires a password to print stored incoming faxes.
- **Change Password**
  - **0000-9999**
    - Sets or changes the password required to print stored incoming faxes.

**NOTE:** This item is available only when Secure Receive Set is set to Enable.

### Received Fax Forward

**NOTE:** Forward to Email feature is available only when E-Mail Server information and Forwarding E-mail Address are registered. For information on e-mail server settings, see “E-Mail Server” and on forwarding e-mail address information, see “Fax Settings.”

**Purpose:**
To set whether to forward incoming faxes to a specified destination.

**Values:**
- **Off**
  - Does not forward incoming faxes.
- **Forward**
  - Forwards incoming faxes to a specified destination. Prints incoming faxes if an error occurs during the transfer.
  - **Forwarding Number**
    - Specifies the fax number of the destination to which incoming faxes will be forwarded.
- **Print and Forward**
  - Prints incoming faxes and also forwards them to a specified destination.
  - **Forwarding Number**
    - Specifies the fax number of the destination to which incoming faxes will be forwarded.
- **Forward to Email**
  - Forwards incoming faxes to specified e-mail addresses. Prints incoming faxes if an error occurs during the transfer.
NOTE: Depending on the e-mail server settings, the printer may not print incoming faxes when forwarding the incoming faxes to e-mail addresses is not successful.

2 Sided Print
To set the duplex printing for fax.
Values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not perform duplex printing.</td>
</tr>
<tr>
<td>On</td>
<td>Performs duplex printing.</td>
</tr>
</tbody>
</table>

Remote Receive
Purpose:
To receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the telephone.
Values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not receive a fax by pressing a remote receive code on the external telephone.</td>
</tr>
<tr>
<td>On</td>
<td>Receives a fax by pressing a remote receive code on the external telephone.</td>
</tr>
</tbody>
</table>

Discard Size
Purpose:
To set the printer to discard images or any text at the bottom of a fax page when the entire page does not fit the output paper.
Values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Prints excess images or text at the bottom of a fax page without discarding it.</td>
</tr>
<tr>
<td>On</td>
<td>Discards any excess images or text.</td>
</tr>
<tr>
<td>Auto Reduction</td>
<td>Automatically reduces a fax page to fit it onto the appropriate paper size.</td>
</tr>
</tbody>
</table>

Transmission Defaults
Purpose:
To configure settings for transmitting fax.
Auto Redial Setup
Purpose:
To configure settings for automatic redial.
Values:

<table>
<thead>
<tr>
<th>Redial Attempts</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3 *</td>
<td>Sets the number of redial attempts to make when the destination fax number is busy. If you enter 0, the printer will not redial. The value is set in increments of 1.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interval of Redial</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 minute *</td>
<td>Sets the interval between redial attempts. The value is set in increments of 1 minute.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resend Delay</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8 seconds *</td>
<td>Sets the interval between re-send attempts. The value is set in increments of 1 second.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tone / Pulse</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tone *</td>
<td>Uses tone dialing.</td>
<td></td>
</tr>
<tr>
<td>Pulse(10PPS)</td>
<td>Sets &quot;DP (10PPS)&quot; (Dial Pulse, 10 Pulse Per Second) as the dial type.</td>
<td></td>
</tr>
<tr>
<td>Pulse(20PPS)</td>
<td>Sets &quot;DP (20PPS)&quot; (Dial Pulse, 20 Pulse Per Second) as the dial type.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prefix Dial</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off *</td>
<td>Does not set a prefix dial number.</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Sets a prefix dial number.</td>
<td></td>
</tr>
<tr>
<td>Prefix Dial Number</td>
<td>Sets a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful for accessing the Private Automatic Branch Exchange (PABX).</td>
<td></td>
</tr>
</tbody>
</table>

Fax Cover Page
Purpose:
To set whether to attach a cover page to faxes.
Values:

<table>
<thead>
<tr>
<th>Fax Cover Page</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off *</td>
<td>Does not attach a cover page to faxes.</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Attaches a cover page to faxes.</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: This setting affects the setting of the direct fax driver, and the default setting of the fax function when the Fax tile is added on the Home screen.
Fax Header
Purpose:
To print the information of the sender on the header of the faxes.
Values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not print the sender's information on the header of faxes.</td>
</tr>
<tr>
<td>On*</td>
<td>Prints the sender's information on the header of faxes.</td>
</tr>
</tbody>
</table>

**NOTE:** If United States is selected for the setting of Country, this option does not appear on the menu. The setting is fixed to On and cannot be changed. For information on the country setting, see “Setting Your Country.”

ECM
Purpose:
To set whether to enable or disable the Error Correction Mode (ECM). To use the ECM, the remote machines must also support the ECM.
Values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables the ECM.</td>
</tr>
<tr>
<td>On*</td>
<td>Enables the ECM.</td>
</tr>
</tbody>
</table>

Modem Speed
Purpose:
To adjust the fax modem speed when a fax transmission or reception error occurs.
Values:

<table>
<thead>
<tr>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.4 Kbps</td>
</tr>
<tr>
<td>4.8 Kbps</td>
</tr>
<tr>
<td>9.6 Kbps</td>
</tr>
<tr>
<td>14.4 Kbps</td>
</tr>
<tr>
<td>33.6 Kbps*</td>
</tr>
</tbody>
</table>

Display Manual Fax Recipients
Purpose:
To set whether to display the fax number of the recipient on the Sending Fax screen when manually sending a fax.
Values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not display the fax number when manually sending a fax.</td>
</tr>
<tr>
<td>On</td>
<td>Displays the fax number when manually sending a fax.</td>
</tr>
</tbody>
</table>

Fax Reports
Purpose:
To configure settings for fax reports.
**Fax Activity**

**Purpose:**
To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Print*</td>
<td>Automatically prints a fax activity report after every 50 incoming and outgoing fax communications.</td>
</tr>
<tr>
<td>No Auto Print</td>
<td>Does not automatically print a fax activity report after every 50 incoming and outgoing fax communications.</td>
</tr>
</tbody>
</table>

**Fax Transmit**

**Purpose:**
To set whether to print a transmission result after a fax transmission.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Always</td>
<td>Prints a transmission report after every fax transmission.</td>
</tr>
<tr>
<td>Print On Error*</td>
<td>Prints a transmission report only when an error occurs.</td>
</tr>
<tr>
<td>Print Disable</td>
<td>Does not print a transmission report after a fax transmission.</td>
</tr>
</tbody>
</table>

**Fax Broadcast**

**Purpose:**
To set whether to print a transmission result after a fax transmission to multiple destinations.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Always*</td>
<td>Prints a transmission report after every fax transmission.</td>
</tr>
<tr>
<td>Print On Error</td>
<td>Prints a transmission report only when an error occurs.</td>
</tr>
<tr>
<td>Print Disable</td>
<td>Does not print a transmission report after a fax transmission to multiple destinations.</td>
</tr>
</tbody>
</table>

**Fax Protocol**

**Purpose:**
To set whether to print the protocol monitor report, which helps you identify the cause of a communication problem.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Always</td>
<td>Prints a protocol monitor report after every fax transmission.</td>
</tr>
<tr>
<td>Print On Error</td>
<td>Prints the protocol monitor report only when an error occurs.</td>
</tr>
<tr>
<td>Print Disable*</td>
<td>Does not print the protocol monitor report.</td>
</tr>
</tbody>
</table>

**System Settings**

Use **System Settings** to configure the power saving mode, warning tones, time-out duration, display language, and job log auto print settings.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**General**

**Purpose:**
To configure general settings for the printer.
**Power Saver Timer**

Purpose:
To specify the time for transition to power saver mode.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sleep</strong></td>
<td>7 minutes²</td>
<td>Specifies the time taken by the printer to enter Sleep mode after it finishes a job.</td>
</tr>
<tr>
<td></td>
<td>Available Range: 1–60 minutes</td>
<td></td>
</tr>
<tr>
<td><strong>Deep Sleep</strong></td>
<td>8 minutes²</td>
<td>Specifies the time taken by the printer to enter Deep Sleep mode after it has entered Sleep mode.</td>
</tr>
<tr>
<td></td>
<td>Available Range: 1–60 minutes</td>
<td></td>
</tr>
</tbody>
</table>

When you specify 1 minute for **Sleep**, the printer enters power saver mode 1 minute after it finishes a job. This uses much less energy, but requires more warm-up time for the printer. Specify 1 minute if your printer shares an electrical circuit with room lighting and you notice lights flickering.

Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate with minimum warm-up time.

Select a medium value if you want a balance between energy consumption and a shorter warm-up period.

The printer automatically returns to the standby mode from the power saver mode when it receives data from the computer or remote fax machine. You can also change the status of the printer to the standby mode by pressing the < Power Saver > button on the operator panel.

**Date & Time**

Purpose:
To specify the date and time formats.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time Zone</strong></td>
<td>Sets the time zone.</td>
<td></td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Sets the date depending on the Format settings.</td>
<td></td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>Sets the date format.</td>
<td></td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Sets the time.</td>
<td></td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>12 Hour</td>
<td>Sets the time in 12-hour format.</td>
</tr>
<tr>
<td></td>
<td>24 Hour</td>
<td>Sets the time in 24-hour format.</td>
</tr>
</tbody>
</table>

**mm / inch**

Purpose:
To specify the default measurement unit displayed after the numeric value on the operator panel.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Millimeters(mm)</strong></td>
<td>Selects millimeter as the default measurement unit.</td>
<td></td>
</tr>
<tr>
<td><strong>Inches(”)</strong></td>
<td>Selects inch as the default measurement unit.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** The default for mm/inch varies depending on other settings, such as Country and Document Size.
**Screen Brightness**

**Purpose:**
To adjust the screen brightness of the touch panel.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5^*</td>
<td>Sets the brightness in ten levels, with ten being the brightest.</td>
</tr>
</tbody>
</table>

Available Range: 1-10

---

**Audio Tone**

**Purpose:**
To configure settings for tones emitted by the printer during operation or when a warning message appears.

**Values:**

<table>
<thead>
<tr>
<th>Control Panel</th>
<th>Off^*</th>
<th>Soft</th>
<th>Normal</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Does not emit a tone when the operator panel input is correct.</td>
<td>Emits a tone when the operator panel input is correct.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Invalid Key</th>
<th>Off^*</th>
<th>Soft</th>
<th>Normal</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Does not emit a tone when the operator panel input is incorrect.</td>
<td>Emits a tone when the operator panel input is incorrect.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Machine Ready</th>
<th>Off</th>
<th>Soft</th>
<th>Normal^*</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Does not emit a tone when the printer is ready to process a job.</td>
<td>Emits a tone when the printer is ready to process a job.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Copy Completed</th>
<th>Off</th>
<th>Soft</th>
<th>Normal^*</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Does not emit a tone when a copy job is complete.</td>
<td>Emits a tone when a copy job is complete.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Job Completed</th>
<th>Off</th>
<th>Soft</th>
<th>Normal^*</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Does not emit a tone when a job other than a copy job is complete.</td>
<td>Emits a tone when a job other than a copy job is complete.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fault Tone</th>
<th>Off</th>
<th>Soft</th>
<th>Normal^*</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Does not emit a tone when a job ends abnormally.</td>
<td>Emits a tone when a job ends abnormally.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Alert Tone</th>
<th>Off</th>
<th>Soft</th>
<th>Normal^*</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Does not emit a tone when a problem occurs.</td>
<td>Emits a tone when a problem occurs.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Understanding the Printer Menus

#### Low Toner Alert Message
**Purpose:**
To specify whether to show the alert message when the toner is low.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not show the alert message when the toner is low.</td>
</tr>
<tr>
<td>On</td>
<td>Shows the alert message when the toner is low.</td>
</tr>
</tbody>
</table>

#### OffHook Wake Up
**Purpose:**
To specify whether to wake up from Sleep or Deep Sleep mode when you pick up the handset of the external telephone.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not wake up from Sleep or Deep Sleep mode when you pick up the handset of the external telephone.</td>
</tr>
<tr>
<td>On</td>
<td>Wakes up from Sleep or Deep Sleep mode when you pick up the handset of the external telephone.</td>
</tr>
</tbody>
</table>

---

#### Out of Paper
**Value:**
Off
- Does not emit a tone when the printer runs out of paper.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft</td>
<td>Emits a tone when the printer runs out of paper.</td>
</tr>
<tr>
<td>Normal*</td>
<td></td>
</tr>
<tr>
<td>Loud</td>
<td></td>
</tr>
</tbody>
</table>

#### Low Toner Alert
**Value:**
Off
- Does not emit a tone when the toner is low.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft</td>
<td>Emits a tone when the toner is low.</td>
</tr>
<tr>
<td>Normal*</td>
<td></td>
</tr>
<tr>
<td>Loud</td>
<td></td>
</tr>
</tbody>
</table>

#### Auto Clear Alert
**Value:**
Off
- Does not emit a tone 5 seconds before the printer performs auto clear.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft</td>
<td>Emits a tone 5 seconds before the printer performs auto clear.</td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Loud</td>
<td></td>
</tr>
</tbody>
</table>

#### NFC Authentication*1
**Value:**
Off
- Does not emit a tone when an NFC card is placed on the NFC reader for authentication.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft</td>
<td>Emits a tone when an NFC card is placed on the NFC reader for authentication.</td>
</tr>
<tr>
<td>Normal*</td>
<td></td>
</tr>
<tr>
<td>Loud</td>
<td></td>
</tr>
</tbody>
</table>

#### All Tones
**Value:**
Off
- Disables all the alert tones.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft</td>
<td>Sets the volume of all the alert tones at once.</td>
</tr>
<tr>
<td>Normal*</td>
<td></td>
</tr>
<tr>
<td>Loud</td>
<td></td>
</tr>
</tbody>
</table>

---

*1 This item is available only on the Dell Cloud Multifunction Printer | H815dw.
**Auto Log Print**  
**Purpose:**
To automatically print a job history report after every 20 jobs.  
**Values:**  
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not automatically print a job history report.</td>
</tr>
<tr>
<td>On</td>
<td>Automatically prints a job history report.</td>
</tr>
</tbody>
</table>

Print logs can also be printed using the Report/List menu.

**RAM Disk**  
**Purpose:**
To allocate memory to the RAM disk file system for the Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof Print features. The change becomes effective after the printer is turned off and then on again.  
**Values:**  
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not allocate memory to the RAM disk file system. Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof Print jobs will abort and be recorded to the job log.</td>
</tr>
</tbody>
</table>
| On*     | Sets the allocation of memory to the RAM disk file system in increments of 20 MB.  

Available Range:  
20-300 MB |

**NOTE:** Restart your printer when you change the settings for the RAM Disk menu.

**Fax Server Phone Book**  
**Purpose:**
To specify whether to search the phone numbers from the phone book for the LDAP server.  
**Values:**  
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not search the phone numbers from the phone book for the LDAP server.</td>
</tr>
<tr>
<td>On</td>
<td>Searches the phone numbers from the phone book for the LDAP server.</td>
</tr>
</tbody>
</table>

**NOTE:** You can search the phone numbers only from the local Phone Book when Fax Server Phone Book is set to Off.

**E-mail Server Address Book**  
**Purpose:**
To specify whether to search the e-mail addresses from the address book for the LDAP server.  
**Values:**  
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not search the e-mail addresses from the address book for the LDAP server.</td>
</tr>
<tr>
<td>On</td>
<td>Searches the e-mail addresses from the address book for the LDAP server.</td>
</tr>
</tbody>
</table>

**NOTE:** You can search the e-mail addresses only from the local Address Book when E-mail Server Address Book is set to Off.
**Power On Wizard**

**Purpose:**
To perform initial setup for the printer.

**Max E-mail Size**

**Purpose:**
To specify the maximum size of e-mail that can be sent.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4096 KB</td>
<td>Sets the maximum size of e-mail that can be sent, in increments of 1 KB.</td>
</tr>
</tbody>
</table>

**Available Range:**
50-16384 KB

**Timers**

**Purpose:**
To configure timer settings.

**Auto Reset**

**Purpose:**
To automatically reset the settings for Copy, Scan, Fax, E-mail, or Print to the default settings and return to the standby mode after you do not specify any settings for the specified time.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables the fault time-out.</td>
</tr>
<tr>
<td>On</td>
<td>60 seconds</td>
</tr>
</tbody>
</table>

**Available Range:**
3-300 seconds

**Fault Time-out**

**Output Settings**

**Purpose:**
To configure settings concerning output from the printer.
**Default Paper Size**

*Purpose:* To specify the default paper size.

*Values:*

<table>
<thead>
<tr>
<th>mm series</th>
<th>inch series</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210x297mm)</td>
<td>A4 (210x297mm)</td>
</tr>
<tr>
<td>Letter (8.5x11&quot;)</td>
<td>Letter (8.5x11&quot;)</td>
</tr>
<tr>
<td><strong>(^*) Denotes country-specific factory default values.</strong></td>
<td><strong>(^*) Denotes country-specific factory default values.</strong></td>
</tr>
</tbody>
</table>


**Print ID**

*Purpose:* To specify a location where the user ID is printed.

*Values:*

<table>
<thead>
<tr>
<th>Off</th>
<th>Does not print the user ID.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Left</td>
<td>Prints the user ID on the top left of the page.</td>
</tr>
<tr>
<td>Top Right</td>
<td>Prints the user ID on the top right of the page.</td>
</tr>
<tr>
<td>Bottom Left</td>
<td>Prints the user ID on the bottom left of the page.</td>
</tr>
<tr>
<td>Bottom Right</td>
<td>Prints the user ID on the bottom right of the page.</td>
</tr>
</tbody>
</table>

⚠️ **NOTE:** When printing on DL size paper, a part of the user ID may not be printed correctly.

**Print Text**

*Purpose:* To specify whether the printer outputs PDL (Page Description Language) data, which is not supported by the printer, as text when the printer receives it. Text data is printed on A4 or Letter size paper.

*Values:*

<table>
<thead>
<tr>
<th>Off</th>
<th>Does not print the received data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Prints the received data as text data.</td>
</tr>
</tbody>
</table>
**Banner Sheet**

**Purpose:**
To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded.

**Values:**

<table>
<thead>
<tr>
<th>Insert Position</th>
<th>Off</th>
<th>Does not print the banner sheet.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front</td>
<td></td>
<td>Inserted before the first page of every copy.</td>
</tr>
<tr>
<td>Back</td>
<td></td>
<td>Inserted after the last page of every copy.</td>
</tr>
<tr>
<td>Front &amp; Back</td>
<td></td>
<td>Inserted before the first page of every copy and after the last page of every copy.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Specify Tray</th>
<th>MPF</th>
<th>The banner sheet is loaded in the MPF.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray1*</td>
<td></td>
<td>The banner sheet is loaded in tray1.</td>
</tr>
<tr>
<td>Tray2*1</td>
<td></td>
<td>The banner sheet is loaded in the optional 550-sheet feeder.</td>
</tr>
</tbody>
</table>

*1 This item is available only when the optional 550-sheet feeder is installed.

**Substitute Tray**

**Purpose:**
Specifies whether to use paper of a different size when the paper that is loaded in the specified tray does not match the paper size settings for the current job.

**Values:**

<table>
<thead>
<tr>
<th>Off</th>
<th>No tray size substitute accepted.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Larger Size</td>
<td>Substitutes paper of next largest size. When there is no larger paper size, the printer substitutes paper of nearest size.</td>
</tr>
<tr>
<td>Nearest Size*</td>
<td>Substitutes paper of nearest size.</td>
</tr>
<tr>
<td>Use MPF</td>
<td>Substitutes paper from the MPF.</td>
</tr>
</tbody>
</table>

**Letterhead 2 Sided**

**Purpose:**
To specify whether to print on both sides when using letterhead.

**Values:**

| Disable* | Does not print on both sides of letterhead. |
| Enable   | Prints on both sides of letterhead. |

**A4<>Letter Switch**

**Purpose:**
To print A4 size jobs on Letter size paper if A4 size paper is not available or to print Letter size jobs on A4 size paper if Letter size paper is not available.

**Values:**

| Off*1 | Does not print A4 size jobs on Letter size paper or Letter size jobs on A4 paper. |
| On    | Prints A4 size jobs on Letter size paper if A4 is not available in the paper trays and vice versa (Letter size job on A4 size paper). |
Understanding the Printer Menus

**A5<>Statement Switch**

**Purpose:**
To print A5 size jobs on Statement size paper if A5 size paper is not available or to print Statement size jobs on A5 size paper if Statement size paper is not available.

**Values:**

- **Off**
  - Does not print A5 size jobs on Statement size paper or Statement size jobs on A5 paper.

- **On**
  - Prints A5 size jobs on Statement size paper if A5 is not available in the paper trays and vice versa (Statement size job on A5 size paper).

- **Off**[*1] Depending on the printer setting, the printer will continue to print on existing media of a different size or prompt the user to select from the following:
  - Delete Job
  - Supply with correct media

**Report 2 Sided Print**

**Purpose:**
To specify to print reports on both sides a sheet of paper.

**Values:**

- **1 Sided**
  - Prints reports on one side of a sheet of paper.

- **2 Sided**
  - Prints reports on both side of a sheet of paper.

**Use Another Tray**

**Purpose:**
To change to another paper tray when a paper size runs out in the specified paper tray.

- **NOTE:** If you select another paper tray with paper size smaller than the paper size specified in the job, the parts that do not fit are not printed (print size is not adjusted automatically).

**Values:**

- **Off**
  - Does not print on other paper sizes in other paper trays if the paper size specified in the job runs out.

- **On**
  - Shows a message to select another tray when the specified paper runs out in the paper tray.

**Envelope Mode Mismatch**

**Purpose:**
To specify whether to display the alert window when the print job is started without setting to the envelope mode.

**Values:**

- **Ignore**
  - Does not display the alert window and continues the print job on the envelope even if a mismatch is detected in the printer's envelope mode settings.

- **Show Warning**
  - Displays the alert window to confirm whether to hold the print job and change to the envelope mode, or to continue the print job anyway without changing to the envelope mode.
Resume Printing After Jam Recovery

Purpose:
To specify whether to reprint or cancel the jammed job after the printer is recovered from paper jam.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Cancel the jammed job when the paper jam happens.</td>
</tr>
<tr>
<td>On*</td>
<td>Reprint the jammed job after the printer is recovered from paper jam.</td>
</tr>
</tbody>
</table>

**NOTE:** This setting will not affect the fax jobs.

Set Available Time

Purpose:
Sets the available time for the Copy, Scan, Fax, and Print functions.

Values:

<table>
<thead>
<tr>
<th>Copy, Scan, Fax, Print</th>
<th>Set Available Time</th>
<th>Off*</th>
<th>Does not set the time when function is available.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>On</td>
<td>Sets the time when function is available.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time</td>
<td>Sets the start time of the available time.</td>
</tr>
<tr>
<td>End Time</td>
<td>Sets the end time of the available time.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>Sets the day of the week to repeat the setting.</td>
</tr>
</tbody>
</table>

**NOTE:** Set Available Time can be configured when Print, Copy, Scan, or Fax is set to On.

Secure Job Expiration

**NOTE:** Secure Job Expiration feature is available only when RAM Disk is set to On.

Purpose:
To specify the date and time to delete the files stored as Secure Print in the RAM disk.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not set the date and time to delete the files stored as Secure Print in the RAM disk.</td>
</tr>
<tr>
<td>On</td>
<td>Sets the date and time to delete the files stored as Secure Print in the RAM disk.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration Time</td>
<td>Sets the time to delete the files stored as Secure Print in the RAM disk.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>Daily</td>
</tr>
<tr>
<td></td>
<td>Weekly*</td>
</tr>
<tr>
<td></td>
<td>Monthly</td>
</tr>
</tbody>
</table>
**Access Control Mode**

Purpose:
To specify who has access to printing.

Values:

<table>
<thead>
<tr>
<th>Off</th>
<th>Does not limit access to printing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Limits access to printing. Authentication is done using user information registered on the printer.</td>
</tr>
</tbody>
</table>

**Non Registered User**

Purpose:
To specify whether to permit the printing of data without authentication information.

Values:

<table>
<thead>
<tr>
<th>Off</th>
<th>Does not permit non-account user to print the data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Permits non-account user to print the data.</td>
</tr>
</tbody>
</table>

**Access Control Error Report**

Purpose:
To specify whether to automatically print error-related information if printing with AccessControl results in an error.

Values:

<table>
<thead>
<tr>
<th>Off</th>
<th>Does not print the error report when printing with AccessControl results in an error.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Prints the error report when printing with AccessControl results in an error.</td>
</tr>
</tbody>
</table>

**NFC - Tap to Print**

NOTE: The Tap to Print feature is available on the Dell Cloud Multifunction Printer | H815dw only.

Purpose:
To specify whether to add the printer to a mobile device such as a tablet or a smartphone by tapping the device to the printer.

Values:

<table>
<thead>
<tr>
<th>Disable</th>
<th>Does not add the printer to a mobile device by tapping the device to the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Adds the printer to a mobile device by tapping the device to the printer.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Weekly Setting</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sets the day of the week to delete the files stored as Secure Print.</td>
</tr>
<tr>
<td>Monday</td>
<td></td>
</tr>
<tr>
<td>Tuesday</td>
<td></td>
</tr>
<tr>
<td>Wednesday</td>
<td></td>
</tr>
<tr>
<td>Thursday</td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td></td>
</tr>
<tr>
<td>Sunday</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Monthly Setting</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week</td>
<td>Sets the day of the week to delete the files stored as Secure Print in the RAM disk.</td>
</tr>
<tr>
<td>Monthly Setting</td>
<td>Available Range: 1-28 days</td>
</tr>
<tr>
<td>Off</td>
<td>Does not limit access to printing.</td>
</tr>
<tr>
<td>On</td>
<td>Limits access to printing. Authentication is done using user information registered on the printer.</td>
</tr>
</tbody>
</table>
Maintenance

Use the Maintenance menu to fine-tune the printer for optimal print quality, reset the print meter or the life counter of the replaced parts, or reset the default settings by initializing the printer's non-volatile memory.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Paper Density

Purpose:
To specify paper density settings.

Values:

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Values</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Light (&lt;81g/m²)</td>
<td>Normal*</td>
<td>Sets the transfer unit voltage in increments of 1. The default settings may not give the best output on all paper types. If you see mottles on the printed paper, try to increase the voltage. If you see white spots on the printed paper, try to decrease the voltage.</td>
</tr>
</tbody>
</table>

Adjust Transfer Unit

NOTE: The print quality changes depending on the setting values you select for this item.

Purpose:
To specify the transfer unit voltage adjustment for each paper type.

Values:

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Values</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain (60-80g/m²)</td>
<td>0*</td>
<td>Sets the transfer unit voltage in increments of 1. The default settings may not give the best output on all paper types. If you see mottles on the printed paper, try to increase the voltage. If you see white spots on the printed paper, try to decrease the voltage.</td>
</tr>
<tr>
<td>Plain Thick (81-105g/m²)</td>
<td>0*</td>
<td>Available Range: -5 to +10</td>
</tr>
<tr>
<td>Covers (106-163g/m²)</td>
<td>0*</td>
<td>Available Range: -5 to +10</td>
</tr>
<tr>
<td>Covers Thick (164-216g/m²)</td>
<td>0*</td>
<td>Available Range: -5 to +10</td>
</tr>
<tr>
<td>Rough Surface</td>
<td>0*</td>
<td>Available Range: -5 to +10</td>
</tr>
<tr>
<td>Label</td>
<td>0*</td>
<td>Available Range: -5 to +10</td>
</tr>
<tr>
<td>Envelope</td>
<td>0*</td>
<td>Available Range: -5 to +10</td>
</tr>
<tr>
<td>Japanese Postcard</td>
<td>0*</td>
<td>Available Range: -5 to +10</td>
</tr>
</tbody>
</table>
**Adjust Fusing Unit**

*NOTE:* The print quality changes depending on the setting values you select for this item.

**Purpose:**
To adjust the temperature setting of the fusing unit for each paper type.

**Values:**

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Default Setting</th>
<th>Available Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain (60-80g/m²)</td>
<td>0°</td>
<td>-3 to +3</td>
<td>Sets the fusing unit temperature in increments of 1. The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.</td>
</tr>
<tr>
<td>Plain Thick (81-105g/m²)</td>
<td>0°</td>
<td>-3 to +3</td>
<td></td>
</tr>
<tr>
<td>Covers (106-163g/m²)</td>
<td>0°</td>
<td>-3 to +3</td>
<td></td>
</tr>
<tr>
<td>Covers Thick (164-216g/m²)</td>
<td>0°</td>
<td>-3 to +3</td>
<td></td>
</tr>
<tr>
<td>Rough Surface</td>
<td>0°</td>
<td>-3 to +3</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>0°</td>
<td>-3 to +3</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>0°</td>
<td>-3 to +3</td>
<td></td>
</tr>
<tr>
<td>Japanese Postcard</td>
<td>0°</td>
<td>-3 to +3</td>
<td></td>
</tr>
</tbody>
</table>

**Adjust Density**

**Purpose:**
To adjust density level.

**Values:**

<table>
<thead>
<tr>
<th>Density Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Darken</td>
<td>-3 to -1</td>
</tr>
<tr>
<td>Normal*</td>
<td>0</td>
</tr>
<tr>
<td>Lighten</td>
<td>+1 to +3</td>
</tr>
</tbody>
</table>

**Chart**

**Purpose:**
To print various charts that can be used for diagnosis of the printer.

**Values:**

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch Chart</td>
<td>Prints a full halftone page. Also prints a page to check the pitch. A total of two pages are printed.</td>
</tr>
<tr>
<td>Full Page Solid</td>
<td>Specifies to print a chart of the full page solid on the paper.</td>
</tr>
<tr>
<td>1-Sided</td>
<td>Specifies to print a chart of the full page solid on both sides of the paper.</td>
</tr>
<tr>
<td>2-Sided</td>
<td>Begins to print a full page solid.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clean Developer</td>
<td>Stirs the developer in the drum cartridge.</td>
</tr>
<tr>
<td>Clean Transfer Unit</td>
<td>Cleans the transfer unit.</td>
</tr>
<tr>
<td>Toner Refresh</td>
<td>Cleans the toner.</td>
</tr>
<tr>
<td>Reset Defaults</td>
<td>Initializes the non-volatile (NV) memory.</td>
</tr>
<tr>
<td>Initialize Print Meter</td>
<td>Initializes the print meter of the printer.</td>
</tr>
<tr>
<td>Reset Transfer Belt Unit</td>
<td>Initializes the life counter of the transfer belt unit.</td>
</tr>
</tbody>
</table>

**Clean Developer**

**Purpose:**
To stir the developer in the drum cartridge.

**Values:**
- **Start**

**Clean Transfer Unit**

**Purpose:**
To clean the transfer unit.

**Values:**
- **Start**

**Toner Refresh**

**Purpose:**
To clean the toner in the drum cartridge (and supply new toner from toner cartridge).

**NOTE:** Toner Refresh feature uses the toner, and shorten the life of the toner cartridge and the drum cartridge.

**Values:**
- **Start**

**Reset Defaults**

**Purpose:**
To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu parameters are reset to their default values.

**Values:**
- **User Fax Section Initialize**
  - Initializes the fax number entries in the Address Book.
- **User Scan Section Initialize**
  - Initializes the e-mail and server address entries in the Address Book.
- **User Account Section Initialize**
  - Initializes the user registration information.
- **User App Section Initialize**
  - Initializes the widget application information.
- **System Section Initialize**
  - Initializes the system parameters.

**Initialize Print Meter**

**Purpose:**
To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to zero.

**Reset Transfer Belt Unit**

**Purpose:**
To initialize the life counter of the transfer belt unit. After replacing the transfer belt unit, be sure to initialize its life counter.
Reset Fusing Unit
Purpose:
To initialize the life counter of the fusing unit. After replacing the fusing unit, be sure to initialize its life counter.

Clear Stored Jobs

NOTE: Clear Stored Jobs feature is available only when RAM Disk is set to On.
Purpose:
To clear all files stored as Secure Print, Private Mail Box Print, Public Mail Box Print, Proof Print, and Stored Print in the RAM disk.
Values:

<table>
<thead>
<tr>
<th>All</th>
<th>Clear</th>
<th>Deletes all files stored as Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof Print in the RAM disk.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Document</td>
<td>Clear</td>
<td>Deletes all files stored as Secure Print in the RAM disk.</td>
</tr>
<tr>
<td>Stored Document</td>
<td>Clear</td>
<td>Deletes all files stored as Stored Print in the RAM disk.</td>
</tr>
</tbody>
</table>

Non-Dell Toner
Purpose:
To use toner cartridge of another manufacturer.

CAUTION: Using a non-Dell™ toner cartridge may severely damage your printer. The warranty does not cover damages caused by using non-Dell toner cartridges.
Values:

<table>
<thead>
<tr>
<th>Off*</th>
<th>Does not use toner cartridge of another manufacturer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Uses toner cartridge of another manufacturer.</td>
</tr>
</tbody>
</table>

Adjust Altitude
Purpose:
To specify the altitude of the location where the printer is installed.
The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are performed by specifying the altitude of the location where the printer is being used.

NOTE: An incorrect altitude setting leads to poor printing quality, incorrect indication of remaining toner, etc.
Values:

<table>
<thead>
<tr>
<th>0m*</th>
<th>Sets the altitude of the location where the printer is installed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000m</td>
<td></td>
</tr>
<tr>
<td>2000m</td>
<td></td>
</tr>
<tr>
<td>3000m</td>
<td></td>
</tr>
</tbody>
</table>
Decrease Electrostatic Memory

Purpose:
To widen the print gap not to leave toner streak on the next page.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not widen the print gap.</td>
</tr>
<tr>
<td>On</td>
<td>Widens the print gap.</td>
</tr>
</tbody>
</table>

NOTE: When Decrease Electrostatic Memory is set to On, the print speed will be slowed.

Decrease Ghosting

Purpose:
To reduce negative ghost.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not decrease negative ghosting.</td>
</tr>
<tr>
<td>On</td>
<td>Decreases negative ghosting.</td>
</tr>
</tbody>
</table>

Clear Job History

Purpose:
To clear the job history of all finished jobs.

Fax Line Test

NOTE: Fax Line Test feature is not available when the Fax function is disabled.

Purpose:
To test if the voltage supply from the fax line is sufficient.

Secure Settings

Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being changed accidentally.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.

See also:
"Panel Lock"

Panel Lock

Purpose:
To set a limited access to Admin Settings with a password, and to set or change the password.

Values:

<table>
<thead>
<tr>
<th>Panel Lock Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Disables password protection for Admin Settings.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enables password protection for Admin Settings.</td>
</tr>
<tr>
<td>Change Password∗</td>
<td>0000–9999 Sets or changes the password required to access Admin Settings.</td>
</tr>
</tbody>
</table>

∗ This item is available only when Panel Lock Control is set to Enable.
## Functions Control

**NOTE:** Functions Control feature is available only when Panel Lock Control is set to Enable.

### Purpose:
To specify whether to enable or disable each of the printer functions, or to require a password to use the functions.

### Values:

<table>
<thead>
<tr>
<th>Function</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy</strong></td>
<td>On*</td>
<td>Enables the Copy function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the Copy function, but requires a password to use the function.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the Copy function.</td>
</tr>
<tr>
<td><strong>Scan to E-mail</strong></td>
<td>On*</td>
<td>Enables the Scan to Email function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the Scan to Email function, but requires a password.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the Scan to Email function.</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td>On*</td>
<td>Enables the Fax function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the Fax function but requires a password to send faxes (does not require a password to receive incoming faxes).</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the Fax function (the printer will not send or receive faxes).</td>
</tr>
<tr>
<td><strong>Fax Driver</strong></td>
<td>Enable*</td>
<td>Enables the Fax Driver function.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the Fax Driver function (the printer will not send faxes).</td>
</tr>
<tr>
<td><strong>Scan to Network Folder</strong></td>
<td>On*</td>
<td>Enables the Scan to Network Folder function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the Scan to Network Folder function, but requires a password.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the Scan to Network Folder function.</td>
</tr>
<tr>
<td><strong>Scan to Computer</strong></td>
<td>On*</td>
<td>Enables the Scan to Computer function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the Scan to Computer function, but requires a password.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the Scan to Computer function.</td>
</tr>
<tr>
<td><strong>PC Scan</strong></td>
<td>On*</td>
<td>Enables the PC Scan function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the PC Scan function, but requires a password.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the PC Scan function.</td>
</tr>
<tr>
<td><strong>Scan To USB</strong></td>
<td>On*</td>
<td>Enables the Scan To USB function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the Scan To USB function, but requires a password.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the Scan To USB function.</td>
</tr>
<tr>
<td><strong>USB Direct Print</strong></td>
<td>On*</td>
<td>Enables the USB Direct Print function.</td>
</tr>
<tr>
<td></td>
<td>On (Password)</td>
<td>Enables the USB Direct Print function, but requires a password.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disables the USB Direct Print function.</td>
</tr>
</tbody>
</table>
ID Copy

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td></td>
<td>Enables the ID Copy function.</td>
</tr>
<tr>
<td>Disable</td>
<td></td>
<td>Disables the ID Copy function.</td>
</tr>
</tbody>
</table>

USB Service

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show When</td>
<td>Enable*</td>
<td>Shows a USB Drive Detected screen when a USB</td>
</tr>
<tr>
<td>Inserted</td>
<td></td>
<td>memory is inserted into the printer.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Does not show a USB Drive Detected screen when a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USB memory is inserted into the printer.</td>
</tr>
</tbody>
</table>

Change Password1

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enable*</td>
<td>Changes the password that is set under the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Functions Control menu.</td>
</tr>
</tbody>
</table>


1 This item is available only when **On (Password)** is enabled.

**Desktop Authentication**

⚠️ **NOTE:** The Desktop Authentication feature is available on the Dell Smart Multifunction Printer | S2815dn only.

**Purpose:**
To specify the Desktop Authentication method.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>Authentication*</td>
<td>Use the local authentication method.</td>
</tr>
<tr>
<td>Remote</td>
<td>Authentication</td>
<td>Use the remote authentication method.</td>
</tr>
</tbody>
</table>

**Edit E-mail From Fields**

**Purpose:**
To specify whether to enable editing of the transmission source when you use Scan to Email.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td></td>
<td>Disables editing of the transmission source.</td>
</tr>
<tr>
<td>Enable1</td>
<td></td>
<td>Enables editing of the transmission source.</td>
</tr>
</tbody>
</table>

**Reconfirm Recipient**

**Purpose:**
To specify whether to reconfirm the recipient before sending a fax or scan.

⚠️ **NOTE:** If the **Reconfirm Recipient** menu is set to **Reconfirm Recipient**, recipients can only be selected from the phone book or the address book. You cannot directly enter an address or fax number.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Confirmation*</td>
<td>Does not display a screen to reconfirm the recipient before the job is actually sent.</td>
</tr>
<tr>
<td></td>
<td>Reconfirm Recipient</td>
<td>Displays a screen to reconfirm the recipient before the job is actually sent.</td>
</tr>
</tbody>
</table>
Domain Filtering
Purpose:
To specify whether to only send e-mails to specified domains.

![NOTE: Set the domains from SMTP Domain Filtering on the Dell Printer Configuration Web Tool.]

Values:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Disables Domain Filtering.</td>
</tr>
<tr>
<td>Allow Domains</td>
<td>Only allows e-mails to be sent to specified domains.</td>
</tr>
</tbody>
</table>

Software Download
Purpose:
To enable or disable download of firmware updates.

Values:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Disables firmware updates.</td>
</tr>
<tr>
<td>Enable*</td>
<td>Enables firmware updates.</td>
</tr>
</tbody>
</table>

Display of Network Information
Purpose:
To show or hide network information in the message field of the Home screen.

Values:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show IPv4 Address*</td>
<td>Shows the IPv4 address of the printer on the Home screen.</td>
</tr>
<tr>
<td>Show Host Name</td>
<td>Shows the host name of the printer on the Home screen.</td>
</tr>
<tr>
<td>Hide Network Information</td>
<td>Does not show network information on the Home screen.</td>
</tr>
</tbody>
</table>

Login Error

![NOTE: Login Error feature is available only when Panel Lock Control is set to Enable.]

Purpose:
To specify the number of error entry attempts allowed when you log in as an administrator in the Admin Settings and Report/List menu.

Values:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not allow an administrator to log in after one error entry attempt.</td>
</tr>
<tr>
<td>On</td>
<td>Sets the number of error entry attempts allowed when an administrator logs in.</td>
</tr>
</tbody>
</table>

Available Range: 1-10
NFC Authentication

Note: The NFC Authentication feature is available on the Dell Cloud Multifunction Printer | H815dw only.

Purpose:
To specify whether to enable the authentication using the NFC authentication card.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Does not permit the authentication using the NFC authentication card.</td>
</tr>
<tr>
<td>Enable</td>
<td>Permits the authentication using the NFC authentication card.</td>
</tr>
</tbody>
</table>

FIPS 140-2 Validation Mode

Note: The FIPS 140-2 Validation Mode feature is available on the Dell Smart Multifunction Printer | S2815dn only.

Purpose:
To specify whether to use the FIPS 140-2 Level-1 approved encryption algorithms for RSA modules.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Allows the use of FIPS 140-2 Level-1 unapproved algorithms.</td>
</tr>
<tr>
<td>Enable</td>
<td>Allows the use of FIPS 140-2 Level-1 approved encryption algorithms.</td>
</tr>
</tbody>
</table>

Note: Communication using the following protocols will not be encrypted using FIPS 140-2 Level-1 approved encryption algorithms even when FIPS 140-2 Validation Mode is enabled:

- SNMP v3
- SMB
- PDF Direct Print

Note: This feature may not be available for certain models.

USB Settings

Use the USB Settings menu to change printer settings affecting a USB port.

USB Port

Note: USB Port feature is available only for the USB port on the rear of the printer.

Purpose:
To specify whether to enable the USB port. The change becomes effective after the printer is turned off and then on again.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Disables the USB interface.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enables the USB interface.</td>
</tr>
</tbody>
</table>

PS Data Format

Purpose:
To specify PostScript 3 Compatible communication protocol. You can configure the PS Data Format settings. The change becomes effective after the printer is turned off and then on again.
Understanding the Printer Menus

Values:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Used when auto-detecting the PostScript 3 Compatible communication protocol.</td>
</tr>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP*</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required for data.</td>
</tr>
</tbody>
</table>

**Job Time-out**

Purpose:
To specify the amount of time the printer waits for data to arrive from the computer. The print job is canceled if the time-out time is exceeded.

Values:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables the job time-out.</td>
</tr>
<tr>
<td>On*</td>
<td>Sets the time the printer waits for data to arrive from the computer.</td>
</tr>
<tr>
<td></td>
<td>Available Range: 5–300 seconds</td>
</tr>
</tbody>
</table>

**Default Settings**

Use Default Settings to modify the Copy, Scan, or Fax menu defaults.

**Copy Defaults**

Purpose:
To modify the Copy menu defaults.

Copy Defaults allows you to configure the following items in addition to the items under the Copy menu.

**Auto Exposure Level**

Purpose:
To specify the default background suppression level.

Values:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal*</td>
<td>Sets the background suppression level to Normal.</td>
</tr>
<tr>
<td>High</td>
<td>Sets the background suppression level to High.</td>
</tr>
<tr>
<td>Highest</td>
<td>Sets the background suppression level to Highest.</td>
</tr>
</tbody>
</table>

**Fax Defaults**

Purpose:
To modify the Fax menu defaults. See "Fax" for more details.

**Scan Defaults**

Purpose:
To modify the Scan menu defaults.

Scan Defaults allows you to configure the following items in addition to the items under the Scan menu.
**Auto Exposure Level**

Purpose:
To specify the default background suppression level.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Sets the background suppression level to Normal.</td>
</tr>
<tr>
<td>High</td>
<td>Sets the background suppression level to High.</td>
</tr>
<tr>
<td>Highest</td>
<td>Sets the background suppression level to Highest.</td>
</tr>
</tbody>
</table>

**TIFF File Format**

Purpose:
To specify the default TIFF file format.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF V6</td>
<td>Sets the default TIFF file format to TIFF V6.</td>
</tr>
<tr>
<td>TTN2</td>
<td>Sets the default TIFF file format to TTN2.</td>
</tr>
</tbody>
</table>

**Image Compression**

Purpose:
To specify the image compression level.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Sets the image compression level to High.</td>
</tr>
<tr>
<td>Normal</td>
<td>Sets the image compression level to Normal.</td>
</tr>
<tr>
<td>Low</td>
<td>Sets the image compression level to Low.</td>
</tr>
</tbody>
</table>

**Direct Print Defaults (available on the Dell Cloud Multifunction Printer | H815dw only)**

**USB Direct Print Defaults (available on the Dell Smart Multifunction Printer | S2815dn only)**

Purpose:
To modify the defaults for the Direct Print Defaults or USB Direct Print Defaults menu. See "Print PDF/TIFF" for more details.

**Tray Management**

Use the Tray Settings menu to define the print media loaded in tray1 and the optional 550-sheet feeder.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.

**Tray Settings**

To configure tray settings.

**MPF**

Purpose:
To specify the paper loaded in the MPF.
## Values:

<table>
<thead>
<tr>
<th>Display Tray Prompt</th>
<th><strong>Enter a check to display a popup message that prompts to set Paper Type and Paper Size when paper is loaded in the MPF. The factory default is on (check).</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>MPF Mode</td>
<td><strong>Use Panel Settings</strong>&lt;sup&gt;*&lt;/sup&gt; Uses the paper size and type specified on the operator panel. <strong>Use Printer Driver Settings</strong> Use the paper size and type specified on the printer driver. <strong>Manual</strong> When the print job is started, the printer pauses the job and shows the screen to prompt the user to load the paper of the specified size and type. To continue the job, check that the specified paper is loaded, and tap Continue in the screen on the touch panel.</td>
</tr>
</tbody>
</table>

### Size<sup>*1</sup>  

<table>
<thead>
<tr>
<th>mm series</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
</tr>
<tr>
<td>A5</td>
</tr>
<tr>
<td>A6</td>
</tr>
<tr>
<td>B5</td>
</tr>
<tr>
<td>B6</td>
</tr>
<tr>
<td>Letter</td>
</tr>
<tr>
<td>Folio</td>
</tr>
<tr>
<td>Legal</td>
</tr>
<tr>
<td>Statement</td>
</tr>
<tr>
<td>Executive</td>
</tr>
<tr>
<td>Envelope #10</td>
</tr>
<tr>
<td>Monarch Env.</td>
</tr>
<tr>
<td>DL Env.</td>
</tr>
<tr>
<td>C5 Env.</td>
</tr>
<tr>
<td>inch series</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type¹</th>
<th>Plain</th>
<th>Plain Thick</th>
<th>Covers</th>
<th>Covers Thick</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(60-80g/m²)</td>
<td>(81-105g/m²)</td>
<td>(106-163g/m²)</td>
<td>(164-210g/m²)</td>
</tr>
</tbody>
</table>
**Tray1**

**Purpose:**
To specify the paper loaded in tray1.

**Values:**

<table>
<thead>
<tr>
<th>Display Tray Prompt</th>
<th>Enter a check to display a popup message that prompts to set Paper Type and Paper Size when paper is loaded in tray1. The factory default is on (check).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td><strong>mm series</strong></td>
</tr>
<tr>
<td></td>
<td>A4</td>
</tr>
<tr>
<td></td>
<td>(210x297mm) *1</td>
</tr>
<tr>
<td></td>
<td>A5</td>
</tr>
<tr>
<td></td>
<td>(148x210mm)</td>
</tr>
<tr>
<td></td>
<td>A6</td>
</tr>
<tr>
<td></td>
<td>(105x148mm)</td>
</tr>
<tr>
<td></td>
<td>B5</td>
</tr>
<tr>
<td></td>
<td>(182x257mm)</td>
</tr>
<tr>
<td></td>
<td>B6</td>
</tr>
<tr>
<td></td>
<td>(128x182mm)</td>
</tr>
<tr>
<td></td>
<td>Letter</td>
</tr>
<tr>
<td></td>
<td>(8.5x11”)</td>
</tr>
<tr>
<td></td>
<td>Folio</td>
</tr>
<tr>
<td></td>
<td>(8.5x13”)</td>
</tr>
<tr>
<td></td>
<td>Legal</td>
</tr>
<tr>
<td></td>
<td>(8.5x14”)</td>
</tr>
<tr>
<td></td>
<td>Statement</td>
</tr>
<tr>
<td></td>
<td>(5.5x8.5”)</td>
</tr>
<tr>
<td></td>
<td>Executive</td>
</tr>
<tr>
<td></td>
<td>(7.3x10.5”)</td>
</tr>
<tr>
<td></td>
<td>Postcard</td>
</tr>
<tr>
<td></td>
<td>(100x148mm)</td>
</tr>
<tr>
<td></td>
<td>Custom</td>
</tr>
</tbody>
</table>

*1 Available only when MFP Mode is set to Use Panel Settings.

*2 Denotes country-specific factory default value.
## inch series

<table>
<thead>
<tr>
<th>Size</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>(8.5x11&quot;)&quot;</td>
</tr>
<tr>
<td>Folio</td>
<td>(8.5x13&quot;)</td>
</tr>
<tr>
<td>Legal</td>
<td>(8.5x14&quot;)</td>
</tr>
<tr>
<td>Statement</td>
<td>(5.5x8.5&quot;)</td>
</tr>
<tr>
<td>A4</td>
<td>(210x297mm)</td>
</tr>
<tr>
<td>A5</td>
<td>(148x210mm)</td>
</tr>
<tr>
<td>A6</td>
<td>(105x148mm)</td>
</tr>
<tr>
<td>B5</td>
<td>(182x257mm)</td>
</tr>
<tr>
<td>B6</td>
<td>(128x182mm)</td>
</tr>
<tr>
<td>Executive</td>
<td>(7.3x10.5&quot;)</td>
</tr>
<tr>
<td>Postcard</td>
<td>(100x148mm)</td>
</tr>
<tr>
<td>Custom</td>
<td></td>
</tr>
</tbody>
</table>

## Type

<table>
<thead>
<tr>
<th>Type</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>(60-80g/m²)</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>(81-105g/m²)</td>
</tr>
<tr>
<td>Covers</td>
<td>(106-165g/m²)</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>(164-210g/m²)</td>
</tr>
<tr>
<td>Rough Surface</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td></td>
</tr>
<tr>
<td>Japanese Postcard</td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td></td>
</tr>
<tr>
<td>Prepunched</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td></td>
</tr>
</tbody>
</table>

*¹ Denotes country-specific factory default value.

**NOTE:** For more information on supported paper sizes, see "Supported Paper Sizes."
**Tray2**

*NOTE:* Tray2 feature is available only when the optional 550-sheet feeder is installed.

**Purpose:**
To specify the paper loaded in the optional 550-sheet feeder.

**Values:**

<table>
<thead>
<tr>
<th>Display Tray Prompt</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enter a check to display a popup message that prompts to set Paper Type and Paper Size when paper is loaded in the optional 550-sheet feeder. The factory default is on (check).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Size</th>
<th>mm series</th>
<th>inch series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Tray Prompt</td>
<td>A4</td>
<td>Letter &lt;br&gt;(8.5x11&quot;)&lt;sup&gt;*1&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td>Folio &lt;br&gt;(8.5x13&quot;)</td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td>Legal &lt;br&gt;(8.5x14&quot;)</td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td>Statement &lt;br&gt;(5.5x8.5&quot;)</td>
</tr>
<tr>
<td></td>
<td>Folio</td>
<td>Executive &lt;br&gt;(7.3x10.5&quot;)</td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td></td>
</tr>
</tbody>
</table>

*Note:*
- A4: (210x297mm)<sup>*1</sup>
- A5: (148x210mm)
- B5: (182x257mm)
### Tray Priority

**Purpose:**
To set the priority order of the paper trays for automatic tray selection. If paper trays loaded with the same paper size and type exist, the paper tray is selected according to this priority order.

**Values:**

<table>
<thead>
<tr>
<th>First</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPF(^1)</td>
<td>Sets the MPF as the first priority.</td>
</tr>
<tr>
<td>Tray1(^1)</td>
<td>Sets the optional 550-sheet feeder as the first priority.</td>
</tr>
<tr>
<td>Tray2</td>
<td>Sets tray1 as the first priority.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Second</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPF(^*)</td>
<td>Sets the MPF as the second priority.</td>
</tr>
<tr>
<td>Tray1(^*)</td>
<td>Sets tray1 as the second priority.</td>
</tr>
<tr>
<td>Tray2</td>
<td>Sets the optional 550-sheet feeder as the second priority.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Third</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPF</td>
<td>Sets the MPF as the third priority.</td>
</tr>
<tr>
<td>Tray1</td>
<td>Sets tray1 as the third priority.</td>
</tr>
<tr>
<td>Tray2(^*)</td>
<td>Sets the optional 550-sheet feeder as the third priority.</td>
</tr>
</tbody>
</table>

\(^*\) The factory default when the optional 550-sheet feeder is installed.

---

### Language Settings

Use the Language Settings menu to configure Panel Language, or Keyboard Layout.

**Panel Language**

**Purpose:**
To determine the language of the text on the touch panel.
Understanding the Printer Menus

Values:

<table>
<thead>
<tr>
<th>Language</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>English*</td>
<td></td>
</tr>
<tr>
<td>Français</td>
<td></td>
</tr>
<tr>
<td>Italiano</td>
<td></td>
</tr>
<tr>
<td>Deutsch</td>
<td></td>
</tr>
<tr>
<td>Español</td>
<td></td>
</tr>
<tr>
<td>Dansk</td>
<td></td>
</tr>
<tr>
<td>Nederlands</td>
<td></td>
</tr>
<tr>
<td>Norsk</td>
<td></td>
</tr>
<tr>
<td>Svenska</td>
<td></td>
</tr>
</tbody>
</table>

**Keyboard Layout**

**Purpose:**
To select the keyboard layout on the touch panel.

**Values:**

<table>
<thead>
<tr>
<th>Keyboard Layout</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>QWERTY</td>
<td></td>
</tr>
<tr>
<td>AZERTY</td>
<td></td>
</tr>
<tr>
<td>QWERTZ</td>
<td></td>
</tr>
</tbody>
</table>

**Print**

Use the **Print** menu to select and print a job stored by the Private Mailbox, Public Mailbox, Proof Print, Secure Print, and Secure Fax Receive features.

⚠️ **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Private Mailbox**

⚠️ **NOTE:** Private Mailbox feature is available only when RAM Disk is set to On.

**Purpose:**
To specify whether and how to print the job stored in the Private Mailbox.

**Values:**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select User ID</td>
<td>Enter the password you specified on the printer driver.</td>
</tr>
<tr>
<td>Select a Job</td>
<td>Selects a job to print.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the documents stored for this User ID.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Specifies the quantity of prints in increments of 1.</td>
</tr>
<tr>
<td>Available Range: 1-999</td>
<td></td>
</tr>
<tr>
<td>Use Driver Settings</td>
<td>Sets the quantity of prints specified on the printer driver.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the selected job.</td>
</tr>
<tr>
<td>Print and Delete*</td>
<td>Deletes the document after it is printed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the specified document from print memory.</td>
</tr>
</tbody>
</table>
Public Mailbox

NOTE: Public Mailbox feature is available only when RAM Disk is set to On.

Purpose:
To specify whether and how to print the job stored in the Public Mailbox.

Values:

| Select User ID | Select a Job | Selects a job to print. |
| Select All | | Selects all the documents stored for this User ID. |
| Quantity | 1* | Specifies the quantity of prints in increments of 1. |
| Available Range: 1-999 |
| Use Driver Settings | | Sets the quantity of prints specified on the printer driver. |
| Print | | Prints the selected job. |
| Print and Delete | | Deletes the document after it is printed. |
| Delete | | Deletes the specified document from print memory. |

Proof Print

NOTE: Proof Print feature is available only when RAM Disk is set to On.

Purpose:
To specify whether and how to print the job stored in the Proof Print. When the print job is sent from the printer driver on the computer, a single copy is printed for you to check the print result. If you do not have problems with the print result, you can choose to print more copies. This prevents a large number of misprinted copies from being printed at one time.

Values:

| Select User ID | Select a Job | Selects a job to print. |
| Select All | | Selects all the documents stored for this User ID. |
| Quantity | 1* | Specifies the quantity of prints in increments of 1. |
| Available Range: 1-999 |
| Use Driver Settings | | Sets the quantity of prints specified on the printer driver. |
| Print | | Prints the selected job. |
| Print and Delete | | Deletes the document after it is printed. |
| Delete | | Deletes the specified document from print memory. |

Secure Print

NOTE: Secure Print feature is available only when RAM Disk is set to On.

Purpose:
To print confidential jobs. The printer can hold the job in memory until you arrive at the printer and type the password on the operator panel.

Values:

| Select User ID | Enter the password you specified on the printer driver. |
| Select a Job | Selects a job to print. |
| Select All | Selects all the documents stored for this User ID. |
### Secure Fax Receive

**Purpose:**
To print confidential faxes. The printer can hold the job in memory until you arrive at the printer and type the password on the operator panel.

**Values:**
- Enter Password: Enter the password you specified in Secure Receive.

### Tile Settings

The **Tile Settings** screen appears when the Print menu is tapped under the Print menu. Use **Tile Settings** to create and edit custom tiles for Print.

### Copy

You can configure a variety of copy features under the Copy menu.

* **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

#### Quantity

**Purpose:**
To specify the number of copies from 1 to 99.

#### Darken / Lighten

**Purpose:**
To make the copy darker or lighter than the original.

**Values:**
- Darken 3: Works well with light documents or faint pencil markings.
- Darken 2
- Darken 1
- Normal*: Works well with standard typed or printed documents.
- Lighten 1: Works well with dark documents.
- Lighten 2
- Lighten 3

<table>
<thead>
<tr>
<th>Print</th>
<th>Prints the selected job.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print and Delete*</td>
<td>Deletes the document after it is printed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the specified document from print memory.</td>
</tr>
</tbody>
</table>
**Select Tray**

**Purpose:**
To specify the input tray.

**Values:**

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>mm series</th>
<th>inch series</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A4 (210x297mm)</td>
<td>Letter (8.5x11&quot;)¹</td>
</tr>
<tr>
<td></td>
<td>A5 (148x210mm)</td>
<td>Folio (8.5x13&quot;)</td>
</tr>
<tr>
<td></td>
<td>A6 (105x148mm)</td>
<td>Legal (8.5x14&quot;)</td>
</tr>
<tr>
<td></td>
<td>B5 (182x257mm)</td>
<td>Statement (5.5x8.5&quot;)</td>
</tr>
<tr>
<td></td>
<td>B6 (128x182mm)</td>
<td>Executive (7.3x10.5&quot;)</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5x11&quot;)</td>
<td>Envelope #10 (4.1x9.5&quot;)</td>
</tr>
<tr>
<td></td>
<td>A4 (210x297mm)</td>
<td>Monarch Env. (3.9x7.5&quot;)</td>
</tr>
<tr>
<td></td>
<td>A5 (148x210mm)</td>
<td>DL Env. (110x220mm)</td>
</tr>
<tr>
<td></td>
<td>A6 (105x148mm)</td>
<td>C5 Env. (162x229mm)</td>
</tr>
<tr>
<td></td>
<td>B5 (182x257mm)</td>
<td>Postcard (100x148mm)</td>
</tr>
<tr>
<td></td>
<td>B6 (128x182mm)</td>
<td>Custom Size</td>
</tr>
</tbody>
</table>

¹ The paper is fed from the MPF. When Use Printer Driver Settings is set in MPF of Tray Settings, Any is displayed for Size and Type. If you start the copy job with Any as the paper size and type, A4 or Letter is selected as the paper size and Plain (60–80g/m²) is selected as the paper type. If you want to specify the size and type of paper in the MPF, select MPF and specify the paper size and type.
Understanding the Printer Menus

2 Sided Copying

Purpose:
To specify whether to make duplex copy and select the binding position.

Values:

<table>
<thead>
<tr>
<th>1 → 1 Sided</th>
<th>1 → 2 Sided</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 → 1 Sided</td>
<td>Prints on one side of a sheet of paper.</td>
</tr>
<tr>
<td>1 → 2 Sided</td>
<td>Prints one sided originals on both sides of a sheet of paper.</td>
</tr>
<tr>
<td><strong>Long Edge Binding</strong></td>
<td>Prints on both sides of a sheet of paper to be bound by long edge.</td>
</tr>
<tr>
<td><strong>Short Edge Binding</strong></td>
<td>Prints on both sides of a sheet of paper to be bound by short edge.</td>
</tr>
<tr>
<td>2 → 1 Sided</td>
<td>Prints two sided originals on one side of a sheet of paper.</td>
</tr>
<tr>
<td><strong>Long Edge Binding</strong></td>
<td>Scans both sides of a document bound by long edge.</td>
</tr>
<tr>
<td><strong>Short Edge Binding</strong></td>
<td>Scans both sides of a document bound by short edge.</td>
</tr>
<tr>
<td>2 → 2 Sided</td>
<td>Prints two sided originals on both sides of a sheet of paper.</td>
</tr>
<tr>
<td><strong>Long Edge Binding</strong></td>
<td>Scans both sides of a document bound by long edge.</td>
</tr>
<tr>
<td><strong>Short Edge Binding</strong></td>
<td>Scans both sides of a document bound by short edge.</td>
</tr>
</tbody>
</table>

Sharpness

Purpose:
To adjust the sharpness to make the copy sharper or softer than the original.

Values:

<table>
<thead>
<tr>
<th>Sharpen</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Makes the copy sharper than the original.</td>
<td>Does not make the copy sharper or softer than the original.</td>
</tr>
</tbody>
</table>
Softened  Makes the copy softer than the original.

**Reduce/Enlarge**

**Purpose:**
To reduce or enlarge the size of a copied image.

**Values:**

<table>
<thead>
<tr>
<th>Custom ratio</th>
<th>100%</th>
<th>Sets a custom ratio in increments of 1 percent.</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm series</td>
<td>100%</td>
<td>70%</td>
</tr>
<tr>
<td></td>
<td>50%</td>
<td>A4→A5</td>
</tr>
<tr>
<td></td>
<td>81%</td>
<td>B5→A5</td>
</tr>
<tr>
<td></td>
<td>122%</td>
<td>A5→B5</td>
</tr>
<tr>
<td></td>
<td>141%</td>
<td>A5→A4</td>
</tr>
<tr>
<td></td>
<td>200%</td>
<td></td>
</tr>
<tr>
<td>inch series</td>
<td>100%</td>
<td>64%</td>
</tr>
<tr>
<td></td>
<td>50%</td>
<td>Ledger→Letter</td>
</tr>
<tr>
<td></td>
<td>78%</td>
<td>Legal→Letter</td>
</tr>
<tr>
<td></td>
<td>129%</td>
<td>Statement→Letter</td>
</tr>
<tr>
<td></td>
<td>154%</td>
<td>Statement→Legal</td>
</tr>
<tr>
<td></td>
<td>200%</td>
<td></td>
</tr>
</tbody>
</table>

**Original Size**

**Purpose:**
To specify the default document size.

**Values:**

<table>
<thead>
<tr>
<th>mm series</th>
<th>Auto</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A4 (210x297mm)</td>
</tr>
<tr>
<td></td>
<td>A5 (148x210mm)</td>
</tr>
<tr>
<td></td>
<td>B5 (182x257mm)</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5x11”)</td>
</tr>
</tbody>
</table>
NOTE: When Auto is selected, the printer assumes that the document size is the size of the print media loaded in tray1 or the MPF.

**Original Type**

*Purpose:* To improve the image quality by selecting the type of the original document.

*Values:*

<table>
<thead>
<tr>
<th>Photo(Text)</th>
<th>Used for documents with both text and photos.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Used for documents with text.</td>
</tr>
<tr>
<td>Photo</td>
<td>Used for documents with photos.</td>
</tr>
</tbody>
</table>

**Collation**

*Purpose:* To sort the copy job. For example, if you make two copies of three page documents, one complete set of three page documents is printed one by one.

*Values:*

<table>
<thead>
<tr>
<th>Auto</th>
<th>Automatically sorts a copy job only when you use the DADF.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collated</td>
<td>Sorts a copy job.</td>
</tr>
<tr>
<td>Uncollated</td>
<td>Does not sort a copy job.</td>
</tr>
</tbody>
</table>

**2-Up**

*Purpose:* To print two original pages to fit onto one sheet of paper.

*Values:*

| Off         | Does not perform 2-up printing.                          |

### Table: Document Sizes (inch series)

<table>
<thead>
<tr>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folio (8.5x13&quot;)</td>
</tr>
<tr>
<td>Legal (8.5x14&quot;)</td>
</tr>
<tr>
<td>Statement (5.5x8.5&quot;)</td>
</tr>
<tr>
<td>Executive (7.3x10.5&quot;)</td>
</tr>
<tr>
<td>Auto*1</td>
</tr>
<tr>
<td>Letter (8.5x11&quot;)</td>
</tr>
<tr>
<td>Folio (8.5x13&quot;)</td>
</tr>
<tr>
<td>Legal (8.5x14&quot;)</td>
</tr>
<tr>
<td>Statement (5.5x8.5&quot;)</td>
</tr>
<tr>
<td>A4 (210x297mm)</td>
</tr>
<tr>
<td>A5 (148x210mm)</td>
</tr>
<tr>
<td>B5 (182x257mm)</td>
</tr>
<tr>
<td>Executive (7.3x10.5&quot;)</td>
</tr>
</tbody>
</table>

*1 Denotes country-specific factory default values.
Understanding the Printer Menus

**Margin**

**Purpose:**
To specify the top, bottom, right, left, and middle margins of the copy.

**Values:**

<table>
<thead>
<tr>
<th>Margin Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>0.1 inch (2 mm)</td>
<td>Sets the value in increments of 0.1 inch (1 mm).</td>
</tr>
<tr>
<td></td>
<td>Available Range: 0.0–2.0 inches (0–50 mm)</td>
<td></td>
</tr>
<tr>
<td>Left/Right</td>
<td>0.1 inch (2 mm)</td>
<td>Sets the value in increments of 0.1 inch (1 mm).</td>
</tr>
<tr>
<td></td>
<td>Available Range: 0.0–2.0 inches (0–50 mm)</td>
<td></td>
</tr>
<tr>
<td>Middle</td>
<td>0.0 inches (0 mm)</td>
<td>Sets the value in increments of 0.1 inch (1 mm).</td>
</tr>
<tr>
<td></td>
<td>Available Range: 0.0–2.0 inches (0–50 mm)</td>
<td></td>
</tr>
</tbody>
</table>

**Auto Exposure**

**Purpose:**
To suppress the background of the original to enhance text.

**Values:**

<table>
<thead>
<tr>
<th>Auto Exposure Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
<td>Does not suppress the background.</td>
</tr>
<tr>
<td>On</td>
<td></td>
<td>Suppresses the background to enhance text.</td>
</tr>
</tbody>
</table>

**Save Settings**

The Save Settings screen appears when is tapped under the Copy menu.

Use Save Settings to save a variety of copy features. And also use to create and edit custom tiles for Copy.

**ID Copy**

You can configure a variety of ID copy features under the ID Copy menu.

**Values:**

<table>
<thead>
<tr>
<th>ID Copy Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>For details about each menu, see &quot;Copy.&quot;</td>
</tr>
<tr>
<td>Darken / Lighten</td>
<td></td>
</tr>
<tr>
<td>Select Tray</td>
<td></td>
</tr>
<tr>
<td>Sharpness</td>
<td></td>
</tr>
<tr>
<td>Auto Exposure</td>
<td></td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td></td>
</tr>
</tbody>
</table>

**Save Settings**

The Save Settings screen appears when is tapped under the ID Copy menu.

Use Save Settings to save a variety of ID Copy features. And also use to create and edit custom tiles for ID Copy.
Scan

As a default setting, the printer provides the following scan feature tiles on the Home screen: Scan to Email, Scan to Network Folder, Scan to USB, and Scan to Computer.

Scan to Email

Purpose:
To use the e-mail to send the scanned image. See "Scan Settings" for more details about the various scan options you can set for the scan.

Values:

<table>
<thead>
<tr>
<th>Enter Recipient's Address</th>
<th>Enters the e-mail address of the recipient using the keyboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Book</td>
<td>Selects an e-mail address from the local address book.</td>
</tr>
<tr>
<td>Individuals</td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td>Selects an e-mail group from the local address book.</td>
</tr>
<tr>
<td>Network Address Book</td>
<td>Searches an e-mail address from the server address book.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sender*1</th>
<th>Enters the e-mail address of the sender using the keyboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard</td>
<td>Selects an e-mail address of the sender from the local address book.</td>
</tr>
<tr>
<td>Address Book</td>
<td></td>
</tr>
<tr>
<td>Network Address Book</td>
<td>Searches an e-mail address of the sender from the server address book.</td>
</tr>
</tbody>
</table>

*1 The sender's e-mail address cannot be edited when the remote authentication is used as the user authentication method on the Dell Smart Multifunction Printer | S2815dn.

Scan to Network Folder

Purpose:
To store the scanned image on a network server or a computer. See "Scan Settings" for more details about the various scan settings you can set for the scan.

Values:

<table>
<thead>
<tr>
<th>Address Book</th>
<th>Selects a FTP address or Server Message Block (SMB) protocol address from the local address book.</th>
</tr>
</thead>
</table>

Scan to USB

Purpose:
To save the scanned image to a USB memory attached to the printer. See "Scan Settings" for more details about the various scan settings you can set for the scan.

Values:

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Selects which folder the scanned image is saved to.</th>
</tr>
</thead>
</table>

Scan to Computer

Purpose:
To save scanned data on a network computer connected using Web Services on Devices (WSD), or on a computer connected via a USB cable.
NOTE: Web Services on Devices (WSD) is supported only on Microsoft® Windows Vista® (SP2 or later), Windows® 7, Windows® 8, Windows® 8.1, and Windows® 10.

Values:

<table>
<thead>
<tr>
<th>Computer (via USB)</th>
<th>Saves scanned data on a computer connected via USB cable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan to <strong>Computer Name</strong></td>
<td>Selects which computer the scanned image is saved to. Up to 20 computers will be listed.</td>
</tr>
<tr>
<td><strong>Scan</strong></td>
<td>Sends the scanned image to the computer according to the chosen event. Which application each event is associated with depends on the setting on the computer.</td>
</tr>
<tr>
<td><strong>Scan for Print</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Scan for Email</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Scan for Fax</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Scan for OCR</strong></td>
<td></td>
</tr>
</tbody>
</table>

Scan Settings

The Scan Settings screen appears when the  is tapped on the Scan to Email, Scan to Network Folder, or Scan to USB screen, or when Computer (via USB) is tapped on the Scan to Computer screen..

Use Scan Settings to configure a variety of scan features.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Output Color

Purpose:
To select color or black and white scanning.

Values:

<table>
<thead>
<tr>
<th>Color</th>
<th>Scans in color mode. Works well with texts and photos.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
<td>Scans in color mode. Works well with texts and photos.</td>
</tr>
<tr>
<td><strong>Black &amp; White</strong></td>
<td>Scans in black and white mode. Works well with texts.</td>
</tr>
<tr>
<td><strong>Gray Scale</strong></td>
<td>Scans in grayscale mode. Works well with texts and photos.</td>
</tr>
</tbody>
</table>

Resolution

Purpose:
To specify the resolution of the scanned image.

Values:

<table>
<thead>
<tr>
<th><strong>Resolution</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>200 dpi*</td>
<td></td>
</tr>
<tr>
<td>300 dpi</td>
<td></td>
</tr>
<tr>
<td>400 dpi</td>
<td></td>
</tr>
<tr>
<td>600 dpi</td>
<td></td>
</tr>
</tbody>
</table>

File Format

Purpose:
To specify the file format to save the scanned image.

Values:

| **File Format** |
|-----------------|-----------------|
| PDF*            |                 |
Understanding the Printer Menus

Multi-Page TIFF
TIFF (1 File per Page)
JPEG (1 File per Page)

2 Sided Scanning
Purpose:
To specify whether to scan both sides of a document.
Values:

<table>
<thead>
<tr>
<th>1 Sided</th>
<th>2 Sided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scans one side of a document.</td>
<td>Long Edge Binding: Scans both sides of a document bound by the long edge.</td>
</tr>
</tbody>
</table>

Darken / Lighten
Purpose:
To adjust the density to make the scanned image darker or lighter than the original.
Values:

<table>
<thead>
<tr>
<th>Darken 3</th>
<th>Darken 2</th>
<th>Darken 1</th>
<th>Normal*</th>
<th>Lighten 1</th>
<th>Lighten 2</th>
<th>Lighten 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Works well with light documents or faint pencil markings.</td>
<td>Works well with standard typed or printed documents.</td>
<td>Works well with dark documents.</td>
<td>Works well with standard typed or printed documents.</td>
<td>Works well with light documents or faint pencil markings.</td>
<td>Works well with light documents or faint pencil markings.</td>
<td>Works well with light documents or faint pencil markings.</td>
</tr>
</tbody>
</table>

Contrast
Purpose:
To adjust the amount of colors to make the contrast of colors darker or lighter than the original.
Values:

<table>
<thead>
<tr>
<th>High</th>
<th>Medium*</th>
<th>Low</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusts the amount of colors to make the contrast of colors darker than the original.</td>
<td>Does not adjust the amount of colors to make the contrast of colors darker or lighter than the original.</td>
<td>Adjusts the amount of colors to make the contrast of colors lighter than the original.</td>
</tr>
</tbody>
</table>

Sharpness
Purpose:
To adjust the sharpness to make the scanned image sharper or softer than the original.
Values:

<table>
<thead>
<tr>
<th>Sharpen</th>
<th>Normal*</th>
<th>Soften</th>
</tr>
</thead>
<tbody>
<tr>
<td>Makes the scanned image sharper than the original.</td>
<td>Does not make the scanned image sharper or softer than the original.</td>
<td>Makes the scanned image softer than the original.</td>
</tr>
</tbody>
</table>
**Auto Exposure**

**Purpose:**
To suppress the background of the original to enhance text on the copy.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not suppress the background.</td>
</tr>
<tr>
<td>On*</td>
<td>Suppresses the background to enhance text.</td>
</tr>
</tbody>
</table>

**Original Size**

**Purpose:**
To specify the default paper size.

**Values:**

- mm series
  - A4 (210x297mm) *1
  - A5 (148x210mm)
  - B5 (182x257mm)
  - Letter (8.5x11”)
  - Folio (8.5x13”)
  - Legal (8.5x14”)
  - Statement (5.5x8.5”)
  - Executive (7.3x10.5”)

  *1 Denotes country-specific factory default values.

- inch series
  - Letter (8.5x11”) *1
  - Folio (8.5x13”)
  - Legal (8.5x14”)
  - Statement (5.5x8.5”)
  - A4 (210x297mm)
  - A5 (148x210mm)
  - B5 (182x257mm)
  - Executive (7.3x10.5”)

  *1 Denotes country-specific factory default values.

**Margin**

**Purpose:**
To specify the top, bottom, right, left, and middle margins of the scanned image.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>0.1 inch (2 mm)</td>
</tr>
</tbody>
</table>

Sets the value in increments of 0.1 inch (1 mm).

**Available Range:** 0.0–2.0 inches (0–50 mm)
### Create Folder

**NOTE:** Create Folder feature is available only for Scan to USB or Scan to Network Folder.

**Purpose:**
To specify whether to create a folder when saving scanned images.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not create a folder when saving a scanned image.</td>
</tr>
<tr>
<td>On</td>
<td>Creates a folder when saving a scanned image.</td>
</tr>
</tbody>
</table>

### File Naming Mode

**Purpose:**
To specify the detailed setting of File Naming Mode.

**Values:**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Sets the default file name.</td>
</tr>
<tr>
<td>Add Prefix</td>
<td>Adds texts in front of the file name.</td>
</tr>
<tr>
<td>Prefix/Suffix String</td>
<td>Specifies the texts that are added when Add Prefix is selected.</td>
</tr>
<tr>
<td>Add Suffix</td>
<td>Adds texts after the file name.</td>
</tr>
<tr>
<td>Prefix/Suffix String</td>
<td>Specifies the texts that are added when Add Suffix is selected.</td>
</tr>
</tbody>
</table>

### Save Settings

The **Save Settings** screen appears when is tapped on the **Scan Settings** screen of the Scan to Email, Scan to Network Folder, or Scan to USB feature, and on the **Scan to Computer** screen.

Use **Save Settings** to save a variety of scan features. And also use to create and edit custom tiles for Scan.
**Fax**

Use the Fax menus to configure a variety of fax features.

**NOTE:** The Fax function cannot be used unless you set up a country code under Country. If Country is not set up, a message Set the Country Code appears on the display.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Values:**

<table>
<thead>
<tr>
<th>Enter Number</th>
<th>Enters the fax number using the keyboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed Dial</td>
<td>Enters the speed dial number stored in the printer.</td>
</tr>
<tr>
<td><strong>Phone Book</strong></td>
<td></td>
</tr>
<tr>
<td>Individuals</td>
<td>Selects a fax number from the local address book.</td>
</tr>
<tr>
<td>Groups</td>
<td>Selects a group dial number from the local address book.</td>
</tr>
<tr>
<td><strong>Network Phone Book</strong></td>
<td>Searches a fax number from the server address book.</td>
</tr>
<tr>
<td><strong>On Hook</strong></td>
<td></td>
</tr>
<tr>
<td>Send*</td>
<td>Sends faxes manually.</td>
</tr>
<tr>
<td>Receive</td>
<td>Receives faxes manually.</td>
</tr>
<tr>
<td>Polling</td>
<td>Manually retrieves information from a remote machine.</td>
</tr>
</tbody>
</table>

**Fax Settings**

The Fax Settings screen appears when 📞 is tapped on the Fax screen.

Use Fax Settings to configure a variety of fax features.

**Darken / Lighten**

**Purpose:**
To adjust the density to make the copy darker or lighter than the original.

**Values:**

| Darken 3 | Works well with light documents or faint pencil markings. |
| Darken 2 |
| Darken 1 |
| Normal* | Works well with standard typed or printed documents. |
| Lighten 1 | Works well with dark documents. |
| Lighten 2 |
| Lighten 3 |

**2 Sided Scanning**

**Purpose:**
To specify whether to scan both sides of a document.

**Values:**

| 1 Sided* | Scans one side of a document. |
| 2 Sided  | Long Edge Binding* | Scans both sides of a document bound by the long edge. |
|          | Short Edge Binding | Scans both sides of a document bound by the short edge. |
### Polling Receive
**Purpose:**
To receive faxes from the remote fax machine when you want to receive it.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not receive faxes using Polling Receive.</td>
</tr>
<tr>
<td>On</td>
<td>Receives faxes using Polling Receive.</td>
</tr>
</tbody>
</table>

### Resolution
**Purpose:**
To specify the scan resolution to improve the output quality.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard*</td>
<td>Suitable for documents with normal sized characters.</td>
</tr>
<tr>
<td>Fine</td>
<td>Suitable for documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td>Super Fine</td>
<td>Suitable for documents containing extremely fine detail. The Super Fine mode is enabled only if the remote machine also supports the Super Fine mode. See the notes below.</td>
</tr>
<tr>
<td>Photo</td>
<td>Suitable for documents containing photographic images.</td>
</tr>
</tbody>
</table>

**NOTE:** Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

### Fax Cover Page
**Purpose:**
To set whether to attach a cover page to faxes.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not attach a cover page to faxes.</td>
</tr>
<tr>
<td>On</td>
<td>Attaches a cover page to faxes.</td>
</tr>
</tbody>
</table>

### Delayed Send
**Purpose:**
To send a fax at a later time.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not send a fax at a later time.</td>
</tr>
<tr>
<td>On</td>
<td>Sets the fax transmission start time when sending a fax at a specified time.</td>
</tr>
</tbody>
</table>

**NOTE:** A maximum of 19 delayed fax jobs can be stored.

### Save Settings
The Save Settings screen appears when icon is tapped on the Fax Settings screen.

Use Save Settings to save a variety of fax features. And also use to create and edit custom tiles for Fax.

**NOTE:** Up to 30 addresses can be stored on the printer. If you have the addresses of more than 31, you cannot save settings of fax features. In that case, please reduce to 30.
Print PDF/TIFF

**NOTE:** Print PDF/TIFF function is available only when a USB memory is inserted in the front USB port.

**Purpose:**
To specify the document stored in the root, file, or folder in a USB memory. See "Print Settings" for more details about the various print settings you can set for the print.

Print JPEG

**NOTE:** Print JPEG function is available only when a USB memory is inserted in the front USB port.

**Purpose:**
To specify the photos stored in the root, file, or folder in a USB memory. See "Print Settings" for more details about the various print settings you can set for the print.

Print Settings

The Print Settings screen appears when 📁 is tapped on the Print PDF/TIFF or Print JPEG screen.

Use Print Settings to configure a variety of print features.

**Quantity**

**Purpose:**
To specify the number of copies from 1 to 99.

**Select Tray**

**Purpose:**
To specify the input tray.

**Values:**

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>mm series</th>
<th>inch series</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210x297mm)</td>
<td></td>
<td>Letter (8.5x11&quot;)</td>
</tr>
<tr>
<td>A5 (148x210mm)</td>
<td></td>
<td>Folio (8.5x13&quot;)</td>
</tr>
<tr>
<td>B5 (182x257mm)</td>
<td></td>
<td>Legal (8.5x14&quot;)</td>
</tr>
<tr>
<td>Letter (8.5x11&quot;)</td>
<td>A5 (148x210mm)</td>
<td>Statement (5.5x8.5&quot;)</td>
</tr>
<tr>
<td>Folio (8.5x13&quot;)</td>
<td>B5 (182x257mm)</td>
<td></td>
</tr>
<tr>
<td>Legal (8.5x14&quot;)</td>
<td>Letter (8.5x11&quot;)</td>
<td></td>
</tr>
<tr>
<td>Statement (5.5x8.5&quot;)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 2 Sided Printing

**Purpose:**
To print on both sides of a sheet of paper.

**Values:**

<table>
<thead>
<tr>
<th>1 Sided</th>
<th>Does not print on both sides of a sheet of paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Sided</td>
<td>Prints on both sides of a sheet of paper to be bound by the long edge.</td>
</tr>
<tr>
<td>Short Edge Binding</td>
<td>Prints on both sides of a sheet of paper to be bound by the short edge.</td>
</tr>
</tbody>
</table>

### Layout

**Purpose:**
To specify the output layout.

**Values:**

| 1-Up | Prints one page on one side of a sheet of paper. |
| 2-Up | Prints two pages on one side of a sheet of paper. |
| 4-Up | Prints four pages on one side of a sheet of paper. |
| Off (No Scaling) | Prints without scaling. |

---

**Paper Type**

- A4 (210x297mm)
- A5 (148x210mm)
- B5 (182x257mm)
- Plain (60-80g/m²)
- Plain Thick (81-105g/m²)
- Covers (106-163g/m²)
- Covers Thick (164-216g/m²)
- Rough Surface
- Labels
- Envelope
- Recycled
- Japanese Postcard
- Letterhead
- Preprinted
- Prepunched
- Color

**Tray1**
The paper is fed from tray1.

**Tray2**
The paper is fed from the optional 550-sheet feeder.

---

* Denotes country-specific factory default value.
**Image Types**

**Purpose:**
To set the print image quality.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Prints PDF/TIFF files in the <strong>Text</strong> mode and JPEG files in the <strong>Photos (Standard Quality)</strong> mode.</td>
</tr>
<tr>
<td>Photos (Standard Quality)</td>
<td>Prints the photographic images at the standard quality.</td>
</tr>
<tr>
<td>Photos (High Quality)</td>
<td>Prints the photographic images at the high quality.</td>
</tr>
<tr>
<td>Text</td>
<td>Prints the text document at the standard quality.</td>
</tr>
</tbody>
</table>

**Collation**

**Purpose:**
To specify whether to sort the job.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collated</td>
<td>Sorts a job.</td>
</tr>
<tr>
<td>Uncollated</td>
<td>Does not sort a job.</td>
</tr>
</tbody>
</table>

**PDF Password**

**Purpose:**
To enter the password when you print a PDF file secured with a document open password (password to open the PDF file).

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter PDF Password</td>
<td>Enter the document open password to print the secure PDF job.</td>
</tr>
</tbody>
</table>

**Save Settings**

The *Save Settings* screen appears when is tapped on the *Print Settings* screen.

Use *Save Settings* to save a variety of print features. And also use to create and edit custom tiles for USB Direct Print.

**Dell Document Hub**

- **NOTE:** The Dell Document Hub feature is available on the Dell Cloud Multifunction Printer | H815dw only.

Use the Dell Document Hub menus to configure a variety of the Dell Document Hub features.

**Search for Files**

**Purpose:**
To search the files saved in the cloud services, and print them from the printer.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Box</td>
<td>Enters the keywords, such as the words including the file name.</td>
</tr>
<tr>
<td>📜</td>
<td>Sorts the searching results by selecting the sorting order.</td>
</tr>
</tbody>
</table>
Sets the settings of the Print Settings.

Displays the selected files. The first three pages of each file are displayed in the small previews.

**Browse for Files**

**Purpose:**
To browse and print the files saved in the selected cloud services.

**Values:**

<table>
<thead>
<tr>
<th><strong>Text Box</strong></th>
<th>Enters the keywords, such as the words including the file name.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Search</strong></td>
<td>Searches for the files in the current location or the selected cloud services.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Displays the selected files. The first three pages of each file are displayed in the small previews.</td>
</tr>
<tr>
<td><strong>Sort</strong></td>
<td>Sorts the searching results by selecting the sorting order.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the settings of the Print Settings as Favorite.</td>
</tr>
</tbody>
</table>

**Scan**

**Purpose:**
To scan the document and save the scanned file in the cloud service.

**Values:**

<table>
<thead>
<tr>
<th><strong>File Name</strong></th>
<th>Enters the file name you want to use.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Format</strong></td>
<td>Selects the file format from the list to save the scanned image.</td>
</tr>
<tr>
<td><strong>Tag</strong></td>
<td>Enters the tag you want to use.</td>
</tr>
<tr>
<td><strong>Search</strong></td>
<td>Searches for the location to save the scanned file. You can search for the location across the cloud services.</td>
</tr>
<tr>
<td><strong>Sort</strong></td>
<td>Sorts the searching results by selecting the sorting order.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Sets the settings of the Scan Settings.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the settings of the Scan Settings as Favorite.</td>
</tr>
</tbody>
</table>

**PDF Password**

**Purpose:**
To enter the password when you print a PDF file secured with a document open password (password to open the PDF file).

**Values:**

| **Enter PDF Password** | Enters the document open password to print the secure PDF job. |

**File Name Option**

**Purpose:**
To specify the way to name the scanned document.

**Values:**

| **Off** | Adds no text in front of the file name or after the file name. |
Understanding the Printer Menus

For more information on other settings, see "Scan Settings."

**Smart OCR Scan**

**Purpose:**
To scan the document using OCR and save it in the cloud service.

**Values:**

<table>
<thead>
<tr>
<th>Add Prefix</th>
<th>Adds texts in front of the file name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix/Suffix String</td>
<td>Specifies the texts that are added when Add Prefix is selected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add Suffix</th>
<th>Adds texts after the file name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix/Suffix String</td>
<td>Specifies the texts that are added when Add Suffix is selected.</td>
</tr>
</tbody>
</table>

**File Name**
Enters the file name you want to use.

**File Format**
Selects the file format from the list to save the scanned image.

**Tag**
Enters the tag you want to use.

**Search**
Searches for the location to save the scanned file. You can search for the location across the cloud services.

**Sorts**
Sorts the searching results by selecting the sorting order.

**Sets**
Sets the settings of the Scan Settings.

**Saves**
Saves the settings of the Scan Settings as Favorite.

**File Format**
Purpose:
To specify the file format to save the scanned image.

**Values:**

<table>
<thead>
<tr>
<th>PDF(Searchable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTF</td>
</tr>
<tr>
<td>DOC</td>
</tr>
<tr>
<td>DOCX</td>
</tr>
<tr>
<td>XLS</td>
</tr>
<tr>
<td>XLSX</td>
</tr>
<tr>
<td>PPTX</td>
</tr>
</tbody>
</table>

**OCR Language**
Purpose:
To specify the language for the OCR.

**Values:**

<table>
<thead>
<tr>
<th>Auto</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
</tr>
<tr>
<td>Français</td>
</tr>
</tbody>
</table>
### PDF Password

**Purpose:**
To enter the password when you print a PDF file secured with a document open password (password to open the PDF file).

**Values:**

<table>
<thead>
<tr>
<th>Enter PDF Password</th>
<th>Enters the document open password to print the secure PDF job.</th>
</tr>
</thead>
</table>

### Remove Blank Page

**Purpose:**
To specify whether to remove the blank pages.

**Values:**

<table>
<thead>
<tr>
<th>Off</th>
<th>Disables the Remove Blank Page feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Enables the Remove Blank Page feature.</td>
</tr>
</tbody>
</table>

### File Name Option

**Purpose:**
To specify the way to name the scanned document.

**Values:**

<table>
<thead>
<tr>
<th>Off</th>
<th>Adds no text in front of the file name or after the file name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Prefix</td>
<td>Adds texts in front of the file name.</td>
</tr>
<tr>
<td>Prefix/Suffix String</td>
<td>Specifies the texts that are added when Add Prefix is selected.</td>
</tr>
<tr>
<td>Add Suffix</td>
<td>Adds texts after the file name.</td>
</tr>
<tr>
<td>Prefix/Suffix String</td>
<td>Specifies the texts that are added when Add Suffix is selected.</td>
</tr>
</tbody>
</table>

For more information on other settings, see "Scan Settings."
**E-mail Me**

**Purpose:**
To scan the document and send to you as an attached file of an e-mail.

**Values:**

<table>
<thead>
<tr>
<th>File Format</th>
<th>Selects the file format from the list to save the scanned image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Enters the subject you want to use.</td>
</tr>
<tr>
<td></td>
<td>Sets the settings of the Scan Settings.</td>
</tr>
<tr>
<td></td>
<td>Saves the settings of the Scan Settings as Favorite.</td>
</tr>
</tbody>
</table>

**File Format**

**Purpose:**
To specify the file format to save the scanned image.

**Values:**

- PDF
- PDF(Searchable)
- RTF
- DOC
- DOCX
- XLS
- XLSX
- PPTX
- Multi-Page TIFF
- TIFF
- JPEG

**OCR Language**

**Purpose:**
To specify the language for the OCR.

**Values:**

- Auto
- English
- Français
- Italiano
- Deutsch
- Español
- Dansk
- Nederlands
- Norsk
- Svenska
**PDF Password**

**Purpose:**
To enter the password when you print a PDF file secured with a document open password (password to open the PDF file).

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter PDF Password</td>
<td>Enter the document open password to print the secure PDF job.</td>
</tr>
</tbody>
</table>

**Remove Blank Page**

**Purpose:**
To specify whether to remove the blank pages.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables the Remove Blank Page feature.</td>
</tr>
<tr>
<td>On</td>
<td>Enables the Remove Blank Page feature.</td>
</tr>
</tbody>
</table>

For more information on other settings, see "Scan Settings."

**Business Card Reader**

**Purpose:**
To scan the business card and send to you as an attached file (.vCard format) of an e-mail.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Enters the subject you want to use.</td>
</tr>
</tbody>
</table>

**SharePoint**

Expiration: The SharePoint feature is available on the Dell Smart Multifunction Printer | S2815dn only.

Use the SharePoint menus to configure a variety of the SharePoint® features.

**Print**

**Purpose:**
To browse and print the files saved in the selected SharePoint® server.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Box</td>
<td>Enter the keywords, such as the words included in the file name.</td>
</tr>
<tr>
<td></td>
<td>Sets the settings of the Print Settings.</td>
</tr>
</tbody>
</table>
**Scan**

**Purpose:**
To scan the document and save the scanned data in the selected SharePoint® server.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File name</strong></td>
<td>Enter the file name you want to use.</td>
</tr>
<tr>
<td><strong>File Format</strong></td>
<td>Selects the file format from the list to save the scanned data.</td>
</tr>
<tr>
<td></td>
<td>Searches for the folder in the selected SharePoint® server.</td>
</tr>
<tr>
<td></td>
<td>Sets the settings of the Scan Settings.</td>
</tr>
</tbody>
</table>

**File Name Option**

**Purpose:**
To specify the way to name the scanned document.

**Values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Off</strong></td>
<td>Adds no text in front of the file name or after the file name.</td>
</tr>
<tr>
<td><strong>Add Prefix</strong></td>
<td>Adds texts in front of the file name.</td>
</tr>
<tr>
<td><strong>Prefix/Suffix String</strong></td>
<td>Specifies the texts that are added when Add Prefix is selected.</td>
</tr>
<tr>
<td><strong>Add Suffix</strong></td>
<td>Adds texts after the file name.</td>
</tr>
<tr>
<td><strong>Prefix/Suffix String</strong></td>
<td>Specifies the texts that are added when Add Suffix is selected.</td>
</tr>
</tbody>
</table>

For more information on other settings, see "Scan Settings."

**NOTE:** You cannot assign the password to the PDF file when saving the scanned data to the SharePoint® server.

**Add Apps**

Use the Add Apps menu to add a variety of tiles on the Home screen.

**Panel Lock**

This feature prevents unauthorized personnel from changing the settings made by the administrator.

**NOTE:** Disabling the operator panel menus does not prevent access to the Stored Print and Tray Settings menus.

**Enabling the Panel Lock**

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap ▼ until Secure Settings appears, and then tap Secure Settings.
4. Tap Panel Lock.
5. Tap Panel Lock Control.
6. Tap Enable, and then tap OK.
Enter the new password, and then tap OK.

⚠️ **CAUTION:** Be sure to remember the password. The procedure described below allows you to reset the password, but the settings for Address Book and Phone Book are cleared.

- Turn off the printer. Then, while holding the Information button, turn on the printer. Perform steps 7 and 8.

Re-enter the password to confirm the password that you entered, and then tap OK.

To change the password while Panel Lock is Enable, perform steps 1 to 4 above, and then tap Change Password. Perform steps 7 and 8 above to change the password.

### Disabling the Panel Lock

1. Press the Information button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Enter the password.
4. Tap until Secure Settings appears, and then tap Secure Settings.
5. Tap Panel Lock.
6. Tap Panel Lock Control.
7. Tap Disable, and then tap OK.
8. Enter the current password, and then tap OK.

### Resetting Defaults

After executing this function and rebooting the printer, the phone book, address book, or menu parameters are reset to their default values.

The following menu parameters are exceptions and are not reset.

- Network settings
- Panel Lock settings and password
- Functions Control settings (Copy, Scan to E-mail, Fax, Scan to Network Folder, Scan to Computer, PC Scan, Scan to USB, USB Direct Print) and passwords
- Secure Receive settings and password
- Login Error settings
- Set Available Time settings
- Secure Job Expiration settings
- USB Port settings
- AccessControl Mode settings
- AccessControl Error Report settings
- Non Registered User settings
- NFC Authentication settings
- Tap to Print settings
When Using the Operator Panel

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Maintenance.
4. Tap ▼ until Reset Defaults appears, and then tap Reset Defaults.
5. Tap the desired setting, and then tap Initialize.

<table>
<thead>
<tr>
<th>User Fax Section</th>
<th>Resets the phone book data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Scan Section</td>
<td>Resets the address book data.</td>
</tr>
<tr>
<td>User Account Section</td>
<td>Resets the user registration information.</td>
</tr>
<tr>
<td>System Section</td>
<td>Resets the system parameters.</td>
</tr>
</tbody>
</table>

6. Tap Yes, Reset.
   The printer is restarted automatically.
Print Media Guidelines

Print media refers to paper, labels, envelopes, and coated paper among others. Your printer provides high-quality printing on a variety of print media. Selecting the appropriate print media for your printer helps avoid printing troubles. This section describes selecting and caring for print media.

NOTE: Use only laser print media. Do not use ink jet paper in your printer.

Paper

For the best print quality, use 90 g/m² (24 lb) xerographic, grain long paper. It is recommended that you try a sample first before buying large quantities of any print media.

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See "Loading Print Media in Tray1 and the Optional 550-Sheet Feeder" and "Loading Print Media in the MPF" for detailed loading instructions.

Recommended Paper

To ensure the best print quality and feed reliability, use 75 g/m² (20 lb) xerographic paper. Business paper designed for general business use also provides acceptable print quality. Only use paper able to withstand high temperatures without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper to high temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is acceptable for laser printers.

It is recommended that you try a sample first before buying large quantities of any print media. When choosing any print media, you should consider the weight, fiber content, and color.

Unacceptable Paper

The following paper types are not recommended for use with the printer:

- Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, carbonless copy paper (CCP), or no carbon required (NCR) paper.
- Preprinted paper with chemicals that may contaminate the printer.
- Preprinted paper that can be affected by the temperature in the fusing unit.
- Preprinted paper that requires a registration (the precise print location on the page) greater than ±0.09 inches, such as optical character recognition (OCR) forms.
  
  In some cases, you can adjust registration with your software program to successfully print on these forms.
- Coated paper (erasable bond), synthetic paper, and thermal paper.
- Rough-edged, rough or heavily textured surface paper, or curled paper.
- Recycled paper containing more than 25 % post-consumer waste that does not meet DIN 19 309.
- Multiple-part forms or documents.
- Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper.
Selecting Paper

Proper paper selection helps prevent jams and ensures trouble-free printing.

To help avoid jams or poor print quality:

- Always use new, undamaged paper.
- Before loading the paper, identify the recommended print side of the paper. This information is usually indicated on the paper package.
- Do not use paper that you have cut or trimmed.
- Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam.
- Do not remove the tray while printing is in progress.
- Ensure that the paper is properly loaded in the tray.
- Flex the paper back and forth, and then fan them. Straighten the edges of the stack on a level surface.

Selecting Pre-Printed Media and Letterheads

When selecting pre-printed and letterhead paper for the printer:

- Use grain long paper for best results.
- Use only forms and letterheads printed using an offset lithographic or engraved printing process.
- Select paper that absorb ink, but does not bleed.
- Avoid paper with rough or heavily textured surfaces.
- Use paper printed with heat-resistant inks designed for use in xerographic copying machines. The ink must withstand temperatures of 225 °C (437 °F) without melting or releasing hazardous emissions.
- Use inks that are not affected by the resin in the toner or the silicone in the fusing unit. Inks that are oxidation-set or oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier.

Selecting Pre-Punched Paper

When selecting pre-punched paper for the printer:

- Test paper from several manufacturers before ordering and using large quantities of pre-punched paper.
- Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled paper can cause jams when multiple sheets feed through the printer. This may result in a paper jam.
- Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent cleaning and feed reliability may not be as good as standard paper.
- Weight guidelines for pre-punched paper are the same as non-punched paper.
Envelopes

Depending on the envelopes, it is possible to expect variable levels of wrinkling. It is recommended that you try a sample first before buying large quantities of any print media. See "Loading Envelopes in the MPF" for instructions on loading envelopes.

When printing on envelopes:

- Use only high-quality envelopes that are designed for use in laser printers.
- Set the print media source to the MPF. Set the paper type to Envelope, and select the correct size of envelope from the printer driver.
- Use envelopes made from 75 g/m² (20 lb bond) paper. You can use up to 105 g/m² (28 lb bond) weight for the envelope feeder as long as the cotton content is 25 % or less. Envelopes with 100 % cotton content must not exceed 90 g/m² (24 lb bond) weight.
- Use only freshly unpackaged, undamaged envelopes.
- Use envelopes that can withstand temperatures of 205 °C (401 °F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the envelope supplier.
- Adjust the guide to fit the width of the envelopes.
- To load an envelope into the MPF, insert the envelope with the flaps closed or open and the short-edge of the envelope facing into the printer. The print side must be facing up.
- See "Loading Envelopes in the MPF" for instructions on loading envelopes.
- Use one envelope size during a print job.
- Ensure that the humidity is low because high humidity (more than 60 %) and the high printing temperatures may seal the envelopes.
- For best performance, do not use envelopes that:
  - Have excessive curl or twist
  - Are stuck together or damaged in any way
  - Contain windows, holes, perforations, cutouts, or embossing
  - Use metal clasps, string ties, or metal folding bars
  - Have an interlocking design
  - Have postage stamps attached
  - Have any exposed adhesive when the flap is in the sealed or closed position
  - Have nicked edges or bent corners
  - Have rough, cockle, or laid finishes
Labels

Your printer can print on many labels designed only for use with laser printers.

When selecting labels:

- Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205 °C (401 °F) and pressure of 25 pounds per square inch (psi).
- Use labels that can be without sealing, excessive curling, wrinkling, or releasing hazardous emissions.
- Do not use label sheets with a slick backing material.

⚠️ CAUTION: Before buying large quantities of any print media, it is recommended that you try a sample first.

When printing on labels:

- Use labels that can withstand temperatures of 205 °C (401 °F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions.
- Set the paper type to Label in the printer driver.
- Load labels in the MPF Tray1 and the optional 550-sheet feeder do not support labels.
- Do not load labels together with paper in the MPF.
- Do not print within 1 mm (0.04 inches) of the die-cut.
- Do not print within 1 mm (0.04 inches) of the edge of the label, of the perforations, or between die-cuts of the label.
- Do not print a label through the printer more than once.
- Portrait orientation is preferred, especially when printing bar codes.
- Do not use labels that have exposed adhesive.
- Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam.
- Do not use label sheets that have adhesive to the edge of the sheet. It is recommended that zone coating of the adhesive is done at least 1 mm (0.04 inches) away from edges. Adhesive material contaminates your printer and could void your warranty.

⚠️ WARNING: Otherwise a jam occurs in the printer and contaminate your printer and your cartridge with adhesive. As a result, could void your printer and cartridge warranties.

Storing Print Media

For proper print media storage, the following guidelines will help to avoid media feeding problems and uneven print quality.

- Store print media in an environment where the temperature is approximately 21 °C (70 °F) and the relative humidity is 40 %.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so that the edges do not buckle or curl.
- Do not place anything on top of the print media packages.
Identifying Print Media and Specifications

The following tables show print media information.

### Supported Paper Sizes

<table>
<thead>
<tr>
<th>Paper size</th>
<th>MPF</th>
<th>Tray1</th>
<th>Optional 550-sheet feeder</th>
<th>Duplex unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210 x 297 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A5 (148 x 210 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A6 (105 x 148 mm)</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>B5 (182 x 257 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>B6 (128 x 182 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Letter (8.5 x 11 in)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Folio (8.5 x 13 in)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Legal (8.5 x 14 in)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Statement (5.5 x 8.5 in)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Executive (7.25 x 10.5 in)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Envelope #10 (4.125 x 9.5 in)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Monarch (3.875 x 7.5 in)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>DL (110 x 220mm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>C5 (162 x 229mm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Postcard JPN</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Custom*1,2</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

*1 Custom: width: 76.2 mm (3.0 inches) to 215.9 mm (8.5 inches) for the MPF and tray1; 139.7 mm (5.5 inches) to 215.9 mm (8.5 inches) for the optional 550-sheet feeder

length: 127.0 mm (5.0 inches) to 355.6 mm (14.00 inches) for the MPF and tray1; 210 mm (8.27 inches) to 355.6 mm (14.00 inches) for the optional 550-sheet feeder

*2 XML Paper Specification (XPS) driver does not support custom size paper.
Supported Paper Types

<table>
<thead>
<tr>
<th>Paper type</th>
<th>MPF Side 1</th>
<th>MPF Side 2</th>
<th>Tray1 Side 1</th>
<th>Tray1 Side 2</th>
<th>Optional 550-sheet feeder Side 1</th>
<th>Optional 550-sheet feeder Side 2</th>
<th>Duplex unit Side 1</th>
<th>Duplex unit Side 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Covers</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Rough surface</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Labels</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Envelope</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Recycled</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Japanese Postcard</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Letterhead</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Preprinted</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Prepunched</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Color</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
</tbody>
</table>

**NOTE:** For Plain paper, you can set the paper density by selecting the Paper Density (Light or Normal) under Maintenance from the operator panel, the Tool Box, or the Dell™ Printer Configuration Web Tool. Once you set the Paper Density settings, the printer uses the settings for Plain paper.

**NOTE:** Rough Surface paper can only be fed one by one.

Paper Type Specifications

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight (g/m²)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>60–80</td>
<td>-</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>81–105</td>
<td>-</td>
</tr>
<tr>
<td>Covers</td>
<td>106–163</td>
<td>-</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>164–216</td>
<td>-</td>
</tr>
<tr>
<td>Rough surface</td>
<td>106–163</td>
<td>Inkjet printer paper cannot be used.</td>
</tr>
<tr>
<td>Labels</td>
<td>106–163</td>
<td>Inkjet printer paper cannot be used.</td>
</tr>
<tr>
<td>Envelope</td>
<td>91–105</td>
<td>-</td>
</tr>
<tr>
<td>Recycled</td>
<td>60–105</td>
<td>-</td>
</tr>
<tr>
<td>Japanese Postcard</td>
<td>190</td>
<td>Inkjet printer paper cannot be used.</td>
</tr>
<tr>
<td>Letterhead</td>
<td>60–90</td>
<td>-</td>
</tr>
<tr>
<td>Preprinted</td>
<td>60–90</td>
<td>-</td>
</tr>
<tr>
<td>Prepunched</td>
<td>60–90</td>
<td>-</td>
</tr>
<tr>
<td>Color</td>
<td>60–90</td>
<td>-</td>
</tr>
</tbody>
</table>
Loading Print Media

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading any print media, identify the recommended print side of the print media. This information is usually indicated on the print media package.

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Capacity

Tray1 can hold:
• 250 sheets of the standard paper.

The optional 550-sheet feeder (tray2) can hold:
• 550 sheets of the standard paper.

The multipurpose feeder (MPF) can hold:
• 50 sheets of the standard paper.

Print Media Dimensions

The maximum dimensions of print media that the MPF and tray1 can handle are:
• Width — 76.2 mm (3.00 inches) to 215.9 mm (8.5 inches)
• Length — 127 mm (5.00 inches) to 355.6 mm (14.00 inches)

The maximum dimensions of print media that the optional 550-sheet feeder can handle are:
• Width — 139.7 mm (5.5 inches) to 215.9 mm (8.5 inches)
• Length — 210 mm (8.27 inches) to 355.6 mm (14.00 inches)
Loading Print Media in Tray1 and the Optional 550-Sheet Feeder

This section describes how to load letterhead. For details about loading print media other than letterhead, see "Loading Paper."

NOTE: To avoid paper jams, do not remove the tray while printing is in progress.

NOTE: Use only laser print media. Do not use ink jet paper in the printer.

Loading Letterhead (Pre-Printed and Pre-Punched Paper)

The pre-printed paper such as letterhead and pre-punched paper must be inserted bottom edge first with the print side facing down as shown below.

NOTE: To enable printing with letterhead paper, set Paper Type to Letterhead and Letterhead Duplex Mode to Enable from the printer driver. Make sure to set Paper Type to Letterhead from the operator panel even when you print on a single side of letterhead, pre-printed, or pre-punched paper.

<table>
<thead>
<tr>
<th>Print media source</th>
<th>Print side</th>
<th>Page orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray1 and optional 550-sheet</td>
<td>Face down</td>
<td>Letterhead enters the printer last</td>
</tr>
<tr>
<td>feeder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPF</td>
<td>Face down</td>
<td>Letterhead enters the printer last</td>
</tr>
</tbody>
</table>

---

270 | Loading Print Media
Loading Print Media in the MPF

1 Gently pull open the MPF cover.

2 Slide the width guides to the edge of the tray. The width guides should be fully extended.

3 Insert all media face up and top edge first into the MPF.

**NOTE:** Do not force the print media into the MPF.
4 Slide both width guides until they rest lightly against the edge of the print media stack.

   NOTE: Do not force the print media into the MPF.

5 On the touch panel, tap Size.

6 Tap ▼ or ▲ until the desired paper size appears, and then select the size.

7 Tap Type.

8 Tap ▼ or ▲ until the desired paper type appears, and then select the type.

9 Tap OK.

Loading Small Print Media in the MPF

When loading small print media such as monarch envelope or the user-specified print media whose feed direction length is 191.6 mm or less in the MPF, remove the MPF from the printer.

1 Gently pull open the MPF cover.
2 Grasp both sides of the MPF, and then pull the MPF from the printer.

3 Slide the width guides to the edge of the tray. The width guides should be fully extended.

4 Pull up the length guide and slide it toward MPF cover until it stops.

5 Load the print media into the MPF with the recommended print side facing up so that the top edge of the print media enters the printer first.
6 Align the paper guides against the edges of the print media.

7 Insert the MPF into the printer.

8 On the touch panel, tap Size.

9 Tap \[\text{▼}\] or \[\text{▲}\] until the desired paper size appears, and then select the size.

10 Tap Type.

11 Tap \[\text{▼}\] or \[\text{▲}\] until the desired paper type appears, and then select the type.

12 Tap OK.
Printing on Envelopes – Envelope Mode

To print on envelopes with better print quality, set the printer to the envelope mode.

**NOTE:** Print jobs can be done on envelopes even when the printer is not set to the envelope mode. To get the better print results, set the printer to the envelope mode.

**NOTE:** When the printer is in the envelope mode, print jobs cannot be done while the paper type is set to other than envelopes.

**To Set the Printer to the Envelope Mode**

1. Pull the rear cover handle to open the rear cover.

2. Lift the levers on both sides of the fusing unit.

3. Slide the envelope switches on both sides of the fusing unit to the position.

**WARNING:** The fusing unit is hot. Do not touch it, doing so may cause burns.
4 Press down the levers on both sides of the fusing unit.

5 Close the rear cover.

To Cancel the Envelope Mode

1 Pull the rear cover handle to open the rear cover.
2 Lift the levers on both sides of the fusing unit.

3 Slide the envelope switches on the both sides of the fusing unit to the position.

⚠️ WARNING: The fusing unit is hot. Do not touch it, doing so may cause burns.

4 Press down the levers on both sides of the fusing unit.
5 Close the rear cover.

Loading Envelopes in the MPF

Use the following guidelines when loading envelopes in the MPF:

⚠️ **CAUTION:** Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can cause damage to the printer.

✅ **NOTE:** If you do not load envelopes in the MPF right after they have been removed from the packaging, they may bulge. To avoid jams, press firmly across the whole envelopes to flatten them as shown below before loading the envelopes in the MPF.

✅ **NOTE:** The maximum height (quantity) of envelopes that can be loaded in the MPF is approximately 15 mm (0.59 inches) (15 envelopes).

**Envelope #10, DL**

Load the envelopes in the short edge feed orientation with the flaps closed and the print side up. Ensure that the flaps come at the right when you face towards the printer.
**Monarch**

You need to pull up and slide the length guide. Load the envelopes in the short edge feed orientation with the flaps closed and the print side up. Ensure that the flaps come at the right when you face towards the printer.

![Image of Monarch loading](image)

**C5**

Load the envelopes in the short edge feed orientation with the flaps open or closed and the print side up. Ensure that the flaps come at the bottom with the flaps open or at the top with the flaps closed when you face towards the printer.

When you print with the orientation of the 1, position of the envelopes may be distorted on the output tray. In this case, set the orientation of the 2.

![Image of C5 loading](image)

**Loading Letterhead in the MPF**

When you use the MPF, letterhead and hole punched paper must be inserted bottom edge first with the print side facing down.

![Image of Letterhead loading](image)
Using the MPF

- Load only one size and type of print media during a single print job.
- To achieve the best possible print quality, use only high-quality print media that is designed for use in laser printer. For more guidelines on print media, see "Print Media Guidelines."
- Do not add or remove print media when there is still print media in the MPF or when the printer is printing from the MPF. This may result in a paper jam.
- Print media should be loaded with the recommended print side up and the top of the print media going into the MPF first.
- Do not place objects on the MPF. Also, avoid pressing down or applying excessive force on it.
- The icons on the MPF show how to load the MPF with paper, and how to turn an envelope for printing.

Linking Trays

The printer automatically links the trays when you load the same size and type of print media in them. The first tray will be utilized until the media runs out, and then the next tray will be used.

⚠️ **NOTE:** The print media should be the same size and type in each tray.
The MPF cannot be linked to any of the tray sources.

After loading the selected trays with the same size and type of print media, select the Paper Type setting in the Tray Settings component for each source (tray).

To disable tray linking change the paper type in one of the sources (trays) to a unique value.

⚠️ **NOTE:** If different types of print media of the same size are loaded in each tray, the printer will automatically link them if the paper type is not specified in the printer driver properties/preferences.
Printing

This chapter covers tips for printing, how to print certain information from your printer, and how to cancel a job.

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Tips for Successful Printing

Tips on Storing Print Media

Store your print media properly. For more information, see "Storing Print Media."

Avoiding Paper Jams

⚠️ **CAUTION:** Before buying large quantities of any print media, it is recommended that you try a sample first.

By selecting appropriate print media and loading it properly, you can avoid paper jams. See the following instructions on loading print media:

- "Loading Paper"
- "Loading Print Media in the MPF"
- "Avoiding Jams"

If you encounter a paper jam, see "Clearing Jams."

Sending a Job to Print

Install the printer driver to use all the features of the printer. When you choose **Print** from an application, a window representing the printer driver opens. Select the appropriate settings for the specific job that you are sending to print. Print settings selected from the driver override the default menu settings selected from the operator panel or the **Tool Box**.

You may need to click **Preferences** from the initial **Print** box to see all of the available system settings. If you are not familiar with a feature in the printer driver window, open the online Help for more information.

To print a file from a typical Microsoft® Windows® application:

1. Open the file you want to print.
2. From the **File** menu, select **Print**.
3. Verify that the correct printer is selected in the dialog box. Change the print settings if needed.
4. Click **Preferences** to adjust system settings that are not available from the first screen, and then click **OK**.
5. Click **OK** or **Print** to send the job to the selected printer.

NOTE: When you print on small-sized print media such as envelopes, lift the operator panel so that you can easily remove the printed media from the output tray.
Canceling a Print Job

There are several methods for canceling a job.
- "Canceling a Job From the Operator Panel"
- "Canceling a Job From a Computer Running Windows® Operating System"

Canceling a Job From the Operator Panel

To cancel a job after it has started printing:
1. Tap Stop.
   Printing is canceled only for the current job. All the following jobs will continue to print.

To cancel a job before it has started printing:
1. Press the button.
   A list of print jobs appears.
2. Tap the desired job to cancel.
3. Tap Stop.
4. Tap Stop Job.

Canceling a Job From a Computer Running Windows® Operating System

Canceling a Job From the Taskbar

When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar.
1. Double-click the printer icon.
   A list of print jobs appears in the printer window.
2. Select the job you want to cancel.
3. Press the <Delete> key.

Canceling a Job From the Desktop

1. Click Start→ Devices and Printers.
   For Windows Vista®: Click Start→ Control Panel→ Hardware and Sound→ Printers.
   For Windows Server® 2008: Click Start→ Control Panel→ Printers.
   For Windows Server® 2008 R2: Click Start→ Devices and Printers.
   For Windows® 8/Windows® 8.1: On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel→ Hardware and Sound→ Devices and Printers.
   For Windows Server® 2012/Windows Server® 2012 R2: On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel→ Hardware→ Devices and Printers.
   For Windows® 10: Right-click the Start button, and then click Control Panel→ Hardware and Sound→ Devices and Printers.
   A list of available printers appears.
2. Right-click the printer that you selected when you sent the job for printing, and then select See what's printing.
3. Select the printer driver.
   A list of print jobs appears in the printer window.
4 Select the job you want to cancel.
5 Press the <Delete> key.

**Duplex Printing**

Duplex printing (or two-sided printing) allows you to print on both sides of a sheet of paper. For sizes that are acceptable for duplex printing, see "Supported Paper Sizes."

**Duplex Printing With Duplex Unit**

1 Click Start→ Devices and Printers.
   For Windows Vista®: Click Start→ Control Panel→ Hardware and Sound→ Printers.
   For Windows Server® 2008: Click Start→ Control Panel→ Printers.
   For Windows Server® 2008 R2: Click Start→ Devices and Printers.
   For Windows® 8/ Windows® 8.1: On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound → Devices and Printers.
   For Windows Server® 2012/ Windows Server® 2012 R2: On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel → Hardware → Devices and Printers.
   For Windows® 10: Right-click the Start button, and then click Control Panel → Hardware and Sound → Devices and Printers.

2 Right-click the printer and select Printing Preferences.
   The General tab appears.

3 From Paper Source, select the paper tray.
   For PCL driver:
   Select from Auto, Tray1, Tray2, or MPF.
   For PS driver:
   Select from Automatically Select, Tray1, Tray2, or MPF.

4 From Duplex, select Flip on Short Edge or Flip on Long Edge.
   
   **NOTE:** For details on the Flip on Short Edge and Flip on Long Edge options, see "Flip on Short Edge" and "Flip on Long Edge."

5 Click OK.

**Using Booklet Print**

To use the booklet print feature, select the Enable check box of the Booklet Printing in the Layout tab.

**NOTE:** When the XML Paper Specification (XPS) or PS driver is used, booklet print is not available.

**NOTE:** You must select Flip on Long Edge in the Duplex when using the Booklet Print feature.
Using the Stored Print Feature

When you send a job to the printer, you can specify the information such as user ID, password, and job name in the printer driver to store the job in the memory. When you are ready to print the job, select the desired job name in the memory using the operator panel.

**NOTE:** The data in the memory is cleared when the printer is turned off.

**NOTE:** Stored Print feature is available when:
- The RAM disk is enabled in the printer menu.
- RAM Disk is set to Available in the printer driver.

Overview

The stored printing feature includes the following job types.
**Secure Print**
You can temporarily store print jobs secured with a password in the memory. Users with the password can print them from the operator panel. This feature can be used to print confidential documents. A stored print job will be deleted after you print it or at a designated time.

**Private Mail Box Print**
You can store print jobs secured with a password in the memory. Users with the password can print them at a more convenient time from the operator panel. This feature can be used to print confidential documents. The stored jobs remain in the memory until you delete them from the operator panel.

**Public Mail Box Print**
You can store print jobs without a password in the memory. Any user can print them at a more convenient time from the operator panel. The stored jobs remain in the memory until you delete them from the operator panel.
Proof Print

The collated print job is stored in the memory, but a single copy is printed automatically so you can check the print result. If you do not have problems with the print result, you can choose to print more copies. This prevents large number of misprinted copies from being printed at one time.

The difference between each of the job types are listed below. If you want to set the password for confidentiality, store the jobs in the Secure Print or Private Mail Box Print.

<table>
<thead>
<tr>
<th>Job types</th>
<th>Password</th>
<th>Differences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Print</td>
<td>Y</td>
<td>• The stored jobs will be deleted at a designated time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You cannot specify the quantity of copies from the operator panel. The</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quantity of copies depends on the number you specified on the printer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>driver.</td>
</tr>
<tr>
<td>Private Mail Box Print</td>
<td>Y</td>
<td>• The stored jobs remain until you delete them from the operator panel.</td>
</tr>
<tr>
<td>Public Mail Box Print</td>
<td>N</td>
<td>• You can specify the quantity of copies from the operator panel.</td>
</tr>
<tr>
<td>Proof Print</td>
<td>N</td>
<td>• The print job is set to collate.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A single copy is printed automatically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The stored jobs remain until you delete them from the operator panel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You can specify the quantity of copies from the operator panel.</td>
</tr>
</tbody>
</table>

NOTE: If a print job is too large for the memory available, the printer may display an error message.

Procedures for Printing Stored Print

NOTE: The stored print feature is available when using the PCL or PS driver.

When you select a job type in the printer driver, the job will be stored in the memory until you request to print it from the operator panel. The following are procedures for storing and printing jobs.

Storing Print Jobs

To use the stored print feature, you need to select a job type other than Normal Print in the General tab of the printer driver. The job will be stored in the memory until you request to print it from the operator panel.

NOTE: Secure Print and Private Mail Box Print require specifying a password for confidentiality.

NOTE: If a document name is not assigned to your print job in the printer driver, the job’s name will be identified using the printer’s time and date of submission to distinguish it from other jobs you have stored under your name.

Printing the Stored Jobs

1 Press the (Home) button.
2 Tap → Print.
3 Select a job type such as Secure Print, Private Mailbox, Public Mailbox, or Proof Print. A list of user ID appears.
4 Tap ▼ until the desired user ID appears, and then tap that user ID.

**NOTE:** Secure Print and Private Mail Box Print require specifying a password for confidentiality. If you select Public Mail Box Print or Proof Print, proceed to step 6.

5 Enter the password using the number pad, and then tap OK.

For details about specifying the password, see "Specifying your password on the operator panel (Secure Print/Private Mail Box Print)."

6 Tap ▼ until the desired document appears, and then tap that document.

**NOTE:** You can tap Quantity to specify the number of copies. For Secured Print, Quantity is not available.

7 Tap Print.

**NOTE:** If you want to keep the data in the memory for the time being, clear the Print and Delete check box.

8 Tap OK.

The stored job will be printed.

### Specifying your password on the operator panel (Secure Print/Private Mail Box Print)

When you tap Secure Print or Private Mailbox from Print Menu, a screen to enter the password appears after selecting your user ID.

Use the number pad to enter the numeric password you specified in the printer driver. The password you entered will appear as asterisks (*******) to ensure confidentiality.

If you enter an invalid password, the message Incorrect password Try again appears. Wait 3 seconds, or tap Close to return to the screen for entering the password.

When you enter a valid password, you have access to all print jobs matching the user ID and password you entered. The print jobs matching the password you entered appear on the screen. You can then choose to print or delete jobs matching the password you entered. (See "Printing the Stored Jobs" for more information.)

### Deleting Stored Jobs

With Secure Print, a job that has been stored will be deleted after printing or deleted at a designated time entered on the operator panel.

For other jobs, these jobs remain stored until you delete them from the operator panel.

### Printing from USB Memory (USB Direct Print)

The USB Direct Print feature allows you to print files stored in a USB memory using the operator panel.

**CAUTION:** To prevent damage to your printer, do not connect any device other than USB memory to the front USB port of the printer.

**CAUTION:** Do not remove the USB memory from the front USB port until the printer has finished printing.

**NOTE:** If the Functions Control setting for USB Direct Print is set to On (Password), you need to enter the four-digit password to use the print function. If the Functions Control setting for USB Direct Print is set to Off, the print function is disabled and the menu is also disabled on the screen. For details, see "Functions Control."

The front USB port of the printer is designed for USB 2.0 devices. You must use only an authorized USB memory with an A plug type connector. Use only a metal shielded USB memory.
Supported File Formats

Files in the following file formats can be printed directly from a USB memory.

- PDF
- TIFF
- JPEG

Inserting and Removing a USB Memory

You can insert the USB memory before printing or scanning images.

Before removing the USB memory, ensure that the printer is not accessing the USB memory.

⚠️ CAUTION: If you remove the USB memory while the printer is accessing, the data in the USB memory or the USB memory device itself may be destroyed.

Printing a PDF/TIFF File in a USB Memory

1. Press the 🏡 (Home) button.
2. Insert a USB memory to the front USB port of the printer.
   
   For details about inserting a USB memory, see "Inserting and Removing a USB Memory."
3. Tap Print PDF/TIFF.
4. Scroll through the page or tap a folder until the desired files appear, and then tap those files.
   
   🚨 NOTE: Only the following characters are displayed on the touch panel:
   A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 0 1 2 3 4 5 6 7 8 9 $ % ' ' - @ {} ~ ! # ( ) & _ ^
   
   🚨 NOTE: Up to 10 files can be selected and printed in display order.
5. Tap 📼.
6. Specify print options such as Select Tray, 2 Sided Printing, Layout, Image Types, Collation, and PDF Password on the Print Settings screen. For details, see "Print PDF/TIFF."
7. Tap Print to begin printing.
   
   🚨 NOTE: Only PDF/TIFF files created using the scan features of your printer can be printed through Print PDF/TIFF.
Printing a JPEG File in a USB Memory

1 Press (Home) button.
2 Insert a USB memory to the front USB port of the printer.
   For details about inserting a USB memory, see "Inserting and Removing a USB Memory."
3 Tap Print JPEG.
4 Scroll through the page or select a folder until the desired files appear, and then tap those files.
   To select all the files, tap .
   • NOTE: Only the following characters are displayed on the touch panel:
     A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 0 1 2 3 4 5 6 7 8 9 $ % ' \ ~ ! # ( ) & _ ^
   • NOTE: Up to 100 files can be selected and printed in display order.
5 Tap .
6 Specify print options such as Select Tray, 2 Sided Printing, Layout, Image Types, and Collation on the Print Settings screen. For details, see "Print JPEG."
7 Tap Print to begin printing.
   • NOTE: Only JPEG files created using the scan features of your printer can be printed through Print JPEG.

Printing With Web Services on Devices (WSD)


Adding Roles of Printer Services


For Windows Server® 2008:
1 Click Start → Administrative Tools → Server Manager.
2 Select Add Roles from the Action menu.
3 Check the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click Next.
4 Check the Print Server check box, and then click Next.
5 Click Install.

For Windows Server® 2008 R2:
1 Click Start → Administrative Tools → Server Manager.
2 Select Add Roles from the Action menu.
3 Check the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, and then click Next.
4 Click Next.
5 Check the Print Server check box, and then click Next.
6 Click Install.
For Windows Server® 2012/Windows Server® 2012 R2:

1. Click Server Manager of the Start screen.
2. Select Add Roles and Features from the Manage menu.
3. Click Next on the Before You Begin window → Select installation type on the Installation Type window → Select destination server on the Server Selection window in the Add Roles and Features Wizard.
4. Check the Print and Document Services check box on the Server Roles window, and then click Next.
5. Select features on the Features window → Confirm installation selections on the Confirmation window.
6. Click Install.

Printer Setup

You can install your new printer on the network using the Software and Documentation disc that shipped with your printer, or using the Add Printer wizard on Microsoft® Windows®.

Installing a Printer Driver Using the Add Printer Wizard


For Windows® 8, Windows® 8.1, Windows Server® 2012, and Windows Server® 2012 R2:

On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel→ Hardware and Sound (Hardware for Windows Server® 2012/Windows Server® 2012 R2)→ Devices and Printers.

For Windows® 10:

Right-click the Start button, and then click Control Panel→ Hardware and Sound→ Devices and Printers.

2. Click Add a printer to launch the Add Printer wizard.


Proceed to step 4.

3. Select Add a network, wireless or Bluetooth printer.

4. In the list of available printers, select the one you want to use, and then click Next.

   NOTE: In the list of available printers, the Web Services on Devices (WSD) printer is displayed in the form of http://IP address/ws/.

   NOTE: If no Web Services on Devices (WSD) printer is displayed in the list, enter the printer’s IP address manually to create a Web Services on Devices (WSD) printer. To enter the printer’s IP address manually, follow the instructions below.

   For Windows Server® 2008 R2, to create a Web Services on Devices (WSD) printer, you must be a member of Administrators group.

   1. Click The printer that I want isn’t listed.
   2. Select Add a printer using a TCP/IP address or hostname and click Next.
   3. Select Web Services Device from Device type.
   4. Enter the printer’s IP address in the Hostname or IP address text box and click Next.

   NOTE: Before installing the driver using the Add Printer wizard on Windows Server® 2008 R2 or Windows® 7, perform one of the following:

   • Establish the Internet connection so that Windows Update can scan your computer.
   • Add the printer driver to your computer.

5. If prompted, install the printer driver on your computer. If you are prompted for an administrator password or confirmation, type the password or provide confirmation.

6. Complete the additional steps in the wizard, and then click Finish.
7 Print a test page to verify installation.
   a Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for Windows Vista® and Windows Server® 2008).

   For Windows® 8, Windows® 8.1, Windows Server® 2012, and Windows Server® 2012 R2:
   On the Desktop screen, right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware for Windows Server® 2012/Windows Server® 2012 R2) → Devices and Printers.

   For Windows® 10: Right-click the Start button, and then click Control Panel → Hardware and Sound → Devices and Printers.

   b Right-click the printer you just created, and then click Printer properties (Properties for Windows Vista® and Windows Server® 2008).

   c On the General tab, click Print Test Page. When a test page prints successfully, installation is complete.

### Printing With Wi-Fi Direct

**NOTE:** The Wi-Fi Direct feature is available on the Dell Cloud Multifunction Printer | H815dw only.

This section provides information for Wi-Fi Direct printing. Wi-Fi Direct allows your Wi-Fi mobile devices such as computers, smartphones, and tablets, to connect to the printer directly via a Wi-Fi network. With Wi-Fi Direct, you can print documents, photos, or e-mail on your Wi-Fi mobile devices directly without a wireless access point.

**NOTE:** Wi-Fi Direct is available even if the printer is connected to your wireless network connection.

**NOTE:** The maximum number of devices that can be connected via the Wi-Fi Direct network is 3.

**NOTE:** You cannot connect your mobile device to the Internet via the printer’s Wi-Fi Direct network.

**NOTE:** Depending on the mobile device, the channel used to connect the device to the printer via Wi-Fi Direct may differ from the channel used by the printer to connect to a network via Wi-Fi infrastructure mode. In such a case, simultaneous connection with Wi-Fi Direct and Wi-Fi infrastructure mode may not work properly.

**NOTE:** The printer connected with Wi-Fi Direct supports the following protocols; LPD, Port9100, Web Services on Devices (WSD), Bonjour (mDNS), SNMPv1/v2c, Dell Printer Configuration Web Tool.

### Setting Up Wi-Fi Direct

To use Wi-Fi Direct, you need to first set up the Wi-Fi Direct settings from the operator panel of the printer. To connect the mobile device to the printer via Wi-Fi Direct, select the SSID of the printer from the list of wireless networks on the mobile device and enter the passphrase necessary for connection.

### Setting Up the Printer

**NOTE:** Wi-Fi Direct cannot be used in an IPv6 or Ad-hoc environment.

1 Press the  (Information) button.
2 Tap the Tools tab, and then tap Admin Settings.
3 Tap Network.
4 Tap Wi-Fi Direct.
5 In the Wi-Fi Direct menu, tap Wi-Fi Direct.
6 Tap Enable, and then tap OK.
   - When a popup message about the devices is displayed, tap Close.
7 Tap Group Role.
8 Tap Group Owner, and then tap OK.
9 The printer must be rebooted after you set Wi-Fi Direct. After the reboot, repeat steps from 1 to 4.
10 Tap ▼ until SSID and Passphrase appears, and tap each menu to check what the SSID and passphrase is.

NOTE: To confirm the printer’s SSID and passphrase, you can also print the list by tapping Print Passphrase under the Passphrase menu.

Connecting the Mobile Device

1 Connect the mobile device to the Wi-Fi Direct network.
   For Windows® 10
   a Click the Start button, and then click Settings.
   b Click the Wi-Fi icon.
   c Click the printer’s SSID ➔ Connect.
   d Enter the passphrase, and then click Next.
   The mobile device will connect to the printer.
   For Windows® 8, Windows® 8.1, Windows® RT, and Windows® RT 8.1
   a Tap Settings in the PC settings menu.
   b Tap the Wi-Fi icon.
   c Tap the printer’s SSID, and then tap Connect.
   d Enter the passphrase, and then tap Next.
   The mobile device will connect to the printer.
   For Windows® 7
   a Click the network icon on the taskbar.
   b Click the printer’s SSID, and then click Connect.
   c Enter the passphrase, and then click OK.
   d Click Cancel to exit the Set Network Location window.
   The mobile device will connect to the printer.
   For Windows Vista®
   a Click Start ➔ Connect To.
   b Click the printer’s SSID.
   c Enter the passphrase, and then click Connect.
   The mobile device will connect to the printer.
   For OS X 10.9 and OS X 10.10
   a Click the network icon on the Menu Bar.
   b Click the printer’s SSID.
   c Enter the passphrase, and then click Join.
   The mobile device will connect to the printer.
For iOS

a  Tap Settings → Wi-Fi.
b  Tap the printer's SSID.
c  Enter the passphrase, and then tap Join.
   The mobile device will connect to the printer.

For Android
The procedure varies depending on your mobile device you are using. Refer to the manual provided with your mobile device.

2  Install the printer on the mobile device.

For Windows® 10

a  Click the Start button, and then click Settings.
b  Click Devices → Add a device.
c  Click Dell_xxxxxx.
   The printer is ready for use.

For Windows® 8, Windows® 8.1, Windows® RT, and Windows® RT 8.1

a  Click Devices in the PC settings menu.
b  Click Add a device in the Devices sub-menu.
c  Click Dell_xxxxxx.
   The printer is ready for use.

For Windows Vista® and Windows® 7
You need to install the printer driver on the mobile device. See "Installing Printer Drivers on Windows® Computers."

For OS X 10.9 and OS X 10.10
You need to install the printer driver on the mobile device. See "Installing Printer Drivers on Macintosh Computers."

For iOS
You need to install the printing application such as the Dell Document Hub app, and then the printer is ready for use.

For Android
You need to install the printing application such as the Dell Document Hub app, and then the printer is ready for use.

Printing via Wi-Fi Direct
The printing procedure varies depending on your mobile device you are using. Refer to the manual provided with your mobile device to print as you normally do from the device.
Disconnecting Wi-Fi Direct Network

1. Press the (Information) button.
2. Tap Paired Device.

   **NOTE:** The Paired Device menu is displayed only when the printer is connected via Wi-Fi Direct.
3. Tap the device name to disconnect.
4. Tap Disconnect Now or Disconnect and Reset Passphrase.
5. Tap Yes.
   The selected device is successfully disconnected.

You can also disconnect the device from the following steps.

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Network.
4. Tap Wi-Fi Direct.
5. Tap Paired Device.
6. Tap the device name to disconnect.
7. Tap Disconnect now.
8. Tap Yes.

Resetting the Passphrase

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Network.
4. Tap Wi-Fi Direct.
5. Tap until Passphrase appears, and then tap Passphrase.
6. Tap Reset Passphrase.
7. Tap Yes.
   The Wi-Fi Direct is disconnected and the passphrase is reset.

Resetting the PIN

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Network.
4. Tap Wi-Fi Direct.
5. Tap until WPS Setup appears, and then tap WPS Setup.
7. Tap Reset Code.
8. Tap Yes.
   The Wi-Fi Direct is disconnected and the PIN is reset.
Mobile Printing and Scanning

The printer supports printing from a variety of mobile devices, using the Dell Document Hub app. Easy to use and navigate, the Dell Document Hub app allows users to scan to and print from a variety of common cloud storage services. It enables direct printing of photos, documents, web content and more, to supported Dell printers on a Wi-Fi, Wi-Fi Direct, or Ethernet network.

Android OS
Download the Dell Document Hub app for free from Google Play. Scan the QR Code for quick access to the relevant application store.

Apple iOS
This printer is compatible with the Dell Document Hub app for free from App Store. Scan the QR Code for quick access to the relevant application store.

This printer is also compatible with AirPrint. For details about AirPrint, see "Printing With AirPrint."
Printing With AirPrint

AirPrint allows you to print through a network with the device running iOS or OS X. Be sure to install the latest version of iOS for iOS device. For OS X, be sure to update OS X and the apps you have purchased from the App Store using the Software Update.

Setting Up AirPrint on Your Printer

1. Ensure that the printer is connected to the network.
2. Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser. For more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer Configuration Web Tool."
3. When the Dell Printer Configuration Web Tool opens, click Print Server Settings in the left frame, and click the Print Server Settings tab.
4. Click AirPrint.
5. In Enable AirPrint, select the check box to enable the printer for AirPrint.
6. Click Apply New Settings.
7. Click Restart Printer.

Printing via AirPrint

The following procedure uses the iPhone running iOS8.1 as an example.

1. Open your email, photo, web page, or document you want to print.
2. Tap the action icon .
3. Tap Print.
4. Select your printer and set printer options.
5. Tap Print.

Printing With Google Cloud Print

By registering the printer to your Google account, you can use the Google Cloud Print service to print from the Google Chrome browser without installing the printer drivers to your device. You can also share the printer with the specified users over the Internet.

The printer supports the following version of the Google Cloud Print service:

- Google Cloud Print version 1.1
- Google Cloud Print version 2.0

NOTE: Information about Google Cloud Print is based on the information as of October 2015. For the latest information, visit the Google Cloud Print web site.

NOTE: Use the latest version of the Google Chrome browser for Google Cloud Print.

Preparing to Use the Printer with Google Cloud Print

To use Google Cloud Print, you need the following preparations in advance:

- "Enabling Google Cloud Print on the Printer"
- "Selecting the Version of the Google Cloud Print Service"
- "Registering the Printer to the Google Cloud Print Service"
- "Sharing the Printer Using the Google Cloud Print Service"
NOTE: To register the printer to the Google Cloud Print service, the printer needs to be connected to the Internet.

NOTE: Google Cloud Print supports only IPv4 connection.

NOTE: If the printer is connected to a network that uses a proxy server, you need to specify the settings in Proxy Server from the Dell Printer Configuration Web Tool. For more information, see "Proxy Server."

NOTE: Acquire a Google account and a Gmail address in advance.

Enabling Google Cloud Print on the Printer

When using the operator panel
1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Network.
5. Tap ▼ until Google Cloud Print appears, and then tap Google Cloud Print.
6. Tap Enable.
7. Tap OK.
8. Turn off the printer, and turn it on again to apply the settings.

When using the Dell Printer Configuration Web Tool
1. Launch the Dell Printer Configuration Web Tool by entering IP address of the printer in your web browser. For more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer Configuration Web Tool."
2. When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click Port Settings. In Port Status, select the On check box for Google Cloud Print.

Selecting the Version of the Google Cloud Print Service
Select the version of the Google Cloud Print service from either version 1.1 or version 2.0.

Google Cloud Print version 1.1 sends the print data to the printer via Internet. For this version, the printer needs to be connected to the Internet.

Google Cloud Print version 2.0 sends the print data to the printer either via Internet or via local network. This version is recommended for the environment where the Internet connection cannot be used.
NOTE: Available options for printing may vary according to your device or the version of the Google Cloud Print service.

NOTE: You cannot use both version 1.1 and version 2.0 of the Google Cloud Print service on a printer.

Registering the Printer to the Google Cloud Print Service

Before registering the printer to the Google Cloud Print service, prepare the Google account to which the printer is registered.

NOTE: To register the printer to the Google Cloud Print service, the printer needs to be connected to the Internet.

NOTE: The Google account which is used in the registration procedure will be registered as the owner.

For Google Cloud Print Version 1.1

1. Launch the Dell Printer Configuration Web Tool by entering IP address of the printer in your web browser. For more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer Configuration Web Tool."

2. When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click Register This Device to Google Cloud Print in Google Cloud Print. A sheet with a URL for the Google Cloud Print printer registration web site is printed.

3. From the web browser of your computer, visit the Google web site and sign in with your Google account. Visit the Google Cloud Print registration web site by entering the URL on the printout into your web browser. You can also visit the site by scanning the QR code with your mobile device.

4. On the Google Cloud Print registration web site, click Finish printer registration.

5. Click Manage your printers. Your printer will be listed in the Printers list and will be ready for use with the Google Cloud Print service.

NOTE: When the printer does not print a sheet with a URL and shows a message of the status code 016-757, launch the Dell Printer Configuration Web Tool, open the Dell AccessControl page in the Print Volume tab, and either turn AccessControl Mode to Off or turn Non Registered User to On.

For Google Cloud Print Version 2.0

1. Launch the Google Chrome browser. When you are using the Google Chromebook, start and log in to the Chromebook.

2. Click in the top right corner, and select Settings.

3. Click Show advanced settings in the bottom of the page.

4. Click Manage under the Google Cloud Print menu.

NOTE: If a message is displayed under New Devices to request you to sign in to Chrome, click sign in and sign in to Chrome.
5 Click **Register** for the printer you want to register.

**NOTE:** If Bonjour (mDNS) is set to off, the new printer will not show in **New devices**. In this case, launch the **Dell Printer Configuration Web Tool**, open the **Port Settings** page in the **Print Server Settings** tab, and turn **Bonjour (mDNS)** to **On**.

6 When the window to confirm the registration appears, click **Register**.

The window appears to show that the printer is being added.

7 Go to the printer, and follow the instructions displayed on the operator panel.

8 When the printer name appears in the **My devices** list, the registration is completed.

**NOTE:** It may take about 5 minutes or more until the printer name appears in the **My devices** list.

**Sharing the Printer Using the Google Cloud Print Service**

You can share the printer registered for the Google Cloud Print service with other users.

1 Launch the Google Chrome browser. When you are using the Google Chromebook, start and log in to the Chromebook.

2 Click ⌘ in the top right corner, and select **Settings**.

3 Click **Show advanced settings** in the bottom of the page.

4 Click **Manage** under the **Google Cloud Print** menu.

**NOTE:** If a message is displayed to request you to sign in to Chrome, click **sign in** and sign in to Chrome.

5 Click **Manage** for the printer you want to share.

6 In the **Google Cloud Print** window, click **Share**.

7 In the window to specify the printer sharing, enter the Google accounts of the users you want to invite to share the printer, and click **Share**.

**NOTE:** When the invited users log in to the Google Cloud Print web page, a message appears to show that the printer owner made the sharing settings. Accept the sharing invitation.

**Canceling Registration to Google Cloud Print**

1 Launch the **Dell Printer Configuration Web Tool**, open the **Google Cloud Print** page in the **Print Server Settings** tab.

2 Click **Cancel Registration**.

3 Confirm that the button changes to **Register This Device to Google Cloud Print**.

**Printing via Google Cloud Print**

The printing procedure varies depending on the application or the device you are using. You can see the application list that supports Google Cloud Print service on the Google web site.

**Printing From an Application on a Mobile Device**

The following procedure uses the Google Drive application on an Android mobile device as an example.

1 Install the Google Drive application on your mobile device.

**NOTE:** You can download the application from Google Play.

2 Access the Google Drive application from your mobile device and select the document.

3 Select **Print** from the application menu.

4 Select your printer from the list.

5 Select printer options and then tap **Print**.
Printing From Google Chrome
The following procedure uses the Google Chrome browser on the computer running a Microsoft® Windows® operating system as an example.

1. Open the Google Chrome browser.
2. Open the web page or e-mail that you want to print.
3. Click or (varies depending on the version of the Google Chrome browser) in the top right corner and then click Print.
4. Click Change in the Destination area.
5. Choose your printer from the Google Cloud Print area.
   
   **NOTE:** When your printer is registered to Google Cloud Print version 2.0, you can print the document by way of the local print with the printer in your local network. In this case, select your printer in Local Destinations.
6. Click Print.

Printing From Google Chromebook

1. Open the web page or e-mail that you want to print.
2. Click in the top right corner and then click Print.
3. Confirm that your printer is specified in the Destination area. If not, click Change and select your printer.
   
   **NOTE:** When your printer is registered to Google Cloud Print version 2.0, you can print the document by way of the local print with the printer in your local network. In this case, select your printer in Local Destinations.
4. Click Print.

Mopria Print Service

Mopria Print Service allows any Android phone or tablet (Android version 4.4 or later) to connect and print to Mopria-certified printers without additional set up.

Firstly, download and install the Mopria Print Service app from Google Play store to your Android mobile device:

https://play.google.com/store/apps/

In order to print, connect your mobile device to the same network as the printer or use the Wi-Fi Direct functionality to connect your mobile device to the printer.

**NOTE:** Mopria Print Service might be preloaded in your mobile device. If your mobile device does not have the Mopria Print Service, you can easily download it from the Google Play store. To learn more about Mopria Print Service, visit http://www.mopria.org/.

**NOTE:** Make sure that Mopria is set to Enable in advance using the Dell Printer Configuration Web Tool. See “Setting Up Mopria Print Service on Your Printer.”

Setting Up Mopria Print Service on Your Printer

1. Make sure that the printer is connected to the network.
2. Start the Dell Printer Configuration Web Tool.
   
   See "Starting the Dell Printer Configuration Web Tool."
3. Click Print Server Settings → the Print Server Settings tab → Mopria.
4. Click Enable.
   
   The printer is ready for Mopria Print Service.
Printing via Mopria Print Service

1. Open your email, photo, web page, or document that you want to print.
2. Tap the menu and select Print.
3. Tap All printers in the menu.
4. Select the printer, and then set printer options.
5. Tap Print.

Printing a Report Page

You can print a variety of settings for your printer including system settings, panel setting, and font list. For details about how to print reports or lists, see "Report / List."

Printer Settings

You can change most of the print settings from the application you are printing from. If your printer is attached to the network, you can also change settings from the Dell Printer Configuration Web Tool. To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. To find your printer's IP address, see "Verifying the IP Settings."

Settings from the application update the default system settings for the printer. Settings from the printer driver only apply to the job that you are currently sending to the printer.

If you cannot change a setting from the application, use the operator panel, the Tool Box or the Dell Printer Configuration Web Tool. Changing a system setting from the operator panel, the Tool Box or from the Dell Printer Configuration Web Tool makes that setting the user default.

You can verify the detailed system settings by printing a system settings report. For details about how to print a system settings report, see "Report / List."

You can reset settings to their default values from the Tool Box or the operator panel.

Using the Operator Panel to Change the Printer Settings

You can select menu items and corresponding values from the operator panel.

When you first browse through the menus from the operator panel, you see some menu items are highlighted. These highlighted items are the factory default and original system settings.

NOTE: Factory defaults may vary for different countries.

When you select a new setting from the operator panel, the item selected is highlighted to identify it as the current user default menu setting.

These settings are active until new ones are selected or the factory defaults are restored.

Driver settings may override changes previously made and may require you to change the operator panel defaults.

Using the Dell Printer Configuration Web Tool to Change the Printer Settings

If your printer is connected to the network, you can change the printer settings from your web browser. If you are a network administrator, you can clone the system settings of one printer to one or all the printers on the network.

Type the IP address of your printer in your web browser. Choose Printer Settings from the topics list. From the Printer Settings tab, select the System Settings to change the printer settings.

To change the paper type and size, choose Tray Management from the topics list. To change the AccessControl settings, choose Print Volume from the topics list, and then select the Dell AccessControl tab.
To copy your system settings to another printer on the network, choose **Copy Printer Settings** from the topics list, and then type the other printer's IP address.

If you do not know your printer's IP address, see the system settings report or display the TCP/IP settings. For details about how to find your printer's IP address, see "Verifying the IP Settings."
Copying

NOTE: If the Functions Control setting for Copy is set to On (Password), you need to enter the four-digit password to use the copy function. If the Functions Control setting for Copy is set to Off, the copy function is disabled and the menu is also disabled on the screen. For details, see “Functions Control.”

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Loading Paper for Copying
The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying. For details about loading paper, see "Loading Print Media." For details about setting the paper type and size in the tray, see "Print Media Guidelines."

Selecting Paper Tray
After loading the print media for copy output, select the desired paper tray to be used for the copy job.
To select the tray:
1. Press the (Home) button.
2. Tap ➔ Copy.
3. Tap Select Tray.
4. Tap the desired tray, and then tap OK.

You can select MPF, Tray1, or Tray2.*

*Tray2 is only available when the optional 550-sheet feeder (tray2) is installed.

Preparing a Document
You can use the document glass or the duplex automatic document feeder (DADF) to load an original document for copying, scanning, and sending a fax. You can load up to 50 sheets of 75 g/m² (20 lb) documents for one job using the DADF or one sheet at a time using the document glass.

WARNING: Avoid loading documents that are smaller than 5.5 inches by 5.5 inches (139.7 mm by 139.7 mm) or larger than 8.5 inches by 14 inches (215.9 mm by 355.6 mm), different sizes or weights together, or booklets, pamphlets, transparencies, or documents having other unusual characteristics in the DADF.

WARNING: Carbon-paper or carbon-backed paper, coated paper, onion skin or thin paper, wrinkled or creased paper, curled or rolled paper, torn paper, photographs, or transparencies cannot be used in the DADF.

WARNING: Do not use the documents with staples, paper clips or exposed to adhesives or solvent based materials such as glue, ink and correcting fluid in the DADF.

NOTE: To get the best scan quality, especially for color or grayscale images, use the document glass instead of the DADF.
Making Copies From the Document Glass

NOTE: A computer connection is not required for copying.
NOTE: Remove any documents from the DADF before copying from the document glass.
NOTE: Contaminants on the document glass may cause black spots on the copy output. For best results, clean the document glass before use. For more information, see "Cleaning the Scanner."

To make a copy from the document glass:

1. Lift and open the document cover.

2. Place the document facing down on the document glass and align it with the registration guide on the top left corner of the glass.

3. Close the document cover.

   NOTE: Leaving the document cover open while copying may affect the copy quality and increase the toner consumption.
   NOTE: If you are copying a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close the cover. If the book or magazine is thicker than 30 mm, start copying with the document cover open.

4. Press the (Home) button.

   To simply make a copy without changing the default copy settings, press the (Copy) button.
5 Tap \( \text{Copy} \). To customize the copy settings such as Select Tray and Darken/Lighten, see "Setting Copy Options."

\[ \text{NOTE:} \] The copy options automatically return to their default status after the auto clear timer is expired.

6 Tap - or + to specify the number of copies from 1 to 99 in the Quantity tile.

7 Tap Copy to begin copying.

\[ \text{NOTE:} \] You can cancel a copy job while scanning a document by tapping Stop.

Making Copies From the DADF

\[ \text{CAUTION:} \] Do not load more than 50 sheets into the DADF or allow more than 50 sheets to be fed to the document output tray. The document output tray should be emptied before it exceeds 50 sheets or your original documents may be damaged.

\[ \text{NOTE:} \] A computer connection is not required for copying.

\[ \text{NOTE:} \] Before loading the document(s) on the DADF, straighten the edges of the stack of the document(s).

1 Load the document(s) facing up on the DADF with top edge of the documents in first. Then adjust the document guides to the document size.

\[ \text{NOTE:} \] Ensure that you use the document stopper before copying a legal-size document.

2 Press the \( \text{Home} \) button. To simply make a copy without changing the default copy settings, press the \( \text{Copy} \) button.

3 Tap \( \text{Copy} \). To customize the copy settings such as Select Tray and Darken/Lighten, see "Setting Copy Options."

\[ \text{NOTE:} \] The copy options automatically return to their default status after the auto clear timer is expired.

4 Tap - or + to specify the number of copies from 1 to 99 in the Quantity tile.

5 Tap Copy to begin copying.

\[ \text{NOTE:} \] You can cancel a copy job while scanning a document by tapping Stop.
Setting Copy Options

Set the following options for the current copy job before tapping Copy to begin copying.

For details about making copies, see "Making Copies From the Document Glass" and "Making Copies From the DADF."

**NOTE:** The copy options automatically return to their default status after the auto clear timer is expired.

Options on each tile are below:

- Copy tile
  - Quantity
  - Darken / Lighten
  - Select Tray
  - 2 Sided Copying
  - Sharpness
  - Reduce / Enlarge
  - Original Size
  - Original Type
  - Collation
  - 2-Up
  - Margin
  - Auto Exposure

**Quantity**

To specify the number of copies from 1 to 99.

1 Tap – or + to specify the number of copies.

**Darken / Lighten**

To adjust the contrast to make the copy darker or lighter than the original:

1 Tap Darken/Lighten.

2 Drag the desired level on the Darken/Lighten bar, and then tap OK.

You can select a contrast level from seven levels between Darken and Lighten.

Drag the indicator on the left side of the bar makes the document contrast lighter, and selecting a cell on the right side of the bar makes the document contrast darker.

<table>
<thead>
<tr>
<th>Darken Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Darken 3</td>
<td>Works well with light documents or faint pencil markings.</td>
</tr>
<tr>
<td>Darken 2</td>
<td></td>
</tr>
<tr>
<td>Darken 1</td>
<td></td>
</tr>
<tr>
<td>Normal*</td>
<td>Works well with normal typed or printed documents.</td>
</tr>
<tr>
<td>Lighten 1</td>
<td>Works well with dark documents.</td>
</tr>
<tr>
<td>Lighten 2</td>
<td></td>
</tr>
<tr>
<td>Lighten 3</td>
<td></td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.
Select Tray

To select the tray:

1 Tap Select Tray.
2 Tap the desired setting, and then tap OK.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPF</td>
<td>The paper is fed from the multipurpose feeder.</td>
</tr>
<tr>
<td>Tray1*</td>
<td>The paper is fed from tray1.</td>
</tr>
<tr>
<td>Tray2</td>
<td>The paper is fed from the optional 550-sheet feeder.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

NOTE: Tray2 is only available when the optional 550-sheet feeder is installed.

NOTE: When Any is displayed as the paper size and type in the MPF, you can select the paper size and type from this menu. For details, see “Select Tray.”

2 Sided Copying

To make duplex copies with the specified binding position:

1 Swipe the screen until 2 Sided Copying appears, and then tap 2 Sided Copying.
2 Tap the desired setting, and then tap OK.

1 → 1 Sided* Select 1 sided or 2 sided and specify binding position for the 2 sided copy.
1 → 2 Sided
2 → 1 Sided
2 → 2 Sided
Long Edge Binding
Short Edge Binding

* Denotes the factory default setting.

When you are using the document glass and it is set to 1 → 2 Sided or 2 → 2 Sided, the display prompts you for another page after tapping Copy.

a If you want to place a new document, replace the document with a new document, and then tap Continue.
b If you finish copying, tap Print Now.

NOTE: When you use the DADF to copy both sides of a document, the printed position of the front and back of the document may differ if the size in the document size setting and the size of the document do not match. In this case, set Original Size to the same size as the document.
Sharpness

To adjust the sharpness to make the copy image sharper or softer than the original:

1. Swipe the screen until Sharpness appears, and then tap Sharpness.
2. Tap the desired setting.

<table>
<thead>
<tr>
<th>Sharpness</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharpen</td>
<td>Makes the copy image sharper than the original.</td>
</tr>
<tr>
<td>Normal*</td>
<td>The clarity of the image is the same as the original.</td>
</tr>
<tr>
<td>Soften</td>
<td>Makes the copy image softer than the original.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

Reduce / Enlarge

To reduce or enlarge the size of a copied image from 25 to 400 percent when you copy original documents from the document glass or DADF:

NOTE: When you make a reduced copy, black lines may appear at the bottom of your copy.

1. Swipe the screen until Reduce/Enlarge appears, and then tap Reduce/Enlarge.
2. Tap the desired setting, and then tap OK.

(Inch series)

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100%*</td>
<td></td>
</tr>
<tr>
<td>50%</td>
<td></td>
</tr>
<tr>
<td>64% (Ledger→Letter)</td>
<td></td>
</tr>
<tr>
<td>78% (Legal→Letter)</td>
<td></td>
</tr>
<tr>
<td>129% (Statement→Letter)</td>
<td></td>
</tr>
<tr>
<td>154% (Statement→Legal)</td>
<td></td>
</tr>
<tr>
<td>200%</td>
<td></td>
</tr>
</tbody>
</table>

(mm series)

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100%*</td>
<td></td>
</tr>
<tr>
<td>50%</td>
<td></td>
</tr>
<tr>
<td>70% (A4→A5)</td>
<td></td>
</tr>
<tr>
<td>81% (B5→A5)</td>
<td></td>
</tr>
<tr>
<td>122% (A5→B5)</td>
<td></td>
</tr>
<tr>
<td>141% (A5→A4)</td>
<td></td>
</tr>
<tr>
<td>200%</td>
<td></td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

NOTE: You can also specify the value in increments of 1 percent from 25 to 400 by tapping – or +.
**Original Size**

To select the default document size:

1. Swipe the screen until Original Size appears, and then tap Original Size.
2. Tap the desired setting.

(Inch series)

<table>
<thead>
<tr>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
</tr>
<tr>
<td>Letter (8.5x11”)</td>
</tr>
<tr>
<td>Folio (8.5x13”)</td>
</tr>
<tr>
<td>Legal (8.5x14”)</td>
</tr>
<tr>
<td>Statement (5.5x8.5”)</td>
</tr>
<tr>
<td>A4 (210x297mm)</td>
</tr>
<tr>
<td>A5 (148x210mm)</td>
</tr>
<tr>
<td>B5 (182x257mm)</td>
</tr>
<tr>
<td>Executive (7.5x10.5”)</td>
</tr>
</tbody>
</table>

(mm series)

<table>
<thead>
<tr>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
</tr>
<tr>
<td>A4 (210x297mm)</td>
</tr>
<tr>
<td>A5 (148x210mm)</td>
</tr>
<tr>
<td>B5 (182x257mm)</td>
</tr>
<tr>
<td>Letter (8.5x11”)</td>
</tr>
<tr>
<td>Folio (8.5x13”)</td>
</tr>
<tr>
<td>Legal (8.5x14”)</td>
</tr>
<tr>
<td>Statement (5.5x8.5”)</td>
</tr>
<tr>
<td>Executive (7.5x10.5”)</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

**Original Type**

To select the copy image quality:

1. Swipe the screen until Original Type appears, and then tap Original Type.
2. Tap the desired setting.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo &amp; Text*</td>
<td>Used for documents with both photos and text.</td>
</tr>
<tr>
<td>Text</td>
<td>Used for documents with text.</td>
</tr>
<tr>
<td>Photo</td>
<td>Used for documents with photos.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.
Collation

To sort the copy output: For example, if you make two copies of three page documents, one complete three page document will be printed followed by the second complete document:

1. Swipe the screen until Collation appears, and then tap Collation.
2. Tap the desired setting.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Only the documents loaded from DADF are copied in collated order.</td>
</tr>
<tr>
<td>Collated</td>
<td>Copies in collated order.</td>
</tr>
<tr>
<td>Uncollated</td>
<td>Does not copy in collated order.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

When you are using the document glass and it is set to Collated, the display prompts you for another page after tapping Copy.

a. If you want to place a new document, replace the document with a new document, and then tap Continue.

b. If you finish copying, tap Print Now.
2-Up

To print two original images to fit onto one sheet of paper:

1 Swipe the screen until 2-Up appears, and then tap 2-Up.
2 Tap the desired setting, and then tap OK.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not perform multiple-up printing.</td>
</tr>
<tr>
<td>Auto</td>
<td>Automatically reduces the original pages to fit onto one sheet of paper.</td>
</tr>
<tr>
<td>Manual</td>
<td>Prints the original pages onto the one sheet of paper in the size specified in Reduce / Enlarge.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

When you are using the document glass and it is set to Auto or Manual, the display prompts you for another page after tapping Copy.

a If you want to place a new document, replace the document with a new document, and then tap Continue.
b If you finish copying, tap Print Now.

**NOTE:** When you use the DADF to copy both sides of a document, the printed position of the front and back of the document may differ if the size in the document size setting and the size of the document do not match. In this case, set Original Size to the same size as the document.
Margin

To specify the margins of the copy:
1. Swipe the screen until Margin appears, and then tap Margin.
2. Tap – or + to enter the desired value, and then tap OK.

<table>
<thead>
<tr>
<th>Margin Setting</th>
<th>Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top / Bottom</td>
<td>0.2 inch* (4 mm*)</td>
<td>Specify the value in increments of 0.1 inch (1 mm). Available Range: 0.0–2.0 inches (0–50 mm)</td>
</tr>
<tr>
<td>Left / Right</td>
<td>0.2 inch* (4 mm*)</td>
<td>Specify the value in increments of 0.1 inch (1 mm). Available Range: 0.0–2.0 inches (0–50 mm)</td>
</tr>
<tr>
<td>Middle</td>
<td>0 inches* (0 mm*)</td>
<td>Specify the value in increments of 0.1 inch (1 mm). Available Range: 0.0–2.0 inches (0–50 mm)</td>
</tr>
</tbody>
</table>

* Denotes the factory default settings.

Auto Exposure

To suppress the background of the original to enhance text on the copy:
1. Swipe the screen until Auto Exposure appears, and then tap Auto Exposure.
2. Tap On.

Using the ID Copy

**NOTE:** If the Functions Control setting for ID Copy is set to Disable, the ID copy function is disabled and the menu is also disabled on the screen. For details, see "Functions Control."

You can copy both sides of an ID card on one side of a single sheet of paper in its original size by tapping ID Copy on the touch panel.

To make a copy:
1. Place an ID card facing down on the document glass, and close the document cover. For details about loading a document, see "Making Copies From the Document Glass."
2. Press the (Home) button.
3. Tap → ID Copy.
4. Specify the copy settings below as required.
   - Quantity
   - Darken / Lighten
   - Select Tray
   - Sharpness
   - Auto Exposure
   For details, see "Setting Copy Options."
5. Tap Copy to begin copying.
   After the front side of the ID card is scanned, the display prompts you to turn over the card.
   a. To scan the back side of the ID card, turn the ID card over and tap Continue.
   b. To finish copying, tap Print Now.
Changing the Default Settings

The default settings of the copy menu options such as Select Tray and Darken/Lighten can be set to the most frequently used modes. When you copy a document, the specified default settings are used unless they are changed by using the operator panel.

The settings on Default Settings will be reflected when you create a new tile. If you change the settings on Default Settings after creating the new tile, it does not affect the settings of the tile you created earlier. For details about creating a new tile, see "Adding a New Tile."

To create your own default settings:

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Default Settings.
3. Tap Copy Defaults.
4. Tap ▼ until the desired menu item appears, and then tap that menu item.
5. Tap the desired setting or enter the value, and then tap OK.
6. Repeat steps 4 and 5 as needed.
Scanning Overview

Use the Dell Cloud Multifunction Printer | H815dw and Dell Smart Multifunction Printer | S2815dn to turn pictures and text into editable images on your computer.

Your printer provides several ways to scan your document. There are two main scanning types. One is operated on the printer side without using the scanner driver, and the other is operated on the computer side using a software and the scanner driver. See the available features below to help you find the information you need.

- Scanning - With scanner driver
- Scanning - Without scanner driver

Tips for Easy Network Scanning

- Use the Scan to Web Services on Devices (WSD) feature if you are not familiar with the network scanning setup. The Scan to Web Services on Devices (WSD) feature does not require the complicated setup of the network shared folder.
- Before using the Scan to Network Folder feature, configure the network connection details using the Address Book Editor if you are not familiar with the setup using the Dell Printer Configuration Web Tool. The Address Book Editor helps to register the scanning destination details to the printer.

Scanning - With scanner driver

- Scan into a graphic software such as Adobe® Photoshop® using a TWAIN driver (Supporting USB and Network connections for both Microsoft® Windows® and Apple Macintosh using a graphic software)
  See "Scanning Using the TWAIN Driver."
- Scan into a Microsoft’s default program such as Windows® Photo Gallery and Microsoft® Paint, using a Windows Image Acquisition (WIA) driver (Supporting USB and Network (including WSD*) connections on Windows® only)
  * Web Services on Devices
  See "Scanning Using the Windows Image Acquisition (WIA) Driver."
- Scan and send the scanned document to computer connected via USB cable (Supporting USB connection for both Microsoft® Windows® and Apple Macintosh)
  Using the feature of Scan to Computer on the operator panel of your printer, the scanned image is saved in the location of your computer you specify.
  See "Scanning to a Computer With a USB Connection."
Scanning - Without scanner driver

- Scan and save the scanned document in a USB memory
  See "Scanning to a USB Memory."
- Scan and send the scanned document by e-mail
  See "Sending an E-Mail With the Scanned Image."
- Scan and send the scanned document to computer or server connected to network
  See "Scanning to a PC or Server via SMB/FTP."
- Scan and send the scanned document to a computer connected to a network using Web Services on Devices (WSD)
  See "Scanning to a Computer Connected With Web Services on Devices (WSD)."

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or document after you scan it to your computer. For the best results, use these recommended settings.

<table>
<thead>
<tr>
<th>Type</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>300 dpi black-and-white or 200 dpi grayscale or color</td>
</tr>
<tr>
<td>Documents of poor quality or that contain small text</td>
<td>400 dpi black-and-white or 300 dpi grayscale</td>
</tr>
<tr>
<td>Photographs and pictures</td>
<td>100–200 dpi color or 200 dpi grayscale</td>
</tr>
<tr>
<td>Images for an inkjet printer</td>
<td>150–300 dpi</td>
</tr>
<tr>
<td>Images for a high-resolution printer</td>
<td>300–600 dpi</td>
</tr>
</tbody>
</table>

Scanning above these recommended resolutions may exceed the capabilities of the application. If you require a resolution above those recommended in the above table, you should reduce the size of the image by previewing (or pre-scan) and cropping before scanning the image.

Scanning to a Computer With a USB Connection

**NOTE:** You must connect your computer via USB for selecting this feature. Network connection is not supported.
**NOTE:** This feature is supported on both Microsoft® Windows® and OS X.

1 Load the document(s) facing up with top edge in first into the DADF.
OR
   Place a single document facing down on the document glass, and close the document cover.

   For details about loading a document, see "Loading an Original Document."

2 Press the (Home) button.

3 Tap ➔ Scan to Computer.

4 Tap Computer (via USB).

5 Specify scan settings such as Output Color, Resolution, File Format, 2 Sided Scanning, Darken/Lighten, Contrast, Sharpness, Auto Exposure, Original Size, Margin, and File Naming Mode. For details, see "Scan Settings."

6 Tap Scan to begin scanning the document.
Changing the Location to Save the Scanned Data

On Microsoft® Windows®, use the Dell Printer Hub for Dell Cloud Multifunction Printer | H815dw or Dell Printer Management Tool for Dell Smart Multifunction Printer | S2815dn to change the output destination of the obtained image files and to select whether to open the image files using the related program. Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool. For details, see the FAQ of the Dell Printer Hub or Dell Printer Management Tool.

On OS X, use ScanButton Manager. Click Finder → Applications → Dell → Dell Cloud Multifunction Printer - H815dw or Dell Smart Multifunction Printer - S2815dn, and then double-click ScanButton Manager.

Scanning to a Computer Connected With Web Services on Devices (WSD)

If the printer is connected to a computer via network using Web Services on Devices (WSD), you can send scanned images to the computer.

NOTE: You need to setup connection using Web Services on Devices (WSD).

NOTE: Web Services on Devices (WSD) are supported only on Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1, and Windows® 10. Ensure that the scanner driver is installed on your computer. See "Setting Up the Printer Using Dell Printer Easy Install (Windows® Only)" for details.

Preparations for Scanning Using Web Services on Devices (WSD)

Setup the printer and computer for connection using Web Services on Devices (WSD).

Checking the Printer Setting

Make sure that the Web Services on Devices (WSD) is enabled from the operator panel of the printer or on the Dell Printer Configuration Web Tool. See "Port Settings" or "Protocols" for details.

Setting Up the Computer

NOTE: For Windows® 8, Windows® 8.1, and Windows® 10, the computer automatically connects the printer using Web Services on Devices (WSD). There is no need to install the printer manually.

For Windows® 7:

1. Click Start → Computer → Network
2. Find the printer you want to use, right-click the icon for the printer, and then click Install. The printer is connected using Web Services on Devices (WSD).
3. Right-click the icon for the printer, and then click Scan profiles. Specify the various settings of the profile, including the Source where the documents are loaded.

For Windows Vista®:

1. Click Start → Network
2. Right-click the icon for the printer, and then click Install.
3. Click Continue. The printer is connected using Web Services on Devices (WSD).

Scanning and Sending Images to the Computer Using Web Services on Devices (WSD)

1. Load the document(s) facing up with top edge first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."
2 Press the (Home) button.
3 Tap → Scan to Computer.

NOTE: Whether to scan from the DADF or from the document glass can be specified in the scan profile. Make sure to specify the scan profile accordingly if you want to scan the document from the DADF.

4 Select a computer.
   Swipe the screen until the desired computer you want to send the scan job to appears, and then select that computer.

5 Specify the type of scan. For details, see "Scan to Computer."

6 Tap Scan to begin sending the scanned file.

Scanning From a Computer Using Web Services on Devices (WSD)
If the printer is connected to a computer via network using Web Services on Devices (WSD), you can scan documents from the computer.

NOTE: To scan from the computer using Web Services on Devices (WSD), you need to setup connection using Web Services on Devices (WSD).

NOTE: Web Services on Devices (WSD) are supported only on Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1, and Windows® 10.

Preparations for scanning from the computer
The same preparations are necessary as in scanning to a computer connected with Web Services on Devices (WSD). See "Preparations for Scanning Using Web Services on Devices (WSD)."
Scanning from the computer

The following procedure uses Windows® 7 as an example.

1. Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."

2. Click Start → Devices and Printers on the computer.

3. Right-click the printer icon of the Dell MFP H815dw or Dell MFP S2815dn, and then select Start scan.
Specify the necessary settings for scanning, and then click Scan.

**NOTE:** When you use Windows Vista®, use the drawing software such as Microsoft® Photo Gallery, select the printer connected using the Web Services on Devices (WSD), and start scanning.

**NOTE:** To open Devices and Printers on Windows® 8, Windows® 8.1, Windows Server® 2012, or Windows Server® 2012 R2, right-click the bottom left corner of the screen on the Desktop screen, and then click Control Panel → Hardware and Sound (Hardware for Windows Server® 2012/Windows Server® 2012 R2) → Devices and Printers.

**NOTE:** To open Devices and Printers on Windows® 10, right-click the Start button, and then click Control Panel → Hardware and Sound → Devices and Printers.

---

### Scanning Using the TWAIN Driver


1. Load the document(s) facing up with top edge in first into the DADF.
   
   OR

   Place a single document facing down on the document glass, and close the document cover.

   For details about loading a document, see "Loading an Original Document."

2. Start the graphic software that supports TWAIN, such as Adobe® Photoshop®.

3. Select the scanner from the TWAIN menu on the graphic software, specify the necessary settings, and then start scanning on the window such as shown below.

   For details on operating the graphic software, see the manuals of your software.
For Microsoft® Windows®:

For Apple Macintosh:

**NOTE:** The screen image may vary depending on the software or the operating system.
Scanning Using the Windows Image Acquisition (WIA) Driver

Your printer also supports the Windows Image Acquisition (WIA) driver for scanning images. Windows Image Acquisition (WIA) is one of the standard components incorporated in the recent Microsoft® Windows® operating systems and works with digital cameras and scanners. Unlike the TWAIN driver, the Windows Image Acquisition (WIA) driver allows you to scan an image and easily manipulate those images without using additional software.

NOTE: The Windows Image Acquisition (WIA) driver is supported only on Windows®.

To scan an image from the drawing software:

1. Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."

2. Start the drawing software, such as Microsoft® Paint for Windows®.
   NOTE: When using applications that utilize Windows Image Acquisition (WIA) 2.0, such as Windows® Fax and Scan on Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1, and Windows® 10, the Feeder (Scan both sides) option can be selected for duplex (two-sided) scanning.

3. Click Paint button → From scanner or camera (File → Import from Scanner or Camera for Windows® Vista or Windows Server® 2008).
   The following image uses Dell Cloud Multifunction Printer | H815dw as an example.

   ![Scan using Dell MFP H815dw (USB)](image)

   NOTE: The screen image may vary depending on the operating system.

4. Select your desired type of picture that you want to scan, and click Adjust the quality of the scanned picture to display the Advanced Properties dialog box.

5. Select the desired properties including brightness and contrast, and then click OK.

6. Click Scan to start scanning.

7. Click File→ Save to save your scanned document in your desired location on your computer.
To scan an image from Control Panel:

- **NOTE:** This feature is supported on Microsoft® Windows Server® 2003 only.

1. Load the document(s) facing up with top edge in first into the DADF. OR
   - Place a single document facing down on the document glass, and close the document cover.
   - For details about loading a document, see "Loading an Original Document."

2. Click **Start** → **Control Panel** → **Printers and Other Hardware** → **Scanners and Cameras**.

3. Double-click the scanner icon. The **Scanner and Camera Wizard** launches.

4. Click **Next** to display the **Choose Scanning Preferences** page.
   - **NOTE:** The screen image may vary depending on the operating system.

5. Select your desired type of picture, paper source, and paper size, and click **Next**.

6. Enter a picture name, select a file format, and specify the desired location to save the scanned document.

7. Click **Next** to start scanning.

8. Follow the on-screen instructions to edit the picture after it is copied to your computer.

### Scanning With Wi-Fi Direct

- **NOTE:** The Wi-Fi Direct feature is available on the Dell Cloud Multifunction Printer | H815dw only.

This section provides information for Wi-Fi Direct scanning. Wi-Fi Direct allows your Wi-Fi mobile devices such as computers, smartphones, and tablets, to connect to the printer directly via a Wi-Fi network. With Wi-Fi Direct, you can scan documents or photos from your Wi-Fi mobile devices directly without a wireless access point.

- **NOTE:** Wi-Fi Direct is available even if the printer is connected to your wireless network.

- **NOTE:** The maximum number of devices that can be connected via the Wi-Fi Direct network is 3.

- **NOTE:** You cannot connect your mobile device to the Internet via the printer’s Wi-Fi Direct network.

- **NOTE:** Depending on the mobile device, the channel used to connect the device to the printer via Wi-Fi Direct may differ from the channel used by the printer to connect to a network via Wi-Fi infrastructure mode. In such a case, simultaneous connection with Wi-Fi Direct and Wi-Fi infrastructure mode may not work properly.

- **NOTE:** The printer connected with Wi-Fi Direct supports the following protocols: LPD, Port9100, Web Services on Devices (WSD), Bonjour (mDNS), SNMPv1/v2c, Dell Printer Configuration Web Tool, TWAIN, WIA, ICA.

### Scanning via Wi-Fi Direct

The scanning procedure varies depending on the mobile device and the application you are using. Refer to the manual supplied with your mobile device or application to scan.
Scanning to a PC or Server via SMB/FTP

NOTE: This feature does not require a network scan driver.

Overview

The Scan to Network Folder feature allows you to send the scanned documents to a computer or FTP server.

Required operating systems:

For FTP:

NOTE: For information on how to configure the FTP service, refer to the manual provided with the software.

NOTE: Microsoft® Windows Server® 2003, Windows Vista®, and Mac OS X 10.5 support IPv4 only.

- Microsoft® Windows Server® 2003 Service Pack 1
  FTP service of Microsoft® Internet Information Services 6.0
- Microsoft® Windows Vista®
  Microsoft® Windows Server® 2008
  FTP service of Microsoft® Internet Information Services 7.0
- Microsoft® Windows® 7
  Microsoft® Windows Server® 2008 R2
  FTP service of Microsoft® Internet Information Services 7.5
- Microsoft® Windows® 8
  Microsoft® Windows Server® 2012
  FTP service of Microsoft® Internet Information Services 8.0
- Microsoft® Windows® 8.1
  Microsoft® Windows Server® 2012 R2
  FTP service of Microsoft® Internet Information Services 8.5
- Microsoft® Windows® 10
  FTP service of Microsoft® Internet Information Services 10
For SMB:

NOTE: Microsoft® Windows Server® 2003, Mac OS X 10.5 and Mac OS X 10.6 support IPv4 only.

- Microsoft® Windows Server® 2003
- Microsoft® Windows Vista®
- Microsoft® Windows Server® 2008
- Microsoft® Windows Server® 2008 R2
- Microsoft® Windows® 7
- Microsoft® Windows® 8
- Microsoft® Windows® 8.1
- Microsoft® Windows Server® 2012
- Microsoft® Windows Server® 2012 R2
- Microsoft® Windows® 10
- Mac OS X 10.5/Mac OS X 10.6/OS X 10.9/OS X 10.10

Procedures

Follow the procedures below to complete the setup for the Scan to Network Folder feature.

For FTP:

1. "Adding a Scanning Destination to the Printer's Address Book"
2. "Sending the Scanned File on the Network Folder"

For SMB:

NOTE: The setup for Scan to Network Folder via SMB can be configured easily with the bundled "Address Book Editor" utility. For details about Address Book Editor, see "Adding a Scanning Destination to the Printer’s Address Book."

NOTE: Scan to Network Folder can be also accomplished with the Web Services on Devices (WSD) function. For details about scanning using the Web Services on Devices (WSD) function, see "Scanning to a Computer Connected With Web Services on Devices (WSD)" and "Scanning From a Computer Using Web Services on Devices (WSD)."

1. "Setting a Login Name and a Password (SMB Only)"
2. "Creating a Shared Folder (SMB Only)"
3. "Adding a Scanning Destination to the Printer's Address Book"
4. "Sending the Scanned File on the Network Folder"

Setting a Login Name and a Password (SMB Only)

The Scan to Network Folder feature requires a user login account with a valid and non-empty password for authentication. Confirm a login user name and password.
For Microsoft® Windows®:

If you do not use a password for your user login, you need to create a password on your User Login Account with the following procedure.

**For Windows Vista® and Windows® 7:**
1. Click Start → Control Panel.
2. Click User Accounts and Family Safety.
3. Click User Accounts.
4. Click Create a password for your account and add in a password for your user login account.

**For Windows Server® 2008:**
1. Click Start → Control Panel.
2. Double-click User Accounts.
3. Click Create a password for your account and add in a password for your user login account.

**For Windows Server® 2008 R2:**
1. Click Start → Control Panel.
2. Select User Accounts.
3. Click User Accounts.
4. Click Create a password for your account and add in a password for your user login account.

**For Windows® 8 and Windows Server® 2012:**
1. Point to the top or bottom right corner of the screen, and then click Settings.
2. Click Change PC settings.
3. Click Users.
4. Click Create a Password and add in a password for your user login account.

**For Windows® 8.1 and Windows Server® 2012 R2:**
1. Point to the top or bottom right corner of the screen, and then click Settings.
2. Click Change PC settings.
3. Click Accounts.
4. Click Sign-in options.
5. Click Add under Password and add in a password for your user login account.
For Windows® 10:
1. Right-click the Start button, and then click Settings.
2. Click Accounts.
3. Click Sign-in options.
4. Click Add under Password and add in a password for your user login account.

For Mac OS X 10.5 and Mac OS X 10.6:
1. Click System Preferences → Accounts.
2. Select Change Password.
3. Enter a password for your user login account in New password.
4. Re-enter the password in Verify.

For OS X 10.9 and OS X 10.10:
1. Click System Preferences → Users & Groups.
2. Select Change Password.
3. Enter a password for your user login account in New password.
4. Re-enter the password in Verify.

Creating a Shared Folder (SMB Only)
Create a shared folder to store the scanned document from your printer.

1. Create a folder in the desired directory on your computer (Example of folder name, MyShare).
2. Right-click the folder, and then select Properties.
   The Properties dialog box appears.
3. Click the Sharing tab, and then select Advanced Sharing.
4. Select the Share this folder check box.
5 Enter a shared name in the Share name box.

   **NOTE:** Write down the shared name as you need to use this name in the next setting procedure.

6 Click Permissions to create a write permission for this folder.

7 Click Add.

8 Search user login name by clicking Advanced, or enter the user login name in Enter the object names to select box and click Check Names to confirm (Example of user login name, Myself).

9 Click OK.

10 Click the user login name that you have just entered. Select Full Control check box. This will grant you permission to send the document into this folder.

   **NOTE:** Do not use Everyone as the user login name.
11 Click OK.

**NOTE:** To add sub-folders, create new folders in the shared folder you have created.

For example:
Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

For Mac OS X 10.5, Mac OS X 10.6, OS X 10.9, and OS X 10.10:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).
2 Select the created folder, and then select Get Info from the File menu.
3 Select the Shared Folder check box.
4 Open System Preferences, and then click Sharing.
5 Select the File Sharing check box, and then click Options.
6 Select the Share Files and folders using SMB and account name check boxes.
7 Click Done.

**Adding a Scanning Destination to the Printer’s Address Book**

You can register the connection details for SMB and FTP server in the address book using Dell Printer Configuration Web Tool or Address Book Editor.

Before beginning to setup a destination, make sure you have the IP addresses you need such as printer and computer.

**Verifying the IP Address Setting of the Printer**

To setup the server address book through the network, you will first need to locate the IP address of the printer. To find your printer’s IP address, see “Verifying the IP Settings.”

**Locating the IP Address Setting of Your Computer**

You can locate the IP address of your computer by the following operations.

1 For Windows Vista®/Windows® 7:
   Click Start→All Programs→Accessories→Run.
   For Windows Server® 2003/Windows Server® 2008/Windows Server® 2008 R2:
   Click Start→Run.
   For Windows® 8/Windows® 8.1/Windows Server® 2012/Windows Server® 2012 R2:
   Point to the top or bottom right corner of the screen, and then click Search→Type Run in the search box, click Apps (for Windows® 8 and Windows Server® 2012 only), and then click Run.
   For Windows®10:
   Right-click the Start button, and then click Run.

2 Type cmd in the text field and click OK. A command prompt window will open.
3 Type ipconfig and press Enter.
4 Write down the IP Address xxx.xxx.xxx.xxx.
Using Dell Printer Configuration Web Tool

1 Open a web browser.

2 Type in the IP address of the printer in the address bar, and press the <Enter> key.

   The web page of the printer appears.

  NOTE: For details on how to check the IP address of the printer, see "Verifying the IP Settings."

3 Click Address Book. If a security login dialog box appears, type in the correct User Name and Password.

  NOTE: The default user name is "admin", and the default password is left blank (NULL).

4 Click the Server Address tab, and then click Create of an ID.
Server Address page appears.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Enter a friendly name that you want to display on the Server address book.</td>
</tr>
<tr>
<td>2</td>
<td>Server Type</td>
<td>Select <strong>FTP</strong> if you store document on a FTP server. Select <strong>SMB</strong> if you store documents in a shared folder on your computer.</td>
</tr>
</tbody>
</table>
| 3 | Server Address | Enter a FTP server name that you have shared out or a server name or IP address of your computer.  
- For FTP:  
  Server name: myhost.example.com  
  (myhost: host name, example.com: domain name)  
  IP address: 192.0.2.1  
- For SMB:  
  Server name: myhost  
  IP address: 192.0.2.1 |
| 4 | Share Name | Enter the name of the shared folder on the recipient computer. For SMB only.  
- For SMB: e.g. Share, Sharefolder |
| 5 | Server Path | Enter the subdirectory path where you want the scanned document to be stored. Ensure that the subdirectory path is already created in the shared folder or FTP server.  
- For FTP: e.g. pub, pub/share  
- For SMB: e.g. finance, finance\Peter, finance\Peter\Sales |
| 6 | Server Port Number | Enter the Server Port Number. If you are unsure, you can enter the default value of 21 for FTP or 139 for SMB.  
Available ports are:  
FTP: 21, 5000 - 65535  
SMB: 139, 445, 5000 - 65535 |
| 7 | Login Name | Enter the user account name to allow access to a shared folder on your computer or to a FTP server.  
- For FTP: Contact the system administrator.  
- For SMB: Windows® login name that you have specified in the procedure 1. |
| 8 | Login Password | Enter the password corresponding to the above login name.  
- For FTP: Contact the system administrator  
- For SMB: Empty password is not valid in the Network (Computer) feature. Ensure that you have a valid password for the user login account. (See "Setting a Login Name and a Password (SMB Only)" for details on how to add a password in your user login account.) |
Using Address Book Editor

1. Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.
   For Windows® 10: Click the Start button → Dell Printer Hub or Dell Printer Management Tool.

2. For Dell Printer Hub, select the printer from My Printers on the home screen.
   For Dell Printer Management Tool, select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the home screen.

3. Click the shortcut to the Address Book Editor on the left of the screen.

4. Click Tool → New (Device Address Book) → Server.

*For Microsoft® Windows®:*

![Address Book Editor](image)

*For Apple Macintosh:*

![Address Book Editor](image)

Server Address dialog box appears.

(9) Re-enter Password

Re-enter your password.
For Microsoft® Windows®:

(1) Name
Enter a friendly name that you want to display on the Server address book.

(2) Server Type
Select Computer if you store documents in a shared folder on your computer.
Select Server if you store documents on a FTP server.

(3) Server Name/IP Address
Enter a server name or IP address of your computer or the FTP server name that you have shared out.

The following are examples:
- For Computer:
  Server name: myhost
  IP address: 192.0.2.1
- For Server:
  Server name: myhost.example.com
  (myhost: host name, example.com: domain name)
  IP address: 192.0.2.1

For Apple Macintosh:

To fill in the fields, enter the information as follows:

(1) Name
Enter a friendly name that you want to display on the Server address book.

(2) Server Type
Select Computer if you store documents in a shared folder on your computer.
Select Server if you store documents on a FTP server.

(3) Server Name/IP Address
Enter a server name or IP address of your computer or the FTP server name that you have shared out.

The following are examples:
- For Computer:
  Server name: myhost
  IP address: 192.0.2.1
- For Server:
  Server name: myhost.example.com
  (myhost: host name, example.com: domain name)
  IP address: 192.0.2.1
Sending the Scanned File on the Network Folder

1 Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."
2 Press the (Home) button.
3 Tap ➙ Scan to Network Folder.
4 Tap and select the desired address. When you cannot find the address, tap Address Book and select the desired address.
5 Tap and specify scan settings such as Output Color, Resolution, File Format, 2 Sided Scanning, Darken/Lighten, Contrast, Sharpness, Auto Exposure, Original Size, Margin, and File Naming Mode. For details, see "Scan Settings."
6 Tap Scan to begin scanning and sending the file.
Scanning to a USB Memory

The Scan to USB feature allows you to store scanned image directly to a USB memory attached to the printer without using software.

Types of a USB Memory

You can use a USB memory with the following interfaces:

- USB 1.1
- USB 2.0

The USB memory must be formatted in FAT file systems (FAT16, FAT32, or VFAT) before inserting the memory device into the front USB port of the printer.

- **NOTE:** If the USB memory is formatted in a file system other than above, the printer may not recognize that the USB memory is attached.

- **NOTE:** A USB memory with authentication feature and some brands of USB memories cannot be used with this printer.

Procedures

To store the scanned images to a USB memory:

- **NOTE:** If you insert a USB memory to the front USB port first, the USB Drive Detected screen may appear. In this case, select Scan to USB, and proceed to step 6.

1. Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."

2. Press the (Home) button.

3. Insert a USB memory into the front USB port of the printer. See "Inserting and Removing a USB Memory" for more details.

4. Tap Scan to USB.

5. Tap and specify scan settings such as Output Color, Resolution, File Format, 2 Sided Scanning, Darken/Lighten, Contrast, Sharpness, Auto Exposure, Original Size, Margin, and File Naming Mode. For details, see "Scan Settings."
   You can also specify the folder to save the scanned image. For details, see "Specifying a Folder to Save the Scanned Image."

6. Tap Scan to begin scanning the document.

7. Remove the USB memory from the printer. See "Inserting and Removing a USB Memory" for more details.

Specifying a Folder to Save the Scanned Image

To save the scanned image to a folder in the USB memory, specify the folder before executing the scan job.

1. If a folder has already existed in the USB memory, the folder name appears on the display.

2. Select a folder to save the scanned image.

   - **NOTE:** The default saving location is the root directory of the USB memory.
   - **NOTE:** You cannot directly enter a folder path using the numeric keypad.
   - **NOTE:** You can select any folder in the USB memory but cannot create a new folder in this step. You should always create a new folder before connecting the memory to the printer.
If the name of the scanned image has already existed in the folder, the printer automatically generate a new file name to save the data.

**Sending an E-Mail With the Scanned Image**

You can send the scanned image as an e-mail attachment using the Scan to Email function. To send an e-mail, an e-mail account is necessary such as the corporate mail account or the Internet service provider's mail account. Gmail account can be used as well.

The following are the procedures necessary to setup Scan to E-mail function.

- "Preparing the Printer to Send the E-Mail"
- "Setting the DNS Server Address"
- "Setting the Information Necessary to Access the Mail Server"
- "Setting the Administrator's E-mail Address"

**Preparing the Printer to Send the E-Mail**

To send an e-mail from your printer, the following information is necessary:

- E-mail account (user account) information
- E-mail sever information

**NOTE:** For information of your e-mail account or the mail server, consult your network administrator or your Internet service provider.

**NOTE:** When the printer is connected to the network which is using a proxy server, the printer may not be able to send the e-mail. In this case, consult your network administrator.

**NOTE:** The preparations described below are effective while the e-mail account information is valid. You do not have to repeat the settings whenever you send the e-mail.

**Setting the DNS Server Address**

To set the DNS server address to your printer, follow the steps below:

1. Launch the Dell Printer Configuration Web Tool.
   - a) Open the web browser.
   - b) Enter the IP address of your printer in the web browser.
     See "Dell™ Printer Configuration Web Tool."

2. Click Print Server Settings.

3. Click TCP/IP.

4. If you are using DHCP for TCP/IP setting for the printer:
   - Set Get DNS Server Address from DHCP to Enable.
   - If you are setting TCP/IP manually:
     - Set Manual DNS Server Address.

5. Click Apply New Settings.
Setting the Information Necessary to Access the Mail Server

To make the printer to send an e-mail, follow the steps below:

1. Launch the Dell Printer Configuration Web Tool.
   a. Open the web browser.
   b. Enter the IP address of your printer in the web browser.
      See "Dell™ Printer Configuration Web Tool."

2. Click E-Mail Server Settings Overview.

3. Set the mail server information under E-Mail Server.

   **NOTE:** In this procedure, the server settings for a Gmail account are used as an example. The server settings will differ for each e-mail service.

   **NOTE:** Information about the Gmail account is based on the information as of October 2013. For the latest information, visit the homepage of Gmail.

   ![Image of Dell Printer Configuration Web Tool]

   a. In the Primary SMTP Gateway text box, set the primary SMTP gateway. For example: smtp.gmail.com

   b. In the SMTP Port Number text box, enter the SMTP port number. This must be between 1 and 65535.

   c. In the E-Mail Send Authentication drop-down menu, specify the authentication method for outgoing e-mail. For example: SMTP_Auth (Auto)

   d. In the SMTP Login User text box, set the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, underscores, and at symbols (@) can be used. If specifying more than one address, separate them using commas. For example: aaaa@gmail.com

      **NOTE:** It is not advisable to share a personal e-mail account with others for Scan to Email function. Instead, use the e-mail account dedicated for Scan to Email function.

   e. In the SMTP Login Password text box, set the SMTP account password using up to 31 alphanumeric characters.

   f. In the Re-enter SMTP Login Password text box, enter the login password again to confirm it.
g In the **POP3 Server Address** text box, enter the POP3 server address in IP address format of "aaa.bbb.ccc.ddd" or as a DNS host name using up to 63 characters. *1

h In the **POP3 Port Number** text box, enter the POP3 server port number. This must be between 1 and 65535. *1

i In the **POP User Name** text box, set the POP3 account user name. Up to 63 alphanumeric characters, periods, hyphens, underscores, and at symbols (@) can be used. If specifying more than one address, separate them using commas. *1

j In the **POP User Password** text box, enter the POP3 account password using up to 31 alphanumeric characters. *1

k In the **Re-enter POP User Password** text box, enter the POP user password again to confirm it. *1

l In the **Reply Address** text box, enter the reply e-mail address sent with each E-Mail Alert.

*1 Required to enter if you select POP before SMTP (Plain) or POP before SMTP (APOP) for E-Mail Send Authentication.

4 Click **Apply New Settings**.

If SMTP authentication is selected for E-Mail Send Authentication and if SSL/TLS encryption is used to communicate with the SMTP sever, the SSL/TLS type must be set in **SMTP-SSL/TLS Communication** of SSL/TLS under the Security tab. Proceed to step 5.

If SSL/TLS is not used or if "Invalid", "POP before SMTP (Plain)", or "POP before SMTP (APOP)" is selected for E-Mail Send Authentication, the mail server settings are complete.

NOTE: To send an e-mail through Gmail, set the SSL/TLS type should be set to STARTTLS in **SMTP-SSL/TLS Communication** of SSL/TLS under the Security tab.

5 Click **Security tab**.

6 Select SSL/TLS.

7 Select a SSL/TLS type from the **SMTP-SSL/TLS Communication** list.

NOTE: To use a Gmail account, select **STARTTLS**.

8 Click **Apply New Settings**.

### Setting the Administrator's E-mail Address

To make the printer to set an administrator's e-mail address, follow the steps below:

1 Launch the **Dell Printer Configuration Web Tool**.
   a Open the web browser.
   b Enter the IP address of your printer in the web browser.
      See "Dell™ Printer Configuration Web Tool."

2 Click **Print Server Settings**.

3 Click **Basic Information**.

4 Set administrator’s e-mail address in the **Administrator E-Mail Address** text box. Up to 63 alphanumeric characters, periods, hyphens, underscores, and at symbols (@) can be used.

5 Click **Apply New Settings**.
Adding a New E-Mail Address to the Printer’s Address Book

1. From the Dell Printer Configuration Web Tool, click Address Book, and then click the E-Mail Address tab.
2. Click Create.
   The E-Mail Address page for registering a new e-mail address appears.

3. Enter the following:
   • Name
   • Address

4. Click Apply New Settings.

Sending an E-mail With the Scanned File

1. Press the (Home) button.
2. Tap ➡ Scan to Email.
3. Specify a recipient from the following:
   - Enter Recipient’s Address: Enter an e-mail address directly.
   - Sender: Select from the following types of selecting sender's e-mail address:
     • Keyboard: Select an e-mail address from using keyboard.
     • Address Book: Select a group of e-mails registered in the address book.
     • Network Address Book: Search an e-mail address from the LDAP server address book.
   - NOTE: The sender’s e-mail address cannot be edited when the remote authentication is used as the user authentication method on the Dell Smart Multifunction Printer | S2815dn.

Address Book: Select from the following types of address books:
• Individuals: Select an e-mail address registered in the address book.
• Groups: Select a group of e-mails registered in the address book.
• Network Address Book: Search an e-mail address from the LDAP server address book.

Tap + and the recipient you specified from Enter Recipient’s Address to remove or edit the recipient.
Tap + and the recipient you specified from Address Book to remove or see details of the recipient. You can also change the e-mail to Bcc.

NOTE: For more information on address book and server address book, see “Address Book Editor (for Microsoft® Windows® and OS X).”

NOTE: For details about Network Address Book, see “Using the Server Address Book and Server Phone Book.”
**NOTE:** The e-mail addresses needs to be registered before you can select Address Book.

4 Tap and specify scan settings such as Output Color, Resolution, File Format, 2 Sided Scanning, Darken/Lighten, Contrast, Sharpness, Auto Exposure, Original Size, Margin, and File Naming Mode. For details, see "Scan Settings."

5 Tap Send to begin scanning the document and sending an e-mail with the scanned file.

**Managing the Scanner**

You can select the port connected to the computer or set the password for the scanner from the TWAIN driver.

Open the application that supports TWAIN, and click **Settings** in the scanning window.

**Port Settings**

When the printer is connected to the computer directly by a USB cable, select **USB**.

When the printer is connected to the network, select **Network**. Enter the IP address or hostname of the printer in the **IP Address or Hostname** text box, and click **OK**.

**When the printer is connected to the network**

When you are using DHCP for TCP/IP setting for the printer, the image capturing software may not find the scanner occasionally due to the change of the IP address allocated for the printer. In this case, check the IP Address of the printer, and then connect the scanner by specifying the IP address.

On Microsoft® Windows®, you can check the IP address of the printer using the **Dell Printer Hub** or **Dell Printer Management Tool**. For **Dell Printer Hub**, select the printer from **My Printers**, and then click **Printer information** on the left of the screen. For **Dell Printer Management Tool**, select the printer from the drop-down list on the upper-right of the screen, and then click **Printer information** on the left.

**Searching the scanner**

In the **Port Settings** tab, you can search the scanners from the network and select the desired one from the detected scanners.

- **Search all scanners from the network** (Windows® only)
  Searches scanners in your network.

- **Scanner List**
  Displays a list of scanners that are detected.

- **Search again**
  Searches the scanners in your network.

- **Search Criteria** (Windows® only)
  Displays the **Search Criteria** dialog box for setting the search condition.
Search Criteria Dialog Box (Windows® only)

- **Subnet Address**
  Enter the subnet address.
  - IPv4: Broadcast Address such as "192.0.2.1"
  - IPv6: Multicast Address such as "2001:db8:"

- **Search Time**
  Specify a time period for searching a scanner.

- **Community Name**
  Enter the SNMPv1/v2 community name. The default community name is "public."

**Password Setting**

In the **Password for Scanner** text box of the **Password Setting** tab, you can input the password that is set for your scanner to access from your computer to the printer.

**For Microsoft® Windows®:**
For Apple Macintosh:

- **Password for Scanner**

  Enter the password.
Faxing

**NOTE:** If the Functions Control setting for Fax is set to On (Password), you need to enter the four-digit password to use the fax function. If the Functions Control setting for Fax is set to Off, the fax function is disabled and the menu is also disabled on the touch panel. For details, see “Functions Control.”

**NOTE:** If the Panel Lock Control is set to Enable, you need to enter the four-digit password to enter the Admin Settings menu.

**NOTE:** The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

### Specifying the Fax Initial Settings Using the Dell Printer Easy Install

You can specify the country, line type, tone/pulse, receive mode, DRPD pattern, fax header name, and fax number.

1. Insert the *Software and Documentation* disc provided with the printer into your computer. The Dell Printer Easy Install program launches automatically.
2. Click Main Menu.

3. Click Change. The Configure Printer window appears.
4. Select Configure the Fax settings, and then click Next.
5 Follow the instructions displayed on the screen.
Available settings are:
  • Country
  • Line Type
  • Tone/Pulse
  • Receive Mode
  • DRPD Pattern
    (This setting is available only when a distinctive ring service is installed on your telephone line by your
    telephone company.)
  • Fax Header Name
  • Fax Number

NOTE: To make initial settings from the printer operator panel, see "Setting Your Country."

Setting Your Country

1 Press the Information (Information) button.
2 Tap the Tools tab, and then tap Admin Settings.
3 Tap Fax Settings.
4 Tap Fax Line Settings.
5 Tap Country.
6 Select the country where the printer is used, and then tap OK.

   The printer must be rebooted after you set the country settings. When a screen prompting you to reboot the
   printer, tap Yes. After the reboot, the Home screen is displayed on the touch panel.

   NOTE: When you configure the country setting, the information, which is registered to the printer, is initialized.

Setting the Printer ID

In most countries, you are required by law to indicate your fax number on any fax you send. The printer ID,
containing your telephone number and name or company name, will be printed at the top of each page sent from
your printer.

1 Press the Information (Information) button.
2 Tap the Tools tab, and then tap Admin Settings.
3 Tap Fax Settings.
4 Tap Fax Line Settings.
5 Tap Fax Number.
6 Enter your fax number using the number pad, and then tap OK.

   NOTE: If you make a mistake while entering numbers, press the button to delete the last digit.
7 Tap Fax Header Name.
8 Enter your name or company name using the keyboard, and then tap OK.

   For details on how to use the keyboard to enter alphanumeric characters, see "Using the Keyboard Displayed on the
   Touch Panel."
Setting the Time and Date

**NOTE:** It may be necessary to reset the correct time and date if loss of power to the printer occurs.

To set the time and date:

1. Press the **(Information)** button.
2. Tap the **Tools** tab, and then tap **Admin Settings**.
3. Tap **System Settings**.
4. Tap **General**.
5. Tap **Date & Time**.
6. Tap **Time Zone**.
7. Tap until the desired geographic region appears, and then select that region.
8. Tap until the desired time zone appears, and then select that time zone.
9. Tap **OK**.
10. Tap **Date**.
11. Tap – or + or enter the date using the number pad, and then tap **OK**.
12. Tap **Time**.
13. Enter the time using the number pad.
14. Tap **OK**.

**NOTE:** The printer beeps and does not allow you to proceed to the next step if a wrong number is entered.

Changing the Clock Mode

You can set the current time using either the 12-hour or the 24-hour format.

1. Press the **(Information)** button.
2. Tap the **Tools** tab, and then tap **Admin Settings**.
3. Tap **System Settings**.
4. Tap **General**.
5. Tap **Date & Time**.
6. Tap **Time**.
7. Tap **12 Hour** or **24 Hour**, and then tap **OK**.

Setting Sounds

Speaker Volume

1. Press the **(Information)** button.
2. Tap the **Tools** tab, and then tap **Admin Settings**.
3. Tap **Fax Settings**.
4. Tap **Fax Line Settings**.
5. Tap until **Line Monitor** appears, and then tap **Line Monitor**.
6. Select the desired volume, and then tap **OK**.
7. Turn off the printer, and turn it on again to apply the settings.
Ringer Volume

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Fax Settings.
4. Tap Incoming Defaults.
5. Tap Ring Tone Volume.
6. Select the desired volume, and then tap OK.
7. Turn off the printer, and turn it on again to apply the settings.

Specifying the Fax Settings Options

Changing the Fax Settings Options

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Fax Settings.
4. Select the desired menu.
5. Select the desired setting or enter a value.
   To enter a value, tap – or +, or use the number pad or the keyboard.
6. Tap OK.
   If necessary, repeat steps 4 through 6.

Available Fax Settings Options

You can use the following settings options for configuring the fax system:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Line Settings</td>
<td></td>
</tr>
<tr>
<td>Fax Number</td>
<td>Specifies the fax number of the printer, which will be printed on the header of faxes. This feature is available when you set Fax Header to On. The number specified in Fax Number is used in the printer ID.</td>
</tr>
<tr>
<td>Country</td>
<td>You can select the country where the printer is used.</td>
</tr>
<tr>
<td></td>
<td>You can change this setting when:</td>
</tr>
<tr>
<td></td>
<td>• No jobs in operation</td>
</tr>
<tr>
<td></td>
<td>• No fax jobs waiting in the memory</td>
</tr>
<tr>
<td>Fax Header Name</td>
<td>Specifies the sender’s name to be printed on the header of faxes.</td>
</tr>
<tr>
<td>Line Type</td>
<td>You can select the default line type.</td>
</tr>
<tr>
<td></td>
<td>• PSTN</td>
</tr>
<tr>
<td></td>
<td>• PBX</td>
</tr>
<tr>
<td>Line Monitor</td>
<td>Sets the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a connection is made.</td>
</tr>
</tbody>
</table>
Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.

You can select the default fax receiving mode.

- **Telephone** (manual receive mode): Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive code, or by tapping Manual Receive in On Hook and then tapping Receive. For details about Manual Receive, see "Receiving a Fax Manually in the Telephone Mode."

- **Fax** (automatic receive mode)

- **Telephone / Fax**: When the printer receives an incoming fax, the external telephone rings for the time specified in Auto Rec Fax/Tel, and then the printer automatically receives a fax. If an incoming call is not a fax, the printer beeps from the internal speaker indicating that the call is a telephone call.

- **Ans Machine/Fax**: The printer can share a telephone line with an answering machine. In this mode, the printer will monitor the fax signal and pick up the line if there are fax tones. If the phone communication is using serial transmission in your country (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, France and Switzerland), this mode is not supported.

- **DRPD**: Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Incoming Defaults</strong></td>
<td><strong>Receive Mode</strong> You can select the default fax receiving mode.</td>
</tr>
<tr>
<td><strong>DRPD Pattern</strong></td>
<td>Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.</td>
</tr>
<tr>
<td><strong>Ring Tone Volume</strong></td>
<td>Sets the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker when Receive Mode is set to Telephone / Fax.</td>
</tr>
<tr>
<td><strong>Auto Receive Setup</strong></td>
<td><strong>Auto Receive Fax</strong> Sets the interval at which the printer goes into the fax receive mode after receiving an incoming call. The interval can be specified within the range of 0 to 255 seconds. The default is 0 second.</td>
</tr>
<tr>
<td><strong>Auto Receive Tel/Fax</strong></td>
<td>Sets the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming call. The interval can be specified within the range of 0 to 255 seconds. The default is 6 seconds.</td>
</tr>
<tr>
<td><strong>Auto Receive Ans/Fax</strong></td>
<td>Sets the interval at which the printer goes into the fax receive mode after the external answering machine receives an incoming call. The interval can be specified within the range of 0 to 255 seconds. The default is 21 seconds.</td>
</tr>
<tr>
<td><strong>Junk Fax Setup</strong></td>
<td>You can reject faxes sent from unwanted stations. The system only accepts faxes from the remote stations registered in the speed dial. This feature is useful for blocking any unwanted faxes. Tap Off to turn the feature off. Anybody can send you a fax. Tap On to turn the feature on.</td>
</tr>
</tbody>
</table>
### Secure Receive
You can specify whether to require a four-digit password to print the stored incoming faxes, and to set or change the password.

### Received Fax Forward
You can set your printer to forward incoming faxes to another fax number, to e-mail addresses, or to a server. When a fax arrives at your printer, it is stored in the memory. Then, the printer dials the fax number you have specified in Forwarding Number or forwards the fax to e-mail addresses or a server address you have specified in the Dell Printer Configuration Web Tool.

To forward to a fax number, you need to register a fax number on Forwarding Number. To forward to e-mail addresses, you need to register information on the e-mail server and the forwarding e-mail addresses. To forward to a server address, you need to register information on the destination server. For details on setting the e-mail server, see "E-Mail Server" and on forwarding number, e-mail address, and server address, see "Fax Settings."

Tap Off not to forward incoming faxes.
Tap Forward to forward incoming faxes without printing. If an error occurs during forwarding a received fax, the printer prints the fax.
Tap Print and Forward to print and forward incoming faxes.
Tap Forward to Email to forward incoming faxes to e-mail.

**NOTE:** Depending on the e-mail server settings, the printer may not get an error which occurs during the transfer.

Tap Print and Forward to E-mail to print and forward incoming faxes to e-mail.
Tap Forward to Server to forward incoming faxes to server.
Tap Print and Forward to Server to print and forward incoming faxes to server.

### 2 Sided Print
You can set whether to make duplex print when you print faxes.
Tap Off to print faxes on one side of a sheet of paper.
Tap On to print faxes on both sides of a sheet of paper.

**NOTE:** Duplex print may not be done depending on the size of the received faxes or settings of the trays, etc.

### Remote Receive
You can receive a fax by pressing the remote receive code on the external telephone after picking up the handset of the telephone. When you set Remote receive to On, specify a two digit remote receive code in Remote Receive Tone.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discard Size</td>
<td>When receiving a document as long as or longer than the paper installed in your printer, you can set the printer to discard any excess at the bottom of the page. If the received page is outside the margin you set, it will print on two sheets of paper at the actual size. When the document is within the margin and Discard Size is set to Auto Reduction, the printer reduces the document to fit it onto the appropriate sized paper and discard does not occur. If Discard Size is set to other than Auto Reduction, the data within the margin will be discarded.</td>
</tr>
<tr>
<td>Transmission Defaults</td>
<td>You can specify the number of redial attempts to make when the destination fax number is busy, within the range of 0 to 13. If you enter 0, the printer will not redial.</td>
</tr>
<tr>
<td>Auto Redial Setup</td>
<td>Your printer can automatically redial a remote fax machine if it was busy. Intervals from 1–15 minutes can be entered.</td>
</tr>
<tr>
<td>Redial Attempts</td>
<td>You can specify whether or not to set a prefix dial number. When you set Prefix Dial to On, the number set in Prefix Dial Number dials before any auto dial number is started. It is useful for accessing the Private Automatic Branch Exchange (PBX). You can set a prefix dial number of up to five digits.</td>
</tr>
<tr>
<td>Tone/Pulse</td>
<td>You can select the dialing type.</td>
</tr>
<tr>
<td></td>
<td>- Tone</td>
</tr>
<tr>
<td></td>
<td>- Pulse(10PPS)</td>
</tr>
<tr>
<td></td>
<td>- Pulse(20PPS)</td>
</tr>
<tr>
<td>Prefix Dial</td>
<td>You can specify whether or not to set a prefix dial number. When you set Prefix Dial to On, the number set in Prefix Dial Number dials before any auto dial number is started. It is useful for accessing the Private Automatic Branch Exchange (PBX). You can set a prefix dial number of up to five digits.</td>
</tr>
<tr>
<td>Fax Cover Page</td>
<td>You can set whether to attach a cover page to faxes when sending faxes.</td>
</tr>
<tr>
<td>Fax Header</td>
<td>Prints the sender’s information on the header of faxes.</td>
</tr>
<tr>
<td></td>
<td>Tap Off to turn this feature off.</td>
</tr>
<tr>
<td></td>
<td>Tap On to turn this feature on.</td>
</tr>
<tr>
<td></td>
<td>Note that if United States is selected for the setting of Country, this option does not appear on the menu. The setting is fixed to On and cannot be changed. For information on the country setting, see &quot;Setting Your Country.&quot;</td>
</tr>
<tr>
<td>ECM</td>
<td>You can set whether to enable or disable the ECM (Error Correction Mode).</td>
</tr>
<tr>
<td>Modem Speed</td>
<td>You can set the modem speed.</td>
</tr>
<tr>
<td>Display Manual</td>
<td>You can set whether to display the fax number of the recipient on the Sending Fax screen when manually sending a fax.</td>
</tr>
<tr>
<td>Fax Reports</td>
<td>You can set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.</td>
</tr>
<tr>
<td>Fax Activity</td>
<td>You can set whether to print a transmission result after a fax transmission.</td>
</tr>
<tr>
<td>Fax Transmit</td>
<td>You can set whether to print a transmission result after a fax transmission to multiple locations.</td>
</tr>
<tr>
<td>Fax Broadcast</td>
<td>You can set whether to print a transmission result after a fax transmission to multiple locations.</td>
</tr>
</tbody>
</table>
Prefix Dial supports only the environment where you send a fax to the external line number. To use Prefix Dial, you must do the following from the operator panel.

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Fax Settings.
4. Tap Fax Line Settings.
5. Tap Line Type.
6. Tap PBX, and then OK.
7. Tap Transmission Defaults.
8. Tap Prefix Dial.
10. Enter a prefix number using the number pad, and then tap OK. The characters you can use for a prefix number are 0–9, *, and #. The maximum number of characters for a prefix number is five.
11. Turn off the printer, and turn it on again to apply the settings.

Advanced Fax Settings

NOTE: The advanced fax settings are only meant for advanced users. Incorrect settings may damage the printer.
If you are experiencing fax send or receive errors, there is an advanced fax settings menu which you can access and change the settings accordingly.

To enter the Diagnostic Menu (Customer Mode), follow the instructions.
1. Turn off the printer.
2. Disconnect all network, phone line, and USB cables from the printer.
3. Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.

After all the advanced fax settings have been made, you will need to turn off and on the printer for the new settings to be effective.

Fax Data Encoding Method

Some of the legacy fax devices do not support the Joint Bi-level Image Experts Group (JBIG) data encoding method. You may experience fax send or receive errors due to this data encoding method. You can disable the JBIG and select the Modified Huffman (MH), Modified Read (MR), or Modified Modified Read (MMR) encoding with the following instructions.

You can change the modem transmission encoding with the following instructions.
1. Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.
2. Tap button to tap Fax/Scanner Diag, and then tap OK.
3. Tap button until Parameter appears, and then tap OK.
4. Ensure that FAX Parameter appears, and then tap OK.
5. Tap button until G3M TX Coding appears, and then tap OK.
6. Tap button until the desired encoding appears, and then tap OK.
You can select MH, MR, or MMR.

You can change the modem receive encoding with the following instructions.

1. Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.
2. Tap button to tap Fax/Scanner Diag, and then tap OK.
3. Tap button until Parameter appears, and then tap OK.
4. Ensure that FAX Parameter appears, and then tap OK.
5. Tap button until G3M RX Coding appears, and then tap OK.
6. Tap button until the desired encoding appears, and then tap OK.

You can select MH, MR, or MMR.

Diagnosing the Fax Connection

You can diagnose the Fax connection using the FAX Line Diagnosis feature that can detect the abnormalities of telephone line connection.

1. Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.
2. Tap button to tap Fax/Scanner Diag, and then tap OK.
3. Tap button until FAX Test appears, and then tap OK.
4. When the message Check FAX Connection appears, tap OK.
5. When the message Ready to Start appears, tap OK to start diagnosing the FAX connection.

One of the following diagnosing result is displayed.

<table>
<thead>
<tr>
<th>Diagnosing result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection not Detected</td>
<td>The telephone line cord is not connected. Make sure that the telephone line cord is securely connected.</td>
</tr>
<tr>
<td>Please Reconnect Telephone Line</td>
<td></td>
</tr>
<tr>
<td>Cable Connected Wrongly</td>
<td>The telephone line cord is connected to the wrong connector. Make sure that the telephone line cord is connected at one end to the wall jack connector ( ) of your printer and at the other end to an active wall jack. If you use a telephone or answering machine, connect to the phone connector ( ).</td>
</tr>
<tr>
<td>Reconnect Telephone Line from Wall Jack to Line Connection</td>
<td></td>
</tr>
<tr>
<td>Fax Connection OK</td>
<td>The telephone line cord is properly connected. Check the Tone/Pulse setting. For information on Tone/Pulse setting, see &quot;Available Fax Settings Options.&quot;</td>
</tr>
<tr>
<td>Please Check Setting of Tone/Pulse in Admin Menu after Restart Printer</td>
<td></td>
</tr>
</tbody>
</table>
Sending a Fax

You can fax data from your printer. You can also directly fax data transferred from the computer running a Microsoft® Windows® operating system or OS X.

Loading an Original Document

You can use the DADF or the document glass to load an original document for faxing. Using the DADF, you can load up to 50 sheets of 75 g/m² (20 lb) paper at a time. Using the document glass, you can load one sheet at a time.

NOTE: To get the best scan quality, especially for grayscale images, use the document glass instead of the DADF.

To fax a document using the Duplex Automatic Document Feeder (DADF):

1. Place the document(s) facing up on the DADF with the top edge of the documents in first. Then adjust the document guides to the correct document size.

2. Adjust the document resolution. (For details, see "Adjusting the Document Resolution.")

To fax a document from the document glass:

1. Open the document cover.
2 Place the document facing down on the document glass and align it with the registration guide on the top left corner of the glass.

3 Adjust the document resolution. (For details, see "Adjusting the Document Resolution.")

4 Close the document cover.

   **NOTE:** Ensure that no document is in the DADF. If any document is detected in the DADF, it takes priority over the document on the document glass.

   **NOTE:** If you are faxing a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close the cover. If the book or magazine is thicker than 30 mm, start faxing with the cover open.

**Adjusting the Document Resolution**

You can improve the quality of the fax document by adjusting the resolution, especially for documents with low image quality or documents containing photographic images.

1 Press the  (Home) button.
2 Tap  → Fax.
3 Tap .
4 Tap Resolution.
5 Tap the desired setting.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard*</td>
<td>Used for documents with normal sized characters.</td>
</tr>
<tr>
<td>Fine</td>
<td>Used for documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td>Super Fine</td>
<td>Used for documents containing extremely fine detail. The super fine mode is enabled only if the remote machine also supports the Super Fine resolution. See the note below.</td>
</tr>
<tr>
<td>Photo</td>
<td>Used for documents containing photographic images.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

**NOTE:** Faxes scanned in the Super Fine resolution transmit at the highest resolution supported by the receiving device.
Adjusting the Document Contrast

You can adjust the contrast of the fax document to be lighter or darker than the original.

1. Load the document(s) facing up with top edge in first into the DADF.
   OR
   
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."

2. Press the (Home) button.
3. Tap ➔ Fax.
4. Tap ⚪
5. Tap Darken/Lighten.
6. Drag the desired level on the Darken/Lighten bar, and then tap OK.
   You can select a contrast level from seven levels between Darken and Lighten.
   Drag the indicator on the left side of the bar makes the document contrast lighter, and selecting a cell on the right side of the bar makes the document contrast darker.

| Darken 3 | Works well with light documents or faint pencil markings. |
| Darken 2 |
| Darken 1 |
| Normal* | Works well with standard typed or printed documents. |
| Lighten 1 | Works well with dark documents. |
| Lighten 2 |
| Lighten 3 |

* Denotes the factory default setting.

Sending a Fax From Memory

1. Load the document(s) facing up with top edge in first into the DADF.
   OR
   
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."

2. Press the (Home) button.
3. Tap ➔ Fax.
4. Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For adjusting the contrast, see "Adjusting the Document Contrast.")
5. To select a fax number, do one of the following:
   - Tap Phone Book, and then select one of the following:
     Individuals: Select an individual fax number and then tap Done.
     Groups: Select a group dial number and then tap Done.
     Network Phone Book: Search and select a fax number from the LDAP server and then tap Search.

   NOTE: For more information on address book and server address book, see "Address Book Editor (for Microsoft® Windows® and OS X)."
NOTE: For details about Network Phone Book, see "Using the Server Address Book and Server Phone Book."
NOTE: The fax number needs to be registered before you can select Address Book.

- Tap Speed Dial.
  Enter the speed dial number using the number pad, and then tap Done.

6 Tap Send to scan data.
When the document is loaded on the document glass, the display prompts you for another page.
If you want to place a new document, replace the document with a new document, and then tap Continue.
When you have finished loading documents, tap Done.
The printer starts dialing the number, and then sends the fax when the remote fax machine is ready.
NOTE: You can cancel the fax job while sending the fax by tapping Stop.

Sending a Fax Manually
1 Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."
2 Press the (Home) button.
3 Tap → Fax.
4 Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For adjusting the contrast, see "Adjusting the Document Contrast.")
5 Tap On Hook.
6 Enter the fax number of the recipient using the number pad.
   You can also select the recipient by using speed dial number or address book. (For details, see "Automatic Redialing.")
7 Tap Send to send the fax.
   NOTE: You can cancel the fax job while sending the fax by tapping Stop.

Confirming Transmissions
When the last page of your document has been sent successfully, the printer beeps and returns to the standby mode.
If something goes wrong while sending your fax, an error message appears on the display.
If you receive an error message, press Close to clear the message and try to send the document again.
You can set your printer to print a confirmation report automatically after each fax transmission. For further details, see "Available Fax Settings Options."

Automatic Redialing
If the number you have dialed is busy or there is no answer when you send a fax, the printer will automatically redial the number every minute based on the number set in the redial settings.
To change the time interval between redials and the number of redial attempts, see "Available Fax Settings Options."
NOTE: The printer will not automatically redial a number that was busy when you send the fax manually.
Sending a Delayed Fax

The Delayed Start mode can be used to save scanned documents for transmission at a specified time to take advantage of lower long distance rates.

1. Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."

2. Press the (Home) button.

3. Tap ➯ Fax.

4. Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For adjusting the contrast, see "Adjusting the Document Contrast.")

5. Tap ✎, and then tap Delayed Send.

6. Tap On.

7. Enter the start time using – or +, and then tap OK.

8. Tap Back, and then enter the fax number of the recipient using the number pad.
   You can also select the recipient by using speed dial number or address book. (For details, see "Automatic Redialing.")

9. Tap Send to scan data.

Once Delayed Start mode is activated, your printer stores all of the documents to be faxed into its memory and sends them at the specified time. After faxing in the Delayed Start mode is complete, the data in the memory is cleared.

NOTE: If you turn off and on the printer, the stored documents are sent as soon as the printer is activated.

NOTE: If the specified start time overlaps with the time periods for the available time or the Fax function, the printer cannot send the delayed fax at the specified time. (For details, see "Set Available Time" for the Available time and "Functions Control" for the Fax function.)

Sending a Fax from the Driver (Direct Fax)

You can send a fax directly from your computer by using the driver.

NOTE: Only black and white faxes can be sent using Direct Fax.

NOTE: If the specified start time overlaps with the time periods for the available time or the Fax function, the printer cannot send the delayed fax at the specified time. (For details, see "Set Available Time" for the Available time and "Functions Control" for the Fax function.)

Example
Procedure

NOTE: The names of the dialog boxes and the buttons may be different from those given in the following procedure depending on the application you are using.

NOTE: To use this feature, you must install the fax driver. (For details, see “Starting Dell Printer Easy Install” for Windows® or “Installing the Drivers and Software” for Macintosh.)

1 Open the file you want to send by fax.
2 Open the print dialog box from the application, and then select Dell MFP H815dw Fax or Dell MFP S2815dn Fax.
3 Click Preferences in Windows®, or select FAX Setting in Macintosh.

For Microsoft® Windows®:

![Windows Print Dialog Box](image)

For Apple Macintosh:

![Macintosh Print Dialog Box](image)

4 When the setting dialog box appears, specify the following settings.

NOTE: The settings done here are only applied to a single fax job.
For Microsoft® Windows®:

![Faxing settings for Windows](image)

For Apple Macintosh:

![Faxing settings for Mac](image)

### a. Transmission image quality

**Purpose:**

To set the output quality.

**Values:**

<table>
<thead>
<tr>
<th>Standard</th>
<th>For documents with normal sized characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>High Quality</strong></td>
<td>For documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td><strong>Super-high image quality</strong></td>
<td>For documents containing extremely fine detail. The super fine mode is enabled only if the remote machine also supports Super Fine resolution. See the notes below.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

**NOTE:** Faxes printed in the Super-high image quality by Direct Fax driver transmits at the highest resolution supported by the receiving device.
b. Transmission report

Purpose:
To specify whether to print a fax transmission result.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output regularly</td>
<td>Prints a transmission result after every fax transmission.</td>
</tr>
<tr>
<td>Output for non-transmission*</td>
<td>Prints a transmission result only when an error occurs.</td>
</tr>
<tr>
<td>Do not output</td>
<td>Does not print fax transmission results.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

c. Fax Cover Page

Purpose:
To specify whether to attach a cover page to your fax.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>According to Printer Settings*</td>
<td>Determines whether to attach a cover page to your fax depending on the setting you specify in Fax Cover Page on the operator panel.</td>
</tr>
<tr>
<td>Attach</td>
<td>Attaches a cover page to your fax.</td>
</tr>
<tr>
<td>None*</td>
<td>Does not attach a cover page to your fax.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

Sender

Purpose:
To specify whether to print the sender’s name on the fax cover page.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>According to Printer Settings*</td>
<td>Determines whether or not to print the sender’s name on the fax cover page based on the printer settings.</td>
</tr>
<tr>
<td>Enter a sender name</td>
<td>Allows you to enter a sender’s name that will be printed on the fax cover page in Sender Name.</td>
</tr>
</tbody>
</table>

* Denotes the factory default setting.

Sender Name

Purpose:
To enter a sender’s name that will be printed on the fax cover page.

The sender’s name can be up to 30 characters. If it exceeds 30 characters, only the first 30 characters will be printed.

5 For Windows®, click OK to close the Printing Preferences dialog box, and then click Print.
   For Macintosh, click Print.

The Set/Check Fax Transmission dialog box appears.
For Microsoft® Windows®:

![Recipient Setting window](image)

For Apple Macintosh:

![Set/Check Fax Transmission window](image)

6 Enter the destination for the recipient. The following procedure is for entering the destination. For details on how to enter the destination, please refer to the Help file for the driver.

a Enter the name and fax number directly.

b Select a fax number from a phone book.

- **Look Up Phone Book**: Displays a list of fax numbers that are saved in the file specified for My Phone Book file.
- **Look Up Device Data**: Displays a list of fax numbers that are saved in the Phone Book on your printer.
- **Import and add file** (Windows® only): Allows you to select a source file such as a CSV file, WAB file, MAPI, or a LDAP server. (For details on LDAP server, see "LDAP Server" and "Fax Server Phone Book").
NOTE: Depending on the application (when you are using Mac OS X 10.7 or later), you cannot use Look Up Device Data function.

NOTE: Enter the password in the Password field in the Authorization area before sending a fax if the fax function is locked with a password.

NOTE: If the Functions Control setting for Fax is set to On (Password), you need to enter the four-digit password to use the fax function.

To lock the fax function with a password:

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap until Secure Settings appears, and then tap Secure Settings.
4. Tap Functions Control.
5. Tap Fax.
6. Tap On (Password).
7. Enter a four-digit password, and then tap OK.
8. Turn off the printer, and turn it on again to apply the settings.

To check whether the fax has been sent:

Print a job history report. For details about how to print a job history report, see "Report / List."

Receiving a Fax

About Receiving Modes

NOTE: To use the Telephone / Fax or Ans Machine/Fax, connect an answering machine to the phone connector (__() on the rear of your printer.

When the memory is full, the fax is received in the Telephone mode.

Loading Paper for Receiving Faxes

The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying, except that faxes can only be printed on Letter-sized, A4-sized, or Legal-sized paper. For details about loading paper, see "Loading Print Media." For details about setting the paper type and size in the tray, see "Print Media Guidelines."

Receiving a Fax Automatically in the Fax Mode

Your printer is preset to the Fax mode at the factory.

If you receive a fax, the printer automatically goes into the fax mode after a specified period of time and receives the fax.

To change the interval at which the printer goes into the fax mode after receiving an incoming call, see "Available Fax Settings Options."

Receiving a Fax Manually in the Telephone Mode

You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive code (see "Available Fax Settings Options"). You can also receive a fax by tapping Manual Receive in On Hook.

To receive a fax by tapping Manual Receive:

1. When the external telephone rings, pick up the handset and check for the fax tone.
2 After you hear the fax tone, press the (Home) button.
3 Tap ➔ Fax.
4 Tap On Hook.
5 Tap Receive.
6 Hang up the hand set of the external telephone.

The printer begins receiving a fax and returns to the standby mode when the reception is completed.

Receiving a Fax Automatically in the Telephone / Fax or Ans Machine/Fax

To use the Telephone / Fax or Ans Machine/Fax mode, you must connect an external telephone to the phone connector ( ) on the rear of your printer.

If the caller leaves a message, the answering machine stores the message as it would normally. If your printer hears a fax tone on the line, it automatically starts to receive a fax.

For details on Telephone / Fax or Ans Machine/Fax mode, see "Available Fax Settings Options."

NOTE: If you have set your printer to Ans Machine/Fax and your answering machine is switched off, or no answering machine is connected to your printer, your printer will automatically go into the Fax mode after a predefined time.

Receiving a Fax Manually Using an External Telephone (Remote Receive)

You can manually receive a fax from the external telephone without having to go to the printer.

To manually receive a fax using the external telephone, you must connect an external telephone to the phone connector ( ) on the rear of your printer and also set Remote Receive to On.

When you receive a call on the external telephone and hear a fax tone, enter the two-digit code from the external telephone.

The printer receives the document.

When entering the remote receive code from the external telephone, press the number keys slowly in sequence. If you still hear the fax tone from the remote machine, try entering the two-digit code once again.

The default remote receive code is 00. You can change the two-digit code to whatever you choose. For details on changing the code, see "Available Fax Settings Options."

NOTE: Set the dialing system of your external telephone to DTMF.

Receiving Faxes Using the DRPD

The DRPD is a telephone company service which enables a user to use a single telephone line to answer several different telephone numbers. The particular number someone uses to call you on is identified by different ringing patterns, which consist of various combinations of long and short ringing sounds.

Before using the Distinctive Ring Pattern Detection option, Distinctive Ring service must be installed on your telephone line by the telephone company. To set up Distinctive Ring Pattern Detection, you will need another telephone line at your location, or someone available to dial your fax number from outside.

To set up the DRPD:

1 Press the (Information) button.
2 Tap the Tools tab, and then tap Admin Settings.
3 Tap Fax Settings.
4 Tap Fax Line Settings.
5 Tap until DRPD Pattern appears, and then tap DRPD Pattern.
6 Tap the desired pattern, and then tap OK.
7 Turn off the printer, and turn it on again to apply the settings.

To receive faxes in the DRPD, you need to set the menu to DRPD. For details, see "Available Fax Settings Options."

Your printer provides seven DRPD patterns. If this service is available from your telephone company, ask your telephone company which pattern you need to select to use this service.

**Receiving Faxes in the Memory**

Since your printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you receive a fax while you are copying, printing, or run out of paper or toner, your printer stores incoming faxes in the memory. Then, as soon as you finish copying, printing, or re-supply the consumables, the printer automatically prints the fax.

**Polling Receive**

You can receive faxes from the remote fax machine when you want to receive it.

1 Press the (Home) button.
2 Tap ➡ Fax.
3 Tap On Hook.
4 Tap Polling.
5 Enter the fax number of the remote machine using the number pad.
6 Tap Receive to begin receiving the fax.

**Automatic Dialing**

**Speed Dialing**

You can store up to 200 frequently dialed numbers in speed dial locations (001–200). When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial number from the operator panel or Dell Printer Configuration Web Tool.

**Setting Speed Dial**

1 Press the (Information) button.
2 Tap the Tools tab, and then tap Admin Settings.
3 Tap Phone Book.
4 Tap Individuals.
5 Tap ▼ until the desired speed dial number between 1 and 200 appears and then select that number.
   To jump to a specific speed dial number, enter the desired number and then # using the number pad.
6 Tap the Enter Name text box.
7 Enter the name, and then tap OK.
8 Tap the Enter Number text box.
9 Enter the fax number using the number pad, and then tap OK.
   To insert a pause between numbers, press the (Redial/Pause) button.
   "." appears on the display.
10 Tap OK.
   To store more fax numbers, repeat steps 5 to 10.

Sending a Fax Using Speed Dial

1 Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."

2 Press the (Home) button.

3 Tap ▶ Fax.

4 Tap Speed Dial.

5 Enter the speed dial number between 1 and 200 using the number pad, and then tap Done.

6 Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For adjusting the contrast, see "Adjusting the Document Contrast.")

7 Tap Send to scan data.
   When the document is loaded on the document glass, the display prompts you for another page.
   If you want to place a new document, replace the document with a new document, and then tap Continue.
   When you have finished loading documents, tap Send Now.

   The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote fax machine answers.
   
   **NOTE:** Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 00*, you can send a document to the locations registered between 001 and 009.

Group Dialing

If you frequently send the same document to several destinations, you can create a group of these destinations and set them under a one-digit group dial location. This enables you to use a group dial number setting to send the same document to all the destinations in the group.

**NOTE:** You cannot include one group dial number within another group dial number.

Setting Group Dial

1 Press the (Information) button.

2 Tap the Tools tab, and then tap Admin Settings.

3 Tap Phone Book.

4 Tap Groups.

5 Tap ▼ until the desired group dial number between 1 and 6 appears and then select that group dial number.
   If a speed dial number is already stored in the location you chose, the display shows the name and the number of entries stored in that group dial number.

6 Tap the Enter Group Name text box.

7 Enter the name, and then tap OK.

8 Tap Add from Phone Book.
   
   **NOTE:** The fax number needs to be registered before you can select Add from Phone Book.
9 Tap ‼ until the desired speed dial number appears and then select that speed dial number.
10 Tap OK.

To store more group dial numbers, repeat steps 5 to 10.

**Editing Group Dial**

You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1 Press the (Information) button.
2 Tap the Tools tab, and then tap Admin Settings.
3 Tap Phone Book.
4 Tap Groups.
5 Tap ‼ until the group dial number that you want to edit appears, and then select that group dial number.
6 Tap Edit.
7 Tap the group name text box.
8 Enter a new name, and then tap OK.
9 To delete a speed dial number from the group dial number:
   a Tap ‼ until the speed dial number that you want to edit appears, and then select that speed dial number.
   b Tap Remove.
10 To add a new speed dial number to the group dial number:
   a Tap Add from Phone Book.
   b Tap ‼ until the desired speed dial number appears and then select that speed dial number.
   c Tap OK.
11 Tap OK.

To delete an existing group dial number, select the group dial number, and then tap Remove.

If you want to edit another group dial number, repeat steps 5 to 11.

**Sending a Fax Using Group Dial (Multi-address Transmission)**

You can use group dialing for Broadcasting or Delayed transmissions.

Follow the procedure of the desired operation. (For Delayed transmission, see "Specifying the Fax Settings Options.")

You can use one or more group numbers in one operation. Then continue the procedure to complete the desired operation.

Your printer automatically scans the document loaded in the DADF or on the document glass into the memory. The printer dials each of the numbers included in the group.

**Printing a Speed Dial List**

You can check your automatic dial setting by printing a Speed Dial list.

For details about how to print a Speed Dial list, see "Report / List."
Phone Book

You can select or search the registered phone numbers from the phone books.

1. Load the document(s) facing up with top edge in first into the DADF.
   OR
   Place a single document facing down on the document glass, and close the document cover.
   For details about loading a document, see "Loading an Original Document."
2. Press the (Home) button.
3. Tap \( \text{Fax} \).
4. Tap Phone Book, and then select one of the following:
   To select from the local phone book:
   a. Tap Individuals or Groups.
   b. Swipe the screen until the desired speed dial number or the group dial number appears, and then select that speed dial number or group dial number.
   c. Tap Done.
   To search from the server phone book:
   a. Tap Network Phone Book.
   b. Enter a keyword using the keyboard, and then tap Search.
   c. Tap a recipient from the search result, and then tap Done.

\[ \text{NOTE:} \text{ For more information on address book and server address book, see "Address Book Editor (for Microsoft® Windows® and OS X)."} \]

\[ \text{NOTE:} \text{ For details about Network Phone Book, see "Using the Server Address Book and Server Phone Book."} \]

\[ \text{NOTE:} \text{ A fax number needs to be registered before you can select an address book.} \]
5. Tap Send to send the fax.

Other Ways to Fax

Using the Secure Receiving Mode

You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the secure fax mode using the Secure Receive option to restrict printing out all of the received faxes when the printer is unattended. In the secure fax mode, all incoming faxes will go in memory. When the mode is turned off, all stored faxes will be printed.

\[ \text{NOTE:} \text{ Before operation, ensure Panel Lock is enabled.} \]

To turn the secure receiving mode on:

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Admin Settings.
3. Tap Fax Settings.
4. Tap Incoming Defaults.
5. Tap \( \text{until Secure Receive appears, and then tap Secure Receive.} \)
6. Tap Secure Receive Set.
7. Tap Enable.
8 Enter a four-digit password, and then tap OK.

When a fax is received in the secure receiving mode, your printer stores it into memory and Secure Fax Receive is enabled on the Print screen to let you know that there is a fax stored.

To print received documents:
1 Press the (Home) button.
2 Tap → Print.
3 Swipe the screen until Secure Fax Receive appears, and then tap Secure Fax Receive.
4 Enter a four-digit password, and then tap OK.
The faxes stored in memory are printed.

To turn the secure receiving mode off:
1 Follow the same steps from 1 to 6 in “To turn the secure receiving mode on:” and tap Secure Receive Set.
2 Tap Disable.

Using an Answering Machine

You can connect a telephone answering device (TAD) directly to the rear of your printer as shown above.

• Set your printer to the Ans Machine/Fax and set Auto Receive Ans/Fax to specify the time for the TAD.
• When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts receiving the fax.
• If the answering device is off, the printer automatically goes into the Fax after the ring tone sounds for a predefined time.
• If you answer the call and hear fax tones, the printer will answer the fax call if you Set On Hook to On (you can hear voice or fax tones from the remote machine), and then tap Receive and hang up the receiver.

OR
Press the two-digit remote receive code and hang up the receiver.
Using a Computer Modem

If you want to use your computer modem for faxing or for a dial-up Internet connection, connect the computer modem directly to the rear of your printer with the TAD as shown above.

- Set your printer to the Ans Machine/Fax and set Auto Receive Ans/Fax to specify the time for the TAD.
- Turn off the computer modem's fax-receive feature.
- Do not use the computer modem if your printer is sending or receiving a fax.
- Follow the instructions provided with your computer modem and fax application to fax via the computer modem.

Printing a Report

The following reports may be useful when using fax:

**NOTE:** For more information about other reports and how to print a report, see “Report / List.”

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed Dial</td>
<td>This list shows all the numbers currently stored in the memory of your printer as speed dial numbers.</td>
</tr>
<tr>
<td>Address Book</td>
<td>This list shows all the addresses currently stored in the printer's memory as Address Book information.</td>
</tr>
<tr>
<td>Server Address</td>
<td>This list shows all of the numbers currently stored in the printer's memory as Server Address information.</td>
</tr>
<tr>
<td>Fax Activity</td>
<td>This report shows information about the faxes you recently received or sent.</td>
</tr>
<tr>
<td>Fax Pending</td>
<td>This list shows the status of pending faxes.</td>
</tr>
<tr>
<td>Print Meter</td>
<td>This report shows the total number of pages printed. The report will be titled Print Volume Report or AccessControl Report, depending on the AccessControl Mode setting.</td>
</tr>
</tbody>
</table>

Changing Setting Options

1. Press the (Information) button.
2. Tap the Tools tab, and then tap Default Settings.
3. Tap Fax Defaults.
4. Select the desired menu.
5. Select the desired setting or enter the value using the number pad, and then tap OK.
Dell Document Hub

NOTE: The Dell Document Hub feature is available on the Dell™ Cloud Multifunction Printer | H815dw only.

The Dell Document Hub is a convenient one-stop gateway to a variety of cloud services to help you manage your documents. With the Dell Document Hub, you can convert hard copy documents into editable digital content and store them directly in your preferred cloud storage service. You can search for files across multiple clouds simultaneously and then share and print content easily.

Registering the User and Signing In to the Dell Document Hub

To use the Dell Document Hub, you need a user account registered to the printer, and sign in to the Dell Document Hub.

Registering a New User to the Dell Document Hub

Prepare the access information required for each of the cloud services you want to use, and make sure that you have a user account registered to the printer. For more information on registering an account, see "Creating a New User Account."

1. Access the Dell Document Hub website from your computer.
   Enter the following URL in the web browser:
   www.dell.com/dochub
2. Follow the instructions displayed on the screen.
3. An e-mail will be soon sent to the registered e-mail address. Check the e-mail and follow the instructions on the e-mail to activate.

To Register a New User From the Printer

You can start the user registration alternatively using the printer.

NOTE: To complete the registration process, you will need to use your computer or mobile device to receive an e-mail and access the Dell Document Hub website.

1. Log in to the printer as a registered user.
2. Tap the Dell Document Hub tile in the Home screen.
3. Tap New User.
   The Welcome to Dell Document Hub screen is displayed. Tap Next.
4. Follow the instructions displayed in the touch panel.
**Signing In to the Dell Document Hub**

1. Log in to the printer as a registered user.
2. Tap the Dell Document Hub tile in the Home screen.
   The Dell Doc Hub Sign In screen is displayed.

   ![Dell Doc Hub Sign In screen](image)

3. Tap the E-mail text box to enter the e-mail address.
   **NOTE:** You can also tap to select a recently entered e-mail address from a list. The list can contain up to eight recently entered e-mail addresses.

4. Tap the Password text box to enter the password, and tap Done.
5. If you want to save your e-mail address and password, tap to check the Save E-mail & Password check box.
   The e-mail and password are stored under the registered user’s account and unauthorized user will not be able to access them. For security purpose, it is recommended that you set a password for registered user.

6. Tap Sign in.
   When the Dell Document Hub screen is displayed, signing in is successful.
   **NOTE:** If all the tiles on the Dell Document Hub screen are pale and disabled when you sign in, you have not completed the necessary procedures to activate your account of the Dell Document Hub. Check the e-mail you received from the Dell Document Hub, and activate your account.

**When the Favorite List Screen is Displayed When You Tap the Tile on the Dell Document Hub Screen**

This means that your favorite settings for the function have been saved on the printer. Select settings from the list as desired.

**Returning to the Home Screen**

Tap Back. The sign-in status is maintained. Next time you tap the Dell Document Hub tile on the Home screen, you do not have to sign in while you are logged in to the Home screen.

You can tap Sign out as well to return to the Home screen, but the sign-in status is not maintained. Next time you sign in to the Dell Document Hub, you need to reenter your e-mail address and password.

**Logging Out From the Printer**

Press the (Login/Logout) button. You will log out from the Home screen and the portal screen will be displayed. In this case, the sign-in status to the Dell Document Hub is maintained as far as the Save E-mail & Password check box option is selected in the step 5 above. Next time you tap the Dell Document Hub tile on the Home screen, you can skip the sign in process.
Searching for and Printing Files

You can search for the files saved in the cloud services, and print them from the printer. You can search across multiple cloud services at once. This method is suitable when you want to search by the keywords, including the file name.

NOTE: To search for files across multiple cloud services, you need to go to www.dell.com/dochub and connect the cloud services with the Dell Document Hub.

1 Tap the Search for Files tile in the Dell Document Hub screen.
2 Enter the keywords, and tap Search.

To enter the accented characters, tap to display the keyboard for those characters.

Files are searched across the cloud services you registered.

3 Tap the files you want to print. You can select up to 10 files.
   To sort the results, tap and select the sorting order.
4 Tap to preview the selected files.
   The File Preview screen is displayed. The first three pages of each file are displayed in the small previews.
   a To show the page in the large preview, tap the page in the small previews.
   b To preview other files, flick the screen side to side.
   c To specify the file as the one to be printed, tap the rectangle beside the small previews to enter a check mark.
   d To return to the previous screen, tap Back.
5 Tap to check or change the print settings.
   The Print Settings screen is displayed.
   a To show the other tiles, flick the screen side to side.
   b To return to the previous screen, tap Back.
   For more information on the Print Settings, see "Print Settings."
6 Tap Print to start printing.
   To cancel printing, tap Stop.

When all the selected files are printed, the screen returns to the Search Results screen.

NOTE: You can start printing by tapping Print in any screens of Search Results, File Preview or Print Settings.
Browsing and Printing Files

You can browse and print the files saved in the selected cloud services. This method is suitable when you know which cloud service the file you want to print is located in.

1 Tap the Browse for Files tile in the Dell Document Hub screen. The Cloud Services screen is displayed.

To scroll the list, flick the screen up or down.

The status of the cloud services can be confirmed by an icon on the right side of the names of each cloud service.

indicates that the cloud service is correctly associated with the Dell Document Hub.

indicates that the cloud service is not associated, or not linked correctly.

indicates that the cloud service link with the Dell Document Hub has expired.

To link the cloud service with the Dell Document Hub, go to www.dell.com/dochub.
For more information, tap the status icon.

2 Tap the cloud service you want to browse in. The list of the contents stored in the selected cloud service is displayed.

3 Tap the location you want to browse in. The contents in the selected location are listed.

4 Tap the files you want to print. You can select up to 10 files.

5 Tap to search the files in the current location.
   a Enter the file name or keywords, and tap Search. The Search Results screen is displayed. You can sort the results by tapping and selecting the sorting order.
   b To return to the previous screen, tap Back.

6 Tap to preview the selected files. The File Preview screen is displayed. The first three pages of each file are displayed in the small previews.
   a To show the page in the large preview, tap the page in the small previews.
   b To preview other files, flick the screen side to side.
   c To specify the file as the one to be printed, tap the rectangle beside the small previews to enter a check mark.
   d To return to the previous screen, tap Back.
7 Tap to check or change the print settings.
   The Print Settings screen is displayed.
   a To show the other tiles, flick the screen side to side.
   b To return to the previous screen, tap Back.
   For more information on the Print Settings, see "Print Settings."

   NOTE: Tap in the Print Settings screen, and you can save your print settings and file path to the cloud service as a
   favorite. Name your favorite in the Save Favorite screen, and tap Save. If you are saving the favorite in the same name
   with the existing favorite, the settings and the file path will be overwritten. You can delete the unnecessary favorite by
   tapping .
   Once you save your settings as a favorite, you can recall those settings the next time you sign in to the Dell Document Hub
   from any printers of the same model.

8 Tap Print to start printing.
   To cancel printing, tap Stop.

   When all the selected files are printed, the screen to show the selected location returns.

   NOTE: You can start printing by tapping Print in any screens of contents list, Search Results, File Preview or Print Settings.

Searching for the Files in the Selected Cloud Service

After you select the cloud service in the step 2 above, you can search for the files by tapping .
Enter the file name or keywords, and tap Search.
You can select the files to print in the Search Results screen, sort the results by tapping , or preview the files by
   tapping .

Scanning

You can scan the document and save the scanned file in the cloud service.

1 Tap the Scan tile in the Dell Document Hub screen.
   The Cloud Services screen is displayed.

![Cloud Services Screen]

   To scroll the list, flick the screen up or down.
   The status of the cloud services can be confirmed by an icon on the right side of the names of each cloud service.
   For more information, tap the status icon.

2 Tap the destination cloud service you want to save the scanned file to.
   The list of the contents stored in the selected cloud service is displayed.

3 Tap the location you want to save the scanned file to.
   The screen to show the selected location is displayed.
4  Tap Next.
   The screen to specify the file name and the file format is displayed.
5  Tap the File Name text box, and enter the file name.
6  Tap the File Format box, and specify the file format to save the scanned file.
7  Tap to check or change the scan settings.
   The Scan Settings screen is displayed.
   a  To show the other tiles, flick the screen side to side.
   b  To return to the previous screen, tap Back.
   For more information on the Scan Settings, see "Scan" and "Scan Settings."

   ![NOTE: Tap in the Scan Settings screen, and you can save your scan settings and file path to the cloud service as a favorite. Name your favorite in the Save Favorite screen, and tap Save. If you are saving the favorite in the same name with the existing favorite, the settings and the file path will be overwritten. You can delete the unnecessary favorite by tapping .
   Once you save your settings as a favorite, you can recall those settings the next time you sign in to the Dell Document Hub from any printers of the same model.](image)

8  Tap Scan to start scanning.
   To cancel scanning, tap Stop.
   When the scanning is completed, the screen to show the selected location returns.

Searching for the Location Across the Cloud Services

Before you select the cloud service in the step 2 above, you can search for the location you want to save the scanned file across the cloud services by tapping .

Enter the keywords, and tap Search.

You can select the location to save the scanned file in the Search Results screen.

You can sort the results by tapping .

Searching for the Location in the Selected Cloud Service

Before you select the location in the step 3 above, you can search for the location in the selected cloud service by tapping .

Enter the keywords, and tap Search.

You can select the location to save the scanned file in the Search Results screen.

You can sort the results by tapping .
**Scanning the Document Using Optical Character Recognition (OCR)**

You can scan the document using OCR, and save it in the cloud service.

1. Tap the **Smart OCR Scan** tile in the **Dell Document Hub** screen. The **Cloud Services** screen is displayed.

   ![Cloud Services](image)

   To scroll the list, flick the screen up or down.

   The status of the cloud services can be confirmed by an icon on the right side of the names of each cloud service. For more information, tap the status icon.

2. Tap the destination cloud service you want to save the converted file to.

   The list of the contents stored in the selected cloud service is displayed.

3. Tap the location you want to save the converted file to.

   The screen to show the selected location is displayed.

4. Tap **Next**.

   The screen to specify the file name and the file format is displayed.

5. Tap the **File Name** text box, and enter the file name.

6. Tap the **File Format** box, and specify the file format to save the converted file.

7. Tap  to check or change the OCR scan settings.

   The **Scan Settings** screen is displayed.

   a. To show the other tiles, flick the screen side to side.

   b. To return to the previous screen, tap **Back**.

   For more information on the Scan Settings, see "Smart OCR Scan" and "Scan Settings."

   **NOTE:** Tap in the **Scan Settings** screen, and you can save your scan settings and file path to the cloud service as a favorite. Name your favorite in the **Save Favorite** screen, and tap **Save**. If you are saving the favorite in the same name with the existing favorite, the settings and the file path will be overwritten. You can delete the unnecessary favorite by tapping . Once you save your settings as a favorite, you can recall those settings the next time you sign in to the Dell Document Hub from any printers of the same model.

8. Tap **Scan** to start scanning using the OCR.
Receiving the Scanned File as an E-Mail

The document can be scanned and sent to you as an attached file of an e-mail.

1. Tap the E-mail Me tile in the Dell Document Hub screen.
   The E-mail Me screen is displayed.

2. Tap the File Format box, and specify the file format to save the scanned file in.
3. Tap the Subject text box, and enter the subject of the mail sent with the scanned file.
4. Tap to check or change the e-mail settings.
   a. To show the other tiles, flick the screen side to side.
   b. To return to the previous screen, tap Back.

   For more information on the E-mail Settings, see "E-mail Me" and "Scan Settings."

   **NOTE:** Tap in the E-mail Settings screen, and you can save your e-mail settings as a favorite. Name your favorite in the Save Favorite screen, and tap Save. If you are saving the favorite in the same name with the existing favorite, the settings will be overwritten. You can delete the unnecessary favorite by tapping . Once you save your settings as a favorite, you can recall those settings the next time you sign in to the Dell Document Hub from any printers of the same model.

5. Tap Send to start scanning and sending the scanned file as an attached file of an e-mail.
Receiving the Scanned Image of the Business Card as an E-Mail

The business card can be scanned and converted to the vCard file, and sent to you as an attached file of an e-mail.

1. Tap the **Business Card Reader** tile in the Dell Document Hub screen.
   The **Business Card Reader** screen is displayed.

2. Tap the **Subject** text box, and enter the subject of the e-mail sent with the vCard file.

3. Tap **** to check or change the scan settings.
   a. Tap the **OCR Language** tile to specify the language.
   b. To return to the previous screen, tap **Back**.

4. Tap **Send** to start scanning and sending the vCard file as an attached file of an e-mail.
Printing and Scanning Directly From SharePoint®

You can connect to the SharePoint® server directly from the printer to print the documents from the server or to save the scanned data to the server.

NOTE: This feature is available on the Dell™ Smart Multifunction Printer | S2815dn only.

NOTE: Only the PDF and the JPEG files can be browsed, printed, and saved with this feature.

Registering the SharePoint® Server

You can register up to 10 servers.

1. Log in to the printer as a registered user using the local authentication.
2. In the Home screen, tap SharePoint.
   The SharePoint Login screen is displayed.

3. Tap .
   The Configuration screen is displayed.

4. Tap the Enter Server URL box.
5. Enter the server URL, tap Done, and then tap +.
   To register more SharePoint® server URLs, repeat steps 4 and 5.

6. Tap Back.
Editing the Server URL List

In the Configuration screen, you can edit the server URL list. Tap the desired server URL, and tap Remove or Edit.

Signing In to the SharePoint® Server

1. Log in to the printer as a registered user using the local authentication.
2. Tap the SharePoint tile in the Home screen. The SharePoint Login screen is displayed.

3. Tap the User ID text box to enter the user ID.
   [NOTE: You can also tap to select a recently entered user ID from a list. The list can contain up to eight recently entered user IDs.]
4. Tap the Password text box to enter the password.
5. Tap to select the desired SharePoint® server from the server list.
6. Tap Log in.

Returning to the Home Screen

Tap Exit or press the button.

[NOTE: When you return to the Home screen by tapping Exit or by pressing the button, login status is maintained. Next time you tap SharePoint on the Home screen, you do not have to log in while you are logged in to the Home screen.]

[NOTE: You can tap Log out or button as well to return to the Home screen, but the login status is not maintained. Next time you tap SharePoint on the Home screen, you need to log in to the SharePoint® server again.]
Browsing and Printing Files

You can browse and print the files saved in the selected SharePoint® server.

1 Tap the Print tile in the SharePoint screen.
   The Print from SharePoint screen is displayed.

2 Select the file you want to print by performing either of the following:
   • Tap the file you want to print.
     ✓ NOTE: If the desired file is not displayed, swipe the screen.
   • Search the files in the selected SharePoint® server.
     a Tap .
     b Enter the file name or keywords, and then tap Search.
     c Tap the file you want to print.
     ✓ NOTE: You can select up to 10 files.

3 Tap to check or change the print settings.
   The Print Settings screen is displayed.
   a To show the other tiles, flick the screen side to side.
   b To return to the previous screen, tap Back.
   ✓ NOTE: You cannot save your print settings to print documents in the SharePoint® server.

4 Tap Print to start printing.
   To cancel printing, tap Stop.
   When all the selected files are printed, the Print from SharePoint screen returns.
   ✓ NOTE: You can start printing by tapping Print in any screens of Print from SharePoint, Search Results, or Print Settings.

Scanning

You can scan the document and save the scanned data in the selected SharePoint® server.

1 Tap the Scan tile in the SharePoint screen.
   The following SharePoint screen is displayed.
When you want to save the scanned data to this folder, tap Next and proceed to step 3.

2 Select the folder you want to save the scanned data to by performing either of the following:
   • Tap the folder you want to save the scanned data to, and then tap Next.
     
     **NOTE:** If the desired folder is not displayed, swipe the screen.
   • Search the folder in the selected SharePoint® server.
     
     a Tap  
     b Enter the folder name or keywords, and then tap Search.
     c Tap the folder you want to save the scanned data to, and then tap Next.

The Scan to SharePoint screen is displayed.

3 Tap the File Name text box, and enter the file name.

4 Tap the File Format box, and specify the file format to save the scanned file.

5 Tap to check or change the scan settings.

The Scan Settings screen is displayed.

a To show the other tiles, flick the screen side to side.

b To return to the previous screen, tap Back.

For more information on the Scan Settings, see “Scan” and “Scan Settings.”

**NOTE:** You cannot save your scan settings to save the scanned data in the SharePoint® server.

6 Tap Scan to start scanning.

To cancel scanning, tap Stop.

When the document is loaded on the document glass, the screen prompts you for another page.

• If you want to scan another document, replace the document with a new document, and then tap Continue.
• When you have finished loading documents, tap Done.

When the scanning is completed, the SharePoint screen that is displayed in the step 1 returns.
Know Your Printer

24 Understanding Your Printer Software ........................................... 387
25 User Authentication ........................................................................ 405
26 Tile Customization ........................................................................ 409
27 Using the Server Address Book and Server Phone Book ... 411
28 Using Digital Certificates .............................................................. 415
29 Understanding Printer Messages .................................................. 425
30 Specifications .............................................................................. 435
Understanding Your Printer Software

The additional printer software comes with your printer. Installing the software will enhance the function of your printer.

Overview

Use the *Software and Documentation* disc to install a combination of software programs. Available software varies depending on your operating system.

The following shows the compatibility between the software programs/utility tools and operating systems.

<table>
<thead>
<tr>
<th>Item</th>
<th>Windows®</th>
<th>OS X</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Printer Hub / Dell Printer Management Tool</td>
<td>✔️</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Printer Status Window</td>
<td>–</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Status Monitor Console</td>
<td>–</td>
<td>–</td>
<td>✔️</td>
</tr>
<tr>
<td>Status Monitor Widget</td>
<td>–</td>
<td>✔️</td>
<td>–</td>
</tr>
<tr>
<td>Tool Box</td>
<td>✔️</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Address Book Editor</td>
<td>✔️</td>
<td>✔️</td>
<td>–</td>
</tr>
<tr>
<td>ScanButton Manager</td>
<td>–</td>
<td>✔️</td>
<td>–</td>
</tr>
<tr>
<td>User Setup Disk Creating Tool</td>
<td>✔️</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>App Manager</td>
<td>✔️</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>

(✔️: supported, –: not supported)
Dell Printer Hub/Dell Printer Management Tool (for Microsoft® Windows®)

NOTE: Dell Printer Hub or Dell Printer Management Tool is supported on Microsoft® Windows® 7 or later.

NOTE: Dell Printer Hub is available on Dell™ Cloud Multifunction Printer | H815dw.

NOTE: Dell Printer Management Tool is available on Dell Smart Multifunction Printer | S2815dn.

This software consolidates your printer management, monitoring tools and cloud connectivity. You can conveniently access printer utilities, advanced scan features and printer/consumables details, and receive notifications on driver/software updates as well as printer status.

NOTE: Connecting to cloud and accessing scan features are available on the Dell Printer Hub only.

You can also use the Dell Printer Hub or Dell Printer Management Tool to order consumables online or by phone from Dell.

See "Using Dell Printer Hub or Dell Printer Management Tool for Windows®."

To launch the Dell Printer Hub/Dell Printer Management Tool, click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.

The following software can be activated from the Dell Printer Hub and Dell Printer Management Tool:

- **Configuration tool**
  
  Configures the IP address settings, fax settings, and Wi-Fi settings.

  NOTE: Wi-Fi settings are available for Dell Cloud Multifunction Printer | H815dw.

- **Tool Box**
  
  See "Tool Box (for Microsoft® Windows®)."

- **App Manager**
  
  See "App Manager (for Microsoft® Windows®)."

- **Address Book Editor**
  
  See "Address Book Editor (for Microsoft® Windows® and OS X)."

- **Printer Embedded Web Server (EWS)**
  
  Displays the Dell Printer Configuration Web Tool. See "Dell™ Printer Configuration Web Tool."

See the FAQ on the Dell Printer Hub or Dell Printer Management Tool.

Printer Status Window (for OS X and Linux)

The Printer Status window alerts you when there is a warning or when an error occurs, for example, when a paper jam occurs or toner is running low.

You can also check toner level, quantity of paper remaining or the configuration of options for the printer.
Status Monitor Widget (for OS X)

Status Monitor Widget is a printer utility that promotes efficient use of the printer through the exchange of information between the Macintosh and the printer.

Status Monitor Widget Feature

- Monitoring Dell Printers
  Allows you to check the status of Dell printers currently connected to your Macintosh
- Receiving Alerts
  Alerts you to problems, such as paper jams or low toner
- Ordering Supplies
  Allows you to access the web site to order supplies

Before Installing the Status Monitor Widget

Operating systems

- Mac OS X 10.5
- Mac OS X 10.6
- Mac OS X 10.7
- OS X 10.8
- OS X 10.9
- OS X 10.10

Network protocols and interfaces

- LPR
- Socket 9100
- Bonjour
- USB 2.0 and 1.1 (When connecting with multiple printers of the same model via USB cables, only the printer recognized first can be monitored in the Status Monitor Widget.)
Installing the Status Monitor Widget

1. Double-click the Dell H815dw Installer icon or Dell S2815dn Installer icon in the Finder window.
2. Follow the on-screen instructions.
   When the Install Succeeded screen appears, the installation is complete.
   NOTE: Entering the administrative login name and password are required during the installation process.

Opening and Closing the Status Monitor Widget

Opening the Status Monitor Widget

1. Click the Dashboard icon in the Dock to launch Dashboard.

2. Click the Plus (+) sign to display the Widget Bar.

3. Click the icon of Status Monitor in the Widget Bar. The Printer Status window appears.
   NOTE: If the message Select a printer is displayed, select your printer in Preferences. (For more information on Preferences, see “Preferences.”)

Closing the Status Monitor Widget

1. Click the Close (x) button in the upper-left corner of the Printer Status window.

Printer Status Window

When the Status Monitor Widget is activated, the Printer Status window appears on Dashboard.
Printer Status Message Area
Displays a message of the current printer status.

- NOTE: The Status Monitor Widget automatically obtains the printer information at the updated interval that can be specified in Preferences. Also, the printer status is refreshed when Dashboard is launched or Preferences is closed.
- NOTE: If the Status Monitor Widget receives no response from the printer, the message Cannot get printer information is displayed.
- NOTE: When the printer is connected via USB cable, you cannot check the status of the printer during a print or scan job.

Printer Status Image Area
Displays the image of printer condition.
- Estimated Toner Level image
  Displays the estimated toner level if the printer is functioning properly.

- NOTE: If the utility does not receive a response from the printer, the Unknown toner image is displayed.
- Printer error image
  Displays an indication image when an error occurs.

Order Supplies button
Click this button to display the Order window.
To hide the Order window, click Order Supplies again.

Info (i) button
Click this button to open Preferences.

- NOTE: The info (i) button appears on the lower-right corner of the window when the cursor is over the Printer Status window. The info (i) button is a standard used across all widgets.
Order Window

This window provides you with the information for ordering printer supplies by telephone or from the web site. To open the Order window:

1. Click Order Supplies in the Printer Status window.
   The Order window appears.

   **NOTE:** The Order window appears when low toner is detected.

Order Online

- **Visit Dell printer supplies ordering web site hyperlink**
  Click the Visit Dell printer supplies ordering web site hyperlink to access the web site for ordering Dell printer supplies.

- **URL list**
  Displays a list of available URLs where you can order Dell printer supplies.
  Select a URL address to use when the Visit Dell printer supplies ordering web site hyperlink is clicked.

Order By Phone

- **Phone number list**
  Displays a list of available phone numbers that you can call to order Dell printer supplies.

- **Update phone contacts when rebooting check box**
  Select this check box to regularly update the phone number list.

Dell and the Environment

Click the hyperlink to access the web site about recycling.
**Preferences**

To open **Preferences:**

1. Click the info (i) button in the **Printer Status** window. **Preferences** appears.

   **NOTE:** The info (i) button appears on the lower-right corner of the window when the cursor is over the **Printer Status** window. The info (i) button is a standard used across all widgets.

---

**Printer**

Displays a list of available printer names in the pull down menu. The first printer displayed in this list is set as default.

**Status Update Interval**

You can specify the update interval of the printer status. By default, it is set to obtain the printer information every 10 seconds. It can be set from 0 to 600 seconds.

**SNMP Community Name**

You can change the SNMP (Simple Network Management Protocol) community name if using default community name (public). Up to 31 characters can be entered.

**Get Tag button**

Click this button to obtain the service tag.

   **NOTE:** You cannot retrieve the service tag when the printer is connected via USB cable.

**done button**

Click this button to return to the **Printer Status** window.
Status Monitor Console (for Linux)

Status Monitor Console is a printer utility that promotes efficient use of the printer through the exchange of information between the Linux and the printer.

Status Monitor Console Feature

- Monitoring Dell Printers
  Allows you to check the status of Dell printers currently connected to your Linux.
- Receiving Alerts
  Alerts you to problems, such as paper jams or low toner.
- Ordering Supplies
  Allows you to access the web site to order supplies.

Before Installing the Status Monitor Console

NOTE: The Status Monitor Console requires the following modules installed.
- Python, PyGTK, Net-SNMP, cups-libs, and xdg-open
Please confirm that these modules are installed before you install the Status Monitor Console.

NOTE: The Status Monitor Console is available when the printer is connected to a network (LPR or Socket 9100). USB connection is not supported.

Distributions

- Red Hat Enterprise Linux 6 Desktop
- SUSE Linux Enterprise Desktop 11
- Ubuntu 12.04 LTS

Printing system

- CUPS (Common Unix Printing System)

Installing the Status Monitor Console

1. Activate the terminal, and log in as a super user.
2. Type the following rpm command in the terminal window.

On Red Hat Enterprise Linux 6 Desktop or SUSE Linux Enterprise Desktop 11

```
# rpm -ivh (Type the package file name)
```

On Ubuntu 12.04 LTS

```
# dpkg -i (Type the package file name)
```
Starting the Status Monitor Console

1. Click Dell Printers→ Status Monitor Console
   The Printer Selection window appears.
   For more information on Printer Selection window, see "Printer Selection Window."

2. Select your printer.
   The Printer Status window appears.
   For more information on Printer Status window, see "Printer Status Window."
   • You can order supplies from the Dell Supplies Management System window. See "Dell Supplies Management System Window."

Printer Selection Window

Printers list
All the printers registered in the CUPS (Common UNIX Printing System) are displayed in a list.
   • Status icons:
     ✓ Ready
     ⚠ Unknown/Offline/Toner Low/Paper Low
     ✗ Door Open/Paper Jam/No Toner/Out Of Paper

Settings button
Click this button to open the Settings window.

Details button
Click this button to open the Printer Status window. If a non-supported printer is selected, it opens the Dell Printer Configuration Web Tool. For details on the Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration Web Tool."

Refresh button
Click this button to update the information of printers.

Close button
Click this button to close the Printer Selection window.
Printer Status Window

When the printer is specified in the Printer Selection window, the Printer Status window appears.

Printer Status Message Area

Displays a message of the current printer status.

**NOTE:** The Status Monitor Console automatically obtains the printer information at the updated interval that can be specified in the Settings window. Also, the printer status is refreshed when the Refresh is clicked.

**NOTE:** If the Status Monitor Console receives no response from the printer, the message Cannot get printer information is displayed.

Printer Status Image Area

- **Current Toner Status icons**
  Displays icons of the current status of the toner.
  - ☑ The toner level is more than 30%.
  - ⬇️ The toner level is less than 29%.
  - ❌ The toner level is less than 9%.
  - ⛈️ The toner level is unknown.
- **Estimated Toner Level images**
  Keeps you informed about the amount of toner that remains.

Toner Alert

Displays an alert message when the remaining toner is low, empty, or unknown.

Order Online

- **Order Supplies Online button**
  Click this button to access the web site for ordering Dell printer supplies. This button appears when the amount of toner becomes less than 30%.

Refresh button

Click this button to update the status of the printer.

Close button

Click this button to close the Printer Status window.
Dell Supplies Management System Window

This window provides you with the information for ordering printer supplies by telephone or from the web site.

To open the Dell Supplies Management System window:

1. Click Order Supplies Online in the Printer Status window.
   OR
   Click Dell Printers → Dell Supplies Management System.

Select Printer Model

Select your printer model name.

Order Online

- Order Supplies Online button
  - When the Regular URL is selected in the Select Reorder URL:
    Click this button to open the Service Tag window.
  - When the Premier URL is selected in the Select Reorder URL:
    Click this button to open the procurement and support web site.

- Select Reorder URL
  Displays a list of available URLs where you can order Dell printer supplies. Select a URL address to use when the Order Supplies Online button is clicked.
  - Regular URL: http://Accessories.us.dell.com/sna/PrinterSeg.aspx
  - Premier URL: http://premier.dell.com

Order by Phone

- To order Dell printer supplies by phone, call the following
  Select your country with phone number from the list, and call the displayed telephone number to order supplies.
- Update phone contacts when rebooting check box
  Select this check box to regularly update the phone number list.
Dell and the Environment
Click the hyperlink to access the web site about recycling.

Close button
Click this button to close the Dell Supplies Management System window.

Service Tag Window

![Service Tag Window image]

1. Enter the Dell printer service tag.

   **NOTE:** For information on the service tag, see “Express Service Code and Service Tag.”

Settings Window

To open the Settings window:

1. Click Settings in the Printer Selection window.

   The Settings window appears.

![Settings Window image]

**Update of status**
- **Printer Status is regularly updated** check box
  
  Select the check box to enable/disable the printer status to be updated by the specified interval.
- **Update interval** text box
  
  Specify the update interval of the printer status.

**Port Number Settings**
- **Port Number**
  
  Specify the port number in the Port Number text box to open the setting page of your printer in a web browser.
Protocol Settings - SNMP

• Community Name
  Enter the Community name of SNMP in the Community Name text box.

Order URL

• Select Reorder URL
  The selected URL address is set as default web site for the Select Reorder URL in the Dell Supplies Management System window.

Tool Box (for Microsoft® Windows®)

The Tool Box allows you to view, specify, and diagnose the system settings.

To start the Tool Box

1 Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.
   For Windows® 10: Click the Start button → Dell Printer Hub or Dell Printer Management Tool.

2 For Dell Printer Hub, select the printer from My Printers on the home screen.
   For Dell Printer Management Tool, select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the home screen.

3 Click the shortcut to the Tool Box on the left of the screen.
   For details on using the Tool Box, see the help on the Tool Box.

Address Book Editor (for Microsoft® Windows® and OS X)

There are several address books available for Scan and Fax functions. Address books help you organize contact information, such as e-mail addresses, fax numbers and server information, and quickly choose the recipient or locate the address. The address book data can be obtained from the printer or a remote LDAP server.

NOTE: Phone Book is described as one of Address Books in this section.

NOTE: For information on how to setup the LDAP server, see “LDAP Server” and "LDAP User Mapping.” For information on how to obtain e-mail addresses and fax numbers from LDAP servers, see “Using the Server Address Book and Server Phone Book.”

Types of Address Books

• E-mail Address Book (for Scan to Email)
  E-mail addresses registered for sending the scanned document via e-mail

• Email Group (for Scan to Email)
  Groups of e-mail addresses registered for sending the scanned document via e-mail

• LDAP Server Address Book (for Scan to Email)
  E-mail addresses registered in the LDAP server for sending the scanned document via e-mail

• Network Address Book (for Scan to Network Folder)
  Computer and FTP server information registered for sending the scanned document to a computer or ftp server

• Phone Book (for Fax)
  Fax numbers registered for sending documents from your printer
• Group Dial (for Fax)
  Groups of fax numbers registered for sending documents from your printer
• LDAP Server Phone Book (for Fax)
  Fax numbers registered in the LDAP server for sending documents from your printer
• PC Fax Address Book (for Direct Fax)
  Fax numbers registered for sending documents from your computer
• PC Fax Address Book for group (for Direct Fax)
  Groups of fax numbers registered for sending documents from your computer

**Adding and Editing Entries to the Address Books Using the Address Book Editor**

**NOTE:** You can add and edit the entries to the Address Books also from the operator panel of the printer or using the Dell Printer Configuration Web Tool. See "Setting Speed Dial" for using the operator panel, or "Address Book" for using the Dell Printer Configuration Web Tool.

---

**Summary Table**

<table>
<thead>
<tr>
<th>Functions</th>
<th>Features</th>
<th>Types of Address Books</th>
<th>Operator Panel on the Printer</th>
<th>Address Book Editor</th>
<th>Dell Printer Configuration Web Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan</td>
<td>E-mail</td>
<td>Address Book</td>
<td>-</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Email Group</td>
<td>-</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server Address Book</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(LDAP server)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Network</td>
<td></td>
<td>Address Book</td>
<td>-</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Fax</td>
<td>Fax</td>
<td>Phone Book</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Group Dial</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server Phone Book</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(LDAP server)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Direct Fax</td>
<td></td>
<td>PC Fax Address Book</td>
<td>-</td>
<td>●</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PC Fax Address Book - group</td>
<td>-</td>
<td>●</td>
<td>-</td>
</tr>
</tbody>
</table>

You can use **Address Book Editor** installed on your computer to add or edit entries. **Address Book Editor** is synchronized with the address books of your printer and updated simultaneously as you save changes to the entries in **Address Book Editor**.

**NOTE:** This tool is supported on both Microsoft® Windows® and OS X.

**NOTE:** When the printer and your computer is connected via USB, you must install the scanner driver.

With **Address Book Editor**, you can:

- Automatically retrieves data from the address books of your printer at startup
- Synchronizes with the printer
- Allows you to import the Address Book data from CSV file, WAB file, MAPI, and LDAP server
- Allows you to export the Address Book data into a CSV file

**NOTE:** Do not edit the exported CSV file with applications other than the **Address Book Editor**. Editing the CSV file with other applications may corrupt the address data.
Address Book Panel

There are two address books you can manage in the Address Book Editor: Device Address Book for Fax, E-mail, and Server and PC Fax Address Book for Direct Fax.

For Microsoft® Windows®:

For Apple Macintosh:

- **Device Address Book**
  - **Fax**
    Links to the printer's Address Book for Fax feature. You can register up to 200 fax numbers and 6 groups with 200 fax numbers.
  - **E-Mail**
    Links to the printer’s Address Book for Scan to Email feature. You can register up to 100 e-mail addresses and 10 groups with 10 e-mail addresses.
• **Server**
  Links to the printer’s Address Book for Scan to Network Folder feature. You can register up to 32 server information.

• **PC Fax Address Book**
  You can manage the PC Fax Address Book for using Direct Fax feature on your computer. You can register up to 500 fax numbers and 500 groups with 30 fax numbers.

**Editing an entry:**
1. Select an Address Book that the entry you want to edit is stored.
2. Select an entry that you want to edit.
3. Click **Edit**, and enter new information.
4. Click **Save** to save changes.

*NOTE:* When the address book entries are updated, it synchronizes with the printer and updates the address books of your printer simultaneously.

**ScanButton Manager (for OS X)**
You can change the location to save the scanned data using the ScanButton Manager. See "Changing the Location to Save the Scanned Data."

**User Setup Disk Creating Tool (for Microsoft® Windows®)**
The User Setup Disk Creating Tool program located in the MakeDisk folder of the Utilities folder on the Software and Documentation disc and the printer drivers located on the Software and Documentation disc are used to create driver installation packages that contain custom driver settings. A driver installation package can contain a group of saved printer driver settings and other data for things such as:
- Print orientation and Multiple Up (document settings)
- Watermarks
- Font references

If you want to install the printer driver with the same settings on multiple computers running the same operating system, create a setup disk in a media or in a server on the network. Using the setup disk that you have created will reduce the amount of work required when installing the printer driver.
- Install the printer driver in the computer on which the setup disk is to be created.
- The setup disk can only be used on the operating system on which the disk was created or computers running the same operating system. Create a separate setup disk for each of the operating systems.
App Manager (for Microsoft® Windows®)

The App Manager is a utility that lets you manage the apps on your printer.

- **NOTE:** The App Manager is supported only on Windows® 7 or later.
- **NOTE:** The features of the App Manager may not be used when the printer has an error. If the App Manager does not respond, check and clear the status of the printer.

Preparing to use the App Manager

To use the App Manager, it is recommended that your computer should have more than 25GB of storage space.

- **NOTE:** Your computer needs to be connected to a network. USB connection is not supported.
- **NOTE:** .Net Framework 4.0 or later is required.

Starting the App Manager

**For the Dell Cloud Multifunction Printer | H815dw**

1. Click Start → All Programs → Dell Printers → Dell Printer Hub.
2. Select the printer from My Printers on the home screen of the Dell Printer Hub.
3. Click App Manager on the left of the screen of the Dell Printer Hub.
4. Enter the same ID and password that is used for the Dell Printer Configuration Web Tool, and click OK.

   The Printers screen of the App Manager appears.

**For the Dell Smart Multifunction Printer | S2815dn**

1. Click Start → All Programs → Dell Printers → Dell Printer Management Tool.
2. Select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the home screen.
3. Click App Manager on the left of the screen of the Dell Printer Management Tool.
4. Enter the same ID and password that is used for the Dell Printer Configuration Web Tool, and click OK.

   The Printers screen of the App Manager appears.

- **NOTE:** If the printer you are looking for does not appear in the list or cannot be accessed from the App Manager, check that the On check box for Port9100 and SNMP is selected in the Port Settings of Print Server Settings tab in the Dell Printer Configuration Web Tool.
User Authentication

Using the user authentication function of the printer, it is possible to create and manage up to 18 user accounts secured with a password. Each user of the accounts can customize the home screen and save the changes.

For the Dell™ Cloud Multifunction Printer | H815dw only, it is also possible to associate NFC (Near Field Communication) capable ID Cards to an user account. When the ID card is associated with a user account, you can login to that user account by waving the ID card over the NFC reader.

For the Dell Smart Multifunction Printer | S2815dn only, it is also possible to select the user authentication method from either local authentication or remote authentication. To use the remote authentication method, the LDAP or Kerberos server is required to authenticate the user. To select the user authentication method, see "Desktop Login" or "Desktop Authentication."

**NOTE:** The Dell Cloud Multifunction Printer | H815dw supports the following card types:

- MIFARE Ultralight
- MIFARE Standard (Classic) 1K
- MIFARE Standard (Classic) 4K

**NOTE:** The images used in this manual are those of the Dell Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Creating and Editing the User Accounts

To use user authentication, you must first create a user account.

Creating a New User Account

1. Turn on the printer and wait until the portal screen is displayed.
2. Tap .
   
   **NOTE:** If the Panel Lock Control is set to Enable, you need to enter the four-digit password to proceed further.

   The dialog box is displayed to confirm to enter the edit mode.
3. Tap OK.

   The printer enters the edit mode, and the Add Account tile is displayed in the portal screen.

   **NOTE:** In the edit mode, each tile except the Add Account tile has .
4. Enter the account name and select the tile color.

   You can preview the image of your custom tile in Preview.
5 Tap Next.
The Account Settings 2/2 screen is displayed.

6 Enter the account password and NFC ID.

**NOTES:**

- When there is a check mark in the **Initial Login** check box, the printer always displays the Home screen of the account when you turn on the printer. If no account is specified as Initial Login, the portal screen is displayed when you turn on the printer.
- You can create a new account without setting the account password.
- NFC ID is available only on the Dell Cloud Multifunction Printer | H815dw.
- When the NFC Authentication is disabled, **NFC ID** is not displayed.
- When you use UID as the NFC ID, enter the hexadecimal characters. The characters A to F should be entered in the capital letters.

7 Tap Done. The screen returns to the portal screen.

**Editing the User Account**

1 Tap **** in the portal screen to enter the edit mode.
2 Tap the account tile you want to edit.
3 Edit the account name, tile color, password, NFC ID, or Initial Login.

**NOTE:** When the NFC authentication is disabled, **NFC ID** is not displayed.

4 Tap Done.
The screen returns to the portal screen.

**Deleting the User Account**

1 Tap **** in the portal screen to enter the edit mode.
2 Tap and hold the account tile you want to edit.

**is displayed.**

3 Drag the tile to **.**
4 Tap OK to delete the tile.

**Logging In to the User Account on the Dell Cloud Multifunction Printer | H815dw**

There are two ways to log in to the account. One is to log in using the touch panel, and the other is to log in using the NFC authentication card.

**Logging In Using the Touch Panel**

1 Start the printer and wait until the portal screen is displayed.
2 Tap the account tile you want to log in to.

**NOTE:** When the account you want to log in to does not require a password, skip step 3. The **Home** screen is displayed.

3 Enter the account password, and tap **Login**.

When the password is correct, the **Home** screen is displayed.
Logging In Using the NFC Authentication Card

To use the NFC authentication card, the following settings are needed:

- Enable the NFC authentication function in Secure Settings of the operator panel.
  (See "NFC Authentication")
- Register your user account to the printer so that you can log in with your NFC Authentication card.
  (See "Creating a New User Account")

1. Turn on the printer and wait until the portal screen is displayed.
   
   **NOTE:** The NFC authentication is available only when the portal screen is displayed.

2. Wave the card over the NFC reader on the printer.
   
   Your Home screen is displayed.

Logging Out

When there is an account which is specified as Initial Login, turning on the printer will always display the Home screen of that account. To log in to another account, you need to log out first.

1. Press the \( \text{Login/Logout} \) button on the operator panel.
   
   The screen returns to the portal screen.

Logging In to the User Account on the Dell Smart Multifunction Printer | S2815dn

You can select the user authentication method from either local authentication or remote authentication. To use the remote authentication method, the LDAP or Kerberos server is required to authenticate the user.

**NOTE:** The Dell Smart Multifunction Printer | S2815dn requires Kerberos Version 5 and Windows Active Directory on the following Microsoft® Windows Server® operating systems:

- Windows Server® 2003
- Windows Server® 2008
- Windows Server® 2008 R2
- Windows Server® 2012
- Windows Server® 2012 R2

Specifying the User Authentication Method

Use the operator panel menu or the Dell Printer Configuration Web Tool. For details about how to specify the user authentication method, see "Desktop Login" or "Desktop Authentication."

Preparations for Remote Authentication

To use the remote authentication method, the printer needs to be configured so that the printer can access to the LDAP or Kerberos server, and the users need to be registered to the Server Address Book. For details, see "Using the Server Address Book and Server Phone Book" and "Address Book Editor (for Microsoft® Windows® and OS X)."

Logging In for Remote Authentication

The Sign In screen is displayed when the printer is turned on while the printer is specified to use the remote authentication method.

Enter the login name and password registered in the LDAP or Kerberos server to log in to the printer.
To use the LDAP authentication, you can select one of the following methods to enter the user name and the domain name in the Login Name text box.

- **Method 1** [user name]
- **Method 2** [domain name]\[user name]
- **Method 3** [user name]@[domain1].[domain2]

The [domain2] in the method 3 can be specified in the Dell Printer Configuration Web Tool, using the “Use Added Text String” feature. In the Login Name text box on the Sign In screen, enter only the [user name]@[domain1]. For details, see "LDAP Authentication."

To use the Kerberos authentication, tap  to select a domain name of the Kerberos server from a list. You need to configure the domain names beforehand in the Dell Printer Configuration Web Tool. Up to five Kerberos servers can be configured. For details, see "Kerberos Server."

**NOTE:** To enter the accented characters, tap  to display the keyboard for those characters.

**NOTE:** When you enter the login name, you can also tap  to select a login name from a list. The list can contain up to eight recently entered login names.

**NOTE:** When the remote authentication method is used, the same Home screen is displayed for each user.

**NOTE:** The Domain text box is displayed only when the Kerberos server is used for the remote authentication.

### Logging In for Local Authentication

When the printer is specified to use the local authentication method, you can log in to the account using the touch panel.

1. Start the printer and wait until the portal screen is displayed.
2. Tap the account tile you want to log in to.
   - **NOTE:** When the account you want to log in to does not require a password, skip step 3. The Home screen is displayed.
3. Enter the account password, and tap Login.
   - When the password is correct, the Home screen is displayed.

### Logging Out

When there is an account which is specified as Initial Login, turning on the printer will always display the Home screen of that account. To log in to another account, you need to log out first.

1. Press the  (Login/Logout) button on the operator panel.
   - The screen returns to the portal screen.
Tile Customization

The Home screen is like a desktop of your computer and customizable to suit your preference or work style. For example, you can gather only the tiles you often use, or rearrange the tiles so that you can easily access the tiles you often use.

The tiles on the Home screen can be the shortcuts to the jobs to be done on the printer, like "taking seven copies of the handouts for the weekly meeting in 2-Sided copy" or "scanning the document and sending the scanned file to my boss by e-mail." If you create a tile for a job with such job settings, the printer will automatically change the settings of the printer as you specified just by tapping the tile.

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Adding a New Tile

You can select and add the tile from the pre-defined tiles, or you can create a new customized tile which includes specific settings for copy, fax, scan or print. Up to 41 tiles can be placed in your Home screen.

You can also add tiles to each of the Copy, Print, Scan, and Fax group screen that is displayed when tapping the icons in the Dock Menu. Up to 8 tiles can be placed in each group screen.

Selecting From the Pre-defined Tiles

The printer offers the pre-defined tiles which include the default job settings.

1. On the Home screen or group screen, tap the Add App tile.
   The Apps List screen is displayed.
2. Tap the tile you want to add to your Home screen or group screen.
   indicates that the tile already exists in your Home screen.

Creating a New Tile Including the Job Settings

You may often use the same settings to copy a certain document, for example. You can create the tile including those job settings and save it in your Home screen.

Creating Your Custom Tile for Job With Its Job Settings

The following explanation is an example to create your custom tile for copying.

To create custom tiles for other jobs such as faxing, scanning, or printing, follow the same procedures on the job settings screen of each job.
1 Tap the Copy tile in your Home screen.
   The Copy Settings screen is displayed.

2 Tap the setting tiles to change the copy options as needed. For more information, see "Setting Copy Options."

3 After setting all the necessary copy options, tap .
   The Save Settings screen is displayed.

4 Tap the text box to name your settings.

5 Tap the color tile to select the color of your custom tile.
   You can preview the image of your custom tile in Preview.

6 Tap Save As.
   Your settings are saved as a new tile in your Home screen.

   **NOTE:** When a tile has the Lock icon, that function is controlled by the Functions Control setting. To enable the function, you need to enter the password.
   For more information, see "Functions Control."

   **NOTE:** When you save the job settings for Fax or Scan to Email as a custom tile, recipient information is saved together with the settings. To prevent from sending faxes or e-mails to wrong recipients, check that the fax number or the e-mail address of the recipient shown in the operator panel is correct.
   To prevent others from using customized tiles with personal information, logout from your user account after you finish using the printer.

**Editing Your Custom Tile for Job**

You can edit the job settings saved in your custom tile.

1 Tap the tile you want to edit in your Home screen or group screen.

2 Change the job settings as needed.

3 Tap .
   The Save Settings screen is displayed.

4 Tap the text box to name your settings if you want to rename your settings.

5 Tap the color tile if you want to change the color of the tile.

6 Tap Save.
   Your settings are overwritten.

   If you have renamed the tile name, the new settings overwrites the old settings, and the tile is renamed with a new name.

   **NOTE:** If you tap Save As instead, the new tile will be added in your Home screen.

**Moving or Deleting Your Tiles**

You can move or delete your tiles from your Home screen or group screen.

For more information, see "Moving, Adding or Deleting the Tiles."
Using the Server Address Book and Server Phone Book

With the E-mail Server Address Book and the Fax Server Phone Book, you can specify an e-mail address or fax number of a recipient registered in the external LDAP server when sending a scanned image with e-mail or fax.

To use the E-mail Server Address Book and the Fax Server Phone Book, the printer needs to be configured in order to access the external LDAP server.

**NOTE:** To configure the settings of the external LDAP server, consult your system administrator.

**NOTE:** The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Preparing the Printer to Access the External LDAP Server

Set the following items using the Dell Printer Configuration Web Tool.

- Authentication type
- LDAP Server
- LDAP User Mapping

Starting the Dell Printer Configuration Web Tool

To launch the Dell Printer Configuration Web Tool, enter the IP address of your printer in your web browser. If you do not know the IP address of your printer, print the system settings report or display the TCP/IP Settings page, which lists the IP address. For details about how to find your printer’s IP address, see “Verifying the IP Settings.”

Setting Authentication Type

1. Select Print Server Settings, click the Security tab, and then select Authentication System.

2. From the Authentication System Settings drop-down menu under Authentication Type, select LDAP as the authentication method, and then click Apply New Settings.

**NOTE:** When the server you are accessing uses the Kerberos authentication, select Kerberos as the authentication method. To set the information necessary to access the Kerberos server, enter the information in Kerberos Server under the Security tab. For more information, see “Kerberos Server.”

3. Click Restart Printer.
Setting LDAP Server

**NOTE:** When SSL/TLS communication is required to access the LDAP server, enter a check in the **Enable** check box for **LDAP-SSL/TLS Communication** in **SSL/TLS** under the **Security** tab. For more information, see “SSL/TLS.”

1. Select Print Server Settings, click the **Security** tab, and then select **LDAP Server**.

2. In the **IP Address/Host Name & Port** text box under **Server Information**, enter IP address or the host name, and the port number. The port number must be 389, 636, 3268, 3269, or between 5000 and 65535.

   **NOTE:** When LDAPS communication is required, set the port number to 636, and when you use the global catalog, set the port number to 3269.

3. Under **Optional information**, set the following items.

   a. In the **Search Directory Root** text box, enter the search directory root.
   b. In **Login Credentials to Access LDAP Server**, select credential used to access the LDAP server. Select **None** to use anonymous login. Make sure that the LDAP server accepts anonymous login.
      Select **Preset** to apply the preset login credentials to each user.
      Select **Prompt User** to prompt the users to enter their login credentials.
   c. In the **Login Name** text box, enter the login name.

For details on configuring each item, consult your network administrator.
d In the **Password** text box, enter the login password using 1 to 127 alphanumeric characters. If the password is left blank (NULL), you cannot log in to a server.

e In the **Re-enter Password** text box, enter the login password again to confirm it.

f In **Search Time-Out**, select **Wait LDAP Server Limit** to follow the time specified by the LDAP server. Select **Wait** to specify the time between 5 and 120 seconds.

g From the **Search Name Order** drop-down menu, specify the search order.

h In **Server Address Book**, select the check box to enable the server address book.

i In **Server Phone Book**, select the check box to enable the server phone book.

4 Click **Apply New Settings**.
5 Click **Restart Printer**.

**Setting LDAP User Mapping**

1 Select **Print Server Settings**, click the **Security** tab, and then select **LDAP User Mapping**.

2 Specify the attribute names used in the LDAP server. If the attribute names are not customized in the LDAP server, leave the settings in this step as they are by default.

3 Click **Apply New Settings** if you make any changes.
4 Click **Restart Printer**.
Sending an E-mail With the Scanned File Using the E-mail Server Address Book

1. Press the (Home) button.
2. Tap ➔ Scan to Email.
3. Tap Address Book.

4. Tap Network Address Book.
5. Enter a keyword using the keyboard, and then tap Search.
6. Tap a recipient from the search result, and then tap Done.

**NOTE:** The sender's e-mail address cannot be edited when the remote authentication is used as the user authentication method on the Dell Smart Multifunction Printer | S2815dn.

7. Tap Send to begin scanning the document and sending an e-mail with the scanned file.

Sending a Fax Using the Fax Server Phone Book

1. Press the (Home) button.
2. Tap ➔ Fax.
3. Tap Phone Book.

4. Tap Network Address Book.
5. Enter a keyword using the keyboard, and then tap Search.
6. Tap a recipient from the search result, and then tap Done.
7. Tap Send to send the fax.
Using Digital Certificates

The authentication feature using digital certificates upgrades security when sending print data or setting data. This chapter describes how to manage digital certificates.

The printer supports the following formats as the digital certificates.

- **PKCS#12**
  - HTTPS, IPsec (PKI), Wi-Fi (WPA-Enterprise)
- **PKCS#7 (for CSR)**
  - HTTPS, IPsec (PKI)

**NOTE:** For information about digital certificate error, see “Understanding Printer Messages” and “Digital Certificate Problems.”

The following is a typical setup flow for using digital certificates.

1. **Prepare to manage digital certificates.**
   - Set HTTPS Communication

2. **Import and set digital certificates.**
   - Import a Digital Certificate
   - Set a Digital Certificate
   - Confirm the Settings of a Digital Certificate

3. **Set various security features using digital certificates.**

Managing Certificates

This section describes how to manage digital certificates as follows.

- "Preparing to Manage Certificates"
- "Creating and Downloading a Certificate Signing Request (CSR)"
- "Importing a Digital Certificate"
- "Setting a Digital Certificate"
- "Confirming the Settings of a Digital Certificate"
- "Deleting a Digital Certificate"
- "Exporting a Digital Certificate"

Preparing to Manage Certificates

Before managing digital certificates, the following settings must be applied.

- "Setting HTTPS Communication"
- "Creating and Downloading a Certificate Signing Request (CSR)"
Setting HTTPS Communication

Before managing certificates, set HTTPS communication with a self-signed certificate.

When Using the Dell™ Printer Configuration Web Tool

1. Launch Dell Printer Configuration Web Tool.
   a. Open the web browser.
   b. Enter the IP address of your printer in the web browser.
      See "Dell™ Printer Configuration Web Tool."
2. Select Print Server Settings.
3. Click the Security tab.
4. Select SSL/TLS.
6. Select the public key method from the list of Public Key Method.
7. Select the size of public key from the list of Size of Public Key.
8. Specify the issuer of self-signed certificate.
9. Click Generate Signed Certificate.
10. The Restart Printer button is displayed after generating the self-signed certificate, and then click Restart Printer.
11. Repeat steps 2 to 4 to display the SSL/TLS page after restarting the printer.
12. Confirm that the HTTP-SSL/TLS Communication column is set to Enable.

Creating and Downloading a Certificate Signing Request (CSR)

NOTE: To download a CSR from the printer, you must set up HTTPS communication. For details, see “Setting HTTPS Communication.”

1. Launch Dell Printer Configuration Web Tool.
   a. Open the web browser.
   b. Enter the IP address of your printer in the web browser.
      See "Dell™ Printer Configuration Web Tool."
2. Select Print Server Settings.
3. Click the Security tab.
4. Select SSL/TLS.
5. Click Certificate Signing Request (CSR).
     The Certificate Signing Request (CSR) page is displayed.
6. Specify each item of certificate signing request.
7. Click Apply New Settings.
8. Confirm the settings of certificate signing request, and then click Download.
9. Save a CSR file to your computer.
   Use this CSR to receive a signed certificate from a trusted certificate authority.

Importing a Digital Certificate

CAUTION: Before importing a certificate file, back up the certificate file.
Using Digital Certificates

NOTE: To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."

NOTE: Be sure to import the certificate with Internet Explorer®.

NOTE: After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1. Launch Dell Printer Configuration Web Tool.
   a. Open the web browser.
   b. Enter the IP address of your printer in the web browser.
      See "Dell™ Printer Configuration Web Tool."

2. Select Print Server Settings.
3. Click the Security tab.
4. Select SSL/TLS.
   The Upload Signed Certificate page is displayed.
6. Enter a password.
   NOTE: The password is not necessary when importing a PKCS#7 format certificate, which is having the filename extension .p7b.
7. Re-enter the password again to confirm it.
8. Click Browse of File Name, and select the file to be imported.
9. Click Import to import the certificate.

Setting a Digital Certificate

NOTE: To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."

1. Launch Dell Printer Configuration Web Tool.
   a. Open the web browser.
   b. Enter the IP address of your printer in the web browser.
      See "Dell™ Printer Configuration Web Tool."

2. Select Print Server Settings.
3. Click the Security tab.
4. Select SSL/TLS.
5. Click Certificate Management to display the Certificate Management page.
6. When setting a Wireless LAN (Server)* certificate, select Trusted Certificate Authorities within Category.
   When setting a certificate of SSL/TLS Server, SSL/TLS Client, IPsec, or Wireless LAN (Client)*, select Local Device.
7. Select the purpose of use from the Certificate Purpose list.
8. Click Display the List to display the Certificate List page.
   NOTE: If the list includes more than 20 certificates, click Next to display the next page.
9. Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.
10. Click Certificate Details to display the Certificate Details page.
11. Confirm the content, and click Use This Certificate at the upper-right corner.

* Dell Cloud Multifunction Printer | H815dw only
Confirming the Settings of a Digital Certificate

**NOTE:** To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."

1. Launch Dell Printer Configuration Web Tool.
   a. Open the web browser.
   b. Enter the IP address of your printer in the web browser.

   See "Dell™ Printer Configuration Web Tool."

2. Select Print Server Settings.
3. Click the Security tab.
4. Select SSL/TLS.
5. Click Certificate Management to display the Certificate Management page.
6. Select the category from the Category list.
7. Select the purpose of use from the Certificate Purpose list.
8. Click Display the List to display the Certificate List page.

   **NOTE:** If the list includes more than 20 certificates, click Next to display the next page.

9. The certificate displayed with an asterisk as "Valid" in the Validity column is the certificate associated with the use purpose and actually used.

Deleting a Digital Certificate

**NOTE:** To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."

1. Launch Dell Printer Configuration Web Tool.
   a. Open the web browser.
   b. Enter the IP address of your printer in the web browser.

   See "Dell™ Printer Configuration Web Tool."

2. Select Print Server Settings.
3. Click the Security tab.
4. Select SSL/TLS.
5. Click Certificate Management to display the Certificate Management page.
6. Select the category from the Category list.
7. Select the purpose of use from the Certificate Purpose list.
8. Click Display the List to display the Certificate List page.

   **NOTE:** If the list includes more than 20 certificates, click Next to display the next page.

9. Select the certificate to be deleted.
10. Click Certificate Details to display the Certificate Details page.
11. To delete the selected certificate, click Delete at the upper-right corner.

   **NOTE:** When a certificate is deleted, the features associated with the deleted certificate are disabled. To delete a certificate being used, either set the feature to OFF in advance or switch the association to another certificate, and then switch to another operation mode if possible before deleting the certificate.

   - For an SSL/TLS Server, switch to another certificate such as a self-signed certificate.
• For Wireless LAN*, change the Wireless Security setting to other than WPA-Enterprise before deleting the certificate.

* Dell Cloud Multifunction Printer | H815dw only

Exporting a Digital Certificate

NOTE: To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."

NOTE: Since the secret key is not exported, an imported PKCS#12 format certificate can be exported only as a PKCS#7 certificate.

1 Launch Dell Printer Configuration Web Tool.
   a Open the web browser.
   b Enter the IP address of your printer in the web browser.
   See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select SSL/TLS.

5 Click Certificate Management to display the Certificate Management page.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

   NOTE: If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to be exported.

10 Click Certificate Details to display the Certificate Details page.

11 To export the selected certificate, click Export this certificate.

Setting the Features

You can set various security features using digital certificates.

See the following for details:

• "Setting the SSL/TLS-use Server Certificate (HTTP/IPP)"
• "Setting SMTP-SSL/TLS Communication"
• "Setting LDAP-SSL/TLS Communication"
• "Setting for Wireless LAN WPA-Enterprise (EAP-TLS)"

   NOTE: This feature is available on the Dell Cloud Multifunction Printer | H815dw only.

• "Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP:TTLS PAP, EAP:TTLS CHAP)"

   NOTE: This feature is available on the Dell Cloud Multifunction Printer | H815dw only.
Using Digital Certificates

Setting the SSL/TLS-use Server Certificate (HTTP/IPP)

- **NOTE:** To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."

1. Import the certificate to be used with the SSL/TLS-use server. For more information, see "Importing a Digital Certificate."
2. Set the certificate to be used with the SSL/TLS-use server. For more information, see "Setting a Digital Certificate."
3. Confirm whether the certificate is set correctly. For more information, see "Confirming the Settings of a Digital Certificate."
   - **NOTE:** Confirm whether the newly set certificate, not the self-signed certificate, is associated.
4. After restarting the printer, the certificate set as described above is used as the server certificate when executing communication with HTTP/IPP-SSL/TLS.

Setting SMTP-SSL/TLS Communication

1. Select Print Server Settings from the left side of the page.
2. Click the Security tab.
3. Select SSL/TLS.
4. Select Enable from the SMTP-SSL/TLS Communication list.
5. Click Apply New Settings.
6. After restarting the printer, SMTP-SSL/TLS Communication is enabled.

Setting LDAP-SSL/TLS Communication

1. Select Print Server Settings from the left side of the page.
2. Click the Security tab.
3. Select SSL/TLS.
4. Select the Enable check box for LDAP-SSL/TLS Communication.
5. Click Apply New Settings.
6. After restarting the printer, LDAP-SSL/TLS Communication is enabled.

Setting for Wireless LAN WPA-Enterprise (EAP-TLS)

- **NOTE:** This feature is available on the Dell Cloud Multifunction Printer | H815dw only.
- **NOTE:** To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."
- **NOTE:** WPA-Enterprise is available only when infrastructure is selected as the network type.
- **NOTE:** Be sure to import the certificate with Internet Explorer®.
- **NOTE:** After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1. Import the certificate to be used with Wireless LAN (server or root certificate). For details, see "Importing a Digital Certificate."
2. Set the digital certificate for wireless LAN (server or root certificate).
   - a. Launch Dell Printer Configuration Web Tool.
   - b. Select Print Server Settings.
   - c. Click the Security tab.
d Select SSL/TLS.
e Click Certificate Management to display the Certificate Management page.
f Select Trusted Certificate Authorities within Category.
g Select Wireless LAN (Server) from the Certificate Purpose list.
h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary if you do not need to specify the order for the certificates.
i Click Display the List to display the Certificate List page.
j Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.
k Click Certificate Details to display the Certificate Details page.
l Confirm the content, and click Use This Certificate at the upper-right corner.
3 Confirm whether the certificate is set correctly. For details, see "Confirming the Settings of a Digital Certificate."
4 Import the certificate to be used with Wireless LAN (client or client certificate). For details, see "Importing a Digital Certificate."
5 Set the digital certificate for wireless LAN (client or client certificate).
a Launch Dell Printer Configuration Web Tool.
b Select Print Server Settings.
c Click the Security tab.
d Select SSL/TLS.
e Click Certificate Management to display the Certificate Management page.
f Select Local Device within Category.
g Select Wireless LAN (Client) from the Certificate Purpose list.
h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary if you do not need to specify the order for the certificates.
i Click Display the List to display the Certificate List page.
j Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.
k Click Certificate Details to display the Certificate Details page.
l Confirm the content, and click Use This Certificate at the upper-right corner.
6 Confirm whether the certificate is set correctly. For details, see "Confirming the Settings of a Digital Certificate."
7 Set WPA-Enterprise for EAP-TLS.
a Launch Dell Printer Configuration Web Tool.
b Click the Print Server Settings tab.
c Select Wi-Fi.
d Select WPA-Enterprise-AES/WPA2-Enterprise-AES or Mixed Mode Enterprise from the Encryption list of Security Settings.

NOTE: WPA-Enterprise-AES/WPA2-Enterprise-AES or Mixed Mode Enterprise becomes available only when the following steps are set correctly.
• Importing a Digital Certificate
• Setting a Digital Certificate
• Confirming the Settings of a Digital Certificate
e Set EAP-Identity of WPA-Enterprise.
f Select EAP-TLS from the Authentication Method list of WPA-Enterprise.
g Click Apply New Settings.

**Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP-TTLS PAP, EAP-TTLS CHAP)**

- **NOTE:** This feature is available on the Dell Cloud Multifunction Printer | H815dw only.
- **NOTE:** To manage digital certificates, you must set up HTTPS communication. For details, see "Preparing to Manage Certificates."
- **NOTE:** WPA-Enterprise is available only when infrastructure is selected as the network type.
- **NOTE:** Be sure to import the certificate with Internet Explorer®.
- **NOTE:** After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Import the certificate to be used with Wireless LAN (server or root certificate). For details, see "Importing a Digital Certificate."

2 Set the digital certificate for wireless LAN (server or root certificate).
   a Launch Dell Printer Configuration Web Tool.
   b Select Print Server Settings.
   c Click the Security tab.
   d Select SSL/TLS.
   e Click Certificate Management to display the Certificate Management page.
   f Select Trusted Certificate Authorities within Category.
   g Select the purpose of use from the Certificate Purpose list.
   h Click Display the List to display the Certificate List page.
   i Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.
   j Click Certificate Details to display the Certificate Details page.
   k Confirm the content, and click Use This Certificate at the upper-right corner.

3 Confirm whether the certificate is set correctly.
   a Launch Dell Printer Configuration Web Tool.
   b Select Print Server Settings.
   c Click the Security tab.
   d Select SSL/TLS.
   e Click Certificate Management to display the Certificate Management page.
   f Select the category from the Category list.
   g Select Wireless LAN (Server) from the Certificate Purpose list.
   h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary if you do not need to specify the order for the certificates.
   i Click Display the List to display the Certificate List page.
   j The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with the use purpose and actually used.

4 Set WPA-Enterprise for PEAPV0-MS-CHAPV2, EAP-TTLS PAP, or EAP-TTLS CHAP.
   a Launch Dell Printer Configuration Web Tool.
   b Click the Print Server Settings tab.
   c Select Wi-Fi.
d) Select WPA-Enterprise-AES/WPA2-Enterprise-AES or Mixed Mode Enterprise from the Encryption list of Security Settings.

**NOTE:** WPA-Enterprise-AES/WPA2-Enterprise-AES or Mixed Mode Enterprise becomes available only when the following steps are set correctly.
- Importing a Digital Certificate
- Setting a Digital Certificate
- Confirming the Settings of a Digital Certificate

e) Set EAP-Identity, Login Name, and Password of WPA-Enterprise.

f) Select either of the following from the Authentication Method list of WPA-Enterprise:
- PEAPV0 MS-CHAPV2
- EAP-TTLS PAP
- EAP-TTLS CHAP

g) Click Apply New Settings.
Understanding Printer Messages

The touch panel displays error messages describing the current state of the printer and indicates possible printer problems you must resolve. This chapter provides a list of status codes or error messages, and informs you what you can do to clear error messages. When you contact customer support about an error, have the status codes and error messages ready.

⚠️ **CAUTION:** When an error occurs, the print data remaining on the printer and the information accumulated in the memory of the printer may be corrupted.

⚠️ **NOTE:** An status code is listed in an error message.

⚠️ **NOTE:** For status codes that are not listed in this chapter, refer to instructions in each error messages.

### Status Codes

<table>
<thead>
<tr>
<th>Status-Code</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>004-310</td>
<td>Turn off the printer. Make sure that the tray is correctly installed, and turn on the printer. Contact customer support if this failure is repeated.</td>
</tr>
<tr>
<td>005-110</td>
<td>Remove the jammed documents.</td>
</tr>
<tr>
<td>005-112</td>
<td>Open the DADF cover and remove the jammed documents.</td>
</tr>
<tr>
<td>005-121</td>
<td></td>
</tr>
<tr>
<td>005-124</td>
<td>Open the DADF cover and remove all documents.</td>
</tr>
<tr>
<td>005-301</td>
<td>Close the DADF cover.</td>
</tr>
<tr>
<td>005-900</td>
<td>Open the DADF cover and remove the jammed documents.</td>
</tr>
<tr>
<td>009-363</td>
<td>Turn off the printer. Make sure that the toner cartridge is correctly installed, and turn on the printer. Contact customer support if this failure is repeated. For more information about installing the toner cartridge, see &quot;Replacing the Toner Cartridge.&quot;</td>
</tr>
<tr>
<td>009-370</td>
<td>Turn off the printer. Make sure that the black toner cartridge is correctly installed, and turn on the printer. Contact customer support if this failure is repeated. For more information about installing the toner cartridge, see &quot;Replacing the Toner Cartridge.&quot;</td>
</tr>
<tr>
<td>010-317</td>
<td>Turn off the printer, wait for 40 minutes to let the fusing unit cool, and then make sure that the fusing unit is fully installed. For more information about installing the fusing unit, see &quot;Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller.&quot;</td>
</tr>
<tr>
<td>010-351</td>
<td>Turn off the printer. Remove the used fusing unit, and install a new fusing unit. For more information about replacing the fusing unit, see &quot;Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller.&quot;</td>
</tr>
<tr>
<td>010-377</td>
<td>Turn off the printer. Confirm that the fusing unit is correctly installed, and turn on the printer. Contact customer support if this failure is repeated. For more information about installing the fusing unit, see &quot;Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller.&quot;</td>
</tr>
<tr>
<td>010-421</td>
<td>It is time to replace the fusing unit soon. Replace the fusing unit, following the procedures in &quot;Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller.&quot;</td>
</tr>
<tr>
<td>010-910</td>
<td>Either one of the two envelope switches is not set to the correct position. Open the rear cover, and slide both the envelope switches on the fusing unit to the correct position. For more information about setting the envelope mode, see &quot;To Set the Printer to the Envelope Mode.&quot;</td>
</tr>
<tr>
<td>010-911</td>
<td>The printer is not set to the envelope mode. To print on envelopes, it is recommended to set the printer to the envelope mode. Open the rear cover, and slide both the envelope switches on the fusing unit to the position.</td>
</tr>
<tr>
<td>Status-Code</td>
<td>What you can do</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>010-912</td>
<td>The printer is set to the envelope mode. To cancel the envelope mode, open the rear cover, and slide both the envelope switches on the fusing unit to the position. For more information about canceling the envelope mode, see &quot;To Cancel the Envelope Mode.&quot;</td>
</tr>
<tr>
<td>010-913</td>
<td>The printer is set to the envelope mode. To cancel the envelope mode, open the rear cover, and slide both the envelope switches to the position. For more information, see &quot;To Cancel the Envelope Mode.&quot;</td>
</tr>
<tr>
<td>016-338</td>
<td>Turn off the printer, and turn it on again. Contact customer support if this failure is repeated.</td>
</tr>
<tr>
<td>016-404</td>
<td>Contact your system administrator. For more information about digital certificate problems, see &quot;Digital Certificate Problems.&quot;</td>
</tr>
<tr>
<td>016-405</td>
<td>Security setting mismatch. Initialize the security setting, and then restart the printer. Contact your system administrator for the security resetting.</td>
</tr>
<tr>
<td>016-503</td>
<td>Unable to resolve the e-mail SMTP server hostname. Tap Close, or wait for 60 seconds for the printer to recover. Check if SMTP server and DNS server are set correctly.</td>
</tr>
<tr>
<td>016-504</td>
<td>Unable to resolve the e-mail POP3 server hostname. Tap Close, or wait for 60 seconds for the printer to recover. Check if user name and password for POP3 server and DNS server are set correctly.</td>
</tr>
<tr>
<td>016-505</td>
<td>E-mail POP3 server login error. Tap Close, or wait for 60 seconds for the printer to recover. Check if user name and password used for POP3 server are set correctly.</td>
</tr>
<tr>
<td>016-506</td>
<td>SMTP server is not configured. Tap Close, or wait for 60 seconds for the printer to recover. Check if SMTP server or POP server is set.</td>
</tr>
<tr>
<td>016-507</td>
<td>E-mail SMTP server login error. Tap Close, or wait for 60 seconds for the printer to recover. Check if user name and password used for SMTP server are set correctly.</td>
</tr>
<tr>
<td>016-520</td>
<td>IPsec certificate error. (Certificate error of the printer.) The certificate of the printer is invalid. Contact your system administrator. Reset the certificate from other connectable clients with Dell™ Printer Configuration Web Tool. If no device can be connected, disconnect Ethernet cable, turn off the IPsec, and then reset the certificate with Dell Printer Configuration Web Tool.</td>
</tr>
<tr>
<td>016-521</td>
<td>IPsec certificate error. (Remote device certification verification error.) The certificate of the destination client is invalid. Contact your system administrator. Confirm the certificate of the destination client and reset.</td>
</tr>
<tr>
<td>016-530</td>
<td>Authentication server access error. Turn off the printer, and turn it on again. Check the access settings for the authentication server and try again. Contact customer support if this failure is repeated.</td>
</tr>
<tr>
<td>016-541</td>
<td>A wireless certificate (server or client) cannot be correctly referenced while using Wireless LAN WPA-Enterprise or WPA2-Enterprise. Ask your system administrator to connect the printer with a wired network, initialize the wireless settings, import the wireless certificate, and set WPA-Enterprise or WPA2-Enterprise again.</td>
</tr>
<tr>
<td>016-542</td>
<td>A server certificate error has occurred when acquiring the certificate with the operation of WPA-Enterprise or WPA2-Enterprise. This is a problem in the server certificate, such as the validity period has expired for the server certificate being used with the Radius server. Ask your system administrator to confirm the server certificate being used with the Radius server.</td>
</tr>
<tr>
<td>016-543</td>
<td>A wireless certificate (server or client) corruption error has occurred while using the Wireless LAN WPA-Enterprise or WPA2-Enterprise. Ask your system administrator to connect the printer with a wired network, initialize the wireless settings, import the wireless certificate, and set WPA-Enterprise or WPA2-Enterprise again.</td>
</tr>
<tr>
<td>016-718</td>
<td>Error relating to USB Direct Print problems has occurred. While the USB memory is still inserted, set Image Types to Photos (Standard Quality) in Print Settings under the Print PDF/TIFF menu and try printing again. For more information about this setting, see &quot;Image Types.&quot;</td>
</tr>
<tr>
<td>016-720</td>
<td>Error relating to PDL emulation problems has occurred. Change the Print Mode setting in the Graphics tab of the printer driver. Contact customer support if this failure is repeated.</td>
</tr>
<tr>
<td>016-756</td>
<td>Printing in the prohibited time. Contact your system administrator.</td>
</tr>
<tr>
<td>016-757</td>
<td>The account is not registered. Contact your system administrator.</td>
</tr>
<tr>
<td>Status-Code</td>
<td>What you can do</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>016-758</td>
<td>The function cannot be used. Contact your system administrator.</td>
</tr>
<tr>
<td>016-759</td>
<td>Printable page limit is exceeded. Contact your system administrator.</td>
</tr>
<tr>
<td>016-764</td>
<td>An error occurs when the printer connected to the SMTP server. Tap Close, or wait for 60 seconds for the printer to recover. Check the SMTP server settings or contact the SMTP server administrator.</td>
</tr>
<tr>
<td>016-765</td>
<td>The capacity of the SMTP server is not enough. Tap Close, or wait for 60 seconds for the printer to recover. Contact the SMTP server administrator.</td>
</tr>
<tr>
<td>016-766</td>
<td>The e-mail exceeds the SMTP server size restriction. Tap Close, or wait for 60 seconds for the printer to recover. Contact the SMTP server administrator.</td>
</tr>
<tr>
<td>016-767</td>
<td>The e-mail address of the recipient is incorrect. Tap Close, or wait for 60 seconds for the printer to recover. Check e-mail address, and try scanning again.</td>
</tr>
<tr>
<td>016-768</td>
<td>The e-mail address of the sender is incorrect. Tap Close, or wait for 60 seconds for the printer to recover. Check e-mail address, and try scanning again.</td>
</tr>
<tr>
<td>016-786</td>
<td>A timeout error occurs when sending or receiving scanned data. Tap Close, or wait for 60 seconds for the printer to recover. Check if the Ethernet cable is connected properly. If there is no problem with the Ethernet cable, contact server administrator.</td>
</tr>
<tr>
<td>016-790</td>
<td>Network connection error. (IP address is not determined.) Tap Close, or wait for 60 seconds for the printer to recover. Check if the Ethernet cable is connected properly. If there is no problem with the Ethernet cable, contact server administrator.</td>
</tr>
<tr>
<td>016-799</td>
<td>Tap Close to clear the message and cancel the current print job. Confirm the configuration of the printer on the printer driver.</td>
</tr>
<tr>
<td>016-930</td>
<td>The device is not supported. Remove it from the front USB port.</td>
</tr>
<tr>
<td>016-931</td>
<td>The USB hub is not supported. Remove it from the front USB port.</td>
</tr>
<tr>
<td>016-985</td>
<td>Tap Close, or wait for 60 seconds for the printer to recover. Retry scanning by lowering the resolution setting or changing the file format of the scanned image.</td>
</tr>
<tr>
<td>024-910</td>
<td>The paper size set is different from the specified size. Load the specified paper in tray1. To load paper in tray1, see &quot;Loading Print Media.&quot;</td>
</tr>
<tr>
<td>024-911</td>
<td>The paper size set is different from the specified size. Load the specified paper in the optional 550-sheet feeder (tray2). To load paper in tray2, see &quot;Loading Print Media.&quot;</td>
</tr>
<tr>
<td>024-914</td>
<td>The paper size set is different from the specified size. Load the specified paper in the multipurpose feeder (MPF). To load paper in the MPF, see &quot;Loading Print Media.&quot;</td>
</tr>
<tr>
<td>024-965</td>
<td>Confirm that the size and type specified in the tray settings matches the size and type of paper loaded in the tray.</td>
</tr>
<tr>
<td>024-966</td>
<td></td>
</tr>
<tr>
<td>024-969</td>
<td></td>
</tr>
<tr>
<td>026-721</td>
<td>Check your USB memory:</td>
</tr>
<tr>
<td></td>
<td>• If the file size or the number of files exceeds the limit of your USB memory.</td>
</tr>
<tr>
<td></td>
<td>• If your USB memory is write-protected.</td>
</tr>
<tr>
<td>027-446</td>
<td>Change the IPv6 address to avoid duplication. Turn off the printer, and turn it on again.</td>
</tr>
<tr>
<td>027-452</td>
<td>Change the IPv4 address to avoid duplication. Turn off the printer, and turn it on again.</td>
</tr>
<tr>
<td>031-521</td>
<td>SMB server login error. Tap Close, or wait for 60 seconds for the printer to recover. Confirm login-able computer with your system administrator.</td>
</tr>
<tr>
<td>031-522</td>
<td>SMB server login error. Tap Close, or wait for 60 seconds for the printer to recover. Check if login name (domain name and user name) and password are correct.</td>
</tr>
<tr>
<td>031-523</td>
<td>Invalid SMB share name. Tap Close, or wait for 60 seconds for the printer to recover. Check the share name you specified.</td>
</tr>
<tr>
<td>Status-Code</td>
<td>What you can do</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>031-524</td>
<td>Exceeded the SMB server user account limit. Tap Close, or wait for 60 seconds for the printer to recover. Check the number of users who use the server at the same time is not exceeding the upper limit.</td>
</tr>
<tr>
<td>031-525</td>
<td>SMB destination client permission error. Tap Close, or wait for 60 seconds for the printer to recover. Check if the specified user can read and write file at the storage location.</td>
</tr>
<tr>
<td>031-526</td>
<td>Unable to resolve the SMB server hostname. Tap Close, or wait for 60 seconds for the printer to recover. Check if forwarding destination server is registered with DNS.</td>
</tr>
<tr>
<td>031-527</td>
<td>Unable to resolve the SMB server hostname. Tap Close, or wait for 60 seconds for the printer to recover. Set DNS address, or set forwarding destination server address as IP address.</td>
</tr>
</tbody>
</table>
| 031-528     | Unable to connect to the SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check if the printer can communicate via network with the forwarding destination SMB server. For example, check the following:  
• Connection of an Ethernet cable  
• TCP/IP setting  
• Communication with Port 137 (UDP), 138 (UDP), and 139 (TCP).  
For communication beyond the subnet, contact your system administrator. |
| 031-529     | SMB server login error. (Invalid password.) Tap Close, or wait for 60 seconds for the printer to recover. Check if password is correct. |
| 031-530     | The SMB share folder was not found on the specified SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check the following:  
• Check if the storage location is correct.  
• Check if the file name you specified can be used when creating a file on the SMB server.  
• Have your system administrator check the DFS setting, and directly specify the SMB server, share name, and storage location according to the checked settings. |
| 031-531     | Unable to get a file or folder name on the SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check access right of the folder you specified. |
| 031-532     | SMB scan file or folder name limit exceeded. Tap Close, or wait for 60 seconds for the printer to recover. Change file name and forwarding destination folder, or move or delete file in forwarding destination folder. |
| 031-533     | Unable to write a file in the SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check the following:  
• If the file name you specified is not used by other users.  
• If file or folder that has the same name as the one you specified already exists. |
| 031-534     | Unable to create a folder on the SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check the following:  
• If the file name you specified is not used by other users.  
• If file or folder that has the same name as the one you specified already exists. |
<p>| 031-535     | Unable to delete a file on the SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check if other user is not operating file in storage location you specified. |
| 031-536     | Unable to delete a folder on the SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check if other user is not operating file in storage location you specified. |
| 031-537     | SMB server capacity exceeded. Tap Close, or wait for 60 seconds for the printer to recover. Check if storage location has free space. |
| 031-539     | The specified SMB server is invalid. Tap Close, or wait for 60 seconds for the printer to recover. Check if server name is correct. |
| 031-540     | The specified domain name is invalid. Tap Close, or wait for 60 seconds for the printer to recover. Check if domain name is correct. |</p>
<table>
<thead>
<tr>
<th>Status-Code</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>031-541</td>
<td>Invalid user name specified for SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check if login name (user name) is correct.</td>
</tr>
<tr>
<td>031-542</td>
<td>TCP/IP not initialized. Tap Close, or wait for 60 seconds for the printer to recover. Wait for a while and try the same operation again. Contact customer support if this failure is repeated.</td>
</tr>
<tr>
<td>031-543</td>
<td>SMB server login error. Tap Close, or wait for 60 seconds for the printer to recover. Check login permitted time with your system administrator.</td>
</tr>
<tr>
<td>031-544</td>
<td>SMB server login error. (Expired password.) Tap Close, or wait for 60 seconds for the printer to recover. Check the password valid period with your system administrator.</td>
</tr>
<tr>
<td>031-545</td>
<td>SMB server login error. (Password change required.) Tap Close, or wait for 60 seconds for the printer to recover. Check necessity of password change with your system administrator.</td>
</tr>
<tr>
<td>031-546</td>
<td>SMB server login error. (Invalid user is specified.) Tap Close, or wait for 60 seconds for the printer to recover. Contact your system administrator for the destination server settings.</td>
</tr>
<tr>
<td>031-547</td>
<td>SMB server login error. (The specified user is restricted from accessing the SMB server.) Tap Close, or wait for 60 seconds for the printer to recover. Contact your system administrator for the destination server settings.</td>
</tr>
<tr>
<td>031-548</td>
<td>SMB server login error. (Logon time of SMB destination expired.) Tap Close, or wait for 60 seconds for the printer to recover. Contact your system administrator for the destination server settings.</td>
</tr>
<tr>
<td>031-549</td>
<td>SMB server login error. Specified user is restricted, and a null password is prohibited. Tap Close, or wait for 60 seconds for the printer to recover. On server security settings, check access permission of null password user.</td>
</tr>
<tr>
<td>031-550</td>
<td>Append command not supported by SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check if the printer has access rights to append data to the SMB server. Check if server supports SMB append command.</td>
</tr>
<tr>
<td>031-551</td>
<td>Rename command not supported by SMB server. Tap Close, or wait for 60 seconds for the printer to recover. Check if the printer has access rights to rename data on the SMB server. Check if server supports SMB append command.</td>
</tr>
<tr>
<td>031-552</td>
<td>Job canceled. Tap Close, or wait for 60 seconds for the printer to recover. Change the file name that already exists on FTP server.</td>
</tr>
<tr>
<td>031-574</td>
<td>Unable to resolve the FTP server hostname. Tap Close, or wait for 60 seconds for the printer to recover. Check DNS connection, or check if name of forwarding destination server is registered with DNS.</td>
</tr>
<tr>
<td>031-575</td>
<td>Unable to resolve the FTP server hostname. Tap Close, or wait for 60 seconds for the printer to recover. Set DNS address, or set forwarding destination server address as IP address.</td>
</tr>
<tr>
<td>031-576</td>
<td>Unable to connect to the FTP server. Tap Close, or wait for 60 seconds for the printer to recover. Check if the printer communicates with forwarding destination FTP server. For example, check connection of Ethernet cable and if the IP address of the server is correct.</td>
</tr>
<tr>
<td>031-578</td>
<td>FTP server login error. Tap Close, or wait for 60 seconds for the printer to recover. Check if login name (user name) and password are correct.</td>
</tr>
<tr>
<td>031-579</td>
<td>Invalid FTP subdirectory path. Tap Close, or wait for 60 seconds for the printer to recover. Check if storage location is correct.</td>
</tr>
<tr>
<td>031-580</td>
<td>Failed to obtain a file or folder name of the FTP server. Tap Close, or wait for 60 seconds for the printer to recover. Check server access right.</td>
</tr>
<tr>
<td>031-581</td>
<td>FTP scan file or folder name limit exceeded. Tap Close, or wait for 60 seconds for the printer to recover. Change file name and forwarding destination folder, or move or delete file in forwarding destination folder.</td>
</tr>
<tr>
<td>031-582</td>
<td>Unable to write a scan file to the FTP server location. Tap Close, or wait for 60 seconds for the printer to recover. Check if the file name you specified can be created in storage location. Check if storage location has free space.</td>
</tr>
<tr>
<td>Status-Code</td>
<td>What you can do</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>031-584</td>
<td>Unable to create a scan folder on the FTP server. Tap Close, or wait for 60 seconds for the printer to recover. Check if the folder name you specified can be created in storage location. Check if the folder that has the same name as the one you specified already exists.</td>
</tr>
<tr>
<td>031-585</td>
<td>Unable to delete a file on the FTP server. (DEL command failure.) Tap Close, or wait for 60 seconds for the printer to recover. Check server access rights.</td>
</tr>
<tr>
<td>031-587</td>
<td>Unable to delete a folder on the FTP server. (RMD command failure.) Tap Close, or wait for 60 seconds for the printer to recover. Check server access rights.</td>
</tr>
<tr>
<td>031-588</td>
<td>Unable to write a file to the FTP server location. Tap Close, or wait for 60 seconds for the printer to recover. Check if storage location has free space.</td>
</tr>
<tr>
<td>031-590</td>
<td>Job canceled. Tap Close, or wait for 60 seconds for the printer to recover. Change the file name that already exists on FTP server.</td>
</tr>
<tr>
<td>031-594</td>
<td>FTP transfer type error. (TYPE command failure.) Tap Close, or wait for 60 seconds for the printer to recover. Try the same operation again. Contact customer support if this failure is repeated.</td>
</tr>
<tr>
<td>031-595</td>
<td>FTP data port error. (PORT command failure.) Tap Close, or wait for 60 seconds for the printer to recover. Try the same operation again. Contact customer support if this failure is repeated.</td>
</tr>
<tr>
<td>031-598</td>
<td>FTP append data error. (APPE command failure.) Tap Close, or wait for 60 seconds for the printer to recover. Check if the printer has access rights to append data to the FTP server. Check if server supports FTP append command.</td>
</tr>
<tr>
<td>031-599</td>
<td>FTP rename file error. (RNFR command failure.) Tap Close, or wait for 60 seconds for the printer to recover. Check if the printer has access rights to rename data on the FTP server. Check if server supports FTP rename command.</td>
</tr>
</tbody>
</table>
| 033-513     | Tap Close, or wait for 60 seconds for the printer to recover. Try the following:  
  • Print the received fax, or wait for a while until sending a fax is completed.  
  • Print the fax job stored using the Secure Receive feature.  
  For more information about the Secure Receive feature, see "Using the Secure Receiving Mode." |
| 033-527     | Tap Close, or wait for 60 seconds for the printer to recover. Wait for a while until the printer is not busy, and try again. |
| 033-528     | Tap Close, or wait for 60 seconds for the printer to recover. Check the available time period for the FAX, and try again. |
| 033-762     | Tap Close, or wait for 60 seconds for the printer to recover. The printer rejects faxes sent from unwanted numbers. For more information, see "Junk Fax Setup." |
| 033-776     | The size of the fax document data is too large and may have exceeded the space available in memory. Lower the scan resolution rate and then try scanning again. For details, see "Adjusting the Document Resolution." |
| 033-788     | Tap Close, or wait for 60 seconds for the printer to recover. Try the following:  
  • Remove the received fax, or wait for a while until sending a fax is completed.  
  • Print the fax job stored using the Secure Receive feature.  
  For more information about the Secure Receive feature, see "Using the Secure Receiving Mode." |
| 034-515     | Tap Close, or wait for 60 seconds for the printer to recover. Try the following:  
  • Try the same operation.  
  • Check the printer or remote machine if the memory is full. |
### Status-Code | What you can do
--- | ---
034-791 Tap Close, or wait for 60 seconds for the printer to recover. Check if the telephone line cord is connected properly. If the line connection is correct, check the following:
- If Tone/Pulse setting is correct.
  For more information about Tone/Pulse setting, see "Tone / Pulse."
If Tone/Pulse setting is correct, check the following:
- If the remote machine can receive a fax.

035-701 Tap Close, or wait for 60 seconds for the printer to recover. Check the following:
- Status of the remote machine
- Tone/Pulse setting
For more information about Tone/Pulse setting, see "Tone / Pulse."

035-708 Tap Close, or wait for 60 seconds for the printer to recover. Try the following:
- Try the same operation.
- Reduce the modem speed.
For more information about modem speed, see "Modem Speed."

035-717 Tap Close, or wait for 60 seconds for the printer to recover. Reduce the modem speed. For more information about modem speed, see "Modem Speed."

035-718 Tap Close, or wait for 60 seconds for the printer to recover. Check the status of the remote machine.

035-720 Tap Close, or wait for 60 seconds for the printer to recover. Check the features of the remote machine.

035-781 Tap Close, or wait for 60 seconds for the printer to recover. Check if the remote machine is busy.

042-700 Wait for a while until the printer cools down. Contact customer support if this failure is repeated.

050-130 Open the rear cover and remove any jammed paper.

050-131

050-132 Pull out MPF, tray1 and tray2, and remove any jammed paper. If the jammed paper cannot be removed, open the rear cover to remove it.

050-133 Pull out MPF, tray1, and tray2. Remove any jammed paper, return paper trays, and then tap OK.

050-134 Pull out MPF and tray1, remove any jammed paper, and then tap OK.

050-142 Pull out MPF and tray1. Open rear cover and remove any jammed paper.

077-300 Close the front cover.

077-302 Close the rear cover.

091-411 The time to replace the drum cartridge is coming soon. Prepare the new drum cartridge.

091-479 Open the front cover. Remove the used drum cartridge, and install a new drum cartridge. For more information about replacing the drum cartridge, see "Replacing the Drum Cartridge."

091-914 Reinstall the drum cartridge. If the message remains, replace the cartridge. For more information about replacing the drum cartridge, see "Replacing the Drum Cartridge."

091-921 Make sure that the drum cartridge is fully installed. For more information about installing the drum cartridge, see "Replacing the Drum Cartridge."

091-931 Remove the used drum cartridge, and install a new cartridge. For more information about replacing the drum cartridge, see "Replacing the Drum Cartridge."

091-942 Reinstall the drum cartridge. If the message remains, replace the cartridge. For more information about replacing the drum cartridge, see "Replacing the Drum Cartridge."

091-963 Remove the unsupported drum cartridge, and install a supported drum cartridge. For more information about installing the drum cartridge, see "Replacing the Drum Cartridge."

093-426 The time to replace the toner cartridge is coming soon. Prepare the new toner cartridge.
**Status-Code** | **What you can do**
---|---
093-922 | Open the front cover, and pull out the toner cartridge. Shake it five or six times, and reinstall it. For more information about replacing the toner cartridge, see "Replacing the Toner Cartridge."
093-933 | Remove the used toner cartridge, and install a new cartridge. For more information about replacing the toner cartridge, see "Replacing the Toner Cartridge."
093-963 | Remove the unsupported toner cartridge, and install a supported toner cartridge. For more information about installing the toner cartridge, see "Replacing the Toner Cartridge."
093-973 | Make sure that the toner cartridge is fully installed. For more information about installing the toner cartridge, see "Replacing the Toner Cartridge."
116-722 | Tap Close for the printer to recover. Check the Web Services on Devices (WSD) scan address and the destination computer, and then try scanning again. Contact your system administrator.
142-700 | Do not start another print job until the warning message disappears.
193-700 | When the genuine toner cartridge is installed, change the Non-Dell Toner setting to disable using the Dell Printer Configuration Web Tool or the Tool Box.

**Error Messages**

<table>
<thead>
<tr>
<th>Message</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot access the LDAP address book. Consult your network administrator if this error persists.</td>
<td>The printer fails to authenticate against an authentication server. An SSL/TLS authentication error on connection to the LDAP server; an SSL/TLS authentication internal error occurs.</td>
<td>Check the server settings. If the error persists, consult your network administrator.</td>
</tr>
<tr>
<td>Cannot access the LDAP address book. The LDAPS server certificate is not correct.</td>
<td>An SSL/TLS authentication error on connection to the LDAP server; the server certificate data is incorrect.</td>
<td>Check the root certificate of the LDAPS server SSL/TLS certificate on the printer.</td>
</tr>
<tr>
<td>Cannot access the LDAP address book. The LDAPS SSL/TLS client certificate is not set.</td>
<td>An SSL/TLS authentication error on connection to the LDAP server; the LDAP server cannot acquire an SSL/TLS client certificate.</td>
<td>Check that an SSL/TLS client certificate is correctly imported into the printer.</td>
</tr>
<tr>
<td>Cannot access the LDAP address book. The server names of LDAPS and the SSL/TLS certificate do not match.</td>
<td>An SSL/TLS authentication error on connection to the LDAP server; the server certificate for the LDAP server is not yet valid or has expired.</td>
<td>Change to a valid LDAP server SSL/TLS certificate.</td>
</tr>
<tr>
<td>Cannot access the LDAP address book. The time settings of the printer and the Kerberos server do not match.</td>
<td>The printer and the Kerberos server clocks have a time difference that exceeds the Kerberos server clock skew value.</td>
<td>Check that the printer and the Kerberos server clocks have the correct time.</td>
</tr>
<tr>
<td>Cannot connect to server. Check the server settings.</td>
<td>The specified server settings such as IP address and realm/domain name are incorrect.</td>
<td>Make sure that the correct IP address/host name, port number, realm/domain name, and search directory root are specified in IP Address / Host Name &amp; Port, Domain Name, and Search Directory Root on the Dell Printer Configuration Web Tool. (See &quot;Kerberos Server&quot; and &quot;LDAP Server.&quot;)</td>
</tr>
<tr>
<td>Message</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The LDAP or Kerberos version on the server</td>
<td>is not compatible with the printer.</td>
<td>Consult your network administrator.</td>
</tr>
<tr>
<td>The server is down.</td>
<td></td>
<td>Check that the server is functioning normally.</td>
</tr>
<tr>
<td>Change the server settings and confirm the</td>
<td>The printer cannot search for destinations within the specified time.</td>
<td>Increase the time setting for Search Time-Out on the Dell Printer</td>
</tr>
<tr>
<td>server connection.</td>
<td></td>
<td>Configuration Web Tool. (See &quot;Authentication System&quot; and &quot;LDAP Server.&quot;)</td>
</tr>
<tr>
<td>Check the authentication settings.</td>
<td>The login name and password for access to an authentication server are incorrect.</td>
<td>Make sure that the correct login name and password are specified in Login Name and Password on the Dell Printer Configuration Web Tool. (See &quot;Kerberos Server&quot; and &quot;LDAP Server.&quot;)</td>
</tr>
<tr>
<td>Invalid search characters or LDAP User</td>
<td>The LDAP search filter fails to work properly as special characters are used in your search condition or on the LDAP User Mapping page on the Dell Printer Configuration Web Tool.</td>
<td>Remove special characters, and then search again. (See &quot;LDAP User Mapping.&quot;)</td>
</tr>
<tr>
<td>User Mapping incorrectly configured for</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration Web Tool.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network connection is not ready. Try again</td>
<td>You have started searching for destinations before the IP address is set for the printer.</td>
<td>Wait for a while, and then search again.</td>
</tr>
<tr>
<td>later.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No attribute or invalid name. Confirm address info. on server.</td>
<td>The address information on the server contain incorrect data or are insufficient to get your search request.</td>
<td>Check the address information registered on the server or consult your network administrator.</td>
</tr>
<tr>
<td>No Entries.</td>
<td>The printer cannot find any destinations that meet your search condition.</td>
<td>Tap OK to return to the Search Network Address Book screen, and then specify a new condition to search again.</td>
</tr>
<tr>
<td>Search Directory Root incorrectly configured</td>
<td>The directories that do not exist in the LDAP server are specified or an invalid DN syntax is specified.</td>
<td>Make sure that valid values are specified in Search Directory Root on the Dell Printer Configuration Web Tool. (See &quot;LDAP Server.&quot;) Specify the origin of the search with the correct DN syntax, as shown in the following example: dc=w2008ad,dc=addressbook,dc=net</td>
</tr>
<tr>
<td>for Configuration Web Tool.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Too many search results. Only a maximum of 50 search scan can be displayed. Please refine your search if needed.</td>
<td>The number of search results has exceeded the limits (50 search results) the printer can display.</td>
<td>Tap Close to display the search results. If you cannot find your desired destination on the result list, specify a new condition to search again.</td>
</tr>
<tr>
<td>Authentication server access Error 016-530</td>
<td></td>
<td>Turn off the printer, and turn it on again. If the error persists, consult your network administrator.</td>
</tr>
</tbody>
</table>
Specifications

**NOTE:** The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

**Operating System Compatibility**


**Power Supply**

<table>
<thead>
<tr>
<th>Rated voltage</th>
<th>220 VAC - 240 VAC</th>
<th>110 VAC - 127 VAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>50/60 Hz</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Current</td>
<td>6 A or less</td>
<td>11 A or less</td>
</tr>
<tr>
<td>Power consumption</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready</td>
<td>52.0 W</td>
<td>52.0 W</td>
</tr>
<tr>
<td>Sleep</td>
<td>14.0 W</td>
<td>14.0 W</td>
</tr>
<tr>
<td>Deep Sleep</td>
<td>2.8 W* (H815dw)</td>
<td>2.8 W*</td>
</tr>
<tr>
<td></td>
<td>1.7 W* (S2815dn)</td>
<td>1.7 W*</td>
</tr>
<tr>
<td>Offline</td>
<td>0 W</td>
<td>0 W</td>
</tr>
<tr>
<td>TEC value</td>
<td>2.7 kWh</td>
<td>2.8 kWh</td>
</tr>
</tbody>
</table>

* This condition is equivalent to Network standby mode, the power consumption in this condition is that all wired network ports are connected and all wireless network ports are activated.

**Dimensions**

Height: 492 mm (19.37 inches) Width: 439 mm (17.28 inches) Depth: 438 mm (17.24 inches) Weight (including toner cartridge and drum cartridge): 19.0 kg (41.90 lb)

**Memory**

<table>
<thead>
<tr>
<th>Memory</th>
<th>1 GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>DDR3-1066MHz</td>
</tr>
</tbody>
</table>
Page Description Language (PDL)/Emulation, Operating System, and Interface

**PDL/Emulations**  
PCL 6, PCL5e, PostScript 3 Compatible, HBPL, XML Paper Specification (Host Based/PCL 6)

**Operating systems**  

**Interfaces**
- Standard local: USB 2.0
- Standard wireless network (Dell Cloud Multifunction Printer | H815dw only): IEEE 802.11b/802.11g/802.11n
- Standard wired network: 10Base-T/100Base-TX/1000Base-T Ethernet

**MIB Compatibility**
Management Information Base (MIB) is a database containing information about network devices (such as adapters, bridges, routers, or computers). This information helps network administrators manage the network (analyze performance, traffic, errors, and so on). Dell Cloud Multifunction Printer | H815dw and Dell Smart Multifunction Printer | S2815dn comply with standard industry MIB specifications, allowing the printer to be recognized and managed by various printer and network management software systems.

**Environment**

**Operation**
- **Temperature**: 10 °C - 32 °C
- **Relative humidity**: 10 % - 85 % RH (no condensation)

**Print Quality Guarantee**
- **Temperature**: 15 °C - 28 °C
- **Relative humidity**: 20 % - 70 % RH (no condensation)

**Storage**
- **Temperature range**: -20 °C to 40 °C (0 °F to 104 °F)
- **Storage humidity range**: 5 % - 85 % RH (no condensation)

**Altitude**
- **Operating**: Up to 3,100 m (10,170 feet)
- **Storage**: Up to 3,100 m (10,170 feet)
Cables

Your interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications and symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Ethernet</td>
<td>10Base-T/100Base-TX/1000Base-T</td>
</tr>
<tr>
<td>2 USB</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>3 Phone connector</td>
<td></td>
</tr>
<tr>
<td>4 Wall jack connector</td>
<td></td>
</tr>
</tbody>
</table>

Print Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print resolution</td>
<td>600 dpi x 600 dpi</td>
</tr>
</tbody>
</table>
| Print speed   | Simplex: 38 ppm (A4), 40 ppm (Letter)
                | Duplex: 22 ppm (A4), 24 ppm (Letter)                                                                                                                                 |
| Paper size    | A4, B5, A5, B6, A6, Letter, Executive, Folio (8.5" x 13"), Legal, Statement, Envelope #10, Monarch, DL, C5, Japanese Postcard |
### Copy Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy resolution</td>
<td>Optical: 600 dpi x 600 dpi</td>
</tr>
</tbody>
</table>
| Copy speed          | 38 cpm (A4)/40 cpm (Letter) or more (When using the document glass to make sequential copies of a document with pages scanned one by one.)  
Simplex: 22 cpm (A4)/24 cpm (Letter) or more  
Duplex: 7 cpm (A4/Letter) or more (When using the Duplex Automatic Document Feeder (DADF) to make sequential copies of multiple documents.) |
| Paper size          | A4, B5, A5, B6, A6, Letter, Executive, Folio (8.5" x 13"), Legal, Statement, Envelope #10, Monarch, DL, C5, Japanese Postcard |
| Zoom rate           | Document glass: 25 % - 400 %, DADF: 25 % - 400 %                           |
| Multiple copies     | 1 - 99                                                                       |
| Copy mode (=Original type) | Text, Text & Photo, Photo                                                 |
| Scanning method     | Document glass: Document-fixed flatbed scanning  
DADF: Carriage-fixed, document-feeding scanning (2- side scanning) |

### Scanner Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatibility</td>
<td>TWAIN, TWAIN-Net, Windows Image Acquisition (WIA)*1, Scan Service for Web Services on Devices (WSD)*2</td>
</tr>
</tbody>
</table>
| Scan resolution   | Optical: 600 dpi x 300 dpi (Color only), 600 dpi x 400 dpi, 600 dpi x 600 dpi, 1,200 dpi x 1,200 dpi  
Enhanced (Pull Scan):  
• TWAIN – 50 x 50 to 9,600 x 9,600 dots/25.4 mm  
• Windows Image Acquisition (WIA) – 75/100/150/200/300/400/600 dots/25.4 mm  
Enhanced (Push Scan):  
200 (Default)/300/400/600 dots/25.4 mm |
| Color bit depth   | 24 bit                                                                      |
| Mono bit depth    | 1 bit for Line art. 8 bit for Gray scale                                     |
| Effective scanning length | Document glass: 297 mm. DADF: 355.6 mm                                      |
| Effective scanning width | 215.9 mm                                                                    |
| Scan speed (Text mode) | Monochrome: 665 μs/line (600 dpi), 1330 μs/line (1200 dpi)  
Color: 1330 μs/line (600 dpi), 2660 μs/line (1200 dpi) |

*1 : Windows® OS only  
*2 : Only on Windows Vista®/Windows® 7/Windows® 8/Windows® 8.1/Windows® 10
Facsimile Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatibility</td>
<td>ITU-T Super G3, ITU-T G3 ECM, ITU-T G3</td>
</tr>
<tr>
<td>Applicable line</td>
<td>Public Switched Telephone Network (PSTN), Private Branch Exchange (PBX), or Leased line (3.4 KHz/2-wire)</td>
</tr>
<tr>
<td>Data coding</td>
<td>1bit/JBIG/MMR/MR/MH</td>
</tr>
<tr>
<td>Max modem speed</td>
<td>33.6 Kbps</td>
</tr>
<tr>
<td>Transmission speed</td>
<td>Approx. 3 seconds/page “Transmission time applies to memory transmission of text data scanned in Standard resolution with ECM using only ITU-T No.1 Chart.</td>
</tr>
<tr>
<td>Scanning speed</td>
<td>Document glass: approx. 3 seconds/A4 (at standard fax resolution mode) DADF: approx. 5 seconds/ Letter (at standard fax resolution mode), 7.5 seconds/ Letter (at fine fax resolution mode)</td>
</tr>
<tr>
<td>Maximum document length</td>
<td>Document glass: 297 mm DADF: 355.6 mm</td>
</tr>
<tr>
<td>Paper size</td>
<td>Letter, A4 (depending on a country)</td>
</tr>
<tr>
<td>Resolution</td>
<td>Standard: R8 x 3.85 l/mm, Fine: R8 x 7.7 l/mm, Super Fine: 400 dpi x 400 dpi, Photo: R8 x 7.7 l/mm</td>
</tr>
<tr>
<td>User memory</td>
<td>4 MB</td>
</tr>
<tr>
<td>Halftone</td>
<td>256 levels</td>
</tr>
</tbody>
</table>

Wireless Connection Specifications

NOTE: The wireless network connection feature is available on the Dell Cloud Multifunction Printer | H815dw only.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connectivity technology</td>
<td>Wireless</td>
</tr>
<tr>
<td>Compliant standards</td>
<td>IEEE 802.11b, 802.11g, and 802.11n</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>2.4 GHz</td>
</tr>
</tbody>
</table>
| Data transfer rate    | IEEE 802.11n: 65 Mbps  
IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps  
IEEE 802.11b: 11, 5.5, 2, and 1 Mbps |
| Security              | 64 (40-bit key)/128 (104-bit key) WEP, WPA-PSK (TKIP, AES), WPA2-PSK (AES), WPA-Enterprise (TKIP, AES) *1, WPA2-Enterprise (AES) *1 |
| Wi-Fi Protected Setup (WPS) *2 | Push-Button Configuration (PBC), Personal Identification Number (PIN) |
| Wireless mode         | Infrastructure, Ad-hoc, Wi-Fi Direct |

*1 EAP method supports PEAPv0, EAP-TLS, EAP-TTLS PAP, and EAP-TTLS CHAP.
*2 WPS 2.0 compliant.
Maintaining Your Printer

31 Maintaining Your Printer .......................................................... 443
32 Clearing Jams ............................................................................ 469
Maintaining Your Printer

You need to complete certain tasks to maintain optimum print quality.

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Determining the Status of Supplies

If your printer is connected to the network, the Dell™ Printer Configuration Web Tool can provide instant feedback on remaining toner level. Type the printer's IP address in your web browser to view this information. To use the E-Mail Alert Setup feature that notifies you when the printer requires new supplies, type the desired e-mail address in the e-mail list box.

On the touch panel screen, you can also confirm the following:

- Any supply or maintenance items that require attention replacing (However, the printer can only display information about one item at a time).
- Amount of toner remaining in the toner cartridge.

Conserving Supplies

You can change several settings in your printer driver to conserve toner cartridge and paper.

<table>
<thead>
<tr>
<th>Supply</th>
<th>Setting</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toner cartridge</td>
<td>Toner Saver in the Others tab</td>
<td>This check box allows the users to select a print mode that uses less toner. The image quality will be lower when this feature is used.</td>
</tr>
<tr>
<td>Print media</td>
<td>Multiple Up in the Layout tab</td>
<td>The printer prints two or more pages on one side of a sheet.</td>
</tr>
<tr>
<td>Print media</td>
<td>Duplex in the General tab</td>
<td>The printer prints on both sides of a sheet of paper.</td>
</tr>
</tbody>
</table>

Ordering Supplies

You can order consumables (toner cartridge and drum cartridge) from Dell online or by phone.

Using Dell Printer Configuration Web Tool

1 Start the Dell Printer Configuration Web Tool.
   See "Starting the Dell Printer Configuration Web Tool."

2 Click the Order Supplies at:

Using Dell Printer Hub or Dell Printer Management Tool for Windows®

1 Click Start → All Programs → Dell Printers → Dell Printer Hub or Dell Printer Management Tool.
   For Windows® 10, click the Start button → Dell Printer Hub or Dell Printer Management Tool.

2 For the Dell Printer Hub, select the printer from My Printers.
   For the Dell Printer Management Tool, select the printer displayed by default, or another printer from the drop-down list on the upper-right corner of the screen.

3 Click Supplies.

4 Order consumables either from the web or phone.
   If you are ordering from the web:
Maintaining Your Printer

a. Select your printer type and printer name.
b. Click Next.

If you are ordering by phone:

Call the number that appears on the top-left corner of the window, or click Contact Us. To ensure that you get the best service, have your Dell printer’s Service Tag ready. See "Express Service Code and Service Tag."

For OS X

You can order consumables from the Status Monitor Widget. See "Status Monitor Widget (for OS X)."

For Linux

You can order consumables from the Status Monitor Console. See "Status Monitor Console (for Linux)."

Storing Print Media

To avoid potential paper feeding problems and uneven print quality, there are several things you can do:

- To achieve the best possible print quality, store print media in an environment where the temperature is approximately 21 °C (70 °F) and the relative humidity is 40%.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so the edges do not buckle or curl.
- Do not place anything on top of the print media packages.

Storing Consumables

Store consumables in their original packaging until you need to use them. Do not store consumables in:

- Temperatures greater than 40 °C (104 °F).
- An environment with extreme changes in humidity or temperature.
- Direct sunlight.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- A humid environment.
Replacing the Toner Cartridge

⚠️ **WARNING:** Before performing any of the following procedures, read and follow the safety instructions in the *Important Information.*

Dell toner cartridge is available only through Dell. You can order cartridge online at http://www.dell.com/supplies or by phone. To order by phone, see "Contacting Dell."

It is recommended to use Dell toner cartridge for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

⚠️ **WARNING:** Never throw used toner cartridge into fire. The residual toner could explode resulting in burns and injuries.

⚠️ **WARNING:** Do not shake the used toner cartridge. This may cause toner spills.

Removing the Toner Cartridge

💡 **NOTE:** Ensure that you remove all the paper from the MPF and close the MPF cover before removing the toner cartridge.

1. After flipping up the operator panel until it clicks, grasp the grips on both sides of the front cover, and then pull it down to open.

2. Grasp the toner cartridge lock lever, and then raise it upward to unlock.
3 Grasp the handle on the toner cartridge, and then pull it out.

⚠️ **WARNING:** Do not shake the toner cartridge. This may cause toner spills.

**Installing a Toner Cartridge**

1. Unpack a new toner cartridge.
2. Shake the new toner cartridge five or six times to distribute the toner evenly.
3. Make sure that the two tabs of the toner cartridge align with the grooves on the printer, and then insert it into the printer until it clicks into place.
4 Grasp the toner cartridge lock lever, and then pull it down until it stops.

5 Close the front cover, and put back the operator panel to the original position.
Replacing the Drum Cartridge

⚠️ WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important Information.

⚠️ CAUTION: Protect the drum cartridge against bright light. If the front side cover remains open for more than 3 minutes, print quality may deteriorate.

Removing the Drum Cartridge

1. After flipping up the operator panel until it clicks, grasp the grips on both sides of the front cover, and then pull it down to open.

2. Grasp the handle on the front of the drum cartridge, and then pull it out halfway with one hand.

3. Hold both sides of the drum cartridge with your hands, and then pull it out completely.
Installing a Drum Cartridge

1 Unpack a new drum cartridge.

⚠️ CAUTION: The protective cover of the drum comes off while inserting the drum cartridge into the cartridge slot. You do not need to remove it in advance.

2 Hold both sides of the drum cartridge with your hands, insert the drum cartridge into the cartridge slot, and then push it in halfway.

3 Grasp the handle on the front of the drum cartridge, and then push and install the drum cartridge until it stops.

4 To remove the toner cartridge from the old drum cartridge, grasp the toner cartridge lock lever, and then raise it upward to unlock.
5 Grasp the handle on the toner cartridge, and then pull it out of the old drum cartridge.

⚠️ **WARNING:** Do not shake the toner cartridge. This may cause toner spills.

⚠️ **WARNING:** Keep the removed toner cartridge on a level surface.

6 Install the removed toner cartridge to the new drum cartridge in the printer. Make sure that the two tabs of the toner cartridge align with the grooves on the printer, and then insert it into the printer until it clicks into place.

7 Grasp the toner cartridge lock lever, and then pull it down until it stops.
8 Close the front cover, and put back the operator panel to the original position.
Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller

You need to replace all three parts (the fusing unit, transfer unit, and retard roller) at a time. Both the transfer unit and the retard roller for replacement come with a new fusing unit.

⚠️ **WARNING:** Before performing any of the following procedures, read and follow the safety instructions in the *Important Information.*

Removing the Fusing Unit

1. Turn off the printer, and wait for 40 minutes.
2. Pull the rear cover handle to open the rear cover.
3. Raise the two gray levers on both sides of the fusing unit to unlock.
4. Grasp the grips on both sides of the fusing unit, and then pull out the unit.
Installing a Fusing Unit

1 Unpack a new fusing unit.
2 Remove the packing material from the fusing unit.
3 Insert the fusing unit into the printer until it clicks into place.
   - **NOTE:** Hold both sides of the fusing unit with your hands.
   - **NOTE:** Make sure that the fusing unit is firmly set in the slots and cannot be moved easily.

4 Lower the two gray levers to lock the fusing unit.

- **NOTE:** After replacing the fusing unit, be sure to initialize its life counter by following the instructions in the accompanying manual.
Removing the Transfer Unit

1. Push the tabs on both sides of the transfer unit inward, and then lift it out of the printer.

Installing a Transfer Unit

1. Unpack a new transfer unit.
2. Hold the transfer unit by both its ends.
3. Put the receptacles (white) on both ends of the transfer unit to the short bars near the arrow marks of the duplexer. And tilt the transfer unit toward the rear cover.
4  Make sure that the arrow marks on the transfer unit and the printer face each other, and then press the two tabs on transfer unit inward to lock.

5  Close the rear cover.

Removing the Retard Roller in Tray1

1  Pull tray1 out of the printer about 200 mm.
2 Hold tray1 with both hands, and remove it from the printer.

**NOTE:** Be sure to remove all the paper from tray1 before removing the retard roller.

3 Slightly pressing down the lock lever on tray1 to the right with one hand, raise the retard roller with the other hand.

4 Slide the retard roller to the left to remove it from tray1.

---

**Installing a Retard Roller in Tray1**

1 Unpack a new retard roller.
2 Hold the both ends of the new retard roller, and attach it by sliding the two axles of the retard roller into the holes on tray 1.

![Image of attaching retard roller](image1.png)

**NOTE:** Be careful not to touch the rubber rollers.

3 While pressing the lock lever on tray 1 slightly to the right, press down the retard roller until it clicks, and then release the lock lever.

![Image of pressing lock lever](image2.png)

4 Load paper in tray 1, and then insert the tray into the printer and push until it stops.

![Image of loading paper](image3.png)
Cleaning the Scanner

Keeping the scanner clean helps ensure the best possible copies. It is recommended to clean the scanner at the start of each day and during the day, as needed.

1. Slightly dampen a soft lint-free cloth or paper towel with water.
2. Open the document cover.

3. Wipe the surface of the document glass and DADF glass until it is clean and dry.

4. Wipe the underside of the white document cover and white sheet until it is clean and dry.

5. Close the document cover.

---

1. White Sheet
   **NOTE:** Handle with care.

2. White Document Cover

3. Document Glass

4. DADF Glass

4. Wipe the underside of the white document cover and white sheet until it is clean and dry.

5. Close the document cover.
Cleaning the DADF Feed Roller

Keeping the DADF feed roller clean helps ensure the best possible copies. It is recommended to clean the DADF feed roller at regular intervals.

1. Open the DADF cover.

2. Wipe the DADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.

   If the DADF feed roller gets soiled with ink stains, paper from the DADF may also be soiled. In this case, slightly dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and then remove the contamination from the DADF feed roller until it is clean and dry.

Cleaning Inside the Printer

Clean the feed roller inside the printer if print media does not feed correctly.

1. Turn off the printer and disconnect the power cable.

   **NOTE:** The data in the memory are cleared when the printer is turned off.
2 Gently pull open the MPF cover.

3 Grasp both sides of the MPF, and then pull the MPF from the printer.

4 Pull tray1 out of the printer about 200 mm.
5 Hold tray1 with both hands, and remove it from the printer.

6 Wipe the feed roller inside the printer with a cloth moistened with water.

7 Insert tray1 into the printer, and push until it stops.

**NOTE:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
Insert the MPF into the printer, push until it stops, and close the cover.

Moving the Printer

This section describes how to move the printer.

⚠️ **WARNING:** Two people are required to move the printer.

⚠️ **WARNING:** To prevent you from dropping the printer and getting backache or injuries, lift the printer by firmly gripping the recessed areas on both sides of the printer. Never lift the printer by gripping any other areas.

⚠️ **NOTE:** If the optional 550-sheet feeder has been installed, uninstall the optional 550-sheet feeder before moving the printer. If the optional 550-sheet feeder is not fixed securely to the printer, it may fall to the ground and cause injuries. For details on how to uninstall the optional 550-sheet feeder, see “Removing the Optional 550-Sheet Feeder.”

1. Turn off the printer and disconnect the power cable, interface cable, and any other cables.

   ⚠️ **NOTE:** The data in the memory are cleared when the printer is turned off.

2. Remove any paper in the document output tray and slide the document stopper inside the DADF.
3 Remove any paper in the output tray and retract the output tray extension.

4 Lift the printer and move it gently.

**NOTE:** If you move the printer over a long distance, remove the toner cartridge from the printer to prevent toner from spilling, and pack the printer inside a box.
Removing the Optional 550-Sheet Feeder

⚠️ **WARNING:** When you remove the optional 550-sheet feeder (Tray2), be sure to turn off the printer, unplug the power cable, and disconnect all cables from the rear of the printer before starting these tasks.

1. Ensure that the printer is turned off, and then disconnect all cables from the rear of the printer.
2. Gently pull open the MPF cover.
3. Grasp both sides of the MPF, and then pull the MPF from the printer.
4. Pull tray1 out of the printer about 200 mm.
5 Hold tray 1 with both hands, and remove it from the printer.

6 Remove the two screws joining the printer and the optional 550-sheet feeder by unscrewing them with a coin or similar object.
7 Gently lift the printer off the optional 550-sheet feeder, and place it on a level surface.

⚠️ **WARNING:** Two people are required to lift the printer.

8 Insert tray1 into the printer, and push until it stops.

⚠️ **CAUTION:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
9  Insert the MPF into the printer, push until it stops, and close the MPF.

10  Re-connect all cables into the rear of the printer and turn on the printer.
Clearing Jams

Careful selection of appropriate print media and proper loading allow you to avoid paper jams. See "Print Media Guidelines" for more information.

NOTE: Before buying large quantities of any print media, it is recommended to try a sample first.

NOTE: The images used in this manual are those of the Dell™ Cloud Multifunction Printer | H815dw unless otherwise mentioned.

Avoiding Jams

- Use only recommended print media. See "Print Media Guidelines" for more information.
- See "Loading Print Media in Tray1 and the Optional 550-Sheet Feeder" and "Loading Print Media in the MPF" to load print media properly.
- Do not overload the print media sources. Ensure that the print media stack height does not exceed the maximum height indicated by the load-line labels in the tray.
- Do not load wrinkled, creased, damp, or curled print media.
- Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a time through the multipurpose feeder (MPF).
- Do not use print media that you have cut or trimmed yourself.
- Do not mix print media sizes, weights, or types in the same print media source.
- Ensure that the recommended print side is face up when you insert the print media.
- Keep print media stored in an acceptable environment. For more information, see "Storing Print Media."
- Do not remove the feeding tray during a print job.
- Push tray1 or the optional 550-sheet feeder (tray2) in firmly after loading.
- Ensure that all cables that connect to the printer are correctly attached.
- Overtightening the guides may cause jams.
- Wipe the retard rollers in the tray or MPF with a cloth that is slightly dampened with water if jams caused by misfeeding paper occur frequently.
Identifying the Location of Paper Jams

⚠ WARNING: Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer.

The following illustration shows where paper jams may occur along the print media path.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Duplex Automatic Document Feeder (DADF)</td>
</tr>
<tr>
<td>2</td>
<td>Fusing Unit</td>
</tr>
<tr>
<td>3</td>
<td>Regi Roll</td>
</tr>
<tr>
<td>4</td>
<td>Duplexer</td>
</tr>
<tr>
<td>5</td>
<td>Tray 1</td>
</tr>
<tr>
<td>6</td>
<td>Optional 550-Sheet Feeder</td>
</tr>
<tr>
<td>7</td>
<td>Multipurpose Feeder (MPF)</td>
</tr>
</tbody>
</table>
Clearing Paper Jams From the DADF

When a document jams while it passes through the DADF, remove the jam according to the following procedure.

NOTE: To prevent document jams, use the document glass for thick, thin, or mixed documents.

If status code: 005-112, 005-121, or 005-900 appears:

1. Remove the remaining documents from the DADF.
   If the document is jammed in the paper feed area:
   a. Open the DADF cover.

   b. Lift the release lever 90 degrees and remove the jammed document by carefully pulling it to the right.

If you find it difficult to pull the document:
c  Remove the DADF feed roller assembly and remove the document by gently pulling it straight up.

![Image of DADF feed roller assembly removal](image_url)

If the document is jammed in the paper exit area:

d  Insert the DADF feed roller assembly and press down the release lever.

![Image of DADF feed roller assembly insertion](image_url)

If the document is jammed in the paper exit area:

e  Remove the jammed document from the document output tray.

![Image of document output tray](image_url)
Close the DADF cover, and then load the documents back into the DADF.

NOTE: Ensure that you adjust the document guides before printing a Legal-size document.

2 If you cannot see the jammed document or the jammed document do not move when you pulled, open the document cover.

3 Remove the document from the white sheet by carefully pulling it to the right.

4 Close the document cover, and then load the documents back into the DADF.

5 Tap Start.

If status code: 005-110 appears:

1 Remove the jammed and the remaining documents from the DADF.
   You do not have to open the DADF cover.

2 Load the documents back into the DADF.

3 Tap Start.

Clearing Paper Jams From the MPF

NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1 Remove any paper loaded on the MPF.
2 Grasp both sides of the MPF, and then pull it out of the printer.

3 Pull tray1 out of the printer about 200 mm.

4 Hold tray1 with both hands, and remove it from the printer.
5 Pull the rear cover handle to open the rear cover.

6 Remove the jammed paper.

7 Insert tray 1 into the printer, and push until it stops.
8 Insert the MPF into the printer.

9 Close the rear cover.
Clearing Paper Jams From Tray1

NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1. Gently pull open the MPF cover.

2. Grasp both sides of the MPF, and then pull the MPF from the printer.

3. Pull tray1 out of the printer about 200 mm.
4 Hold tray 1 with both hands, and remove it from the printer.

5 Pull the rear cover handle to open the rear cover.

6 Remove the jammed paper.
7 Insert tray1 into the printer, and push until it stops.

8 Insert the MPF into the printer, push until it stops, and close the MPF.

9 Close the rear cover.

10 Tap Start.
Clearing Paper Jams From the Fusing Unit

NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

If status code: 050-130 appears:

1. Pull the rear cover handle to open the rear cover.

2. Lift the levers on both sides of the fusing unit.
   
   WARNING: The fusing unit is hot. Do not touch it, doing so may cause burns.

3. If the document is jammed under the fusing unit, remove the jammed document from under the fusing unit.
4 If the document is jammed above the fusing unit, raise the tab of the inner part, and turn it to open.

5 Remove the jammed document from above the fusing unit.

6 Replace the inner part.
7 Press down the levers on both sides of the fusing unit.

8 Close the rear cover.
Clearing Paper Jams From the Duplexer

⚠️ **CAUTION:** Ensure that nothing touches or scratches the surface (the roll made with sponge) of the transfer unit. Scratches, dirt, or oil from your hands on the roll of the transfer unit may reduce print quality.

⚠️ **CAUTION:** Protect the drum of the drum cartridge against bright light. If the rear cover remains open for more than 3 minutes, print quality may deteriorate.

⚠️ **NOTE:** To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

If status code: 050-131 appears:

1. Pull the rear cover handle to open the rear cover.

2. Remove the jammed paper from the duplexer.

3. Close the rear cover.
Clearing Paper Jams From the Regi Roll

⚠️ CAUTION: Ensure that nothing touches or scratches the surface (the roll made with sponge) of the transfer unit. Scratches, dirt, or oil from your hands on the roll of the transfer unit may reduce print quality.

⚠️ CAUTION: Protect the drum of the drum cartridge against bright light. If the rear cover remains open for more than 3 minutes, print quality may deteriorate.

⚠️ NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

If status code: 050-142 appears:

1. Open the MPF, or remove the remaining documents from the MPF.

2. Grasp both sides of the MPF, and then pull the MPF from the printer.
3 Pull tray1 from the printer about 200 mm.

4 Hold tray1 with both hands, and remove it from the printer.

5 Pull the rear cover handle to open the rear cover.
6 Remove the jammed paper from the regi roll.

7 Insert tray1 into the printer, and push until it stops.

⚠️ **NOTE:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

8 Insert the MPF into the printer, push until it stops, and close the MPF.
9 Close the rear cover.

If status code: 050-132 appears:

1 Open the MPF, or remove the remaining documents from the MPF.

2 Grasp both sides of the MPF, and then pull the MPF from the printer.
3 Pull tray1 from the printer about 200 mm.

4 Hold tray1 with both hands, and remove it from the printer.

5 Pull the optional 550-sheet feeder from the printer about 200 mm.
6 Hold the optional 550-sheet feeder with both hands, and remove it from the printer.

7 Pull the rear cover handle to open the rear cover.

8 Remove the jammed paper.
9 Insert the optional 550-sheet feeder into the printer, and push until it stops.

10 Insert tray 1 into the printer, and push until it stops.

11 Insert the MPF into the printer, push until it stops, and close the MPF.
Close the rear cover.

**Clearing Paper Jams From the Optional 550-Sheet Feeder**

*NOTE:* To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1. Pull the optional 550-sheet feeder out of the printer about 200 mm.
2 Hold the optional 550-sheet feeder with both hands, and remove it from the printer.

3 Pull the rear cover handle to open the rear cover.

4 Remove the jammed paper.
Insert the optional 550-sheet feeder into the printer, and push until it stops.

Close the rear cover.
Clearing Paper Jams From the Trays

If status code 050-134 appears:

1. Open the MPF, or remove the remaining documents from the MPF.

2. Grasp both sides of the MPF, and then pull the MPF from the printer.

3. Pull tray1 from the printer about 200 mm.
4 Hold tray1 with both hands, and remove it from the printer.

5 Remove the jammed paper.

6 Insert tray1 into the printer, and push until it stops.

**NOTE:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

7 Insert the MPF into the printer, push until it stops, and close the MPF.

8 Tap OK on the touch panel.
If status code 050-133 appears:

1. Open the MPF, or remove the remaining documents from the MPF.

2. Grasp both sides of the MPF, and then pull the MPF from the printer.

3. Pull tray1 from the printer about 200 mm.
4 Hold tray 1 with both hands, and remove it from the printer.

5 Pull the optional 550-sheet feeder from the printer about 200 mm.

6 Hold the optional 550-sheet feeder with both hands, and remove it from the printer.
7 Remove the jammed paper.
8 Insert the optional 550-sheet feeder into the printer, and push until it stops.

9 Insert tray 1 into the printer, and push until it stops.

10 Insert the MPF into the printer, push until it stops, and close the MPF.

11 Tap OK on the touch panel.
Troubleshooting

33 Troubleshooting Guide ............................................................. 501
Troubleshooting Guide

Basic Printer Problems

Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the following:

- The power cable is plugged into the printer and a properly grounded electrical outlet.
- The printer is turned on.
- The electrical outlet is not turned off at any switch or breaker.
- Other electrical equipment plugged into the outlet is working.
- All options are properly installed.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn on the printer. This often fixes the problem.

NOTE: If error messages are displayed on the touch panel or on your computer screen, follow the on-screen instructions to resolve the printer problems. For details about error messages and status codes, see “Understanding Printer Messages.”

Display Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu settings changed from the operator panel have no effect.</td>
<td>Settings in the software program, the printer driver, or the printer utilities are overriding the settings made on the operator panel.</td>
</tr>
</tbody>
</table>

Printing Problems

NOTE: If Panel Lock Control is set to Enable, you need to enter the four-digit password to enter the Admin Settings menu.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job did not print or incorrect characters printed.</td>
<td>Ensure that the top menu appears on the touch panel before you send a job to print. Press the (Home) button to return to the top menu.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the print media is loaded in the printer. Press the (Home) button to return to the top menu.</td>
</tr>
<tr>
<td></td>
<td>Verify that the printer is using the correct Page Description Language (PDL).</td>
</tr>
<tr>
<td></td>
<td>Verify that you are using the correct printer driver.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the correct USB or Ethernet cable is securely connected to the printer.</td>
</tr>
<tr>
<td></td>
<td>Verify that the correct print media size is selected.</td>
</tr>
<tr>
<td></td>
<td>If you are using a print spooler, verify that the spooler has not stalled.</td>
</tr>
<tr>
<td></td>
<td>Print a Demo Page from the Report/List.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the printer is correctly working.</td>
</tr>
<tr>
<td></td>
<td>Check the printer's interface from the Admin Settings.</td>
</tr>
<tr>
<td></td>
<td>Determine the host interface you are using. Print a panel settings report to verify that the current interface settings are correct.</td>
</tr>
</tbody>
</table>
Check if the icon is shown on the touch panel. If is shown, cancel the envelope mode. For details on canceling the envelope mode, see "To Cancel the Envelope Mode."

Ensure that the print media you are using meets the specifications for your printer. See "Supported Paper Types" for more information.

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides of the print media sources are adjusted correctly.

Ensure that tray1, the optional 550-sheet feeder (tray2), or the multi-purpose feeder (MPF) unit is securely inserted.

Do not overload tray1, the optional 550-sheet feeder, or the MPF.

Do not force print media into the MPF when you load it; otherwise, it may skew or buckle.

Ensure that the print media is not curled.

Face the recommended print side up. See "Loading Print Media in Tray1 and the Optional 550-Sheet Feeder" for more information.

Turn the print media over or around and try printing again to see if feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading the print media.

Load print media only when tray1, the optional 550-sheet feeder, or the MPF is empty.

Wipe the retard rollers in tray1, the optional 550-sheet feeder, or the MPF with a cloth moistened with water.

Make sure that the envelope is loaded in the MPF as instructed in "Loading Envelopes in the MPF."

Increase the value for Time-Out using the operator panel, the Tool Box, or Dell™ Printer Configuration Web Tool.

Turn the print media stack over in tray1 or the MPF.

Set Print Mode to High Speed in the printer menu. See "Print Mode" for more information.

Load the print media into the MPF.

NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, see "Understanding the Printer Menus" and "Dell™ Printer Configuration Web Tool."

NOTE: In some of the following procedures you may need to use the Tool Box, which can be opened from the Dell Printer Hub or Dell Printer Management Tool. To start the Tool Box, see "Tool Box (for Microsoft® Windows®)."
• The output is too light
• Toner smears or print comes off
• Random spots/Blurred images
• The entire output is blank
• Streaks appear on the output
• Pitched dots
• Vertical blanks
• Mottle
• Ghosting
• Light-induced fatigue
• Fog
• Bead-Carry-Out (BCO)
• Jagged characters
• Banding
• Auger mark
• Wrinkled/Stained paper
• Damage on the leading edge of paper

The output is too light

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| The toner cartridge may be low or need to be replaced. Confirm the amount of toner left in the toner cartridge.  
  a Check the toner level on the Dell Printer Configuration Web Tool.  
  b Replace the toner cartridge as necessary. | The task is complete. | Go to action 2. |
| 2      |     |    |
| If you are using a non-Dell brand toner cartridge, enable the Non-Dell Toner option.  
  a Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Service Tools on the Printer Maintenance tab.  
  b Ensure that the On check box under Non-Dell Toner is selected. | The task is complete. | Go to action 3. |

Does this solve your problem?
<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>
| 3. | Disable the Toner Saver in the printer driver.  
| a. | On the Others tab, ensure that Off is selected in the Toner Saver drop-down menu.  
| | The task is complete. | Go to action 4. |
| 4. | The print media surface may be uneven. Try changing the Paper Type setting in the printer driver. For example, change the plain paper to thick.  
| a. | On the General tab, change the Paper Type setting.  
| | The task is complete. | Go to action 5. |
| 5. | Verify that the correct print media is being used. See "Supported Paper Types." If not, use the print media recommended for the printer.  
| | The task is complete. | Go to action 6. |
| 6. | Ensure the transfer unit is correctly installed.  
| | The task is complete. | Go to action 7. |
| 7. | Stir the developer in the drum cartridge.  
| a. | Press the (Information) button and tap the Tools tab → tap Admin Settings → Maintenance → Clean Developer.  
| b. | After you stir the developer in the drum cartridge, print a Demo Page from Report/List.  
| | The task is complete. | Go to action 8. |
| 8. | Clean the toner in the drum cartridge.  
| a. | Press the (Information) button and tap the Tools tab → tap Admin Settings → Maintenance → Toner Refresh.  
| b. | After you refresh the toner in the drum cartridge, print a Demo Page from Report/List.  
| | The task is complete. | Go to action 9. |
| 9. | Replace the drum cartridge.  
| a. | Replace the drum cartridge. See "Replacing the Drum Cartridge."  
| b. | After you replace the drum cartridge, click Reports on the Printer Setting Reports tab.  
| c. | Click Demo Page.  
| | The task is complete. | Contact Dell. |
## Toner smears or print comes off

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>
| **1**  | The print media surface may be uneven. Try changing the **Paper Type** setting in the printer driver. For example, change the plain paper to thick.  
  a. On the **General** tab, change the **Paper Type** setting.  
  Does this solve your problem? | The task is complete. | Go to action 2. |
| **2**  | Verify that the correct print media is being used. See "Supported Paper Types." If not, use the print media recommended for the printer.  
  Does this solve your problem? | The task is complete. | Go to action 3. |
| **3**  | Replace the drum cartridge.  
  a. Replace the drum cartridge. See "Replacing the Drum Cartridge."  
  b. After you replace the drum cartridge, test print your document again.  
  Does this solve your problem? | The task is complete. | Go to action 4. |
| **4**  | Clean the transfer unit.  
  a. Press the (Information) button and tap the Tools tab → tap Admin Settings → Maintenance → Clean Transfer Unit.  
  b. After you clean the transfer unit, press the (Information) button and tap Report/List.  
  c. Tap Demo Page.  
  The demo page is printed.  
  Does this solve your problem? | The task is complete. | Go to action 5. |
| **5**  | Replace the fusing unit, the transfer unit, and the retard roller.  
  a. Replace the fusing unit, the transfer unit, and the retard roller. See "Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller."  
  b. After you replace the fusing unit, the transfer unit, and the retard roller, press the (Information) button and tap Report/List.  
  c. Tap Demo Page.  
  The demo page is printed.  
  Does this solve your problem? | The task is complete. | Contact Dell. |
**Random spots/Blurred images**

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ensure that the toner cartridge is installed correctly. See &quot;Installing a Toner Cartridge.&quot;&lt;br&gt;Does this solve your problem?</td>
<td>The task is complete. Go to action 2.</td>
</tr>
<tr>
<td>2</td>
<td>Ensure that the drum cartridge is installed correctly. See &quot;Installing a Drum Cartridge.&quot;&lt;br&gt;Does this solve your problem?</td>
<td>The task is complete. Go to action 3.</td>
</tr>
</tbody>
</table>
| 3      | Replace the drum cartridge.<br>a Replace the drum cartridge. See "Replacing the Drum Cartridge."
| b After you replace the drum cartridge, press the (Information) button and tap Report/List.
| c Tap Demo Page.<br>The demo page is printed.<br>Does this solve your problem? | The task is complete. Contact Dell. | Go to action 3. |

**The entire output is blank**

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Print a Demo Page from Report/List. Ensure that the demo page is correctly printed.&lt;br&gt;Does this solve your problem?</td>
<td>Go to action 2. Go to action 3.</td>
</tr>
<tr>
<td>2</td>
<td>If you are printing a document, try to print another data from the computer.&lt;br&gt;Does this solve your problem?</td>
<td>The task is complete. Go to action 8.</td>
</tr>
<tr>
<td>Action</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>--------</td>
<td>-----</td>
<td>----</td>
</tr>
<tr>
<td>3</td>
<td>The task is complete. Go to action 4.</td>
<td></td>
</tr>
</tbody>
</table>
|        | The toner cartridge may be low or need to be replaced. Confirm the amount of toner left in the toner cartridge.  
  a Check the toner level on the Dell Printer Configuration Web Tool.  
  b Replace the toner cartridge as necessary. | Does this solve your problem? |
| 4      | The task is complete. Go to action 5. |  |
|        | If you are using a non-Dell brand toner cartridge, enable the Non-Dell Toner option.  
  a Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Service Tools on the Printer Maintenance tab.  
  b Ensure that the On check box under Non-Dell Toner is selected. | Does this solve your problem? |
| 5      | The task is complete. Go to action 6. |  |
|        | Disable the Toner Saver in the printer driver.  
  a On the Others tab, ensure that Off is selected in the Toner Saver drop-down menu. | Does this solve your problem? |
| 6      | The task is complete. Go to action 7. |  |
|        | The print media surface may be uneven. Try changing the Paper Type setting in the printer driver. For example, change the plain paper to thick.  
  a On the General tab, change the Paper Type setting. | Does this solve your problem? |
| 7      | The task is complete. Go to action 8. |  |
|        | Verify that the correct print media is being used. See "Supported Paper Types." If not, use the print media recommended for the printer. | Does this solve your problem? |
| 8      | The task is complete. Contact Dell. |  |
|        | Replace the drum cartridge.  
  a Replace the drum cartridge. See "Replacing the Drum Cartridge."  
  b After you replace the drum cartridge, click Reports on the Printer Setting Reports tab.  
  c Click Demo Page.  
  The demo page is printed. | Does this solve your problem? |
**Streaks appear on the output**

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The toner cartridge may be low or need to be replaced. Confirm the amount of toner left in the toner cartridge.</td>
<td>The task is complete.</td>
</tr>
<tr>
<td></td>
<td>a Check the toner level on the Dell Printer Configuration Web Tool.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b Replace the toner cartridge as necessary.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Replace the drum cartridge.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a Replace the drum cartridge. See &quot;Replacing the Drum Cartridge.&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b After you replace the drum cartridge, click Reports on the Printer Setting Reports tab.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c Click Demo Page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>If you are using a non-Dell brand toner cartridge, enable the Non-Dell Toner option.</td>
<td>The task is complete.</td>
</tr>
<tr>
<td></td>
<td>a Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Service Tools on the Printer Maintenance tab.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b Ensure that the On check box under Non-Dell Toner is selected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Replace the drum cartridge.</td>
<td>The task is complete.</td>
</tr>
<tr>
<td></td>
<td>a Replace the drum cartridge. See &quot;Replacing the Drum Cartridge.&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b After you replace the drum cartridge, click Reports on the Printer Setting Reports tab.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c Click Demo Page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
</tbody>
</table>
### Pitched dots

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locate the cause of the problem using the Pitch Configuration Chart.</td>
<td>Proceed to the action corresponding to the location of the problem: • Drum cartridge - 2 • Fusing unit - 3</td>
<td>Contact Dell.</td>
</tr>
<tr>
<td>a Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Chart Print on the Diagnosis tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b Click Pitch Configuration Chart. The Pitch Configuration Chart is printed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>c Compare the pitch of the spots on your output with that on the Pitch Configuration Chart, and locate the cause of the problem.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Is the cause of the problem located?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
<tr>
<td>Replace the drum cartridge.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a Replace the drum cartridge. See &quot;Replacing the Drum Cartridge.&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b After you replace the drum cartridge, click Chart Print on the Diagnosis tab of the Tool Box.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>c Click Pitch Configuration Chart. The Pitch Configuration Chart is printed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
<tr>
<td>Replace the fusing unit, the transfer unit, and the retard roller.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a Replace the fusing unit, the transfer unit, and the retard roller. See &quot;Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller.&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b After you replace the fusing unit, the transfer unit, and the retard roller, click Chart Print on the Diagnosis tab of the Tool Box.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>c Click Pitch Configuration Chart. The Pitch Configuration Chart is printed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Vertical blanks

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>
| 1      | Ensure the light path is not covered.  
  a. Remove the drum cartridge, and keep it in the dark place.  
  b. Clean the rear side of the drum cartridge with a dry cloth. | The task is complete. | Go to action 2. |

**NOTE:** Be careful not to touch or damage the drum.

- c. Re-install the drum cartridge.
- d. Press the **(Information)** button and tap **Report/List**.
- e. Tap **Demo Page**.

  The demo page is printed.

Does this solve your problem?

| 2      | Replace the drum cartridge.  
  a. Replace the drum cartridge. See "Replacing the Drum Cartridge."  
  b. After you replace the drum cartridge, press the **(Information)** button and tap **Report/List**.  
  c. Tap **Demo Page**.  
  The demo page is printed. | The task is complete. | Contact Dell. |

Does this solve your problem?
## Mottle

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>
| 1 Verify that the correct print media is being used. See "Supported Paper Types." If not, use the print media recommended for the printer.  
Does this solve your problem? | The task is complete.  
Go to action 2. | Go to action 2. |
| 2 Raise the transfer unit voltage.  
   a Press the **(Information)** button and tap the **Tools** tab ➝ tap **Admin Settings** ➝ **Maintenance** ➝ **Adjust Transfer Unit**.  
   b Increase the voltage. See "Adjust Transfer Unit." | The task is complete.  
Go to action 3. | Go to action 3. |
| 3 Replace the drum cartridge.  
   a Replace the drum cartridge. See "Replacing the Drum Cartridge."  
   b After you replace the drum cartridge, press the **(Information)** button and tap **Report/List**.  
   c Tap **Demo Page**.  
   The demo page is printed.  
Does this solve your problem? | The task is complete.  
Contact Dell. | Contact Dell. |
## Ghosting

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>
| 1 Identify the type of ghosting.  
  a Positive ghost  
  b Negative ghost | Proceed to the action corresponding to the type of ghosting.  
  Positive ghost - 2a  
  Negative ghost - 2c | Contact Dell. |

Is the type of the problem identified?

- 2a Specify Decrease Ghosting to On.  
  a Press the (Information) button and tap the Tools tab ➔ tap Admin Settings ➔ Maintenance ➔ Decrease Ghosting.  
  b Tap On.  
  c Tap OK.  
  The task is complete.  
  Go to action 2b.  
  Does this solve your problem?

- 2b Lower the transfer unit voltage.  
  a Press the (Information) button and tap the Tools tab ➔ tap Admin Settings ➔ Maintenance ➔ Adjust Transfer Unit.  
  b Decrease the voltage. See "Adjust Transfer Unit."  
  The task is complete.  
  Go to action 3.  
  Does this solve your problem?

- 2c Increase the transfer unit voltage.  
  a Press the (Information) button and tap the Tools tab ➔ tap Admin Settings ➔ Maintenance ➔ Adjust Transfer Unit.  
  b Increase the voltage. See "Adjust Transfer Unit."  
  The task is complete.  
  Go to action 3.  
  Does this solve your problem?

- 3 Verify that the correct print media is being used. See "Supported Paper Types." If not, use the print media recommended for the printer.  
  The task is complete.  
  Go to action 4.  
  Does this solve your problem?
### Light-induced fatigue

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Check the light fatigue pattern using the Pitch Configuration Chart.</td>
<td>Go to action 2.</td>
</tr>
<tr>
<td></td>
<td>a Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Chart Print on the Diagnosis tab.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b Click Pitch Configuration Chart.</td>
<td>The Pitch Configuration Chart is printed.</td>
</tr>
<tr>
<td></td>
<td>Does the pattern on the output match with that on the Pitch Configuration Chart?</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>If the cause of the trouble is identified as the drum cartridge, replace the drum cartridge. See &quot;Replacing the Drum Cartridge.&quot;</td>
<td>The task is complete.</td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
</tbody>
</table>

### Fog

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Check if you are using a non-Dell brand toner cartridge.</td>
<td>Go to action 2a.</td>
</tr>
</tbody>
</table>
**Troubleshooting Guide**

**Bead-Carry-Out (BCO)**

1. **If the printer is installed in a high altitude location, set the altitude of the location.**
   - Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Service Tools on the Printer Maintenance tab.
   - Under Adjust Altitude, select the value close to the altitude of the location where the printer is installed.
   - Click Reports on the Printer Setting Reports tab.
   - Click Demo Page.
     - The demo page is printed.
   Does this solve your problem?
   - The task is complete. Go to action 2.

2a. **Enable the Non-Dell Toner option.**
   - Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Service Tools on the Printer Maintenance tab.
   - Ensure that the On check box under Non-Dell Toner is selected.
   Does this solve your problem?
   - The task is complete. Go to action 2b.

2b. **Replace the drum cartridge and the toner cartridge.**
   - Remove the drum cartridge. See "Removing the Drum Cartridge."
   - Install a drum cartridge and a toner cartridge using a Dell toner.
   - After you replace the drum cartridge and the toner cartridge, click Reports on the Printer Setting Reports tab of the Tool Box.
   - Click Demo Page.
     - The demo page is printed.
   Does this solve your problem?
   - The task is complete. Contact Dell.

3. **Replace the drum cartridge.**
   - Replace the drum cartridge. See "Replacing the Drum Cartridge."
   - After you replace the drum cartridge, click Reports on the Printer Setting Reports tab of the Tool Box.
   - Click Demo Page.
     - The demo page is printed.
   Does this solve your problem?
   - The task is complete. Contact Dell.
Jagged characters

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Set Screen to Fineness in the printer driver.</td>
<td>The task is complete.</td>
</tr>
<tr>
<td></td>
<td>a On the Graphics tab, set Screen to Fineness.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Enable Print Page Mode in the printer driver.</td>
<td>The task is complete.</td>
</tr>
<tr>
<td></td>
<td>a On the Others tab, set Print Page Mode under Image Options: to On.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>If using a downloaded font, ensure that the font is recommended for the printer, operating system, and the application being used.</td>
<td>The task is complete.</td>
</tr>
<tr>
<td></td>
<td>Does this solve your problem?</td>
<td></td>
</tr>
</tbody>
</table>
## Banding

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. <strong>Locate the cause of the problem using the Pitch Configuration Chart.</strong>&lt;br&gt;a. Start the Tool Box from the Dell Printer Hub or Dell Printer Management Tool, and click Chart Print on the Diagnosis tab.&lt;br&gt;b. Click Pitch Configuration Chart.&lt;br&gt;Is the cause of the problem located?</td>
<td>Proceed to the action corresponding to the location of the problem:&lt;br&gt;• Drum cartridge - 2&lt;br&gt;• Fusing unit - 3</td>
<td>Contact Dell.</td>
</tr>
</tbody>
</table>
| 2. Replace the drum cartridge.<br>a. Replace the drum cartridge. See "Replacing the Drum Cartridge."
   b. After you replace the drum cartridge, click Chart Print on the Diagnosis tab of the Tool Box.<br>c. Click Pitch Configuration Chart.<br>The Pitch Configuration Chart is printed.<br>Does this solve your problem? | The task is complete. | Contact Dell. |
| 3. Replace the fusing unit, the transfer unit, and the retard roller.<br>a. Replace the fusing unit, the transfer unit, and the retard roller. See "Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller."
   b. After you replace the fusing unit, the transfer unit, and the retard roller, click Chart Print on the Diagnosis tab of the Tool Box.<br>c. Click Pitch Configuration Chart.<br>The Pitch Configuration Chart is printed.<br>Does this solve your problem? | The task is complete. | Contact Dell. |

## Auger mark

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>
| 1. Replace the drum cartridge. See "Replacing the Drum Cartridge."
   Does this solve your problem? | The task is complete. | Contact Dell. |
### Wrinkled/Stained paper

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that the correct print media is being used. See &quot;Supported Paper Types.&quot; If not, use the print media recommended for the printer. Does this solve your problem?</td>
<td>The task is complete. If printing on an envelope, go to action 2. If printing on print media other than envelopes, go to action 5.</td>
</tr>
<tr>
<td>2</td>
<td>Ensure that the printer is set to the envelope mode. See &quot;Printing on Envelopes – Envelope Mode.&quot; Does this solve your problem?</td>
<td>The task is complete. Go to action 3.</td>
</tr>
<tr>
<td>3</td>
<td>Check the wrinkle. Is the wrinkle within 30 mm of the four edges of the envelope? This type of wrinkle is considered normal. Your printer is not at fault.</td>
<td>Go to action 4.</td>
</tr>
<tr>
<td>4</td>
<td>Load the envelopes in the MPF properly. For details, see &quot;Loading Envelopes in the MPF.&quot; Does this solve your problem?</td>
<td>The task is complete. Go to action 5.</td>
</tr>
<tr>
<td>5</td>
<td>Adjust the paper guides properly. Does this solve your problem?</td>
<td>The task is complete. Go to action 6.</td>
</tr>
<tr>
<td>6</td>
<td>Replace the print media with the freshly unpackaged, undamaged one. Does this solve your problem?</td>
<td>The task is complete. Contact Dell.</td>
</tr>
</tbody>
</table>

### Damage on the leading edge of paper

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Adjust the paper guides properly. Does this solve your problem?</td>
<td>The task is complete. Go to action 2.</td>
</tr>
</tbody>
</table>
### Jam/Alignment Problems

**NOTE:** Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, see "Understanding the Printer Menus" and "Dell™ Printer Configuration Web Tool."

- The top and side margins are incorrect
- Images are skewed
- Tray1/Optional 550-Sheet Feeder Misfeed Jam
- MPF Misfeed Jam
- Regi Jam (Exit Sensor On JAM)
- Exit Jam (Exit Sensor Off JAM)
- Tray1/Optional 550-Sheet Feeder Multi-feed Jam
- MPF Multi-feed Jam

#### The top and side margins are incorrect

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Adjust the paper guides properly.</td>
<td>The task is complete.</td>
<td>Go to action 2.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Use any of the trays in place of the MPF.</td>
<td>The task is complete.</td>
<td>Go to action 3.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Ensure that the margins are set correctly on the application being used.</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust the paper guides properly.</td>
</tr>
<tr>
<td>Use any of the trays in place of the MPF.</td>
</tr>
<tr>
<td>Ensure that the margins are set correctly on the application being used.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Use any of the trays in place of the MPF.</td>
<td>The task is complete.</td>
<td>Go to action 3.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Ensure that the margins are set correctly on the application being used.</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Images are skewed

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Adjust the paper guides properly. Does this solve your problem?</td>
<td>The task is complete. Go to action 2.</td>
</tr>
<tr>
<td>2</td>
<td>Use any of the trays in place of the MPF. Does this solve your problem?</td>
<td>The task is complete. Go to action 3.</td>
</tr>
<tr>
<td>3</td>
<td>Replace the print media with the freshly unpackaged, undamaged one. Does this solve your problem?</td>
<td>The task is complete. Contact Dell.</td>
</tr>
</tbody>
</table>

### Tray1/Optional 550-Sheet Feeder Misfeed Jam

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ensure that tray1 or the optional 550-sheet feeder is properly inserted. Does this solve your problem?</td>
<td>The task is complete. Proceed to the action corresponding to the type of the print media being used:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2a</td>
<td>Use thick paper that is 216 g/m² or less. Does this solve your problem?</td>
<td>The task is complete. Go to action 3a.</td>
</tr>
<tr>
<td>2b</td>
<td>Use thin paper that is 60 g/m² or more. Does this solve your problem?</td>
<td>The task is complete. Go to action 3a.</td>
</tr>
<tr>
<td>2c</td>
<td>Load rough surface paper one sheet at a time. Does this solve your problem?</td>
<td>The task is complete. Go to action 3b.</td>
</tr>
<tr>
<td>2d</td>
<td>Ensure that the print media is not curled. Does this solve your problem?</td>
<td>The task is complete. Go to action 3a.</td>
</tr>
<tr>
<td>2e</td>
<td>Is the print media damp?</td>
<td>Go to action 3c. Go to action 3a.</td>
</tr>
<tr>
<td>3a</td>
<td>Fan the print media. Does this solve your problem?</td>
<td>The task is complete. Go to action 3b.</td>
</tr>
<tr>
<td>3b</td>
<td>Wipe the retard roller in tray1 or the optional 550-sheet feeder with a cloth moistened with water. Does this solve your problem?</td>
<td>The task is complete. Go to action 4b.</td>
</tr>
</tbody>
</table>
### MPF Misfeed Jam

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Ensure that the MPF is properly inserted. | The task is complete. | Proceed to the action corresponding to the type of the print media being used:  
- Thick - 2a  
- Thin - 2b  
- Rough Surface - 2c  
- Envelope - 2d  
If using paper other than the above, go to action 2e. |  |
| 2a     |     |    |
| Use thick paper that is 216 g/m² or less. | The task is complete. | Go to action 3a. |
| 2b     |     |    |
| Use thin paper that is 60 g/m² or more. | The task is complete. | Go to action 3a. |
| 2c     |     |    |
| Load rough surface paper one sheet at a time. | The task is complete. | Go to action 3b. |
| 2d     |     |    |
| Ensure that the envelope is properly loaded in the MPF as instructed in "Loading Envelopes in the MPF." | The task is complete. | Go to action 3c. |
| 2e     |     |    |
| Is the print media damp? | Go to action 3d. | Go to action 3a. |
| 3a     |     |    |
| Fan the print media. | The task is complete. | Go to action 3b. |
| 3b     |     |    |
| Wipe the retard roller in the MPF with a cloth moistened with water. | The task is complete. | Go to action 4b. |
| 3c     |     |    |
| If the envelope is deformed, correct it or use another envelope. | The task is complete. | Go to action 3a. |
| 3d     |     |    |
| Turn over the print media. | The task is complete. | Go to action 4a. |
| 4a     |     |    |
| Use print media that is not damp. | The task is complete. | Go to action 3a. |
| 4b     |     |    |
| Replace the drum cartridge. | The task is complete. | Contact Dell. |
## Regi Jam (Exit Sensor On JAM)

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Ensure that the drum cartridge is installed correctly. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Go to action 2.</td>
</tr>
<tr>
<td>2. Replace the drum cartridge. See &quot;Replacing the Drum Cartridge.&quot; &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Go to action 3.</td>
</tr>
<tr>
<td>3. Ensure that the fusing unit is set properly. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Go to action 4.</td>
</tr>
<tr>
<td>4. Replace the fusing unit, the transfer unit, and the retard roller. &lt;br&gt;a. Replace the fusing unit, the transfer unit, and the retard roller. See &quot;Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller.&quot; &lt;br&gt;b. After you replace the fusing unit, the transfer unit, and the retard roller, press the <strong>(Information)</strong> button and tap <strong>Report/List</strong>. &lt;br&gt;c. Tap <strong>Demo Page</strong>. &lt;br&gt;The demo page is printed. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
</tbody>
</table>

## Exit Jam (Exit Sensor Off JAM)

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Ensure the fusing unit is installed correctly. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Go to action 2.</td>
</tr>
<tr>
<td>2. Replace the fusing unit, the transfer unit, and the retard roller. &lt;br&gt;a. Replace the fusing unit, the transfer unit, and the retard roller. See &quot;Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller.&quot; &lt;br&gt;b. After you replace the fusing unit, the transfer unit, and the retard roller, press the <strong>(Information)</strong> button and tap <strong>Report/List</strong>. &lt;br&gt;c. Tap <strong>Demo Page</strong>. &lt;br&gt;The demo page is printed. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
</tbody>
</table>

## Tray1/Optional 550-Sheet Feeder Multi-feed Jam

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Ensure that tray 1 or the optional 550-sheet feeder is properly inserted. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>If using rough surface paper, go to action 2. &lt;br&gt;If using other type of print media, go to action 3.</td>
</tr>
<tr>
<td>2. Load rough surface paper one sheet at a time. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Go to action 4.</td>
</tr>
<tr>
<td>3. Use print media that is not damp. &lt;br&gt;Does this solve your problem?</td>
<td>The task is complete.</td>
<td>Go to action 4.</td>
</tr>
</tbody>
</table>
### MPF Multi-feed Jam

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>4</strong> Fan the print media.</td>
<td>The task is complete.</td>
<td>Go to action 5.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>5</strong> Wipe the retard roller in tray 1 or the optional 550-sheet feeder where the multi-feed occurred with a cloth moistened with water.</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Noise

<table>
<thead>
<tr>
<th>Action</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> Ensure the media type you are using.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If using rough surface paper, go to action 2.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If using other type of print media, go to action 3.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>2</strong> Load rough surface paper one sheet at a time.</td>
<td>The task is complete.</td>
<td>Go to action 4.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>3</strong> Use print media that is not damp.</td>
<td>The task is complete.</td>
<td>Go to action 4.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>4</strong> Fan the print media.</td>
<td>The task is complete.</td>
<td>Go to action 5.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>5</strong> Wipe the retard roller in the MPF where the multi-feed occurred with a cloth moistened with water.</td>
<td>The task is complete.</td>
<td>Go to action 6.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>6</strong> Decrease the number of print media to be loaded to the MPF.</td>
<td>The task is complete.</td>
<td>Contact Dell.</td>
</tr>
<tr>
<td>Does this solve your problem?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Replace the fusing unit, the transfer unit, and the retard roller.

- Replace the fusing unit, the transfer unit, and the retard roller. See "Replacing the Fusing Unit, the Transfer Unit, and the Retard Roller."
- After you replace the fusing unit, the transfer unit, and the retard roller, press the **(Information)** button and tap **Report/List**.
- Tap **Demo Page**. The demo page is printed.

Does this solve your problem?

- Replace the drum cartridge.

Does this solve your problem?

- Replace the toner cartridge. See "Replacing the Toner Cartridge."

(The toner cartridge has been damaged. Replace it with a new one.)

Contact Dell.
## Copy Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The copy is misaligned or skewed.</td>
<td>Before loading the document(s) on the DADF, straighten the edges of the stack of the document(s).</td>
</tr>
<tr>
<td></td>
<td>Load the document(s) correctly, and align the document guides to the document(s).</td>
</tr>
<tr>
<td>A document loaded in the DADF cannot be copied.</td>
<td>Ensure that the DADF cover is firmly closed.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the release lever is properly positioned.</td>
</tr>
<tr>
<td>Vertical blanks or streaks appear on the output when scanned using the DADF.</td>
<td>Clean the DADF glass.</td>
</tr>
<tr>
<td>Vertical lines appear on the outputs when you copy using the DADF.</td>
<td>Clean the DADF glass.</td>
</tr>
</tbody>
</table>

## Fax Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is not working, there is no display and the buttons are not working.</td>
<td>Unplug the power cable and plug it in again.</td>
</tr>
<tr>
<td></td>
<td>Ensure that there is power to the electrical receptacle.</td>
</tr>
<tr>
<td>No dial tone sounds.</td>
<td>Check that the phone line is connected properly. See &quot;Connecting to the Telephone Line.&quot;</td>
</tr>
<tr>
<td></td>
<td>Check that the phone socket in the wall is working by plugging in another phone.</td>
</tr>
<tr>
<td></td>
<td>Diagnose the fax connection. See &quot;Diagnosing the Fax Connection.&quot;</td>
</tr>
<tr>
<td>Faxes are not sent correctly to the numbers stored in the memory.</td>
<td>Print a Phone Book list and ensure that the numbers are stored in the memory correctly.</td>
</tr>
<tr>
<td>The document does not feed into the printer.</td>
<td>Ensure that the document is not wrinkled and you are putting it in correctly.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the DADF cover is firmly closed.</td>
</tr>
<tr>
<td>Faxes are not received automatically.</td>
<td>The FAX mode should be selected.</td>
</tr>
<tr>
<td></td>
<td>Ensure that there is paper in the paper tray.</td>
</tr>
<tr>
<td></td>
<td>Check to see if the display shows MFP Memory Full.</td>
</tr>
<tr>
<td></td>
<td>If the time interval specified for the following features is too long, change the time interval shorter such as 30 seconds.</td>
</tr>
<tr>
<td></td>
<td>• Auto Rec Fax</td>
</tr>
<tr>
<td></td>
<td>• Auto Rec TEL/FAX</td>
</tr>
<tr>
<td></td>
<td>• Auto Rec Ans/FAX</td>
</tr>
<tr>
<td></td>
<td>Diagnose the fax connection. See &quot;Diagnosing the Fax Connection.&quot;</td>
</tr>
<tr>
<td>The printer does not send faxes.</td>
<td>Sending Fax should show up on the display.</td>
</tr>
<tr>
<td></td>
<td>Check the other fax machine you are sending to, to see if it can receive your fax.</td>
</tr>
<tr>
<td></td>
<td>Check the dialing type for Tone or Pulse.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the document is loaded in the DADF or on the document glass.</td>
</tr>
<tr>
<td></td>
<td>Diagnose the fax connection. See &quot;Diagnosing the Fax Connection.&quot;</td>
</tr>
<tr>
<td>Problem</td>
<td>Action</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| The incoming fax has blank spaces or is received in poor quality. | Check your printer by making a copy.  
The toner cartridge may be empty. Replace the toner cartridge. See "Replacing the Toner Cartridge."  
A noisy phone line can cause line errors. Set the fax modem speed to a slower speed.  
The fax machine sending you the fax may be faulty. |
| Some of the words on an incoming fax are stretched. | The fax machine sending you the fax had a temporary document jam. |
| There are lines on the documents you send. | Check the surface of the document glass and DADF glass for marks and clean it. See "Cleaning the Scanner." |
| Vertical lines appear on the documents when you send using the DADF. | Clean the DADF glass. |
| The printer dials a number, but the connection with another fax machine fails. | The other fax machine may be turned off, out of paper, or cannot answer incoming calls. Speak with the other machine operator and ask her/him to sort out the problem. |
| Documents are not stored in the memory. | There may not be enough memory to store the document. If the display shows a MFP Memory Full message, delete any documents you no longer need from the memory and then restore the document, or wait for the job in progress (e.g., a fax transmission or reception) to complete. |
| Blank areas appear at the bottom of each page or on other pages, with a small strip of text at the top. | You may have chosen the wrong paper settings in the user option setting. See "Print Media Guidelines." |
| The printer will not send or receive faxes. | Ensure that the country code is set correctly. Press the Information (Information) button and tap the Tools tab→tap Admin Settings→Fax Settings→Fax Line Settings→Country.  
Check that the cables are connected properly.  
If the telephone line cord is connected to the printer via any device such as an answering machine and a computer, remove the device and directly connect the telephone line cord to the printer.  
Ensure that Junk Fax Setup is set to off. |
| An error often occurs during a fax transmission or reception. | Reduce the modem speed. Press the Information (Information) button and tap the Tools tab→tap Admin Settings→Fax Settings→Transmission Defaults→Modem Speed. |
| The printer receive faxes, but it does not print. | Check the toner level.  
Ensure that there is paper in the paper tray.  
Ensure that Received Fax Forward is set to off.  
Check whether the printer is in the secure receiving mode. If this mode is turned on, enter the correct password or turn off this mode to print faxes in memory. |
## Scanning Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The scanner does not work.</td>
<td>Ensure that you place the document to be scanned facing down from the document glass, or facing up in the DADF. If there may not be enough available memory to hold the document you want to scan, lower the scan resolution rate and then try scanning again. Check that the USB or Ethernet cable is connected properly. Ensure that the USB or Ethernet cable is not defective. Switch the cable with a known good cable. If necessary, replace the cable. If using the network TWAIN or Windows Image Acquisition (WIA) driver, check that the Ethernet cable is connected properly and the IP address of the printer is set correctly. To check the IP address, see “Verifying the IP Settings.” Check that the scanner is configured correctly. Check the application you want to use to make certain that the scanner job is being sent to the correct port. Ensure that the scanner sharing feature is disabled when you use Mac OS X before you scan documents via an ICA compatible application such as Image Capture. The printer does not support the scanner sharing feature of Mac OS X. Select a printer which is directly connected to the computer via USB or wired/wireless LAN and scan documents.</td>
</tr>
<tr>
<td>The printer scans very slowly.</td>
<td>Graphics are scanned more slowly than text when using the Scan to Email or Scan to Network Folder feature. Communication speed becomes slow in scan mode because of the large amount of memory required to analyze and reproduce the scanned image. Scanning images at a high resolution takes more time than scanning at a low resolution.</td>
</tr>
<tr>
<td>Document misfeeds or multiple feeds occur in the DADF.</td>
<td>Check whether the DADF roller assembly is installed properly. Ensure the document’s paper type meets the specifications for the printer. See “Supported Paper Types” for more information. Check whether the document is properly loaded in the DADF. Ensure that the document guides are adjusted properly. Ensure that the number of document sheets do not exceed the maximum capacity of the DADF. Ensure that the document is not curled. Fan the document well before loading it in the DADF.</td>
</tr>
<tr>
<td>Vertical blanks or streaks appear on the output when scanned using the DADF.</td>
<td>Clean the DADF glass.</td>
</tr>
<tr>
<td>Vertical lines appear on the output when scanned using the DADF.</td>
<td>Clean the DADF glass.</td>
</tr>
<tr>
<td>A smear appears at the same location on the output when scanned using the document glass.</td>
<td>Clean the document glass.</td>
</tr>
<tr>
<td>Images are skewed.</td>
<td>Before loading the document(s) on the DADF, straighten the edges of the stack of the document(s). Ensure that the document is loaded straight in the DADF or on the document glass.</td>
</tr>
<tr>
<td>Problem</td>
<td>Action</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Diagonal lines appear jagged when scanned using the DADF.</td>
<td>If the document uses thick media, try scanning it from the document glass.</td>
</tr>
<tr>
<td>Message appears on your computer screen:</td>
<td>There may be a copying or printing job in progress. When the current job is complete, try the job again.</td>
</tr>
<tr>
<td>• &quot;Device can't be set to the H/W mode you want.&quot;</td>
<td>The selected port is currently being used. Restart your computer and try again.</td>
</tr>
<tr>
<td>• &quot;Port is being used by another program.&quot;</td>
<td>The cable may be improperly connected or the printer may be turned off.</td>
</tr>
<tr>
<td>• &quot;Port is Disabled.&quot;</td>
<td>The scanner driver is not installed or an operating environment is not set up properly.</td>
</tr>
<tr>
<td>• &quot;Scanner is busy receiving or printing data. When the current job</td>
<td>Ensure that the port is properly connected and the printer is turned on. Then restart your computer.</td>
</tr>
<tr>
<td>is completed, try again.&quot;</td>
<td>Check that the USB or Ethernet cable is connected properly.</td>
</tr>
<tr>
<td>• &quot;Invalid handle.&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;Scanning has failed.&quot;</td>
<td></td>
</tr>
<tr>
<td>The printer does not properly transfer scan data to a specified</td>
<td>Check if the following settings have been set correctly on the Dell Printer Configuration Web Tool.</td>
</tr>
<tr>
<td>data via the Scan to Email or Scan to Network Folder feature.</td>
<td></td>
</tr>
<tr>
<td>Scan to Network Folder</td>
<td>Check the following settings under Address Book→ Server Address:</td>
</tr>
<tr>
<td>Check the following settings under Address Book→ Server Address:</td>
<td>• Server Address</td>
</tr>
<tr>
<td>• Server Address</td>
<td></td>
</tr>
<tr>
<td>• Share Name</td>
<td></td>
</tr>
<tr>
<td>• Server Path</td>
<td></td>
</tr>
<tr>
<td>• Login Name</td>
<td></td>
</tr>
<tr>
<td>• Login Password</td>
<td></td>
</tr>
<tr>
<td>Scan to Email</td>
<td>Check the following setting under Address Book→ E-Mail Address:</td>
</tr>
<tr>
<td>Check the following setting under Address Book→ E-Mail Address:</td>
<td>• Address</td>
</tr>
<tr>
<td>• Address</td>
<td></td>
</tr>
<tr>
<td>Cannot scan using Windows Image Acquisition (WIA) on a Microsoft</td>
<td>Enable Windows Image Acquisition (WIA) on the computer.</td>
</tr>
<tr>
<td>Windows Server® 2003 computer.</td>
<td>To enable Windows Image Acquisition (WIA):</td>
</tr>
<tr>
<td>1 Click Start, point to Administrative Tools, and then click Services.</td>
<td>2 Right-click Windows Image Acquisition (WIA), and then click Start.</td>
</tr>
<tr>
<td>Cannot scan using TWAIN or Windows Image Acquisition (WIA) on a</td>
<td>Install the Desktop Experience feature on the computer.</td>
</tr>
<tr>
<td>Windows Server® 2008 or Windows Server® 2008 R2 computer.</td>
<td>To install Desktop Experience:</td>
</tr>
<tr>
<td>1 Click Start, point to Administrative Tools, and then click Server Manager.</td>
<td>2 Under Features Summary, click Add Features.</td>
</tr>
<tr>
<td>3 Select the Desktop Experience check box, click Next, and then click Install.</td>
<td>4 Restart the computer.</td>
</tr>
</tbody>
</table>
Cannot scan using TWAIN or Windows Image Acquisition (WIA) on a Windows Server® 2012 or Windows Server® 2012 R2 computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:
1 Click Server Manager from the Start screen.
2 Under Manage, click Add Roles and Features.
3 Click Next to skip the Before you begin page.
4 Ensure that Role-based or feature-based installation is selected, and then click Next.
5 Ensure that Select a server from the server pool is selected, select the server under Server Pool, and then click Next.
6 Click Next to skip the Select server roles page.
7 Select the Desktop Experience check box under User Interfaces and Infrastructure, and then click Next.
8 Click Confirmation from the list on the left.
9 Select the Restart the destination server automatically if required check box, and then click Install.
10 Restart the computer.

### Digital Certificate Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The certificate import button is disabled.</td>
<td>SSL/TLS communication is disabled.</td>
<td>Create a self-signed certificate and enable SSL/TLS.</td>
</tr>
<tr>
<td>The certificate details button is disabled.</td>
<td>The time setting is incorrect.</td>
<td>Confirm validity period of the certificate as well as the time setting of the device.</td>
</tr>
<tr>
<td>The certificate cannot be imported.</td>
<td>The certificate file is incorrect.</td>
<td>Confirm whether the password is correct. Confirm whether the file type is PKCS#7/#12 or x509CACert (extension: p7b/p12/pfx/cer/crt). Confirm whether the attribute information (key Usage/Extended key usage) of the certificate to be imported is set correctly.</td>
</tr>
<tr>
<td>016-404 is displayed when trying to use security functions that require certificates.</td>
<td>The certificate data stored in internal memory is either deleted, corrupt, or is not readable.</td>
<td>Import the certificate and enable the security settings again.</td>
</tr>
</tbody>
</table>
## Troubleshooting Guide

### Problems With Installed Optional Accessory

If an option does not operate correctly following installation or stops working:

- Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the printer, and check the connection between the option and the printer.
- Print the system settings report to see if the option is listed in the Printer Options list. If the option is not listed, re-install it. See "Report / List."
- Ensure the option is selected in the printer driver you are using.

The following table lists printer's option and corrective action for related problem. If the suggested corrective action does not correct the problem, call customer service.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A certificate cannot be set with &quot;Certificate Details&quot;.</td>
<td>The validity period is invalid.</td>
<td>The validity period of the certificate is invalid. Confirm whether the time setting of the machine is correct, and whether the validity period of the certificate has expired.</td>
</tr>
<tr>
<td></td>
<td>The certificate path is invalid.</td>
<td>The certificate chain (path validation) of the imported certificate may not be correctly validated. Confirm whether all of the high-level certificates (Trusted/Intermediate) have been imported and are not deleted, and whether the validity period has expired.</td>
</tr>
<tr>
<td>Although a certificate was imported, it is not displayed when selecting with &quot;Local Device&quot;.</td>
<td>The type of the certificate is incorrect.</td>
<td>To import a certificate for use with the device (own device), import the secret key and a certificate of the PKCS#12 (p12/pfx) format as a pair.</td>
</tr>
<tr>
<td>Server validation is not operating correctly.</td>
<td>The certificate chain is incorrect when importing.</td>
<td>Although importing a root certificate (Trusted) to use for server authentication, an Intermediate certificate may be required when validating the path. When executing a certificate file with the certification authority, create the certificate with a format including all paths and then import that certificate.</td>
</tr>
</tbody>
</table>

### Wi-Fi Direct Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The device cannot discover the printer.</td>
<td>The printer may be connected to another device via Wi-Fi Direct. Disconnect the printer and the device. See &quot;Disconnecting Wi-Fi Direct Network.&quot;</td>
</tr>
</tbody>
</table>
When you call for printer service, be prepared to describe the problem you are experiencing or the error message that appears.

You need to know the model type and Service Tag number of your printer. See the label located inside the front cover of your printer and write down the Service Tag number. For details on the location of the Service Tag, see "Express Service Code and Service Tag."

---

**Scanner Driver/Printer Utility Problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to retrieve the Address Book data from the printer on the Address Book Editor.</td>
<td>Check that the USB or Ethernet cable is connected properly. Ensure that the printer is turned on. Ensure that the scanner driver is installed on your computer. (The Address Book Editor retrieves the Address Book data via the scanner driver when the printer is connected using a USB cable.)</td>
</tr>
<tr>
<td>The TWAIN driver cannot connect to the printer.</td>
<td>Check that the USB or Ethernet cable is connected properly. If using the network connection, check that IP address of the printer is set correctly. To check the IP address, see &quot;Scanning Using the TWAIN Driver.&quot; Check whether the printer is turned on. If the printer is turned on, reboot it by turning off the printer and then on again. If a scan application is running, close the application once, restart the application, and then try scanning again.</td>
</tr>
<tr>
<td>The scanner driver has not been registered on your computer.</td>
<td>Install the scanner driver. If the scanner driver is installed, uninstall it and then re-install it again.</td>
</tr>
</tbody>
</table>

**Other Problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condensation has occurred inside the printer.</td>
<td>This usually occurs within several hours after you heat the room in winter. This also occurs when the printer is operating in a location where relative humidity reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate environment.</td>
</tr>
</tbody>
</table>


---

**Contacting Service**

When you call for printer service, be prepared to describe the problem you are experiencing or the error message that appears.

You need to know the model type and Service Tag number of your printer. See the label located inside the front cover of your printer and write down the Service Tag number. For details on the location of the Service Tag, see "Express Service Code and Service Tag."
Appendix

Dell™ Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the operating system, software program and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is provided by the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Online Services

You can access Dell Support through the following websites:

- Product support and manuals
  - www.dell.com/support
  - www.dell.com/support/manuals
  - www.dell.com/printer

Warranty and Return Policy

Dell Inc. ("Dell") manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your printer, see dell.com/support.

Recycling Information

It is recommended that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials.

For specific information on Dell’s worldwide recycling programs, see www.dell.com/recyclingworldwide.

Contacting Dell

You can contact Dell electronically using the following addresses:

- World Wide Web
  - www.dell.com/contactdell
New Zealand PTC200 Warnings

General warning
"The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection to its network. It indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work correctly in all respects with another item of Telepermitted equipment of a different make or model, nor does it imply that any product is compatible with all of Telecom's network services"

Warnings taken from Specification text

2.11.1 Compliance testing (6) & (7) (Functional tests)
"This equipment is not capable, under all operating conditions, of correct operation at the higher speeds for which it is designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

4.5.1 Off-hook line impedance
(4) "This equipment does not fully meet Telecom's impedance requirements. Performance limitations may occur when used in conjunction with some parts of the network. Telecom will accept no responsibility should difficulties arise in such circumstances"

4.9.3 Non-voice equipment
(4) "This equipment is not capable, under all operating conditions, of correct at the higher speeds for which it is designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

5.6.1 General requirements (automatic dialling devices)
(3) "This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency Service"

5.5.5 User instructions
(4) If a charge for local calls is unacceptable, the 'Dial' button should NOT be used for local calls. Only the 7-digits of the local number should be dialled from your telephone. DO NOT dial the area code digit or the '0' prefix

8.1.7 User Instructions (automatic call set-up)
(b) This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency Service

8.2.1(b) Call answering
When this equipment is set up call answering not within 3~30 sec., the telephone or answering machine shall answer incoming call with 3~30sec.
USA/Canada Wi-Fi Warnings

Class B:

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE STATEMENT

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

CAUTION:
Any changes or modifications not expressly approved by the grantee of this device could void the user's authority to operate the equipment.

Labeling Requirements

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference, including interference that may cause undesired operation.

RF Exposure Warning

This equipment must be installed and operated in accordance with provided instructions and the antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all persons and must not be co-located or operating in conjunction with any other antenna or transmitter. End-users and installers must be provide with antenna installation instructions and transmitter operating conditions for satisfying RF exposure compliance.

Canada, Industry Canada (IC) Notices

This Class B digital apparatus complies with Canadian ICES-003 and RSS-210.

Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.
Radio Frequency (RF) Exposure Information

The radiated output power of the Wireless Device is below the Industry Canada (IC) radio frequency exposure limits. The Wireless Device should be used in such a manner such that the potential for human contact during normal operation is minimized.

This device has also been evaluated and shown compliant with the IC RF Exposure limits under mobile exposure conditions. (antennas are greater than 20cm from a person's body).

This device has been certified for use in Canada. Status of the listing in the Industry Canada's REL (Radio Equipment List) can be found at the following web address:

Additional Canadian information on RF exposure also can be found at the following web address:

Canada, avis d'Industry Canada (IC)

Cet appareil numérique de classe B est conforme aux normes canadiennes ICES-003 et RSS-210. Son fonctionnement est soumis aux deux conditions suivantes : (1) cet appareil ne doit pas causer d'interférence et (2) cet appareil doit accepter toute interférence, notamment les interférences qui peuvent affecter son fonctionnement.

Informations concernant l’exposition aux fréquences radio (RF)

La puissance de sortie émise par l'appareil de sans fil Dell est inférieure à la limite d'exposition aux fréquences radio d'Industry Canada (IC). Utilisez l'appareil de sans fil Dell de façon à minimiser les contacts humains lors du fonctionnement normal.

Ce périphérique a également été évalué et démontré conforme aux limites d'exposition aux RF d'IC dans des conditions d'exposition à des appareils mobiles (les antennes se situent à moins de 20 cm du corps d'une personne).

Ce périphérique est homologué pour l'utilisation au Canada. Pour consulter l'entrée correspondant à l'appareil dans la liste d'équipement radio (REL - Radio Equipment List) d'Industry Canada rendez-vous sur:

Pour des informations supplémentaires concernant l'exposition aux RF au Canada rendez-vous sur :

Canada IC Statement

NOTICE:
• This equipment meets the applicable Industry Canada Terminal Equipment Technical Specifications. This is confirmed by the registration number. The abbreviation, IC, before the registration number signifies that registration was performed based on a Declaration of Conformity indicating that Industry Canada technical specifications were met. It does not imply that Industry Canada approved the equipment.

• The Ringer Equivalence Number (REN) for this terminal equipment is 0.0. The REN assigned to each terminal equipment provides an indication of the maximum number of terminals allowed to be connected to a telephone interface. The termination on an interface may consist of any combination of devices subject only to the requirement that the sum of the Ringer Equivalence Numbers of all the devices does not exceed five.
Avis :

- Le présent matériel est conforme aux spécifications techniques d'Industrie Canada applicables au matériel terminal. Cette conformité est confirmée par le numéro d'enregistrement. Le sigle IC, placé devant le numéro d'enregistrement, signifie que l'enregistrement s’est effectué conformément à une déclaration de conformité et indique que les spécifications techniques d'Industrie Canada ont été respectées. Il n'implique pas qu'Industrie Canada a approuvé le matériel.

- L'indice d'équivalence de la sonnerie (IES) du présent matériel est de 0.0. L'IES assigné à chaque dispositif terminal indique le nombre maximal de terminaux qui peuvent être raccordés à une interface téléphonique. La terminaison d'une interface peut consister en une combinaison quelconque de dispositifs, à la seule condition que la somme d'indices d'équivalence de la sonnerie de tous les dispositifs n'excède pas 5.